Hydrologic Modeling System
HEC-HMS

User's Manual

Version 3.0.0
December 2005
The Hydrologic Modeling System (HEC-HMS) is designed to simulate the precipitation-runoff processes of dendritic watershed systems. It supersedes HEC-1 and provides a similar variety of options but represents a significant advancement in terms of both computer science and hydrologic engineering. In addition to unit hydrograph and hydrologic routing options, capabilities include a linear quasi-distributed runoff transform (ModClark) for use with gridded precipitations, continuous simulation with either a one-layer or more complex five-layer soil moisture method, and a versatile parameter estimation option.

The program features a completely integrated work environment including a database, data entry utilities, computation engine, and results reporting tools. A graphical user interface allows the user seamless movement between the different parts of the program. Simulation results are stored in the Data Storage System (HEC-DSS) and can be used in conjunction with other software for studies of water availability, urban drainage, flow forecasting, future urbanization impact, reservoir spillway design, flood damage reduction, floodplain regulation, and systems operation.

Program functionality and appearance are the same across all supported platforms. It is available for Microsoft Windows® and Sun Microsystems Solaris™ operating systems.

2005. This Hydrologic Engineering Center (HEC) documentation was developed with U.S. Federal Government resources and is therefore in the public domain. It may be used, copied, distributed, or redistributed freely. However, it is requested that HEC be given appropriate acknowledgment in any subsequent use of this work.

Use of the software described by this document is controlled by certain terms and conditions. The user must acknowledge and agree to be bound by the terms and conditions of usage before the software can be installed or used. For reference, a copy of the terms and conditions of usage are included in Appendix D of this document so that they may be examined before obtaining the software.

This document contains references to product names that are trademarks or registered trademarks of their respective owners. Use of specific product names does not imply official or unofficial endorsement. Product names are used solely for the purpose of identifying products available in the public market place.

Athlon is a trademark of Advanced Micro Devices, Inc.

Intel and Pentium are registered trademarks of Intel Corp.

Microsoft and Windows are registered trademarks of Microsoft Corp.

Solaris and Java are trademarks of Sun Microsystems, Inc. UltraSPARC is a registered trademark of Sun Microsystems, Inc.

Please recycle this document when you are finished using it.
# Table of Contents

**PREFACE**

**INTRODUCTION**

**INSTALLING AND RUNNING THE PROGRAM**

**OVERVIEW**

**PROGRAM SCREEN**

**DATA CONVENTIONS**

**APPLICATION STEPS**

**DATA CONVENTIONS**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PREFACE</td>
<td>IX</td>
</tr>
<tr>
<td>INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>SCOPE</td>
<td>1</td>
</tr>
<tr>
<td>HISTORY</td>
<td>1</td>
</tr>
<tr>
<td>CAPABILITIES</td>
<td>2</td>
</tr>
<tr>
<td>Watershed Physical Description</td>
<td>2</td>
</tr>
<tr>
<td>Meteorology Description</td>
<td>3</td>
</tr>
<tr>
<td>Hydrologic Simulation</td>
<td>4</td>
</tr>
<tr>
<td>Parameter Estimation</td>
<td>4</td>
</tr>
<tr>
<td>Analyzing Simulations</td>
<td>4</td>
</tr>
<tr>
<td>GIS Connection</td>
<td>4</td>
</tr>
<tr>
<td>LIMITATIONS</td>
<td>4</td>
</tr>
<tr>
<td>Model Formulation</td>
<td>5</td>
</tr>
<tr>
<td>Flow Representation</td>
<td>5</td>
</tr>
<tr>
<td>DOCUMENTATION CONVENTIONS</td>
<td>6</td>
</tr>
<tr>
<td>REFERENCES</td>
<td>6</td>
</tr>
<tr>
<td>INSTALLING AND RUNNING THE PROGRAM</td>
<td>7</td>
</tr>
<tr>
<td>OPERATING SYSTEM REQUIREMENTS</td>
<td>7</td>
</tr>
<tr>
<td>HARDWARE REQUIREMENTS AND RECOMMENDATIONS</td>
<td>7</td>
</tr>
<tr>
<td>INSTALLATION</td>
<td>8</td>
</tr>
<tr>
<td>Microsoft Windows® Operating System</td>
<td>8</td>
</tr>
<tr>
<td>Sun Microsystems Solaris™ Operating System</td>
<td>9</td>
</tr>
<tr>
<td>RUNNING THE PROGRAM</td>
<td>10</td>
</tr>
<tr>
<td>Microsoft Windows® Operating System</td>
<td>10</td>
</tr>
<tr>
<td>Sun Microsystems Solaris™ Operating System</td>
<td>10</td>
</tr>
<tr>
<td>COMMAND LINE OPERATION</td>
<td>11</td>
</tr>
<tr>
<td>ADDITIONAL RESOURCES</td>
<td>12</td>
</tr>
<tr>
<td>OVERVIEW</td>
<td>13</td>
</tr>
<tr>
<td>PROGRAM SCREEN</td>
<td>13</td>
</tr>
<tr>
<td>Menu System</td>
<td>14</td>
</tr>
<tr>
<td>Toolbar</td>
<td>17</td>
</tr>
<tr>
<td>Watershed Explorer</td>
<td>17</td>
</tr>
<tr>
<td>Desktop</td>
<td>19</td>
</tr>
<tr>
<td>Component Editor</td>
<td>19</td>
</tr>
<tr>
<td>Message Log</td>
<td>21</td>
</tr>
<tr>
<td>PROGRAM SETTINGS</td>
<td>21</td>
</tr>
<tr>
<td>DATA CONVENTIONS</td>
<td>22</td>
</tr>
<tr>
<td>Saving Properties</td>
<td>22</td>
</tr>
<tr>
<td>Number Formatting</td>
<td>23</td>
</tr>
<tr>
<td>Date and Time Formatting</td>
<td>23</td>
</tr>
<tr>
<td>Units Conversion</td>
<td>24</td>
</tr>
<tr>
<td>Interpolation</td>
<td>24</td>
</tr>
<tr>
<td>APPLICATION STEPS</td>
<td>24</td>
</tr>
<tr>
<td>Create a New Project</td>
<td>25</td>
</tr>
<tr>
<td>Enter Shared Project Data</td>
<td>25</td>
</tr>
<tr>
<td>Describe the Physical Watershed</td>
<td>26</td>
</tr>
<tr>
<td>Describe the Meteorology</td>
<td>29</td>
</tr>
<tr>
<td>Enter Simulation Time Windows</td>
<td>30</td>
</tr>
<tr>
<td>Simulate and View Results</td>
<td>31</td>
</tr>
<tr>
<td>Create or Modify Data</td>
<td>33</td>
</tr>
<tr>
<td>Make Additional Simulations and Compare Results</td>
<td>34</td>
</tr>
<tr>
<td>Exit the Program</td>
<td>34</td>
</tr>
</tbody>
</table>
# Table of Contents

## PROJECTS AND CONTROL SPECIFICATIONS

**PROJECTS** .......................................................................................................................... 35
Creating a New Project ............................................................................................................. 35
Opening a Project ...................................................................................................................... 35
Copying a Project ...................................................................................................................... 36
Renaming a Project ................................................................................................................... 37
Deleting a Project ..................................................................................................................... 38
Project Properties .................................................................................................................... 39
Project Options ....................................................................................................................... 40

**DIRECTORIES AND FILES** ............................................................................................. 41
Files Generated by the Program ............................................................................................... 41
Files Specified by the User ........................................................................................................ 43
Manually Entered Time-Series and Paired Data ...................................................................... 43
Computed Results .................................................................................................................... 43
External Time-Series, Paired, and Grid Data .......................................................................... 44
Security Limitations .................................................................................................................. 44

**CONTROL SPECIFICATIONS** ....................................................................................... 44
Creating a New Control Specifications .................................................................................... 44
Copying a Control Specifications ............................................................................................ 45
Renaming a Control Specifications .......................................................................................... 46
Deleting a Control Specifications ............................................................................................. 48
Time Window ........................................................................................................................... 49
Time Interval ............................................................................................................................ 50

**IMPORTING HEC-1 FILES** ............................................................................................. 50
Selecting and Processing a File ............................................................................................... 51
Unsupported Features ................................................................................................................ 53

**REFERENCES** .................................................................................................................. 53

## SHARED COMPONENT DATA

**TIME-SERIES DATA** ........................................................................................................ 55
Creating a New Gage ................................................................................................................ 55
Copying a Gage ......................................................................................................................... 56
Renaming a Gage ....................................................................................................................... 57
Deleting a Gage ......................................................................................................................... 59
Time Windows ......................................................................................................................... 60
Data Source ............................................................................................................................. 63
Data Units ................................................................................................................................ 64
Time Interval ............................................................................................................................ 64
Retrieval From a HEC-DSS File .............................................................................................. 65
Table ........................................................................................................................................ 65
Graph ....................................................................................................................................... 67
Latitude and Longitude ............................................................................................................ 68
Elevation .................................................................................................................................. 69

**PAIRED DATA** .................................................................................................................. 69
Creating a New Curve .............................................................................................................. 69
Copying a Curve ....................................................................................................................... 70
Renaming a Curve .................................................................................................................... 72
Deleting a Curve ....................................................................................................................... 73
Data Source ............................................................................................................................. 74
Data Units ................................................................................................................................ 75
Time Intervals .......................................................................................................................... 75
Retrieval From a HEC-DSS File .............................................................................................. 75
Table ........................................................................................................................................ 78
Graph ....................................................................................................................................... 79

**REFERENCES** .................................................................................................................. 34
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRID DATA</td>
<td>80</td>
</tr>
<tr>
<td>Creating a New Grid</td>
<td>80</td>
</tr>
<tr>
<td>Copying a Grid</td>
<td>81</td>
</tr>
<tr>
<td>Renaming a Grid</td>
<td>82</td>
</tr>
<tr>
<td>Deleting a Grid</td>
<td>83</td>
</tr>
<tr>
<td>Retrieval From a HEC-DSS File</td>
<td>85</td>
</tr>
<tr>
<td>REFERENCES</td>
<td>88</td>
</tr>
<tr>
<td>WATERSHED PHYSICAL DESCRIPTION</td>
<td>89</td>
</tr>
<tr>
<td>BASIN MODELS</td>
<td>89</td>
</tr>
<tr>
<td>Creating a New Basin Model</td>
<td>89</td>
</tr>
<tr>
<td>Copying a Basin Model</td>
<td>90</td>
</tr>
<tr>
<td>Renaming a Basin Model</td>
<td>91</td>
</tr>
<tr>
<td>Deleting a Basin Model</td>
<td>92</td>
</tr>
<tr>
<td>Importing a Basin Model</td>
<td>93</td>
</tr>
<tr>
<td>Gridded Subbasins</td>
<td>94</td>
</tr>
<tr>
<td>Optional Flow Computations</td>
<td>94</td>
</tr>
<tr>
<td>Unit System</td>
<td>95</td>
</tr>
<tr>
<td>Background Maps</td>
<td>95</td>
</tr>
<tr>
<td>Maximum Extents</td>
<td>97</td>
</tr>
<tr>
<td>HYDROLOGIC ELEMENTS</td>
<td>98</td>
</tr>
<tr>
<td>Creating a New Element</td>
<td>98</td>
</tr>
<tr>
<td>Copying an Element</td>
<td>99</td>
</tr>
<tr>
<td>Pasting an Element</td>
<td>101</td>
</tr>
<tr>
<td>Cutting an Element</td>
<td>102</td>
</tr>
<tr>
<td>Renaming an Element</td>
<td>102</td>
</tr>
<tr>
<td>Deleting an Element</td>
<td>103</td>
</tr>
<tr>
<td>Optional Features</td>
<td>105</td>
</tr>
<tr>
<td>Element Inventory</td>
<td>106</td>
</tr>
<tr>
<td>FLOW NETWORK</td>
<td>106</td>
</tr>
<tr>
<td>Connecting and Disconnecting Elements</td>
<td>106</td>
</tr>
<tr>
<td>Moving Elements</td>
<td>108</td>
</tr>
<tr>
<td>Background Gridlines</td>
<td>109</td>
</tr>
<tr>
<td>Element Icons and Names</td>
<td>109</td>
</tr>
<tr>
<td>Displaying Flow Directions</td>
<td>109</td>
</tr>
<tr>
<td>Finding and Selecting Elements</td>
<td>109</td>
</tr>
<tr>
<td>Adjusting the View and Zooming</td>
<td>111</td>
</tr>
<tr>
<td>SUBBASIN</td>
<td>112</td>
</tr>
<tr>
<td>Selecting a Loss Method</td>
<td>112</td>
</tr>
<tr>
<td>Deficit Constant Loss</td>
<td>113</td>
</tr>
<tr>
<td>Exponential Loss</td>
<td>114</td>
</tr>
<tr>
<td>Green Ampt Loss</td>
<td>115</td>
</tr>
<tr>
<td>Gridded Deficit Constant Loss</td>
<td>116</td>
</tr>
<tr>
<td>Gridded SCS Curve Number Loss</td>
<td>117</td>
</tr>
<tr>
<td>Gridded Soil Moisture Accounting</td>
<td>118</td>
</tr>
<tr>
<td>Initial Constant Loss</td>
<td>119</td>
</tr>
<tr>
<td>SCS Curve Number Loss</td>
<td>120</td>
</tr>
<tr>
<td>Soil Moisture Accounting Loss</td>
<td>121</td>
</tr>
<tr>
<td>Selecting a Transform Method</td>
<td>122</td>
</tr>
<tr>
<td>Clark Unit Hydrograph Transform</td>
<td>123</td>
</tr>
<tr>
<td>Kinematic Wave Transform</td>
<td>124</td>
</tr>
<tr>
<td>ModClark Transform</td>
<td>127</td>
</tr>
<tr>
<td>SCS Unit Hydrograph Transform</td>
<td>127</td>
</tr>
<tr>
<td>Snyder Unit Hydrograph Transform</td>
<td>128</td>
</tr>
<tr>
<td>User-Specified S-Graph Transform</td>
<td>128</td>
</tr>
<tr>
<td>User-Specified Unit Hydrograph Transform</td>
<td>129</td>
</tr>
</tbody>
</table>
Table of Contents

Selecting a Baseflow Method ................................................................. 129
Bounded Recession Baseflow .............................................................. 130
Constant Monthly Baseflow ................................................................. 131
Linear Reservoir Baseflow ................................................................. 131
Recession Baseflow ........................................................................ 132

REACH .................................................................................................. 133
Selecting a Route Method ................................................................. 133
Kinematic Wave Route ...................................................................... 134
Lag Route .......................................................................................... 135
Modified Puls Route ......................................................................... 136
Muskingum Route ............................................................................ 136
Muskingum-Cunge Route ................................................................. 137
Straddle Stagger Route .................................................................... 138

SOURCE ............................................................................................. 139
Representative Area ......................................................................... 139
Discharge Gage ................................................................................ 140
Constant Flow .................................................................................. 140

DIVERSION .......................................................................................... 140
Inflow-Diversion Function ............................................................... 141
Connecting Diversion Flow .............................................................. 141
Limiting Flow or Volume ................................................................ 142

RESERVOIR .......................................................................................... 142
Selecting a Route Method ................................................................. 142
Storage Method ................................................................................ 143
Initial Condition .............................................................................. 144
Tailwater Method ............................................................................ 144
Outlets ............................................................................................... 145
Spillways ........................................................................................... 148
Dam Tops .......................................................................................... 149
Pumps ............................................................................................... 151
Dam Break ....................................................................................... 152

JUNCTION ........................................................................................... 155

SINK .................................................................................................... 156

REFERENCES ...................................................................................... 156

METEOROLOGY DESCRIPTION ......................................................... 157

METEOROLOGIC MODELS ................................................................ 157
Creating a New Meteorologic Model ......................................................... 157
Copying a Meteorologic Model ................................................................. 158
Renaming a Meteorologic Model .............................................................. 159
Deleting a Meteorologic Model ................................................................. 160
Importing a Meteorologic Model .............................................................. 161
Precipitation Method .......................................................................... 162
Evapotranspiration Method ................................................................... 162
Snowmelt Method ............................................................................. 163
Unit System ......................................................................................... 163
Selecting Basin Models ....................................................................... 163

PRECEPTATION ................................................................................... 165
Frequency Storm .............................................................................. 165
Gage Weights .................................................................................... 167
Gridded Precipitation ......................................................................... 170
Inverse Distance ............................................................................... 171
SCS Storm ........................................................................................ 174
Specified Hyetograph ........................................................................ 174
Standard Project Storm ...................................................................... 175

EVAPOTRANSPIRATION .................................................................. 176
## Table of Contents

- **Hydrologic Simulation** ................................................. 189
  - Simulation Runs .............................................................. 189
    - Creating a New Run .................................................. 189
    - Copying a Run .......................................................... 191
    - Renaming a Run ....................................................... 192
    - Deleting a Run ......................................................... 193
    - Selecting Components ............................................. 194
    - Precipitation and Flow Ratios .................................. 195
    - Start and Saved States ............................................. 196
    - Selecting a Current Run ............................................ 197
    - Checking Parameters .............................................. 198
    - Computing a Run .................................................... 198
  - Viewing Results for the Current Run ............................ 199
    - Global Summary Table ............................................. 199
    - Individual Elements ................................................ 200
  - Viewing Results for Other Runs .................................... 202
    - Global Summary Table ............................................. 202
    - Element Summary Table ........................................... 203
    - Element Time-Series Preview Graph ........................ 203
    - Time-Series Tables and Graphs ................................. 203
- **Parameter Estimation** .................................................. 205
  - Optimization Trials ..................................................... 205
    - Creating a New Trial ................................................ 206
    - Copying a Trial ....................................................... 207
    - Renaming a Trial ..................................................... 209
    - Deleting a Trial ....................................................... 210
    - Selecting a Simulation Run ...................................... 211
    - Search Method ........................................................ 211
    - Controlling Search Tolerance ................................... 212
    - Objective Function .................................................. 212
    - Adding and Deleting Parameters ............................... 213
    - Specifying Parameter Information ............................ 217
    - Selecting a Current Trial ......................................... 218
    - Checking Parameters .............................................. 218
    - Computing a Trial .................................................... 218
  - Viewing Results for a Trial .......................................... 219
    - Objective Function Table ......................................... 219
    - Optimized Parameters Table .................................... 220
    - Hydrograph Comparison Graph ............................... 221
    - Flow Comparison Graph ......................................... 221
    - Flow Residuals Graph .............................................. 222
    - Objective Function Graph ....................................... 223
    - Element Summary Table ........................................... 223
    - Element Time-Series Preview Graph ........................ 224
    - Time-Series Tables and Graphs ................................. 224

**References** ........................................................................... 187

**Viewing Results for a Trial** ............................................. 219

**Optimization Trials** ..................................................... 205

**Computing a Run** .......................................................... 218

**Selecting a Current Run** ................................................ 218

**Specifying Parameter Information** ................................ 217

**Search Method** ............................................................. 211

**Controlling Search Tolerance** ....................................... 212

**Objective Function** ....................................................... 212

**Adding and Deleting Parameters** .................................. 213

**Specifying Parameter Information** ................................ 217

**Selecting a Current Trial** .............................................. 218

**Checking Parameters** .................................................. 218

**Computing a Trial** ........................................................ 218

**Viewing Results for a Trial** .......................................... 219

**Objective Function Table** ............................................. 219

**Optimized Parameters Table** ....................................... 220

**Hydrograph Comparison Graph** ................................... 221

**Flow Comparison Graph** ............................................. 221

**Flow Residuals Graph** .................................................. 222

**Objective Function Graph** ............................................ 223

**Element Summary Table** ............................................. 223

**Element Time-Series Preview Graph** ........................... 224

**Time-Series Tables and Graphs** ................................... 224

**Global Summary Table** ................................................ 199

**Individual Elements** ................................................... 200

**Precipitation and Flow Ratios** ..................................... 195

**Start and Saved States** ............................................... 196

**Selecting a Current Run** .............................................. 197

**Checking Parameters** .................................................. 198

**Computing a Run** ........................................................ 198

**Viewing Results for the Current Run** ............................ 199

**Global Summary Table** ................................................ 199

**Individual Elements** ................................................... 200

**Viewing Results for Other Runs** .................................... 202

**Global Summary Table** ................................................ 202

**Element Summary Table** ............................................. 203

**Element Time-Series Preview Graph** ........................... 203

**Time-Series Tables and Graphs** ................................... 203

**Gridded Priestley Taylor** ................................................ 176

**Monthly Average** ........................................................ 177

**Priestley Taylor** ........................................................... 178

**Snowmelt** ......................................................................... 179

**Gridded Temperature Index** ......................................... 179

**Temperature Index** ..................................................... 182

**References** ........................................................................... 187

**Viewing Results for a Trial** .......................................... 219

**Element Time-Series Preview Graph** ........................... 224

**Element Summary Table** ............................................. 223

**Flow Comparison Graph** ............................................. 221

**Hydrograph Comparison Graph** ................................... 221

**Optimized Parameters Table** ....................................... 220

**Computing a Run** ........................................................ 218

**Selecting a Current Run** .............................................. 218

**Specifying Parameter Information** ................................ 217

**Search Method** ............................................................. 211

**Controlling Search Tolerance** ....................................... 212

**Objective Function** ....................................................... 212

**Adding and Deleting Parameters** .................................. 213

**Specifying Parameter Information** ................................ 217

**Selecting a Current Trial** .............................................. 218

**Checking Parameters** .................................................. 218

**Computing a Trial** ........................................................ 218

**Viewing Results for a Trial** .......................................... 219

**Objective Function Table** ............................................. 219

**Optimized Parameters Table** ....................................... 220

**Hydrograph Comparison Graph** ................................... 221

**Flow Comparison Graph** ............................................. 221

**Flow Residuals Graph** .................................................. 222

**Objective Function Graph** ............................................ 223

**Element Summary Table** ............................................. 223

**Element Time-Series Preview Graph** ........................... 224

**Time-Series Tables and Graphs** ................................... 224
# Table of Contents

## ANALYZING SIMULATION RUNS 227

### Analyses ................................................................. 227
- Creating a New Analysis ........................................... 227
- Copying an Analysis .................................................. 229
- Renaming an Analysis ............................................... 230
- Deleting an Analysis .................................................. 231
- Selecting a Current Analysis ...................................... 232
- Checking Parameters ............................................... 233
- Computing an Analysis ............................................. 233
- Viewing Results for an Analysis ................................. 233

### Depth-Area Analysis ................................................. 234
- Selecting a Simulation Run ........................................ 234
- Selecting Analysis Points ......................................... 235
- Peak Flow Summary Table ........................................ 235

## DATA STORAGE IN HEC-DSS 237

### Descriptors .............................................................. 237

## GRID CELL FILE FORMAT 241

### File Definition .......................................................... 241

## MAP FILE FORMAT 243

### File Definition .......................................................... 243

## HEC-HMS AND HEC-1 DIFFERENCES 245

### Recession Baseflow .................................................... 245
- Clark Unit Hydrograph .............................................. 245
- Muskingum Cunge Routing ........................................... 245
- General Channel Properties ....................................... 245
- Eight Point Cross Sections ........................................ 246

## TERMS AND CONDITIONS OF USE 247

### Terms and Conditions of Use .................................. 247
This manual is not intended to teach you how to do hydrologic engineering or even hydrology. It does not describe the mathematical equations for the various models included in the program. So what does it do? This manual will teach you how to use the various features and capabilities of the program. It works very well to simply read the manual through starting at the beginning. If you read the manual in front of your computer with the program up and running, it will work even better. However, the manual works equally well as an occasional reference when you cannot remember exactly how to perform a certain task or need to check the parameter definitions for a particular method.

The scope of this manual does not mean that we think engineering applications or mathematical analysis are unimportant. In fact, both of those things are vital to producing good engineering plans and designs. We feel they are so important that we have created a separate manual for each of them. The Technical Reference Manual provides detailed descriptions of each of the models included in the program. You can expect to find the mathematical derivation of the model equations, details on the numerical schemes employed in the program to solve the equations, and specific guidance on parameter estimation. Consequently, it focuses less on using the program and more on understanding the science of hydrology. The Applications Guide provides practical suggestions for using the program to perform engineering work. We selected a number of typical projects that engineers often encounter and showed how the program can be used to provide real answers. Consequently, it focuses less on using the program and more on the engineering process.

Many engineers, computer specialists, and student interns have contributed to the success of this project. Each one has made valuable contributions that enhance the overall success of the program. Nevertheless, the completion of the project was overseen by David J. Harris while Darryl Davis was director of the Hydrologic Engineering Center.
CHAPTER 1

Introduction

The Hydrologic Modeling System is designed to simulate the precipitation-runoff processes of dendritic watershed systems. It is designed to be applicable in a wide range of geographic areas for solving the widest possible range of problems. This includes large river basin water supply and flood hydrology, and small urban or natural watershed runoff. Hydrographs produced by the program are used directly or in conjunction with other software for studies of water availability, urban drainage, flow forecasting, future urbanization impact, reservoir spillway design, flood damage reduction, floodplain regulation, and systems operation.

Scope

The program is a generalized modeling system capable of representing many different watersheds. A model of the watershed is constructed by separating the hydrologic cycle into manageable pieces and constructing boundaries around the watershed of interest. Any mass or energy flux in the cycle can then be represented with a mathematical model. In most cases, several model choices are available for representing each flux. Each mathematical model included in the program is suitable in different environments and under different conditions. Making the correct choice requires knowledge of the watershed, the goals of the hydrologic study, and engineering judgement.

The program features a completely integrated work environment including a database, data entry utilities, computation engine, and results reporting tools. A graphical user interface allows the seamless movement between the different parts of the program. Program functionality and appearance are the same across all supported platforms.

History

The computation engine draws on over 30 years experience with hydrologic simulation software. Many algorithms from HEC-1 (HEC, 1998), HEC-1F (HEC, 1989), PRECIP (HEC, 1989), and HEC-IFH (HEC, 1992) have been modernized and combined with new algorithms to form a comprehensive library of simulation routines. Future versions of the program will continue to modernize desirable algorithms from legacy software. The current research program is designed to produce new algorithms and analysis techniques for addressing emerging problems.

The initial program release was called Version 1.0 and included most of the event-simulation capabilities of the HEC-1 program. It did introduce several notable improvements over the legacy software including an unlimited number of hydrograph ordinates and gridded runoff representation. The tools for parameter estimation with optimization were much more flexible than in previous programs. The maiden release also included a number of “firsts” for HEC including object-oriented development in the C++ language and multiplatform support.

The second major release was called Version 2.0 and focused on continuous simulation. The addition of the soil moisture accounting method extended the program from an event-simulation package to one that could work equally well with
event or continuous simulation applications. The reservoir element was also
expanded to include physical descriptions for an outlet, spillway, and overflow. An
overtopping dam failure option was also added.

The graphics libraries used to implement the multi-platform interface used in Version
1.0 and Version 2.0 were sold and soon became unavailable. Faced with the
prospect of using unsupported graphics tools, the design team evaluated alternatives
and chose to move the program to the Java™ language. The simulation engine was
converted to Java™ and a completely new interface was designed. During the
process, careful attention was paid to lessons learned from earlier versions. The
result is Version 3.0 with the new interface plus new simulation capabilities for
infiltration, reservoir outlet structures, piping dam failure, and analysis tools.

Enhancement of the program is ongoing. HEC has a strong commitment to
continued research in emerging needs for hydrologic simulation, both in terms of
simulation techniques and representation of physical processes. Future needs are
identified by conducting our own application projects, speaking with program users,
and monitoring academic journals. HEC also has a strong commitment to continued
development of the program interface. Plans are already underway to add new
features in a future version that will make the program easier to use by providing
more flexible ways to accomplish work. New visualization concepts are also being
developed. Look for future versions to continue the tradition.

Capabilities

The program has an extensive array of capabilities for conducting hydrologic
simulation. Many of the most common methods in hydrologic engineering are
included in such a way that they are easy to use. The program does the difficult work
and leaves the user free to concentrate on how best to represent the watershed
environment.

Watershed Physical Description

The physical representation of a watershed is accomplished with a basin model.
Hydrologic elements are connected in a dendritic network to simulate runoff
processes. Available elements are: subbasin, reach, junction, reservoir, diversion,
source, and sink. Computation proceeds from upstream elements in a downstream
direction.

An assortment of different methods is available to simulate infiltration losses.
Options for event modeling include initial constant, SCS curve number, gridded SCS
curve number, exponential, and Green Ampt. The one-layer deficit constant method
can be used for simple continuous modeling. The five-layer soil moisture accounting
method can be used for continuous modeling of complex infiltration and
evapotranspiration environments. Gridded methods are available for both the deficit
constant and soil moisture accounting methods.

Several methods are included for transforming excess precipitation into surface
runoff. Unit hydrograph methods include the Clark, Snyder, and SCS techniques.
User-specified unit hydrograph or s-graph ordinates can also be used. The modified
Clark method, ModClark, is a linear quasi-distributed unit hydrograph method that
can be used with grided meteorologic data. An implementation of the kinematic
wave method with multiple planes and channels is also included.

Multiple methods are included for representing baseflow contributions to subbasin
outflow. The recession method gives an exponentially decreasing baseflow from a
single event or multiple sequential events. The constant monthly method can work well for continuous simulation. The linear reservoir method conserves mass by routing infiltrated precipitation to the channel.

A variety of hydrologic routing methods are included for simulating flow in open channels. Routing with no attenuation can be modeled with the lag method. The traditional Muskingum method is included along with the straddle stagger method for simple approximations of attenuation. The modified Puls method can be used to model a reach as a series of cascading, level pools with a user-specified storage-discharge relationship. Channels with trapezoidal, rectangular, triangular, or circular cross sections can be modeled with the kinematic wave or Muskingum-Cunge methods. Channels with overbank areas can be modeled with the Muskingum-Cunge method and an 8-point cross section.

Water impoundments can also be represented. Lakes are usually described by a user-entered storage-discharge relationship. Reservoirs can be simulated by describing the physical spillway and outlet structures. Pumps can also be included as necessary to simulate interior flood area. Control of the pumps can be linked to water depth in the collection pond and, optionally, the stage in the main channel.

**Meteorology Description**

Meteorologic data analysis is performed by the meteorologic model and includes precipitation, evapotranspiration, and snowmelt. Six different historical and synthetic precipitation methods are included. Two evapotranspiration methods are included at this time. Currently, only one snowmelt method is available.

Four different methods for analyzing historical precipitation are included. The user-specified hyetograph method is for precipitation data analyzed outside the program. The gage weights method uses an unlimited number of recording and non-recording gages. The Thiessen technique is one possibility for determining the weights. The inverse distance method addresses dynamic data problems. An unlimited number of recording and non-recording gages can be used to automatically proceed when missing data is encountered. The gridded precipitation method uses radar rainfall data.

Four different methods for producing synthetic precipitation are included. The frequency storm method uses statistical data to produce balanced storms with a specific exceedance probability. Sources of supporting statistical data include Technical Paper 40 (National Weather Service, 1961) and NOAA Atlas 2 (National Weather Service, 1973). While it was not specifically designed to do so, data can also be used from NOAA Atlas 14 (National Weather Service, 2004ab). The standard project storm method implements the regulations for precipitation when estimating the standard project flood (Corps of Engineers, 1952). The SCS hypothetical storm method implements the primary precipitation distributions for design analysis using Natural Resources Conservation Service (NRCS) criteria (Soil Conservation Service, 1986). The user-specified hyetograph method can be used with a synthetic hyetograph resulting from analysis outside the program.

Potential evapotranspiration can be computed using monthly average values. There is also an implementation of the Priestley-Taylor method that includes a crop coefficient. A gridded version of the Priestley-Taylor method is also available.

Snowmelt can be included for tracking the accumulation and melt of a snowpack. A temperature index method is used that dynamically computes the melt rate based on current atmospheric conditions and past conditions in the snowpack.
Hydrologic Simulation

The time span of a simulation is controlled by control specifications. Control specifications include a starting date and time, ending date and time, and a time interval.

A simulation run is created by combining a basin model, meteorologic model, and control specifications. Run options include a precipitation or flow ratio, capability to save all basin state information at a point in time, and ability to begin a simulation run from previously saved state information.

Simulation results can be viewed from the basin map. Global and element summary tables include information on peak flow and total volume. A time-series table and graph are available for elements. Results from multiple elements and multiple simulation runs can also be viewed. All graphs and tables can be printed.

Parameter Estimation

Most parameters for methods included in subbasin and reach elements can be estimated automatically using optimization trials. Observed discharge must be available for at least one element before optimization can begin. Parameters at any element upstream of the observed flow location can be estimated. Six different objective functions are available to estimate the goodness-of-fit between the computed results and observed discharge. Two different search methods can be used to minimize the objective function. Constraints can be imposed to restrict the parameter space of the search method.

Analyzing Simulations

Analysis tools are designed to work with simulation runs to provide additional information or processing. Currently, the only tool is the depth-area analysis tool. It works with simulation runs that have a meteorologic model using the frequency storm method. Given a selection of elements, the tool automatically adjusts the storm area and generates peak flows represented by the correct storm areas.

GIS Connection

The power and speed of the program make it possible to represent watersheds with hundreds of hydrologic elements. Traditionally, these elements would be identified by inspecting a topographic map and manually identifying drainage boundaries. While this method is effective, it is prohibitively time consuming when the watershed will be represented with many elements. A geographic information system (GIS) can use elevation data and geometric algorithms to perform the same task much more quickly. A GIS companion product has been developed to aid in the creation of basin models for such projects. It is called the Geospatial Hydrologic Modeling Extension (HEC-GeoHMS) and can be used to create basin and meteorologic models for use with the program.

Limitations

Every simulation system has limitations due to the choices made in the design and development of the software. The limitations that arise in this program are due to two aspects of the design: simplified model formulation, and simplified flow representation. Simplifying the model formulation allows the program to complete simulations very quickly while producing accurate and precise results. Simplifying
the flow representation aids in keeping the compute process efficient and reduces duplication of capability in the HEC software suite.

Model Formulation

All of the mathematical models included in the program are deterministic. This means that the boundary conditions, initial conditions, and parameters of the models are assumed to be exactly known. This guarantees that every time a simulation is computed it will yield exactly the same results as all previous times it was computed. Deterministic models are sometimes compared to stochastic models where the same boundary conditions, initial conditions, and parameters are represented with probabilistic distributions. Plans are underway to develop a stochastic capability through the addition of a Monte Carlo analysis tool.

All of the mathematical models included in the program use constant parameter values, that is, they are assumed to be time stationary. During long periods of time it is possible for parameters describing a watershed to change as the result of human or other processes at work in the watershed. These parameter trends cannot not be included in a simulation. There is a limited capability to break a long simulation into smaller segments and manually change parameters between segments. Plans are underway to develop a variable parameter capability, through an as yet undetermined means.

All of the mathematical models included in the program are uncoupled. The program first computes evapotranspiration and then computes infiltration. In the physical world, the amount of evapotranspiration depends on the amount of soil water. The amount of infiltration also depends on the amount of soil water. However, evapotranspiration removes water from the soil at the same time infiltration adds water to the soil. To solve the problem properly the evapotranspiration and infiltration processes should be simulated simultaneously with the mathematical equations for both processes numerically linked. This program does not currently include such coupling of the process models. Errors due to the use of uncoupled models are minimized as much as possible by using a small time interval for calculations.

Flow Representation

The design of the basin model only allows for dendritic stream networks. The best way to visualize a dendritic network is to imagine a tree. The main tree trunk, branches, and twigs correspond to the main river, tributaries, and headwater streams in a watershed. The key idea is that a stream does not separate into two streams. The basin model allows each hydrologic element to have only one downstream connection so it is not possible to split the outflow from an element into two different downstream elements. The diversion element provides a limited capability to remove some of the flow from a stream and divert it to a different location downstream in the network. However, in general branching or looping stream networks cannot be simulated with the program and will require a separate hydraulic model which can represent such networks.

The design of the process for computing a simulation does not allow for backwater in the stream network. The compute process begins at headwater subbasins and proceeds down through the network. Each element is computed for the entire simulation time window before proceeding to the next element. There is no iteration or looping between elements. Therefore, it is not possible for an upstream element to have knowledge of downstream flow conditions, which is the essence of backwater effects. There is a limited capability to represent backwater if it is fully contained
within a reach element. However, in general the presence of backwater within the stream network will require a separate hydraulic model.

**Documentation Conventions**

The following conventions are used throughout the manual to describe the graphical user interface:

- Screen titles are shown in *italics*.
- Menu names, menu items, and button names are shown in **bold**.
- Menus are separated from submenus with the right arrow ⇒.
- Data typed into an input field or selected from a list is shown using the **courier font**.
- A column heading, tab name, or field title is shown in “double quotes”.

**References**


CHAPTER 2

Installing and Running the Program

This chapter describes the minimum and recommended computer system requirements for running the program. Step-by-step installation procedures are also provided.

Operating System Requirements

The program has been created using the Java™ programming language. Programs written in the language can run on almost any operating system. However, two libraries used by the program are still in the FORTRAN language. These libraries are currently only available for the Microsoft Windows® and the Sun Microsystems Solaris™ operating systems. This means that the program itself is also only available for those operating systems. Nevertheless, because the program was created with the Java™ language, the program looks and behaves the same on both operating systems.

The program is available for any version of the Microsoft Windows® operating system. This includes Windows 98, 2000, Millennium Edition, and XP. The program is tested most extensively on the XP version.

The program is also available for Sun Microsystems Solaris™ 8 or higher.

Hardware Requirements and Recommendations

The minimum hardware equipment for the Microsoft Windows® installation includes:

- An AMD Athlon™ or Intel® Pentium® 3 processor.
- 64 MB of memory available for the sole use of the program.
- 24 MB of available hard disk space for installation.
- 17" SVGA monitor.
- Compatible keyboard and mouse.

The minimum hardware equipment for the Sun Microsystems Solaris™ installation includes:

- An UltraSPARC® II processor.
- 64 MB of memory available for the sole use of the program.
- 24 MB of available hard disk space for installation.
- 17" SVGA monitor.
- Keyboard and mouse.
Significantly more resources may be needed depending on your application. The minimum equipment for either operating system will be suitable for event simulation with basin models containing only 20 or 30 hydrologic elements. However, you will need better equipment if you intend to build basin models with over a hundred elements, perform continuous simulation for long time windows, or use the ModClark gridded transform method. For intense applications you should consider a faster processor and up to 1 GB of physical memory.

Installation

Installation packages for the program are available from the Hydrologic Engineering Center (HEC) website where the current version of the program is always available. Old versions of the program are only available upon request. However, old versions are not maintained, contain bugs and errors, and may not function correctly with current versions of the supported operating systems.

Microsoft Windows® Operating System

You must obtain the installer before you can setup the program on your computer. If you have access to the internet, the installer can be downloaded directly from the HEC website at www.hec.usace.army.mil. If you do not have access to the internet then you must obtain a copy on removable media such as a CD-ROM disk. Participating vendors make the program available on CD-ROM and possibly other media in exchange for a fee. Participating vendors are listed on the HEC website. Any relationship with a vendor is solely between the user and the vendor.

In order to run the installer you must have administrator privileges on your computer. You only need the privileges during installation; once installation is complete the program can run successfully in a so-called limited privileges environment. If you do not have administrator privileges, the installer will notify you and quit. Please contact your system administrator for assistance during installation.

After you have obtained the installer and administrator privileges, use the following steps to install the program:

1. Click on the Start menu and select the Run… command.
2. Type the complete file path to the installer. If you do not know the exact location of the installer, press the Browse… button to locate and select it. The installer can be on any available resource including a local disk, a network disk, or removable media such as a CD-ROM.
3. Click the OK button to proceed with the installation.
4. Depending on your security settings, you may receive a warning before the installer starts. The installer is signed with a digital signature so you can verify it was produced by HEC and has not been altered. If the digital signature is OK, press the Run button to proceed with starting the installer.
5. The installer will open in a new window and perform some preliminary configurations in preparation for installation. A welcome window will notify you that HEC-HMS 3.0.0 will be installed. Press the Next button to continue with the installation.
6. The next window will display the terms and conditions for using the program. This must be accepted during installation and later by every user who starts using the program on the computer where it is installed. Please read the
terms and conditions for use carefully. If you agree, click the "I agree to the above Terms and Conditions for Use" radio button, and then press the Next button. If you do not agree, the installer will exit without installing the program.

7. The next window is used to select the location where the program will be installed on the local disk. It is recommended that the default location in the C:\Program Files directory be used. Press the Next button when you are satisfied with the installation location.

8. The next window allows you to choose if a shortcut to the program will be placed on the desktop. The program will be listed in the Start menu under the All Programs ⇒ HEC folder, so having an desktop shortcut is optional.

9. The next and final window allows you to confirm that you are ready for installation. This is your last chance to cancel the installation by pressing the Cancel button. Press the Install button to install the program with all of the configuration information specified in the previous windows.

The installer will copy all necessary files and make additional configuration changes to the operating system. You do not need to restart the computer after the installation completes. At any time you can uninstall the program through the Control Panel. When future versions of the program become available, you may have each version separately installed on your computer.

**Sun Microsystems Solaris™ Operating System**

You must obtain the installer before you can setup the program on your computer. If you have access to the internet, the installer can be downloaded directly from the HEC website at [www.hec.usace.army.mil](http://www.hec.usace.army.mil). If you do not have access to the internet then you must obtain a copy on removable media such as a CD-ROM disk.

There is no installation program for this operating system so a manual procedure is required. You will need administrator privileges during the installation; once installation is complete the program can run successfully in a so-called limited privileges environment. In general, the changes required to install on this operating system require the skills of a system administrator. Please contact your system administrator to install the program for you. You may need to refer your administrator to this section of the manual.

After you have obtained the installer and proper permissions, use the following steps to install the program:

1. Log on to the system as "root."

2. If you do not have the Java™ run time environment on your system, obtain a (free) copy and install it. Many companies and organizations have developed certified Java™ run time environments. However, the program has only been tested with Version 1.4.2 of the run time environment produced by Sun Microsystems.

3. Create the installation directory on your system. A typical location would be /usr/hec/hechms. The chosen location is where the program archive and libraries will be installed.
4. Change to the directory created in the previous step and un-tar the installation file. Use the command `tar -xvf hms300.tar` to extract the files. The tar utility will extract the archive and copy all necessary files.

5. You will need to make one change to the shell file for each user account that will use the program before the program becomes fully usable. For users with the C shell environment, the shell file is named `.cshrc` in the `$HOME` directory of each user. Add the installation directory, as selected in Step 3 above, to the path. For example, a typical line added to the file would look like the following:

   ```bash
   set path = ($path /usr/hec/hechms)
   ```

When future versions of the program become available, you may have each version separately installed on your computer. You will need to carefully organize the installation locations so that each version can be kept separate.

**Running the Program**

The program is designed to be installed only once on a computer, and shared by every user with logon access to the computer. Program configuration information is stored separately for each user. Projects will also be stored separately for each user, unless the users take steps to make the projects available to all users.

**Microsoft Windows® Operating System**

Run the program by clicking on the **Start** menu and then place the mouse over the **All Programs** selection. After a short hesitation, the list of available programs will be displayed. Move the mouse to the **HEC** folder and move to the **HEC-HMS** subfolder. Click on the version of the program you wish to run.

If you chose to add a desktop shortcut during installation, you can also run the program directly from the desktop. An icon will be shown on the desktop for the program. Move the mouse over the icon and double-click the left mouse button.

**Sun Microsystems Solaris™ Operating System**

The installation package includes a script for starting the program, as shown in Figure 1. The script will have to be modified before it can be used. The `JAVA_HOME` variable specifies the base directory for the Java™ run time environment; the actual executable should be in the `bin` directory below the base directory. You will need to make sure the directory is correct before the script can be used successfully. You will also need to make the `HMS_HOME` variable correct for the directory where the program is installed.

Once the script is customized for the installation operating system, it can be used to run the program. Open a command window and type `hms`, which is the name of the script.
#!/bin/ksh
PROG=hms.Hms
JAVA_HOME=/usr/java1423
HMS_HOME=/usr/hec/hechms
JARS=$HMS_HOME
JARS=$JARS: $HMS_HOME/hms.jar
JARS=$JARS: $HMS_HOME/jython.jar
JAVA_LIB_PATH=$HMS_HOME
JAVA_LIB_PATH="$JAVA_LIB_PATH:$JAVA_HOME/lib/sparc"
JAVA_LIB_OPT="-Djava.library.path=$JAVA_LIB_PATH"
PYOPTS="-Dpython.path=$JARS"
$JAVA_HOME/bin/java -ms32M -mx512M $PYOPTS $JAVA_LIB_OPT -cp $JARS $PROG $1 $2 $3 $4

Figure 1. Script for starting the program when it is installed on the Solaris™
operating system.

Command Line Operation

The normal mode of operation starts the program and displays the interface. From
the interface the user can access all the features and capabilities of the program
using the mouse and keyboard. However, for some uses it may advantageous to
start the program, have it carry out certain commands, and then shut down. There is
a very limited capability to operate in this mode using scripting control. Additional
scripting capabilities will be added in the future.

The first step is to create a control script. It is best if the simulation that will be
computed by the script already exists and has been tested in normal operation to
make sure it completes successfully. A typical script would contain the following lines
in a file:

```python
from hms.model.JythonHms import *
OpenProject("Tenk", "C:\hmsproj\Tenk")
Compute("Run 1")
Exit(1)
```

Once you have created the script file, it can be used with the program from the
command line. The program will start and automatically process the script. The first
line is used to setup the scripting environment and make the program data model
accessible to the script. The second line opens an existing project and the third line
computes an existing simulation run. The final line of the script exits the program.

To use a script on the Microsoft Windows® operating system, begin by opening a
command window and changing directories to the installation folder. The installation
folder is not standardized and depends on where you chose to install the program.
One possibility would look like the following:

```
C:\Program Files\hec\Hec-Hms\3.0.0>
```

At the command prompt, type the following to launch the program and run the script,
where the last argument is the complete path to a script:
To use a script on the Sun Microsystems Solaris™ operating system, begin by opening a command window and changing directories to the installation folder. The installation folder is not standardized and depends on the policies of your system administrator. One possibility would look like the following:

```
>hec-hms -s C:\hmsproj\Tenk\compute.script
```

At the command prompt, type the following to launch the program and run the script, where the last argument is the complete path to the script:

```
>hms -s /usr/smith/hmsproj/tenk/compute.script
```

The program will not be visible while it is running the script. However, the commands in the script will be carried out. Any messages generated while computing the simulation run will be written to the log file. All results will be stored in the output DSS file. Inspection of the log file will reveal any errors, warning, or notes and results can be read from the DSS file.

### Additional Resources

The program includes an online help system that is automatically installed when the program is installed. The help system is equivalent to the User's Manual, Technical Reference Manual, and Applications Guide. The various documents are also available separately.

Three sample projects are included with the program. The "Castro" project shows how the program can be used for basic hydrology. The "Tenk" project demonstrates the capability of the program to use gridded precipitation. Finally, the "Tifton" project exhibits continuous simulation with the soil moisture accounting method. The projects are kept in a space-saving, compressed form. They can be extracted for use at any time by going to the **Help** menu and selecting the **Install Sample Projects...** command.
CHAPTER 3

Overview

This chapter describes the basics of working with the program. It includes descriptions of the main parts of the interface. Specific details of when and how data are saved is also included. Conventions are provided for the formatting of input data, the use of units, and interpolation. An outline of the way to use the program is also provided.

Program Screen

The program screen contains a title bar, menu system, toolbar, and four panes. These panes will be referred to as the Watershed Explorer, Desktop, Component Editor, and the Message Log as shown in Figure 2. The title bar displays the version of the program used and the location of the opened project. The other parts of the program screen are discussed in detail in this chapter.

Figure 2. The main program screen with Watershed Explorer in the upper left, Component Editor in the lower left, Message Log at the bottom, and Desktop taking up the remaining area.
Menu System

The menu system contains several menus to help you use the program. Each menu contains a list of related commands. For example, the **Parameters** menu contains a list of commands to open global parameter tables for viewing and editing parameters required by hydrologic elements in the selected basin model. Items in an individual menu are inactive, cannot be selected, if the command can not be carried out by the program at the current time.

Commands for managing the opened project are available from the **File** menu. **File** menu items and the resulting actions are provided in Table 1. The last four projects opened are shown at the bottom of the **File** menu. Click on one of the project names to open the project.

The **Edit** menu contains commands for editing hydrologic elements in the selected basin model. If no basin model is selected, then all commands in this menu are inactive. **Edit** menu commands and the resulting actions are provided in Table 2.

The **View** menu contains a list of commands for working in the basin map. These commands are inactive if no basin model is open in the desktop. A list of **View** menu items and the resulting actions are provided in Table 3.

<table>
<thead>
<tr>
<th><strong>File Menu Commands</strong></th>
<th><strong>Action</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>New…</td>
<td>Create a new project.</td>
</tr>
<tr>
<td>Open…</td>
<td>Open a project.</td>
</tr>
<tr>
<td>Import ⇒</td>
<td>Import HEC-1 files, basin or meteorologic models</td>
</tr>
<tr>
<td>Save</td>
<td>Save the current project.</td>
</tr>
<tr>
<td>Save As…</td>
<td>Make a copy of the current project.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the current project.</td>
</tr>
<tr>
<td>Rename</td>
<td>Rename the current project.</td>
</tr>
<tr>
<td>Print…</td>
<td>Print the currently selected item.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the program.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Edit Menu Commands</strong></th>
<th><strong>Action</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cut or delete the selected hydrologic element(s).</td>
</tr>
<tr>
<td>Copy</td>
<td>Make a copy of the selected hydrologic element(s).</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste the copied hydrologic element(s).</td>
</tr>
<tr>
<td>Select All</td>
<td>Select all hydrologic elements in the basin model.</td>
</tr>
<tr>
<td>Clear Selection</td>
<td>Unselect all selected hydrologic elements in the basin model.</td>
</tr>
<tr>
<td>Select Special…</td>
<td>Open the Select Special dialog.</td>
</tr>
</tbody>
</table>
Table 3. Commands available from the View menu.

<table>
<thead>
<tr>
<th>View Menu Commands</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Extents</td>
<td>Open the maximum extents editor.</td>
</tr>
<tr>
<td>Background Maps</td>
<td>Open the map layer selector editor.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Zoom in by a factor of 25%.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zoom out by a factor of 50%.</td>
</tr>
<tr>
<td>Zoom To Selected</td>
<td>Zoom to the current element selection.</td>
</tr>
<tr>
<td>Zoom To Maximum Extents</td>
<td>Zoom out to the maximum extents.</td>
</tr>
<tr>
<td>Element Icons</td>
<td>Toggle showing of element icons.</td>
</tr>
<tr>
<td>Element Names</td>
<td>Toggle showing of element names.</td>
</tr>
<tr>
<td>Flow Directions</td>
<td>Toggle flow direction arrows on reach elements.</td>
</tr>
<tr>
<td>Gridlines</td>
<td>Toggle showing gridlines in basin map.</td>
</tr>
<tr>
<td>Clear Messages</td>
<td>Clear all messages from the message window.</td>
</tr>
</tbody>
</table>

Table 4. Commands available from the Components menu.

<table>
<thead>
<tr>
<th>Components Menu Commands</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basin Model Manager</td>
<td>Open the basin model manager.</td>
</tr>
<tr>
<td>Meteorologic Model Manager</td>
<td>Open the meteorologic model manager.</td>
</tr>
<tr>
<td>Control Specifications Manager</td>
<td>Open the control specifications manager.</td>
</tr>
<tr>
<td>Time-Series Data Manager</td>
<td>Open the time-series data manager.</td>
</tr>
<tr>
<td>Paired Data Manager</td>
<td>Open the paired data manager.</td>
</tr>
<tr>
<td>Grid Data Manager</td>
<td>Open the grid data manager.</td>
</tr>
</tbody>
</table>

Component managers are opened from the Components menu. Program components include basin models, meteorologic models, control specifications, time-series data, paired data, and gridded data. A list of Components menu items and the resulting actions are provided in Table 4.

The Parameters menu contains menu commands to open global parameter editors. Global parameter editors let you view and edit subbasin and reach parameters for elements using the same methods (subbasin loss, transform, and baseflow methods and reach routing methods). Global parameter menu options are only active if subbasin or reach elements in the basin model use the method. For example, if the Parameter ⇒ Loss menu option is selected, a submenu with all loss methods opens. Only loss methods used by subbasin elements in the current basin model will be active in the menu. If hydrologic elements are selected in the basin model, then the selected elements determine what menu items are available. The Parameters menu also contains menu commands to change subbasin loss, transform, and baseflow methods and reach routing method. If subbasin or reach elements are selected in the basin model, then only the selected elements will change methods. The last menu command on the Parameters menu is Element Inventory. This command lets you view a table of all hydrologic elements in the basin model. If elements are selected, then only the selected elements will be included in the table.
Chapter 3 Overview

The **Compute** menu contains a list of commands for creating, computing, and managing simulation runs, optimization trials, and analyses. A list of **Compute** menu items and the resulting actions are provided in Table 5. Menu commands for creating simulation runs, optimization trials, and analyses are only enabled with the necessary underlying components have been created. The **Check Parameters** and **Compute** commands are only enabled when a compute item is selected.

The **Results** menu contains a list of commands for viewing results from hydrologic elements in a basin model. Three cases must be met before commands from the **Results** menu are active:

1. A simulation run must be selected.
2. A hydrologic element or elements must be selected.
3. The results for the simulation run must be available.

Results for a simulation run are available as long as the simulation run computed successfully and no changes were made by the user to components used by the simulation after the simulation computed. If you change parameter data, like values in a paired data table used by a reach element for modified-Puls routing, then the simulation run must be recomputed. A list of **Results** menu items and the resulting actions are provided in Table 6.

The **Tools** menu offers a list of specialized commands. A list of **Tools** menu items and the resulting actions are provided in Table 7. Additional tools will be added to the menu in a future program version.

**Table 5. Commands available from the Compute menu.**

<table>
<thead>
<tr>
<th>Compute Menu Commands</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Simulation Run</td>
<td>Open wizard to create a simulation run.</td>
</tr>
<tr>
<td>Select Run ⇒</td>
<td>Select a simulation run from list of available runs.</td>
</tr>
<tr>
<td>Run Manager</td>
<td>Open the simulation run manager.</td>
</tr>
<tr>
<td>Create Optimization Trial</td>
<td>Open wizard to create an optimization trial.</td>
</tr>
<tr>
<td>Select Trial ⇒</td>
<td>Select an optimization trial from list of available trials.</td>
</tr>
<tr>
<td>Trial Manager</td>
<td>Open the optimization trial manager.</td>
</tr>
<tr>
<td>Create Analysis</td>
<td>Open wizard to create an analysis.</td>
</tr>
<tr>
<td>Select Analysis ⇒</td>
<td>Select an analysis from list of available analyses.</td>
</tr>
<tr>
<td>Analysis Manager</td>
<td>Open the analysis manager.</td>
</tr>
<tr>
<td>Check Parameters</td>
<td>Checks validity of parameters used in the selected simulation run, optimization trial, or analysis.</td>
</tr>
<tr>
<td>Compute</td>
<td>Compute the selected simulation run, optimization trial, or analysis.</td>
</tr>
</tbody>
</table>
Table 6. Commands available from the Results menu.

<table>
<thead>
<tr>
<th>Results Menu Commands</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Summary Table</td>
<td>Open a summary table containing all hydrologic elements in the basin model.</td>
</tr>
<tr>
<td>Element Graph</td>
<td>Open a graph of results for the current selection.</td>
</tr>
<tr>
<td>Element Summary Table</td>
<td>Open a summary table for the current selection.</td>
</tr>
<tr>
<td>Element Time-Series Table</td>
<td>Open a time-series table for the current selection.</td>
</tr>
</tbody>
</table>

Table 7. Commands available from the Tools menu.

<table>
<thead>
<tr>
<th>Tools Menu Commands</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Options</td>
<td>Select default methods for the current project.</td>
</tr>
<tr>
<td>Program Settings</td>
<td>Change properties for the program.</td>
</tr>
</tbody>
</table>

The Help menu provides links to the online help system. The sample projects can be installed from this menu. You may also access the terms and conditions for using the program, and information about the program and development team; this information is helpful when reporting program problems.

Toolbar

Like the menu system, the toolbar groups tools with similar uses. Also, tools are inactive if the resulting action for the tool cannot be carried out by the program. Table 8 contains a description of tools on the toolbar.

Watershed Explorer

The Watershed Explorer was developed to provide quick access to all components and simulations in a project. For example, the user can easily navigate from a basin model to a precipitation gage and then to a meteorologic model without using menu commands or opening additional windows. The Watershed Explorer is divided into three parts: Components, Compute, and Results.

A typical view of the “Components” tab of the Watershed Explorer is shown in Figure 3. The hierarchal structure of model components, such as basin models, meteorologic models, etc., is available from the “Components” tab. The Watershed Explorer organizes model components into individual folders. If all component types were in a project, then the Components tab would contain six main folders, Basin Models, Meteorologic Models, Control Specifications, Time-Series Data, Paired Data, and Grid Data. The Watershed Explorer expands when one of these main component folders is selected. When a component in a main folder is selected, the Watershed Explorer expands even more to show sub-components. For example, when the Basin Models folder is selected, the Watershed Explorer expands to show all basin models in the project. The Watershed Explorer will expand again to show all hydrologic elements in a basin model if a basin model is selected. Notice in Figure 3 that the Castro 1 basin model is selected and the Watershed Explorer is expanded to show all hydrologic elements in the basin model. The plus/minus sign beside model components and sub-components can be used to expand/collapse the Watershed Explorer. The “Compute” tab of the Watershed Explorer contains all project simulation runs, optimization trials, and analyses. Model results are available from the “Results” tab of Watershed Explorer.
Table 8. Description of the tools in the toolbar.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>Create a new project.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Open an existing project.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Save the current project.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Print the selected item in the desktop (basin map or result window).</td>
</tr>
<tr>
<td>![icon]</td>
<td>Select hydrologic elements in the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Pan in the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Zoom in or increase the magnification in the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Zoom out or decrease the magnification in the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Add a subbasin element to the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Add a reach element to the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Add a reservoir element to the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Add a junction element to the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Add a diversion element to the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Add a source element to the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Add a sink element to the basin map.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Display or hide element icons.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Compute the currently selected simulation run.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Compute the currently selected optimization trial.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Compute the currently selected analysis.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Open global summary table.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Open graph for the current element selection.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Open summary table for the current element selection.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Open time-series table for the current element selection.</td>
</tr>
</tbody>
</table>
Figure 3. Watershed Explorer showing the “Components” tab with all of the
different component types.

Desktop

The desktop holds a variety of windows including global parameter editors, and most
importantly the basin map. Result windows including graphs, summary tables, and
time-series tables can be shown in the desktop, or optionally, outside the desktop.
These windows cannot be moved outside of the desktop area. The basin map is
used to develop a basin model. Hydrologic elements (subbasin, river reach,
reservoir, etc.) are added from the toolbar and connected to represent the physical
drainage network of the study area. Background maps can be imported to help
visualize the watershed. The Castro 1 basin map is shown in Figure 4.

Component Editor

When a component or sub-component in the Watershed Explorer or hydrologic
element in the basin map is active (use the mouse and click on the component name
in the Watershed Explorer or select the hydrologic element in the basin map), a
specific Component Editor will open. Data required by model components is entered
in the Component Editor. For example, loss parameter data for a subbasin element
is entered in the Component Editor for the subbasin. The Component Editor for the
Castro 1 basin model is shown in Figure 5.
Figure 4. Basin map for a basin model named Castro 2. The basin map is shown in the desktop area of the program screen.

Figure 5. A basin model component editor showing the name, description, and other parameter data.
**Message Log**

Notes, warnings, and errors are shown in the message log, as seen in Figure 6. These messages are useful for identifying why a simulation run failed or why a requested action, like opening a project, was not completed.

![Message Log](image)

**Program Settings**

Additional program settings are available. Click the **Tools** menu and select the **Program Settings** command to access the **Program Settings** window. The window allows you to change any of the optional settings for the project as shown in Figure 7.

The first option on the "General" tab controls whether a warning is displayed before changing methods in a component. This applies to subbasin, reach, and reservoir elements. For example, a warning is displayed when switching from Green Ampt loss rate method to deficit constant if the option is checked on. The method is changed without warning if the option is checked off.

The second option on the "General" tab controls whether a warning is displayed before deleting a component. This applies to basin models, hydrologic elements, meteorologic models, control specifications, time-series data, paired data, grid data, simulation runs, optimization trials, and analyses. If this option is checked, a warning will be displayed so you can confirm the deletion of a junction element. The item is deleted without warning if the option is checked off.

The third option on the "General" tab controls what kind of tooltips are shown on the "Compute" tab of the **Watershed Explorer**. You have the option of using the description of the compute component as the tooltip. You also have the option of using the components that make up the compute object as its tooltip. Only the first 35 letters of the description or components are shown in the tooltip.

The fourth option determines where results will be displayed. If the option is not checked, all results will be shown in the **Desktop** area. If the option is selected, all results will be shown in floating windows that can be moved anywhere on your computer display.

The fifth option controls how the program starts up. You have the option of automatically opening the last project that was in use when the program shut down.

The sixth option on the "General" tab controls the default location for projects. Anytime you open a project, the browser will begin looking in the specified directory. Regardless of where you begin browsing for a project, you can always use the file browser to open a project anywhere on the local computer or a network device.
Figure 7. Changing program settings.

The "Messages" tab contains settings for the error, warning, and note messages. You can select whether a sound is played when a particular type of message occurs. You can also choose the color that is used to print the message in the message log.

Data Conventions

The program must manage many different kinds of data that are part of a wide variety of components. Part of the management is the saving and display of the data entered by the user. The remainder of the management is the use of the data during a compute.

Saving Properties

The program uses the concept of the current component to manage saving updates or changes to properties. The current component is the item in the project that is currently selected in the Watershed Explorer. For example, if you click on a subbasin icon in the Watershed Explorer it will become highlighted, and its editor will be shown in the Component Editor. The subbasin becomes the current component at that moment. You may make changes to the properties of the subbasin on any of the tabs in the Component Editor. When you switch between tabs, any changes are automatically updated in the subbasin. The changes are also updated when you leave the tabs and click anywhere else in the program interface. Even though the updates are made in the subbasin properties, the changes are not saved to disk. Updates and changes are only saved to disk when the project is saved. You can save the project two different ways.

The first way to save all pending changes is from the File menu. Click on the File menu and then select the Save command. All components currently open in the project will be saved to disk, including the current basin model with its hydrologic elements, current meteorologic model, current control specifications, and all other project components.
The second way to save all pending changes is from the toolbar. Click the **Save Current Project** button. All components in the project will be saved to disk.

**Number Formatting**

Each country of the world has socially accepted conventions for formatting numbers. The combination of spoken language and country are combined and called a locale. For example, there is a locale for English conventions in Canada and also a locale for French conventions in Canada, since both languages are commonly used in that country. Locales have been defined for almost every language and country combination in the world. Each locale includes the language and conventions for formatting numbers. For example, in the United States a number would be displayed as follows:

12.34

In Austria the same number would usually be displayed as follows:

12,34

The program has been designed to accept and display numbers according to the locale selected on the computer. Even though the computer may be in one country, it is possible to set the computer to any locale. When the program starts it will check the locale selected on the computer and use those conventions for accepting number entry and displaying output. If the program is not able to interpret a number in the context of the locale selected on the computer, it will attempt to interpret the number using the locale for the United States.

**Date and Time Formatting**

The formatting of dates and times is also part of each locale. However, the program imposes some limitations to simplify the formatting of date and time information. All dates should specify a two-digit day, followed by a three-letter month, and end with a four-digit year. For example, in the United States a date would be entered or displayed as follows:

07May2004

The same date would be entered or displayed in Austria as follows:

07Mäi2004

Similar to number formatting, the program has been designed to accept and display dates according to the locale selected on the computer. If the program is not able to interpret a date in the context of the locale selected on the computer, it will attempt to interpret the date using the locale for the United States.

All times are formatted with the same rules regardless of the locale selected on the computer. A time should use two digits for the hour, followed by a colon, and end with two digits for the minutes. All times are assumed to be in an arbitrary local time zone that does not observe summer time (daylight savings in the United States). It uses 24-hour clock time instead of AM or PM notation. For example, time would be displayed as follows regardless of selected locale:

14:25
Some status messages displayed by the program indicate when some event occurred. Those times also show the seconds after the minutes. In those cases the minutes are followed by a colon and the number of seconds.

**Units Conversion**

Almost all initial conditions and parameter data for the various methods included in the program require units. For example, hydraulic conductivity has units of either millimeters per hour (mm/hr) or inches per hour (in/hr) depending on the unit system of the basin model. The unit system is one of the properties of the basin model and meteorologic model. If the system international unit system is selected for a basin model, then the hydraulic conductivity should be entered in mm/hr. However, the conductivity should be entered in in/hr if the U.S. customary unit system is selected. The units of an initial condition or parameter are shown in parenthesis after the label.

The value of initial conditions and parameter data are automatically converted when the unit system of a basin model or meteorologic model is changed. For example, suppose a basin model used the U.S. Customary unit system and a hydraulic conductivity was entered as 0.23 in/hr. If the unit system were changed to system international, the conductivity would be automatically converted to 5.84 mm/hr. The conversions are performed according to standards specified by the National Institutes of Standards and Technology (Taylor 1995).

Time-series data, paired data, and grid data components each have their own unit system based on the units of the data. The unit system is determined automatically from the units of the data. For example, a discharge time-series gage with units of cubic meters per second (M3/S) will be in the system international unit system. The units are selected by the user for manual entry data, but are read automatically from the record header for external DSS data. Data is automatically converted to the correct unit system during a compute.

**Interpolation**

Time-series data and gridset data are usually defined with a fixed time interval, though some data may be defined on an irregular basis. All of the different types of simulations happen with a fixed time interval, as specified in the control specifications. When the time interval of the time-series or gridset data does not match the time interval of the compute, the data is automatically interpolated. A linear interpolation in time is used.

Paired data components use a limited number of points to represent a curve, such as a storage-discharge curve. However, the curve represents continuous data. Linear interpolation is used when a dependent value is required for an independent value between two specified values. The interpolation is performed between the dependent values corresponding to the closest available independent values on each side of the requested value. Some paired data components use irregularly spaced values to represent an annual pattern, such as a groundmelt pattern. Linear interpolation in time is used on these components.

**Application Steps**

The program is designed with reusable data sets that can be independently developed. However, some data sets depend on others for important definitions. Gages must be created before they can be used in basin or meteorologic models. A basin model must exist before it can be used in a meteorologic model. A complete set of compatible components must exist before a simulation run can be configured.
and computed. Consequently, there is a necessary sequence to successfully obtain results. The remainder of this chapter provides an overview of the best procedure for obtaining computation results.

**Create a New Project**

Create a new project by selecting the **File ⇒ New...** menu command. After you press the button a window will open where you can name, choose a location on your computer or a network computer to save the new project, and enter a description for the new project. If the description is long, you can press the button to the right of the description field to open an editor. The editor makes it easier to enter and edit long descriptions. Press the **Create** button when you are satisfied with the name, location, and description. You cannot press the **Create** button if no name or location is specified for the new project. If you change your mind and do not want to create a new meteorologic model, press the **Cancel** button or the **X** button in the upper right of the **Create a New Project** window.

**Enter Shared Project Data**

Shared data includes time-series data, paired data, and grid data. Shared data is often required by basin and meteorologic models. For example, a reach element using the Modified-Puls routing method requires a storage-discharge relationship for the program to calculate flow through the reach. Table 9 contains a complete list of shared data types used by the program.

*Table 9. Different kinds of shared component data that may be required.*

<table>
<thead>
<tr>
<th>Time-Series Data</th>
<th>Paired Data</th>
<th>Grid Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precipitation</td>
<td>Storage-discharge</td>
<td>Precipitation</td>
</tr>
<tr>
<td>Discharge</td>
<td>Elevation-storage</td>
<td>Temperature</td>
</tr>
<tr>
<td>Stage</td>
<td>Elevation-area</td>
<td>Solar radiation</td>
</tr>
<tr>
<td>Temperature</td>
<td>Elevation-discharge</td>
<td>Crop coefficient</td>
</tr>
<tr>
<td>Solar radiation</td>
<td>Inflow-diversion</td>
<td>Storage capacity</td>
</tr>
<tr>
<td>Crop Coefficient</td>
<td>Cross sections</td>
<td>Percolation rate</td>
</tr>
<tr>
<td></td>
<td>Unit hydrograph curves</td>
<td>Storage coefficients</td>
</tr>
<tr>
<td></td>
<td>Percentage curves</td>
<td>Moisture deficit</td>
</tr>
<tr>
<td></td>
<td>ATI-meltrate functions</td>
<td>Impervious area</td>
</tr>
<tr>
<td></td>
<td>ATI-coldrate functions</td>
<td>SCS curve number</td>
</tr>
<tr>
<td></td>
<td>Groundmelt patterns</td>
<td>Elevation</td>
</tr>
<tr>
<td></td>
<td>Evaporation patterns</td>
<td>Cold content</td>
</tr>
<tr>
<td></td>
<td>Meltrate patterns</td>
<td>Cold content ATI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Meltrate ATI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Liquid water content</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Snow water equivalent</td>
</tr>
</tbody>
</table>
Open a component manager to add shared data to a project. Go to the **Components** menu and select **Time-Series Data Manager**, **Paired Data Manager**, or **Grid Data Manager** command. Each one of these component managers contains a menu for selecting the type of data to create or manage. The **Paired Data Manager** with the **Storage-Discharge** data type selected is shown in Figure 8. Once the data type is selected, you can use the buttons on the right side of the component manager to add a New, Copy, Rename, and Delete a data type. In the case or time-series data, the manager contains two extra buttons to add or delete time windows. A time window is needed for entering or viewing time-series data.

**Describe the Physical Watershed**

The physical watershed is represented in the basin model. Hydrologic elements (subbasin, reach, reservoir, junction, diversion, source, and sink) are added and connected to one another in a way as to model the real-world flow of water in a natural watershed. A description of each hydrologic element is given in Table 10.

The basin model manager can be used to add a new basin model to the project. Open the basin model manager by selecting the **Components ⇒ Basin Model Manager** command. The basin model manager can be used to copy, rename, or delete an existing basin model.

Once a basin model is created, hydrologic elements can be added to the basin map. Select the basin model in the **Watershed Explorer** to open the basin map in the desktop. If background map layers are available, add them to the basin model before adding hydrologic elements. Add a hydrologic element by select one of the hydrologic element tools from the toolbar, and clicking the left mouse button on the desired location in the basin map. Connect a hydrologic element to a downstream element by placing the pointer tool over the upstream element icon and clicking the right mouse button. Select the **Connect Downstream** menu item. Place the pointer over the downstream element icon and click the left mouse button. A connection link shows the elements are connected.
Table 10. Different kinds of hydrologic elements that can be used.

<table>
<thead>
<tr>
<th>Hydrologic Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subbasin</td>
<td>The subbasin element is used to represent the physical watershed. Given precipitation, outflow from the subbasin element is calculated by subtracting precipitation losses, transforming excess precipitation to streamflow at the subbasin outlet, and adding baseflow.</td>
</tr>
<tr>
<td>Reach</td>
<td>The reach element is used to convey streamflow downstream in the basin model. Inflow into the reach element can come from one or many upstream hydrologic elements. Outflow from the reach is calculated by accounting for translation and attenuation of the inflow hydrograph.</td>
</tr>
<tr>
<td>Junction</td>
<td>The junction element is used to combine streamflow from hydrologic elements located upstream of the junction element. Inflow into the junction element can come from one or many upstream elements. Outflow is simply calculated by summing all inflows and assuming no storage at the junction.</td>
</tr>
<tr>
<td>Source</td>
<td>The source element is used to introduce flow into the basin model. The source element has no inflow. Outflow from the source element is defined by the user.</td>
</tr>
<tr>
<td>Sink</td>
<td>The sink element is used to represent the outlet of the physical watershed. Inflow into the sink element can come from one or many upstream hydrologic elements. There is no outflow from the sink element.</td>
</tr>
<tr>
<td>Reservoir</td>
<td>The reservoir element is used to model the detention and attenuation of a hydrograph caused by a reservoir or detention pond. Inflow into the reservoir element can come from one or many upstream hydrologic elements. Outflow from the reservoir element can be calculated two ways. The user can enter a storage-outflow, elevation-storage-outflow, or elevation-area-outflow relationship, or the user can enter an elevation-storage or elevation-area relationship and define one or more outlet structures.</td>
</tr>
<tr>
<td>Diversion</td>
<td>The diversion element is used for modeling streamflow leaving the main channel. Inflow into the diversion element can come from one or many upstream hydrologic elements. Outflow from the diversion element consists of diverted flow and non-diverted flow. Diverted flow is calculated using input from the user. Both diverted and non-diverted flows can be connected to hydrologic elements downstream of the diversion element.</td>
</tr>
</tbody>
</table>
Most hydrologic elements require parameter data so that the program can model the hydrologic processes represented by the element. In the case of the subbasin element, many mathematical models are available for determining precipitation losses, transforming excess precipitation to streamflow at the subbasin outlet, and adding baseflow. In this document the different mathematical models will be referred to as methods. The available methods for subbasin and reach elements are shown in Table 11. Parameter data is entered in the Component Editor. Select a hydrologic element in the basin map or Watershed Explorer to open the correct Component Editor as shown in Figure 9. Global parameter editors can also be used to enter or view parameter data for many hydrologic elements as shown in Figure 10. Global parameter editors are opened using the Parameters menu.
Describe the Meteorology

The meteorologic model calculates the precipitation input required by a subbasin element. The meteorologic model can utilize both point and gridded precipitation and has the capability to model frozen and liquid precipitation along with evapotranspiration. The snowmelt methods model the accumulation and melt of the snow pack. The evapotranspiration methods include the constant monthly method and the new Priestly Taylor and gridded Priestly Taylor methods. An evapotranspiration method is only required when simulating the continuous or long term hydrologic response in a watershed. A brief description of the methods available for calculating basin average precipitation or grid cell precipitation is included in Table 12.

Use the meteorologic model manager to add a new meteorologic model to the project. Go to the Components menu and select the correct option from the menu list. The meteorologic model manager can also be used to copy, rename, and delete an existing meteorologic model.

Table 11. Methods available in the subbasin and reach hydrologic elements.

<table>
<thead>
<tr>
<th>Hydrologic Element</th>
<th>Calculation Type</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subbasin</td>
<td>Loss Rate</td>
<td>Deficit and constant rate (DC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exponential</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Green and Ampt</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gridded DC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gridded SCS CN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gridded SMA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Initial and constant rate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SCS curve number (CN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Soil moisture accounting (SMA)</td>
</tr>
<tr>
<td>Transform</td>
<td>Clark’s UH</td>
<td>Kinematic wave</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ModClark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SCS UH</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Snyder’s UH</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User-specified s-graph</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User-specified unit hydrograph (UH)</td>
</tr>
<tr>
<td>Baseflow</td>
<td>Bounded recession</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Constant monthly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Linear reservoir</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Recession</td>
<td></td>
</tr>
<tr>
<td>Reach</td>
<td>Routing</td>
<td>Kinematic wave</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modified Puls</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Muskingum</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Muskingum-Cunge</td>
</tr>
</tbody>
</table>
Table 12. Precipitation methods available for describing meteorology.

<table>
<thead>
<tr>
<th>Precipitation Methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency storm</td>
<td>Used to develop a precipitation event where depths for various durations within the storm have a consistent exceedance probability.</td>
</tr>
<tr>
<td>Gage weights</td>
<td>User specified weights applied to precipitation gages.</td>
</tr>
<tr>
<td>Gridded precipitation</td>
<td>Allows the use of gridded precipitation products, such as NEXRAD radar.</td>
</tr>
<tr>
<td>Inverse distance</td>
<td>Calculates subbasin average precipitation by applying an inverse distance squared weighting with gages.</td>
</tr>
<tr>
<td>SCS storm</td>
<td>Applies a user specified SCS time distribution to a 24-hour total storm depth.</td>
</tr>
<tr>
<td>Specified hyetograph</td>
<td>Applies a user defined hyetograph to a specified subbasin element.</td>
</tr>
<tr>
<td>Standard project storm</td>
<td>Uses a time distribution to an index precipitation depth.</td>
</tr>
</tbody>
</table>

Enter Simulation Time Windows

A simulation time window sets the time span and time interval of a simulation run. A simulation time window is created by adding a control specifications to the project. This can be done using the control specifications manager. Go to the Components menu and select the correct option from the menu list. Besides creating a new simulation time window, the control specifications manager can be used to copy, rename, and delete an existing window.

Once a new control specifications has been added to the project, use the mouse pointer and select it in the Watershed Explorer. This will open the Component Editor for the control specifications as shown in Figure 11. Information that must be defined includes a starting date and time, ending date and time, and computation time step.

![Control Specifications](image)

**Figure 11.** Control specifications component editor.
Simulate and View Results

A simulation run calculates the precipitation-runoff response in the basin model given input from the meteorologic model. The control specifications define the time period and time interval. All three components are required for a simulation run to compute.

Create a new simulation run by selecting the Compute ⇒ Create Simulation Run menu option. A wizard will open to step you through the process of creating a simulation run as shown in Figure 12. First, enter a name for the simulation. Then, choose a basin model, meteorologic model, and control specifications. After the simulation run has been created, select the run. Go to the Compute ⇒ Select Run menu option. When the mouse moves on top of Select Run a list of available runs will open. Choose the correct simulation. To compute the simulation, reselect the Compute menu and choose the Compute Run option at the bottom of the menu.

![Create a Simulation Run [Step 1 of 4]](image)

Figure 12. Using the wizard to create a new simulation run.

Results can be accessed from the basin map and the Watershed Explorer, "Results" tab. Results are available as long as a simulation run has been successfully computed and no edits have been made after the compute to any component used by the simulation run. For example, if the time of concentration parameter was changed for a subbasin element after the simulation run was computed, then results are no longer available for any hydrologic element in the basin model. The simulation run must be recomputed for results to become available.

The simulation must be selected (from the Compute menu or Watershed Explorer) before results can be accessed from the basin map. After the simulation run is selected, select the hydrologic element where you want to view results. While the mouse is located on top of the element icon, click the right mouse button. In the menu that opens, select the View Results option. Three result types are available: Graph, Summary Table, and Time-Series Table (Figure 13). These results can also be accessed through the toolbar and the Results menu. A hydrologic element must be selected before the toolbar buttons and options from the Results menu are active. A global summary table is available from the toolbar and Results menu. The global summary table contains peak flows and time of peak flows for each hydrologic element in the basin model.
Results can also be viewed from the Watershed Explorer, “Results” tab. Select the simulation run and the Watershed Explorer will expand to show all hydrologic elements in the basin model. If you select one of the hydrologic elements, the Watershed Explorer expands again to show all result types as shown in Figure 14. For a subbasin element, you might see outflow, incremental precipitation, excess precipitation, precipitation losses, direct runoff, and baseflow as the output results. Select one of these results to open a preview graph. Multiple results can be selected and viewed by holding down the Control or Shift buttons. Results from multiple hydrologic elements can be viewed together. Also, results from different simulation runs can be selected and viewed. Once output types are selected in the Watershed Explorer, a larger graph or time-series table can be opened in the desktop by selecting the Graph and Time-Series buttons on the toolbar.

Figure 13. Accessing results for the current simulation run using the basin map.
Create or Modify Data

Many hydrologic studies are carried out to estimate the change in runoff given some change in the watershed. For example, a residential area is planned in a watershed. The change in flow at some point downstream of the new residential area is required to determine if flooding will occur as a result of the residential area. If this is the case, then two basin models can be developed. One is developed to model the current rainfall-runoff response given predevelopment conditions and another is developed to reflect future development.

An existing basin model can be copied using the basin model manager or the right mouse menu in the Watershed Explorer. In the Watershed Explorer, “Components” tab, select the basin model. Keep the mouse over the selected basin model and click the right mouse button. Select the Create Copy... menu item to copy the selected basin model. The copied basin model can be used to model the future development in the watershed.

To reflect future changes in the watershed, method parameters can be changed. For example, the percent impervious area can be increased for a subbasin element to reflect the increase in impervious area from development. Routing parameters can also be adjusted to reflect changes to the routing reach.
Figure 15. Graph comparing outflow in the same element in two different simulations runs. The correct time-series were selected in the Watershed Explorer and then the graph toolbar button was pressed.

**Make Additional Simulations and Compare Results**

Additional simulations can be created using new or modified model components. Results from each simulation run can be compared to one another in the same graph or time-series table. Select the "Results" tab in the Watershed Explorer. Select each simulation run that contains results you want to compare. The Watershed Explorer will expand to show all hydrologic elements in the basin models. Select the hydrologic element in all simulation runs where results are needed. This will expand the Watershed Explorer even more to show available result types. Press the Control key and select each output result from the different simulation runs. When a result type is selected the result is added to the preview graph. Once all the results have been selected, a larger graph or time-series table can be opened by selecting the Graph and Time-Series buttons on the toolbar as seen in Figure 15.

**Exit the Program**

Save the project by selecting the File ⇒ Save menu item. After the project is saved, exit the program by selecting the File ⇒ Exit menu item.

**References**

Chapter 4  Projects and Control Specifications

Projects and Control Specifications

A project serves as a container for all the different parts that together form the complete representation of a watershed. Control specifications are one of the main components of a project, and are principally used to control simulation runs. The remainder of the project components are described in later chapters. This chapter describes how to create and manage projects. It also includes information on how the file system is used by the program to organize and access the files that represent the project components. Finally, it describes the control specifications.

Projects

A project represents all of the input data and simulation output necessary to answer an engineering question. Possible questions could include the following:

- What will be the flow rate at the bridge due to a 1% storm?
- How will the average in-stream flow depth for the month of July change after the operation schedule of an irrigation diversion is modified?
- What is the impact of changing the land use on 7% of the watershed from cow pasture to home sites?
- How will the frequency curve be affected by building a reservoir?

The questions may involve a single watershed or several adjacent watersheds. There may only be a single representation of the watershed, or multiple representations may be needed for different future scenarios. The project is flexible enough to work with any of these applications.

Creating a New Project

To create a new project, select the File ⇒ New... menu command. After this command is selected, the Create a New Project window will open where you can name, select the location on your computer or network computer to store the project, and describe the project (Figure 16). If the project description is long you can use the button to the right of the description field to open an editor. A default location is provided. The default location for creating new projects is specified in the program settings. Access the program settings by clicking the Tools menu and selecting the Program Settings command. You are not required to use the default directory and may create a new project on the local computer or a network resource anywhere your security limitations permit. All project files created by the program will be saved in a folder (the folder name is the name of the project) in the location entered. Select the default unit system for creating new components. The unit system of a component can always be changed after it is created. Press the Create button when you are satisfied with the name, location, and description. You cannot press the Create button if no name or location is specified. If you change your mind and do not want to create a new project, press the Cancel button or the X button in the upper right to close the window. The Create a New Project window can also be opened by pressing the Create a New Project button on the toolbar.
Chapter 4 Projects and Control Specifications

Figure 16. Creating a new project. The location may be changed to suit your preferences for storing and organizing projects.

Opening a Project

Open a project by selecting the File ⇒ Open… menu option. After this option is selected, the Open an Existing Project window will open as shown in Figure 17. This window contains all projects in the watershed list. The watershed list contains all projects previously opened by the program. Open a project by clicking the project name and pressing the Open button. You may also double-click a project name to open it. You cannot press the Open button if no project is selected. If the project you want to open is not in the list, press the Browse button. The Select Project File window opens that lets you navigate to the directory containing the desired project (Figure 18). If you change your mind and do not want to open a project, press the Cancel button or the X button in the upper right to close the window. The Open an Existing Project window can also be opened by pressing the Open a Project button on the toolbar.

Figure 17. Opening a project. Previously opened projects are kept on a list for easy reference.
Figure 18. Browsing to open a project that has not been opened previously. Select the project file with extension HMS to open that project.

Copying a Project

Copy a project by selecting the File ⇒ Save As... menu option. After this option is selected, the Save Current Project As window will open where you can name, select the location on your computer or network computer to store the project, and describe the project as shown in Figure 19. A default location is provided. The default location for creating new projects is specified in the program settings. Access the program settings by clicking the Tools menu and selecting the Program Settings command.

Figure 19. Saving a copy of the current project.
You are not required to use the default directory and may copy a project to the local computer or a network resource anywhere your security limitations permit. All project files will be copied to a folder (the folder name is the name of the project) in the location entered. If the project description is long you can use the button to the right of the description field to open an editor. Press the Copy button when you are satisfied with the name, location, and description. You cannot press the Copy button if no name or location is specified. If you change your mind and do not want to create a copy, press the Cancel button or the X button in the upper right to close the window.

There are two options in this window that need extra attention. The first option, Copy external DSS data (time-series, paired, grid data), will copy all external DSS records defined in the project and paste them into DSS files in the new project folder. Time-series, paired, and grid data are copied into separate DSS files. All references to these DSS records are automatically updated. The second option, Copy basin files (grid cell, maps), will copy all grid cell files and background map layer files used by all basin models in the project and paste them into the new project folder. The background map layer files are placed in a folder named “Maps.” All references to grid cell and map layer files are automatically updated.

**Renaming a Project**

Rename a project by selecting the File ⇒ Rename menu option. After this option is selected, the Rename Current Project window opens (Figure 20). The window shows the current project name and description and contains a text box for you to enter the new project name and description. If the project description is long you can use the button to the right of the description field to open an editor. Press the Rename button when you are satisfied with the name and description. You cannot press the Rename button if no name is specified. If you change your mind and do not want to rename the project, press the Cancel button or the X button in the upper right to close the window.

![Rename Current Project](image)

*Figure 20. Renaming the current project.*
Deleting a Project

Delete a project by selecting the File ⇒ Delete menu item. The Delete Current Project window will open (Figure 21). This window contains the project name and description and three choices for deleting the project. The first option, Watershed entry in watershed list only (all files remain intact), will only delete the project from the watershed list. The watershed list contains all projects previously opened by the program. No files are deleted when this option is selected. The second option, Watershed entry and all watershed files (external files remain intact), will delete the project from the project list and delete all project files. Project files include *.hms, *.basin, etc. (refer to Table 13 for a complete list of project files). No external files are deleted when this option is selected. External files include DSS, grid cell, and map layer files. The third option, Watershed entry, watershed files, and all external files, will delete the project from the watershed list, all files created by the program for this project, and all external files referenced by the project (DSS, grid cell, and map layer files). It is very important to keep in mind that the third option will delete external files which could be used by other projects. After the appropriate option is selected, press the Delete button. Once a project has been deleted it cannot be retrieved or undeleted. If you change your mind and do not want to delete the project, press the Cancel button or the X button in the upper right to close the window.

![Delete Current Project](image)

Figure 21. Preparing to delete the current project.

Project Properties

Basic properties and settings for the project are provided in the Component Editor for the project. Access the Component Editor on any tab of the Watershed Explorer. The highest level folder is labeled with the project name; click on the project name to display the Component Editor (Figure 22).

The description can be used to provide internal documentation. It is helpful to include notes and comments within the project to remind yourself of details at a later time. It also helps with providing information to other users who may work with the project in the future. If the description is short, you can type it directly into the description field. For long descriptions, you can press the editor button to the right of the description field. The description editor makes it easier to enter and edit long descriptions.
Chapter 4 Projects and Control Specifications

![Project component editor accessed by clicking on the top node of the Watershed Explorer. The top node is labeled with the project name.](image)

Output results are written to the project DSS file by default. However, you can change the file where results are written. Results will not be available after changing the output DSS file until the component is recomputed. If you wish, you can press the folder button to the right of the file field to open a file browser for locating the file. The file browser is set to locate files with the DSS extension. If you change your mind about searching for a different output file, you can press the Cancel button or the X button in the upper right of the browser window. Press the Select button after you locate and highlight the desired file. It is possible to have more than one project write output results to the same DSS file. However, the separate projects are not synchronized and extreme care must be taken in naming components in order to avoid conflicts.

**Project Options**

Additional project settings are available. Click the Tools menu and select the Options command to access the Options window. The window allows you to change any of the optional settings for the project as shown in Figure 23.

The first option on the "General" tab controls whether a warning is displayed before changing methods in a component. This applies to subbasin and reach elements. For example, a warning is displayed when switching from Green Ampt loss rate method to deficit constant if the option is checked on. The method is changed without warning if the option is checked off.

The second option on the "General" tab controls whether a warning is displayed before deleting a component. This applies to basin models, hydrologic elements, meteorologic models, control specifications, time-series data, paired data, grid data, simulation runs, optimization trials, and analyses. If this option is checked, a warning will be displayed so you can confirm the deletion of a junction element. The item is deleted without warning if the option is checked off.

The third option on the "General" tab controls what kind of tooltips are shown on the "Compute" tab of the Watershed Explorer. You have the option of using the description of the compute component as the tooltip. You also have the option of using the components that make up the compute object as its tooltip. Only the first 35 letters of the description or components are shown in the tooltip.
Figure 23. Project options accessed from the Tools menu.

The fourth option on the "General" tab controls the default location for projects. Anytime you open a project, the browser will begin looking in the specified directory. Regardless of where you begin browsing for a project, you can always use the file browser to open a project anywhere on the local computer or a network device.

The "Defaults" tab contains settings for the default methods in basin and meteorologic models. These are the methods that will be used when a model is first created, or hydrologic elements are first created. You can always change the method at a later time. These options will save time if you set them to the methods you use most often.

The "Messages" tab contains settings for the error, warning, and note messages. You can select whether a sound is played when a particular type of message occurs. You can also choose the color that is used to print the message in the message log.

Directories and Files

The program automatically creates and manages many different files, all of which are stored in the project directory. A project directory is automatically created in the file system when a new project is created. Even though multiple projects can be stored in the same directory, it is recommended that each project be stored in a separate directory. Separate directories improve file system organization and facilitate archiving by external backup software.

Files Generated by the Program

Each data set or class of data sets is stored in a separate file in the project directory. The names used for components or data sets are automatically converted to filenames for the files. Underscores are substituted for special characters not allowed by the operating system. For example, a basin model named North Branch would be stored in the file North_Branch.basin. A complete list of files used by
the program is shown in Table 13. A majority of the files are in ASCII format but the user should never need to look at the files. Management should always be performed using program commands since some information is stored in multiple files. The program may not run correctly when files are unsynchronized because of external management operations.

Table 13. Files created by the program for storing component data. Sample names have been used assuming a project named Castro, that contains a basin model named North Branch, a meteorologic model named Historic Calib, and a control specifications named Oct 1977. It is also assumed that all features of the program are used including an optimization trial named Est Baseflow, and a saved state named Mid Oct 77.

<table>
<thead>
<tr>
<th>Filename</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Castro.access</td>
<td>Control file used to limit access to the project to one user at a time.</td>
</tr>
<tr>
<td>Castro.dsc</td>
<td>Catalog of the project DSS file to speed finding specific records.</td>
</tr>
<tr>
<td>Castro.dss</td>
<td>Project DSS file containing manual entry time-series and paired data, and all results from simulation runs, optimization trials, and analyses.</td>
</tr>
<tr>
<td>Castro.gage</td>
<td>Definition of all time-series data.</td>
</tr>
<tr>
<td>Castro.grid</td>
<td>Definition of all grid data.</td>
</tr>
<tr>
<td>Castro.hms</td>
<td>Project definition including listing of all basin models, meteorologic models, and control specifications.</td>
</tr>
<tr>
<td>Castro.log</td>
<td>All messages are recorded in the log file except for messages generated during a compute. Compute messages are recorded in their own separate files.</td>
</tr>
<tr>
<td>Castro.nals</td>
<td>Definition of all analyses.</td>
</tr>
<tr>
<td>Castro.out</td>
<td>List of all data read or written from DSS files.</td>
</tr>
<tr>
<td>Castro.pdata</td>
<td>Definition of all paired data.</td>
</tr>
<tr>
<td>Castro.run</td>
<td>Definition of simulation runs including their properties and the time of last compute.</td>
</tr>
<tr>
<td>North_Branch.basin</td>
<td>Basin model element properties, network configuration, and other settings. There is a separate file for each basin model.</td>
</tr>
<tr>
<td>Historic_Calib.met</td>
<td>Meteorologic model configuration for precipitation, evapotranspiration, and snowmelt. There is a separate file for each meteorologic model.</td>
</tr>
<tr>
<td>Oct_1977.control</td>
<td>Control specifications data. There is a separate file for each control specifications.</td>
</tr>
<tr>
<td>Castro.trial</td>
<td>Definition of all the optimization trials.</td>
</tr>
<tr>
<td>Est_Baseflow.optim</td>
<td>Optimization trial properties including search method, objective function, and selected parameters. There is a separate file for each optimization trial.</td>
</tr>
<tr>
<td>Castro.statelIndex</td>
<td>Definition of all the saved states.</td>
</tr>
<tr>
<td>Mid_Oct_77.state</td>
<td>Saved state information for all the hydrologic elements in a specific basin model part of a specific simulation run. There is a separate file for each saved state.</td>
</tr>
</tbody>
</table>
Files Specified by the User

Files that are not automatically created and managed by the program can be added to the project directory by the user. Optional background map files can be added and used in basin models. The grid cell file required by the ModClark gridded transform method must be created external to the program. These optional and required files can be stored at any location on the computer file system, but it is often convenient to store them in the project directory. Additional supplementary files, related to the project but not used by the program, can also be placed in the project directory and will be ignored. However, when a project is copied, only files used by the program will be copied.

Manually Entered Time-Series and Paired Data

The project DSS file stores all time-series and paired data that is manually entered by the user. The data entered by the user is automatically stored as a record in the file. When the data is edited the record is automatically updated. The record is automatically updated if the time-series gage or paired data function is renamed, copied, or deleted. The record can be accessed by other programs that can read and write in the DSS format.

Each DSS record contains only one type of data. Information about the data is stored in a header inside the record. The header for time-series data includes the record name, whether the data is on a regular or irregular time interval, start date and time, end date and time, number of values, measurement units, and data type. The header for paired data includes the record name, number of curves, measurement units of the first series, data type of the first series, measurement units of the second and subsequent series, and data type of the second and subsequent series.

Computed Results

By default, all computed results are stored in the project DSS file. However, the user has the option of changing the file where computed results are stored. Any manually entered time-series or paired data will continue to be stored in the project DSS file regardless of the file used for computed results. If the computed results are stored in a different file, that file can be safely deleted without affecting the program. However, it is not possible to view results after deleting the file where they are stored.

The result from each element is stored in a separate record. Some elements compute different types of results; each result is stored in a separate record. The record is identified with a pathname. Each record pathname contains six parts called the A-part, B-part, C-part, D-part, E-part, and F-part. The pathname parts are separated with a slash and may contain spaces. The complete pathname, including slashes and spaces, can total up to 256 uppercase characters. The following is an example of a pathname for the computed flow at a hydrologic element named “Sand Cr” in simulation run “Plan 3A”:

//SAND CR/FLOW/01JAN1985/1HOUR/RUN:PLAN 3A/

A consistent naming convention is used for assigning the different pathname parts of the computation results (HEC, 1994). The B-part is assigned the name of the element in the basin model. The C-part is assigned a data descriptor as described in Appendix B. The D-part is assigned the simulation start date. The E-part is assigned the simulation time interval. The F-part begins with a three-letter code that identifies the type of computed result, followed by a colon and the name of the compute component.
External Time-Series, Paired, and Grid Data

Any time-series or paired data that is not manually entered must be stored in an external DSS file. Grid data cannot be manually entered and so must be stored in an external DSS file. External DSS files are all DSS files used in a project except the project DSS file which was created to store model data and computation results. The external files can store regular or irregular interval time-series data, paired data, or grid data. They can be located anywhere on the computer or network and shared with other programs. This program automatically determines the data type, units, and interval from the record header.

Security Limitations

The program can create a project on the local computer or on any accessible network device. Creating a project requires the user to have read and write permission for the folder that will contain the new project. Usually the system administrator determines where a user has permission to read and write. Depending on the security settings assigned to the user by the system administrator, the program may not be able to create a project in some folders. As a user, be sure you understand where you have permission to create new projects. No other privileges beyond read and write permission are required to use the program; it is fully compatible with operating in a so-called reduced privilege environment.

The program automatically checks all of the project files for read and write permission every time the project is opened. If any of the files are read-only, then the program will not be able to open the project and an error message will be displayed. If a project was previously accessible but becomes inaccessible, it is possible that the file permissions were changed external to the program. It is also possible for the files to have read-only permission if they are copied from a CD-ROM or other removable storage media. If the files have been set to read-only permission for any reason, you will need to manually change the permissions on the files before the program can open the project. If you are using the Microsoft Windows® operating system, you can change file permissions using Windows Explorer. On the Sun Microsystems Solaris™ operating system, you can open a command window and use the chmod command.

The program is designed to work with projects that may be shared by several users. Usually shared projects will be stored on a server or network storage device, but could be stored in a shared folder on a local computer. All users who will share the project must have read and write permission for that folder. Even though several users may share the project, only one user can access the project at a time. The program automatically tracks how many users are accessing a project and limits access as necessary.

Control Specifications

Control specifications are one of the main components in a project, even though they do not contain much parameter data. Their principle purpose is to control when simulations start and stop, and what time interval is used in the simulation.

Creating a New Control Specifications

A new control specifications is created using the Control Specifications Manager. To access the manager, click on the Components menu and select the Control Specifications Manager command. The manager will open and show all of the control specifications currently in the project. The manager can remain open while
you manage control specifications or while you perform tasks elsewhere in the program. You can close the manager using the X button in the upper right corner.

The buttons to the right of the specifications list can be used to manage existing specifications or create a new one. To create a new control specifications, press the **New...** button. After you press the button a window (Figure 24) will open where you can name and describe the new control specifications that will be created. A default name is provided for the new specifications; you can use the default or replace it with your own choice. A description can also be entered. If the description is long, you can press the button to the right of the description field to open an editor. The editor makes it easy to enter and edit long descriptions. When you are satisfied with the name and description, press the **Create** button to finish the process of creating the new control specifications. You cannot press the **Create** button if no name is specified for the new specifications. If you change your mind and do not want to create a new control specifications, press the **Cancel** button or the X button in the upper right to return to the *Control Specifications Manager* window.

![Figure 24. Creating a new control specifications. This was accessed by opening the Control Specifications Manager from the Components menu, and then pressing the **New...** button.](image)

**Copying a Control Specifications**

There are two ways to copy a control specifications. Both methods for copying a specifications create an exact duplicate with a different name. Once the copy has been made it is independent of the original and they do not interact.

The first way to create a copy is to use the *Control Specifications Manager*, which is accessed from the **Components** menu. Select the control specifications you wish to copy by clicking on it in the list of current control specifications. The selected specifications is highlighted after you select it. After you select a specifications you can press the **Copy...** button on the right side of the window. A new **Copy Control Specifications** window (Figure 25) will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the **Copy** button to finish the process of copying the selected control specifications. You cannot press the **Copy** button if no name is specified. If you change your mind and do not want to copy the selected control specifications, press the **Cancel** button or the X button in the upper right to return to the *Control Specifications Manager* window.
Chapter 4 Projects and Control Specifications

The second way to copy is from the "Components" tab of the Watershed Explorer. Move the mouse over the control specifications you wish to copy, then press the right mouse button (Figure 26). A context menu is displayed that contains several choices including copy. Click the Create Copy… command. A new Copy Control Specifications window will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected control specifications. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected control specifications, press the Cancel button or the X button in the upper right of the Copy Control Specifications window to return to the Watershed Explorer.

Renaming a Control Specifications

There are two ways to rename a control specifications. Both methods for renaming a specifications change its name and then all references to the old specifications name are automatically updated to the new name.
The first way to perform a rename is to use the Control Specifications Manager, which you can access from the Components menu. Select the control specifications you wish to rename by clicking on it in the list of current control specifications. The selected specifications is highlighted after you select it. After you select a specifications you can press the Rename... button on the right side of the window. A new Rename Control Specifications window (Figure 27) will open where you can provide the new name. If you wish you can also change the description at the same time. If the new description will be long, you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Rename button to finish the process of renaming the selected control specifications. You cannot press the Rename button if no name is specified. If you change your mind and do not want to rename the selected control specifications, press the Cancel button or the X button in the upper right of the Rename Control Specifications window to return to the Control Specifications Manager window.

The second way to rename is from the "Components" tab of the Watershed Explorer. Select the control specifications you wish to rename by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected specifications and click the right mouse button. Select the Rename... command from the menu and the highlighted name will change to editing mode as shown in Figure 28. You can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished changing the name, press the Enter key to finalize your choice. You can also finalize your choice by clicking elsewhere on the "Components" tab. If you change your mind while in editing mode and do not want to rename the selected control specifications, press the Escape key.
Deleting a Control Specifications

There are two ways to delete a control specifications. Both methods for deleting a specifications remove it from the project and then automatically update all references to that specifications. Once a specifications has been deleted it cannot be retrieved or undeleted. Any references to the deleted specifications will switch to using no control specifications, which is usually not a valid choice during a simulation. At a later time you will have to go to those components and manually select a different control specifications.

The first way to perform a deletion is to use the Control Specifications Manager, which you can access from the Components menu. Select the control specifications you wish to delete by clicking on it in the list of current control specifications. The selected specifications is highlighted after you select it. After you select a specifications you can press the Delete button on the right side of the window. A window will open where you must confirm that you wish to delete the selected specifications as shown in Figure 29. Press the OK button to delete the specifications. If you change your mind and do not want to delete the selected control specifications, press the Cancel button or the X button in the upper right to return to the Control Specifications Manager window.

![Figure 29. Preparing to delete a control specification from the Control Specifications Manager. A confirmation will be required after pressing the Delete button.](image)

The second way to delete is from the "Components" tab of the Watershed Explorer. Select the control specifications you wish to delete by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected specifications and click the right mouse button (Figure 30). A context menu is displayed that contains several choices including delete. Click the Delete command. A window will open where you must confirm that you wish to delete the selected specifications. Press the OK button to delete the specifications. If you change your mind and do not want to delete the selected control specifications, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.
Chapter 4  Projects and Control Specifications

Figure 30. Deleting a control specifications in the Watershed Explorer.

**Time Window**

Each control specifications sets the time window over which a simulation will be performed. The window is specified using a separate start date, start time, end date, and end time. There is no limit on the length of a time window, or the number of simulation time steps it can contain. The program contains simulation methods suitable for both event and continuous simulation. Whether a particular simulation is considered event or continuous depends on the length of the time window set in the control specifications and the methods chosen in the basin model.

The program is capable of processing dates from 1 AD through 4000 AD. The format for specifying a date is to use two digits for the day, followed by the three-letter month abbreviation, and finally the four digit year. Two digit years are never used for entering or displaying dates. For example, the date February 8, 1936 should be entered as follows:

08Feb1936

It is very important to use the correct format or the date you enter may be incorrectly interpreted. If the program is not able to interpret a date, the entry field will become blank. The same format is used for both start and end dates, and for dates throughout the program.

The program processes times assuming an arbitrary local time zone that does not observe summer time (daylight savings in the United States). It uses 24-hour clock time instead of AM or PM notation. Time windows can only be entered with minute resolution. Times may range from 00:00 at the beginning of a day to 23:59 at the end. If a time of 24:00 is entered, it is automatically converted to 00:00 on the following day. For example, the time of 2:15:00 PM should be entered as follows:

14:15

It is very important to use the correct format, including the colon, or the time may be incorrectly interpreted. The same format is used for start and end times, and for times throughout the program.

Enter or edit the time window in the Component Editor for the control specifications. Access the editor from the Watershed Explorer on the “Components” tab by clicking on the desired control specifications icon (Figure 31). Type the date and time information in the appropriate fields.
Time Interval

Each control specifications includes the time interval that will be used to perform computations during a simulation. The same interval will be used when viewing time-series results from the simulation. In some cases, computations may be carried out at a shorter time interval and results interpolated to the interval specified in the control specifications. Some methods in the basin model have parameters that are sensitive to time interval. Those parameters have to be estimated with knowledge of the time interval in the control specifications.

Time-series gage data and grid data are interpolated to the time interval during a simulation. The original data stored for the gage or grid is not altered; the available data is interpolated as part of the simulation process and is not retained. The interpolation is performed linearly in time between the available data points.

Specify the time interval in the Component Editor for the control specifications (Figure 31). Access the editor from the Watershed Explorer on the Components tab by clicking on the desired control specifications icon. Select the desired time interval from the list of available choices. The possible choices range from 1 minute to 24 hours.

It is important that any minutes included in a start or end time be an integer multiple of the time interval. For example, if the time interval were chosen to be 10 minutes, then the start or end time could be 10:00, 10:10, 10:20 or other multiples of 10 minutes. For the same time interval, the start or end time could not be 10:07 since that is not an integer multiple of the time interval.

Importing HEC-1 Files

The program can import HEC-1 files formatted for the 1981 and newer program versions. Some of the computation options available in HEC-1 are not available in the program. Unrecognized input data is automatically ignored during the import process and reported in the import log. However, the import process is generally successful in separating the input file into component parts for addition to the current project. The job description and initialization data records become control specifications. The hydrograph calculation data records are separated into a basin model and meteorologic model. Precipitation and flow gages are created when necessary. Imported components should always be checked for accuracy.
Selecting and Processing a File

You can import an existing HEC-1 file into the current project (HEC, 1998). The HEC-1 program used a single file to contain all of the data necessary to perform a simulation. The import process will read the file and create equivalent components for time-series and paired data. It will create a basin model, meteorologic model, and control specifications. It is left to the user to check all of the imported data and create a simulation run to obtain results. Because of more advanced numerical analysis techniques used in the program, results may not match exactly the results obtained with HEC-1.

Begin the process of importing a HEC-1 by clicking File menu and selecting the Import ⇒ HEC-1 File... command. An Import HEC-1 File window opens where you can specify the HEC-1 file to be imported (Figure 32). If you do not know which file you want to import, you can click the button to the right of the file name field to open a file browser. Use the browser to navigate the file system and find the correct HEC-1 file. The browser will allow you to select HEC-1 files, which usually end with the DAT or HC1 extensions. Once you have located and selected the desired HEC-1 file, press the Select button. If you change your mind about selecting a file, you can press the Cancel button or the X button in the upper right of the browser to return to the Import HEC-1 File window without selecting a file. If you change your mind about importing a HEC-1 file, you can press the Cancel button or the X button in the upper right of the Import HEC-1 File window.

After you specify the HEC-1 file to import, you must enter the name of the basin model, meteorologic model, and control specifications. You can use the default names that are provided or you can enter your own names. You can always rename the components at a later time. Press the Import button when you have finished specifying the HEC-1 file name to import, and the names of the three components. You cannot import a HEC-1 file unless the file name and all three component names are specified. When you press the Import button, the import process will read the HEC-1 file and create the appropriate parts of the three components.
Table 14. Unsupported HEC-1 records that cannot be processed during import along with possible alternatives.

<table>
<thead>
<tr>
<th>Record Identifier</th>
<th>Alternative</th>
</tr>
</thead>
<tbody>
<tr>
<td>IO, VS, VV</td>
<td>The program automatically writes all computed time-series data to the project DSS file. Complete summary tables and time-series tables are available at all hydrologic elements. There is no need to control the output level.</td>
</tr>
<tr>
<td>JP, KP</td>
<td>The program does not currently compute multiple simulation runs simultaneously.</td>
</tr>
<tr>
<td>JR</td>
<td>The simulation run includes a precipitation or flow ratio capability but only one ratio is provided. You will need to create a separate simulation run for each ratio.</td>
</tr>
<tr>
<td>JD</td>
<td>Depth-area analyses provide an equivalent capability with superior accuracy, but there is no direct conversion.</td>
</tr>
<tr>
<td>OU, OR</td>
<td>Optimization trials provide an equivalent capability for estimating loss rate method, transform method, baseflow method, and routing method parameters but there is no direct conversion.</td>
</tr>
<tr>
<td>OS, OF, OO, DO, DC, DD, SO, SD, WO, WC, WD</td>
<td>There is no capability to automatically estimate optimal sizes for flood control system components based on economic factors. Risk-based design procedures should be used to size system components.</td>
</tr>
<tr>
<td>HB</td>
<td>There is currently no capability to balance computed hydrographs.</td>
</tr>
<tr>
<td>HL</td>
<td>The basin model includes a setting to compute local flow at junctions that is somewhat similar.</td>
</tr>
<tr>
<td>HS</td>
<td>There is currently no equivalent capability to simulate reservoir storage from a specified release schedule.</td>
</tr>
<tr>
<td>KF</td>
<td>All computed results are stored in the project DSS file using double precision. There is no need to specify output format.</td>
</tr>
<tr>
<td>LM, LH</td>
<td>The exponential-snowmelt and Holtan loss rate methods are not currently available.</td>
</tr>
<tr>
<td>MA, MC, MT, MS, MD, MW</td>
<td>There is a temperature index snowmelt capability in the program that is similar, but there is no direct conversion.</td>
</tr>
<tr>
<td>PM</td>
<td>There is no probable maximum precipitation capability in the program. The HMR52 program should be used instead (HEC 1984).</td>
</tr>
<tr>
<td>QP</td>
<td>Pattern hydrographs for local inflow are not needed because of how the routing optimization is implemented.</td>
</tr>
<tr>
<td>RC</td>
<td>Normal depth routing to determine the modified Puls storage-outflow curve is not supported. Channel data are converted to the Muskingum-Cunge method.</td>
</tr>
<tr>
<td>RL</td>
<td>Channel losses are not included in the program at this time.</td>
</tr>
<tr>
<td>UA</td>
<td>There is currently no capability to specify the time-area curve used with Clark or Snyder unit hydrographs. The ModClark transform method provides a similar capability to specifying the curve.</td>
</tr>
<tr>
<td>WP, WR</td>
<td>The head-discharge pump included in the reservoir provides a similar capability, but there is no direct conversion.</td>
</tr>
</tbody>
</table>
Unsupported Features

Most of the features in the HEC-1 program are also available in this program. Some features related to economic estimates were not incorporated into this program because they are inconsistent with modern engineering analysis methods for risk-based design. Other features have not been added to this program because they use old numerical algorithms that have been replaced by superior method in this program and no direct translation is available. Other features may be added to this program in the future. The so-called cards from HEC-1 that are not supported during import are shown in Table 14. An error message will be displayed if any of those cards are encountered.

References


CHAPTER 5

Shared Component Data

Hydrologic simulation requires a wealth of data that is used as initial conditions, boundary conditions, or parameters. A large portion of the data is measurements of atmospheric conditions, such as precipitation, temperature, and solar radiation.

Time-Series Data

Hydrologic models often require time-series of precipitation data for estimating basin-average rainfall. A time-series of flow data, often called observed flow or observed discharge, is helpful for calibrating a model and is required for optimization. Other kinds of time-series data are used as well. Time-series data is stored in a project as a gage. The program separates different types of data with different gage types. Gage data only has to be entered one time. The gages are part of the project and can be shared by multiple basin or meteorologic models.

Creating a New Gage

A new gage is created using the time-series data manager. To access the manager, click on the Components menu and select the Time-Series Data Manager menu command (Figure 33). The manager can remain open while you perform tasks elsewhere in the program. You can close the manager using the X button in the upper right corner. At the top of the manager is a Data Type menu. This menu lets you select one of the time-series data types supported by the program. Refer to Table 9 for a complete list of time-series data types. When a data type is selected, the manager will show all time-series data of the same type. The buttons to

Figure 33. Time-Series Data Manager accessed from the Components menu.
Chapter 5  Shared Component Data

Figure 34. Creating a new discharge gage after pressing the New... button in the Time-Series Data Manager.

The right of the time-series data list can be used to manage existing data or create new data. To create a new time-series gage, press the New... button. After you press the button a window will open (Figure 34) where you can name and describe the new gage. A default name is provided for the new gage; you can use the default or replace it with your own choice. A description can also be entered. If the description is long, you can press the button to the right of the description field to open an editor.

The editor makes it easy to enter and edit long descriptions. When you are satisfied with the name and description, press the Create button to finish the process of creating the new time-series gage. You cannot press the Create button if no name is specified. If you change your mind and do not want to create a new time-series gage, press the Cancel button or the X button in the upper right to return to the time-series data manager.

Copying a Gage

There are two ways to copy a time-series gage. Both methods for copying a gage create an exact duplicate with a different name. Once the copy has been made it is independent of the original and they do not interact.

The first way to create a copy is to use the time-series data manager, which is accessed from the Components menu. First, select the data type of the time-series gage you want to copy from the Data Type menu. Then, select the time-series gage you want to copy by clicking on it in the list of current time-series gages. The selected gage is highlighted after you select it. After you select a gage you can press the Copy... button on the right side of the window. A new window will open where you can name and describe the copy that will be created (Figure 35). A default name is provided for the copy; you can use the default or replace it with your own choice.

Figure 35. Creating a copy of a gage after pressing the Copy... button in the Time-Series Data Manager.
Chapter 5  Shared Component Data

Figure 36. Creating a copy of a gage by selecting it in the Watershed Explorer and using the right-mouse menu.

A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected time-series gage. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected gage, press the Cancel button or the X button in the upper right to return to the time-series data manager.

The second way to create a copy is from the Watershed Explorer, on the "Components" tab. Move the mouse over the time-series component you wish to copy, then press the right mouse button (Figure 36). A context menu is displayed that contains several choices including copy. Click the Create Copy… menu option. A new window will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected time-series gage. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the gage, press the Cancel button or the X button in the upper right of the window to return to the Watershed Explorer.

Renaming a Gage

There are two ways to rename a time-series gage. Both methods for renaming a gage changes its name and then all references to the old name are automatically updated to the new name.

The first way to perform a rename is to use the time-series data manager, which you can access from the Components menu. First, select the data type of the time-series gage you want to rename from the Data Type menu. Then, select the time-series gage you want to rename by clicking on it in the list of current time-series gages. The selected gage is highlighted after you select it. After you select a gage you can press the Rename… button on the right side of the window. A window will open where you can provide the new name (Figure 37). You can also change the description at the same time. If the new description will be long, you can
use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Rename button to finish the process of renaming the selected time-series gage. You cannot press the Rename button if no name is specified. If you change your mind and do not want to rename the selected gage, press the Cancel button or the X button in the upper right of the window to return to the time-series data manager.

The second way to rename is from the Watershed Explorer, on the “Components” tab. Move the mouse over the time-series component you wish to rename, then press the right mouse button (Figure 38). A context menu is displayed; select the Rename... command and the highlighted name will change to editing mode. You can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished changing the name, press the Enter key to finalize your choice. You can also finalize your choice by clicking elsewhere in the Watershed Explorer. If you change your mind while in editing mode and do not want to rename the selected gage, press the Escape key.
Deleting a Gage

There are two ways to delete a time-series gage. Both methods for deleting a gage will remove it from the project and then automatically update all references to that gage. Once a gage has been deleted it cannot be retrieved or undeleted. Any references to the deleted gage will switch to using no gage, which is usually not a valid choice during a simulation. At a later time you will have to go to those components and manually select a different gage.

The first way to perform a deletion is to use the time-series data manager, which you can access from the Components menu. First, select the data type of the time-series gage you want to delete from the Data Type menu. Then, select the time-series gage you want to delete by clicking on it in the list of current time-series gages. The selected gage is highlighted after you select it. After you select a gage you can press the Delete button on the right side of the window (Figure 39). A window will open where you must confirm that you want to delete the selected gage. Press the OK button to delete the gage. If you change your mind and do not want to delete the selected gage, press the Cancel button or the X button in the upper right to return to the time-series data manager.

![Figure 39. Preparing to delete a gage from the Time-Series Data Manager.](image)

The second way to delete a gage is from the Watershed Explorer, on the “Components” tab. Select the time-series gage you want to delete by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected gage and click the right mouse button. A context menu is displayed that contains several choices including delete. Click the Delete menu option. A window will open where you must confirm that you want to delete the selected gage. Press the OK button to delete the gage. If you change your mind and do not want to delete the selected gage, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.
Chapter 5 Shared Component Data

Time Windows

Time windows are used to separate the time-series data into manageable sections. You may choose to have a separate time window for each event. Alternately you may have several time windows for a continuous record to break it into months or years. You may choose to have a combination of time window types and they may overlap. All time windows use the same data units, time interval, and other properties discussed in the following sections.

The program is capable of processing dates from 1 AD through 4000 AD. The format for specifying a date is to use two digits for the day, followed by the three-letter month abbreviation, and finally the four digit year. Two digit years are never used for entering or displaying dates. For example, the date October 2, 1955 should be entered as follows:

02Oct1955

It is very important to use the correct format or the date you enter may be incorrectly interpreted. If the program is not able to interpret a date, the entry field will become blank. The same format is used for both start and end dates, and for dates throughout the program.

The program processes times assuming an arbitrary local time zone that does not observe summer time (daylight savings in the United States). It uses 24-hour clock time instead of AM or PM notation. Time windows can only be entered with minute resolution. Times may range from 00:00 at the beginning of a day to 23:59 at the end. If a time of 24:00 is entered, it is automatically converted to 00:00 on the following day. For example, the time of 6:20:00 PM should be entered as follows:

18:20

It is very important to use the correct format, including the colon, or the time may be incorrectly interpreted. The same format is used for start and end times, and for times throughout the program.

There are two ways to create a new time window. The first way is from the Time-Series Data Manager, accessed by clicking the Components menu and then selecting the Time-Series Data Manager command. Select the desired data type, then click on a time-series data component in the list; the component will become...
highlighted. Press the **Add Window** button to create a new time window. The **Add Time-Series Data Time Window** window will open where you can enter the start date and other information as shown in Figure 41. You can either enter the information manually, or select a control specifications. If you select a control specifications, the start and end time in that control specifications will be used for the new time window. Press the **Add** button to finish the process of creating the new time window. If you change your mind and do not want to create a new time window, press the **X** button in the upper corner of the **Add Time-Series Data Time Window**. The second way to create a new time window is directly from the **Watershed Explorer**. Select a time-series component by clicking on it or one of the existing time windows. Keep the mouse over the gage or time window icon and click the right mouse button. A context menu appears as shown in Figure 42; click the **Create Time Window** command to create a new time window. A new time window will be added to the **Watershed Explorer**. The new time window will contain default start and end times. Click on the time window in the **Watershed Explorer** and use the **Component Editor** to change the start or end time.

![Add Time-Series Data Time Window](image1)

**Figure 41.** Creating a new time window for a gage, beginning from the Time-Series Data Manager.

![Watershed Explorer](image2)

**Figure 42.** Creating a new time window from the Watershed Explorer.
There are two ways to delete a time window. The first way is from the Time-Series Data Manager, accessed by clicking the Components menu and then selecting the Time-Series Data Manager command. Select the desired data type, then click on a time-series gage in the list; it will become highlighted. Press the Delete Window button to delete a time window. The Delete Time-Series Data Time Window window will open where you can select the window to delete (Figure 43). Click on the desired window and it will become highlighted. Press the Delete button to delete the highlighted time window. If you change your mind and do not want to delete a time window, press the X button in the upper corner of the Delete Time-Series Data Time Window window. The second way to delete a time window is directly from the Watershed Explorer. Select a time window for a time-series gage; it will become highlighted. Keep the mouse over the time window icon and click the right mouse button. A context menu appears as shown in Figure 44; click the Delete Time Window command to delete the selected time window.
Chapter 5  Shared Component Data

Figure 45. Using the time window component editor for a gage to view and edit the start and end time for a window.

You can change the start date, start time, end date, and end time of an existing time window. Use the Watershed Explorer to select the time window you wish to change. Click on the time window under the correct time-series component. The component will become the selected component and its data will be shown in the Component Editor as seen in Figure 45; the “Time Window” tab is automatically selected. Change the start date or other properties to the desired values. Click on a different tab in the Component Editor or elsewhere in the program interface to make the changes take affect.

Data Source

The data source determines how the data for a time-series component will be stored. Data may be entered manually or retrieved from the Data Storage System (HEC-DSS). Manual entry means that you must enter values for all of the time windows. Data can be retrieved from a DSS file without having to enter the values, but the data must be correctly loaded into the file. The type of properties you specify for the time-series gage will be determined by the data source, as discussed in the following sections. Compare Figure 46 and Figure 47 to see the difference in entering data for manual entry or HEC-DSS data sources.

Figure 46. Component editor for a temperature gage with manually-entered data. Of the different data types, only temperature gages have elevation.

You can change the start date, start time, end date, and end time of an existing time window. Use the Watershed Explorer to select the time window you wish to change. Click on the time window under the correct time-series component. The component will become the selected component and its data will be shown in the Component Editor as seen in Figure 45; the “Time Window” tab is automatically selected. Change the start date or other properties to the desired values. Click on a different tab in the Component Editor or elsewhere in the program interface to make the changes take affect.

Data Source

The data source determines how the data for a time-series component will be stored. Data may be entered manually or retrieved from the Data Storage System (HEC-DSS). Manual entry means that you must enter values for all of the time windows. Data can be retrieved from a DSS file without having to enter the values, but the data must be correctly loaded into the file. The type of properties you specify for the time-series gage will be determined by the data source, as discussed in the following sections. Compare Figure 46 and Figure 47 to see the difference in entering data for manual entry or HEC-DSS data sources.

Figure 46. Component editor for a temperature gage with manually-entered data. Of the different data types, only temperature gages have elevation.

You can change the start date, start time, end date, and end time of an existing time window. Use the Watershed Explorer to select the time window you wish to change. Click on the time window under the correct time-series component. The component will become the selected component and its data will be shown in the Component Editor as seen in Figure 45; the “Time Window” tab is automatically selected. Change the start date or other properties to the desired values. Click on a different tab in the Component Editor or elsewhere in the program interface to make the changes take affect.

Data Source

The data source determines how the data for a time-series component will be stored. Data may be entered manually or retrieved from the Data Storage System (HEC-DSS). Manual entry means that you must enter values for all of the time windows. Data can be retrieved from a DSS file without having to enter the values, but the data must be correctly loaded into the file. The type of properties you specify for the time-series gage will be determined by the data source, as discussed in the following sections. Compare Figure 46 and Figure 47 to see the difference in entering data for manual entry or HEC-DSS data sources.
Chapter 5  Shared Component Data

Figure 47. Component editor for a precipitation gage retrieving data from a Data Storage System (HEC-DSS) file. Of the different data types, only precipitation gages have latitude and longitude.

Data Units

The data units can only be selected for a manual entry time-series gage (Figure 46); they are retrieved automatically for the DSS option (Figure 47). Most types of time-series data have only two options for units; one for the system international unit system and one for the U.S. customary unit system. For example, discharge gages can use cubic meters per second (M3/S) or cubic feet per second (CFS). The precipitation time-series type has additional options for specifying incremental or cumulative data. The units available in the "Units" field will depend on the time-series type of the selected component. All time windows defined for a time-series component must use the same time interval.

Generally you should choose the data units before entering any data for the gage. However, if you change the units after entering data, the data will be adjusted to the new units. There is no units conversion during the adjustment. The values are all kept the same but the assigned units are changed. This is helpful when the data is entered without first checking to make sure the data units are in the desired unit system.

Select the data units for a time-series gage using the Component Editor. Access the editor by selecting a time-series gage in the Watershed Explorer. The "Time-Series Gage" tab in the Component Editor will display the data units if the manual entry option is selected.

Time Interval

The time interval can only be selected for a manual entry time-series gage (Figure 46); it is retrieved automatically for the DSS option (Figure 47). An interval must be selected from the available choices that range from 1 minute to 24 hours. All time windows defined for a time-series component must use the same time interval.

Generally you should choose the time interval before entering any data for the component. However, if you change the time interval after entering data, the data will
be adjusted to the new time interval. When the time interval is made shorter, the data for each time window will be adjusted so that it still begins at the start of the time window. The data will have the new, shorter time interval and there will be missing data from the last specified value to the end of the time window. When the time interval is made longer, the data for each time window will be adjusted so that it still begins at the start of the time window. The data will have the new, longer time interval and the end of the time window will be advanced so that no data is lost.

Select the time interval for a time-series gage using the Component Editor. Access the editor by selecting a time-series gage in the Watershed Explorer. The "Time-Series Gage" tab in the Component Editor will display the time interval if the manual entry option is selected.

**Retrieval From a HEC-DSS File**

Retrieving time-series data from a DSS file requires that the data be loaded in a file. The file can be stored on the local computer or on a network server. It is not a good idea to store the file on removable media since the file must be available whenever the time-series component is selected in the Watershed Explorer, and during computes. It is poor practice to store the data in the project DSS file used for storing simulation results. Data for each gage can be stored in a separate file or one file can contain data for several gages. However, all data for a single time-series gage must be stored in the same DSS file and use appropriate pathname convention. The HEC-DSSVue utility (HEC 2003) can be used to load time-series data into a DSS file.

When the DSS option is selected, you must specify the filename to use for the time-series component (Figure 47). You may type the complete filename if you know it. To use a file browser to locate the file, press the Open File Chooser button to the right of the "DSS Filename" field. The browser allows you to find the desired file but it is limited to locating files with the DSS extension which is required for all Data Storage System files. Once you locate the desired file, click on it in the browser to select it and press the Select button. If you change your mind, press the Cancel button or the X button in the upper corner of the Select HEC-DSS File window to return to the Component Editor.

You must also specify the pathname to retrieve from the selected DSS file (Figure 47). You may type the complete pathname if you know it. Each pathname contains six parts called the A-part, B-part, C-part, D-part, E-part, and F-part. The pathname parts are separated with a slash and may contain spaces. The complete pathname, including slashes and spaces, can total up to 256 uppercase characters. The following is an example of an incremental precipitation pathname:

```
//COOPER SMITH DAM/PRECIP-INC/01OCT2001/15MIN/OBS/
```

Because of internal performance considerations, a DSS file will usually contain multiple records when storing long time-series. The different records will each have all the same pathname parts except for the D-part which indicates the starting time of each record. Any of the record pathnames can be selected and the program will automatically retrieve the correct data depending on the selected time window.

If you do not know the full pathname of the record you wish you use, you can use the pathname browser to specify it. You must select a DSS file first before the browser is available. Press the Select DSS Pathname button to the right of the "DSS Pathname" field to open the browser. The browser initially shows all of the records in the specified DSS file, organized by pathname in the selection table. You can scroll through the list and select a record pathname by clicking on it. Press the Select button at the bottom of the browser to choose that record and return to the
Component Editor. If you change your mind and do not want to select a record pathname, press the Cancel button or the X button in the upper right of the Select Pathname From HEC-DSS File window. You can reduce the number of record pathnames shown in the selection table using the "Search by Parts" filters. A separate filter selection is shown for each of the six pathname parts. By selecting a choice for a filter, only pathnames that match that choice will be shown in the selection table. If you make choices in several filters, only pathnames that satisfy all of the choices will be shown in the selection table.

The program observes a very strict set of rules for data type and units within the record pathnames. Rules governing the C-part of the pathname are also enforced. Data cannot be used unless is follows the rules correctly; error messages will be generated if you attempt to use an invalid C-part, data type, or units. The acceptable data types for the different types of time-series data are shown in Table 15. The correct unit labels are shown in Table 16.

Table 15. Internal DSS data type label for different types of time-series data.

<table>
<thead>
<tr>
<th>Time-Series Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precipitation</td>
<td>PER-CUM</td>
<td>The amount of precipitation, measured as a depth, occurring in each time interval. This is essentially incremental data and the C-part should be &quot;PRECIP-INC&quot;.</td>
</tr>
<tr>
<td></td>
<td>INST-CUM</td>
<td>The total cumulative precipitation, measured as a depth, occurring since accumulation began but measured at the end of each time interval. This is essentially cumulative data and the C-part should be &quot;PRECIP-CUM&quot;.</td>
</tr>
<tr>
<td>Discharge</td>
<td>PER-AVER</td>
<td>The average discharge, measured as a flow rate, occurring during each time interval. This is usually used for time steps of 24 hours or longer. The C-part should be &quot;FLOW&quot;.</td>
</tr>
<tr>
<td></td>
<td>INST-VAL</td>
<td>The instantaneous discharge, measured as a flow rate, occurring at the end of each time interval. This is usually used for time steps less than 24 hours. The C-part should be &quot;FLOW&quot;.</td>
</tr>
<tr>
<td>Stage</td>
<td>INST-VAL</td>
<td>The instantaneous stage, measured as a depth, occurring at the end of each time interval. The C-part should be &quot;STAGE&quot;.</td>
</tr>
<tr>
<td>Temperature</td>
<td>INST-VAL</td>
<td>The instantaneous temperature, measured in degrees, occurring at the end of each time interval. The C-part should be &quot;TEMPERATURE&quot;.</td>
</tr>
<tr>
<td>Solar Radiation</td>
<td>PER-AVER</td>
<td>The average solar radiation, measured in power per area, occurring during each time interval. The C-part should be &quot;SOLAR RADIATION&quot;.</td>
</tr>
<tr>
<td>Crop Coefficient</td>
<td>INST-VAL</td>
<td>The instantaneous crop coefficient, specified as a dimensionless decimal number, occurring at the end of each time interval. The C-part should be &quot;CROP COEFFICIENT&quot;.</td>
</tr>
</tbody>
</table>
Table 16. **Internal DSS units label for different types of time-series data.**

<table>
<thead>
<tr>
<th>Time-Series Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precipitation</td>
<td>MM</td>
<td>Millimeters</td>
</tr>
<tr>
<td></td>
<td>IN</td>
<td>Inches</td>
</tr>
<tr>
<td>Discharge</td>
<td>M3/S</td>
<td>Cubic meters per second</td>
</tr>
<tr>
<td></td>
<td>CFS</td>
<td>Cubic feet per second</td>
</tr>
<tr>
<td>Stage</td>
<td>M</td>
<td>Meters</td>
</tr>
<tr>
<td></td>
<td>FT</td>
<td>Feet</td>
</tr>
<tr>
<td>Temperature</td>
<td>DEG C</td>
<td>Degrees centigrade</td>
</tr>
<tr>
<td></td>
<td>DEG F</td>
<td>Degrees Fahrenheit</td>
</tr>
<tr>
<td>Solar Radiation</td>
<td>WATT/M2</td>
<td>Watts per square meter</td>
</tr>
<tr>
<td></td>
<td>LANGLEY/MIN</td>
<td>Langleys per minute</td>
</tr>
<tr>
<td>Crop Coefficient</td>
<td>UNSPECIF</td>
<td>Dimensionless coefficient</td>
</tr>
</tbody>
</table>

**Table**

The data for the current time window is shown in tabular form on the "Table" tab of the *Component Editor* (Figure 48). If you select a time-series gage in the *Watershed Explorer*, only the tab for the "Time-Series Gage" is shown in the *Component Editor*. If you select a time window under a time-series gage in the *Watershed Explorer*, the "Table" tab will be added to the *Component Editor*. Data in the table can be edited if the gage uses manual entry. Data is not editable if the gage retrieves data from a DSS file. Furthermore, if the gage uses DSS data and no time-series data is available for the specified time window, then the table will not contain any data.

![Figure 48](image-url)  
*Manually entering data for a temperature gage. The fill command will be used to linearly interpolate between two known temperatures.*
You can enter all of the data for each time window one value at a time in the table. However, there are tools to help you enter the data quickly. The table includes support for the clipboard. This means you can copy data stored in a spreadsheet or other file and then paste it into the table. You can also use the fill tool to enter or adjust data values in the table. Select the cells in the table you wish to fill and click the right mouse button. A context menu is displayed; select the Fill... command. The Fill Table Options window opens for you to control the process of filling and adjusting cell values. Options include linearly interpolating the values between the first and last cell in the selection, copying the first selected cell value to all other selected cells, adding a constant value to all selected cells, and multiplying the selected cell values by a constant. Press the OK button to apply your choice, or the Cancel button to return to the table without making any changes.

**Graph**

The data for the current time window is shown in graphical form on the "Graph" tab of the Component Editor (Figure 49). If you select a time-series gage in the Watershed Explorer, only the tab for the "Time-Series Gage" is shown in the Component Editor. If you select a time window under a time-series gage in the Watershed Explorer, the "Graph" tab will be added to the Component Editor. Data in the graph cannot be edited regardless of whether the gage uses manual entry or retrieves data from a DSS file. If no time-series data is available for the specified time window, then the graph will not contain any data.

![Figure 49. Viewing data for a discharge gage connected to a HEC-DSS file.](image)

**Latitude and Longitude**

The location of a precipitation gage can be specified using latitude and longitude; location information cannot be specified for other types of time-series data (Figure 47). Only the inverse distance precipitation method requires the location of each gage to be specified. An error message will be displayed if you try to use a precipitation gage with the inverse distance method without specifying the latitude.
and longitude. You do not need to specify the location if the gage will only be used with other methods.

The degrees, minutes, and seconds are specified separately for the latitude and longitude. In general you should only specify the whole degrees and whole minutes. You can choose to specify fractional seconds. If you enter more than 60 minutes or more than 60 seconds, the program will automatically adjust the degrees, minutes, or second as necessary to have 60 or fewer minutes and 60 or fewer seconds. For example, if you entered 120 degrees and 64 minutes, the program would convert that data to 121 degrees and 4 minutes. A similar adjustment is made when the number of seconds is greater than 60.

General cartography conventions use negative longitude degrees in the Western hemisphere and positive longitude degrees in the Eastern hemisphere. Negative latitude degrees are used in the Southern hemisphere and positive latitude degrees are used in the Northern hemisphere. These conventions may be used with the program. However, if all locations are in the same quarter sphere, the positive and negative convention can be safely ignored.

**Elevation**

The elevation of a temperature gage can be specified using meters or feet; elevation information cannot be specified for other types of time-series data (Figure 46). Only the temperature index snowmelt method requires the elevation of each gage to be specified. An error message will be displayed if you try to use a temperature gage with the temperature index method without specifying the elevation. You do not need to specify the location if the gage will only be used with other methods.

**Paired Data**

Hydrologic models often require the use of paired data to describe inputs that are functional in form. Functional data defines a dependant variable in terms of an independent variable. For most cases, the function must be monotonically increasing which means it only increases and never decreases. Examples of paired data include unit hydrographs and stage-discharge curves. The program separates different types of paired data with different data types. Paired data only has to be entered one time. The data are part of the project and can be shared by multiple basin or meteorologic models.

**Creating a New Curve**

A new curve is created using the paired data manager. To access the manager, click on the **Components** menu and select the **Paired Data Manager** menu item (Figure 50). The manager can remain open while you perform tasks elsewhere in the program. You can close the manager using the **X** button in the upper right corner. At the top of the manager is a **Data Type** menu. This menu lets you select one of the paired data types supported by the program. Refer to Table 9 for a complete list of paired data types. When a data type is selected, the manager will show all paired data of the same type. The buttons to the right of the paired data list can be used to manage existing data or create new data. To create a paired data curve, press the **New...** button. After you press the button a window will open (Figure 51) where you can name and describe the new curve. A default name is provided for the new curve; you can use the default or replace it with your own choice. A description can also be entered. If the description is long, you can press the button to the right of the description field to open an editor. The editor makes it easier to enter and edit long descriptions. When you are satisfied with the name and description, press the
Create button to finish the process of creating the new paired data curve. You cannot press the Create button if no name is specified. If you change your mind and do not want to create a paired data curve, press the Cancel button or the X button in the upper right to return to the paired data manager.

Figure 50. Paired Data Manager accessed from the Components menu.

Figure 51. Creating a new cross section after pressing the New... button in the Paired Data Manager.

Copying a Curve

There are two ways to copy a paired data curve. Both methods for copying a curve create an exact duplicate with a different name. Once the copy has been made it is independent of the original and they do not interact.

The first way to create a copy is to use the paired data manager, which is accessed from the Components menu. First, select the data type of paired data curve you want to copy from the Data Type menu. Then, select the paired data curve you want to copy by clicking on it in the list of current paired data curves. The selected curve is highlighted after you select it. After you select a curve you can press the Copy... button on the right side of the window. A new window will open where you can name and describe the copy that will be created (Figure 52). A default name is provided for the copy; you can use the default or replace it with your own choice. A description
can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected paired data curve. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected curve, press the Cancel button or the X button in the upper right to return to the paired data manager.

The second way to create a copy is from the Watershed Explorer, on the "Components" tab. Move the mouse over the paired data component you wish to copy, then press the right mouse button (Figure 53). A context menu is displayed that contains several choices including copy. Click the Create Copy... menu option. A new window will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected paired data curve. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the curve, press the Cancel button or the X button in the upper right of the window to return to the Watershed Explorer.
Renaming a Curve

There are two ways to rename a paired data curve. Both methods for renaming a curve changes its name and then all references to the old name are automatically updated to the new name.

The first way to perform a rename is to use the paired data manager, which you can access from the Components menu. First, select the data type of paired data curve you want to rename from the Data Type menu. Then, select the paired data curve you want to rename by clicking on it in the list of current curves. The selected curve is highlighted after you select it. After you select a curve you can press the Rename… button on the right side of the window. A window will open where you can provide the new name (Figure 54). You can also change the description at the same time. If the new description will be long, you can use the button to the right of the field to open an editor. When you are satisfied with the name and description, press the Rename button to finish the process of renaming the selected paired data curve. You cannot press the Rename button if no name is specified. If you change your mind and do not want to rename the selected curve, press the Cancel button or the X button in the upper right of the window to return to the paired data manager.

Figure 54. Renaming a cross section after pressing the Rename... button in the Paired Data Manager.

Figure 55. Renaming a cross section by selecting it in the Watershed Explorer and using the right-mouse menu.
The second way to rename is from the Watershed Explorer, on the “Components” tab. Move the mouse over the paired data you wish to copy, then press the right mouse button (Figure 55). A context menu is displayed; select the Rename… command and the highlighted name will change to editing mode. You can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished changing the name, press the Enter key to finalize your choice. You can also finalize your choice by clicking elsewhere in the Watershed Explorer. If you change your mind while in editing mode and do not want to rename the selected curve, press the Escape key.

**Deleting a Curve**

There are two ways to delete a paired data. Both methods for deleting a curve will remove it from the project and then automatically update all references to that curve. Once a curve has been deleted it cannot be retrieved or undeleted. Any references to the deleted curve will switch to using no curve, which is usually not a valid choice during a simulation. At a later time you will have to go to those components and manually select a different curve.

The first way to perform a deletion is to use the paired data manager, which you can access from the Components menu. First, select the data type for the paired data curve you want to delete from the Data Type menu. Then, select the curve you want to delete by clicking on it in the list of current curves. The selected curve is highlighted after you select it. After you select a curve you can press the Delete button on the right side of the window (Figure 56). A window will open where you must confirm that you want to delete the selected curve. Press the OK button to delete the curve. If you change your mind and do not want to delete the selected curve, press the Cancel button or the X button in the upper right to return to the paired data manager.

![Figure 56. Preparing to delete a cross section from the Paired Data Manager.](image)
Chapter 5  Shared Component Data

The second way to delete a paired data is from the Watershed Explorer, on the “Components” tab. Select the curve you want to delete by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected curve and click the right mouse button. A context menu is displayed that contains several choices including delete. Click the Delete menu option. A window will open where you must confirm that you want to delete the selected curve. Press the OK button to delete the curve. If you change your mind and do not want to delete the selected curve, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.

Data Source

The data source determines how the data for a paired data will be stored. Data may be entered manually or retrieved from the Data Storage System (HEC-DSS). Manual entry means that you must enter each of the values in the curve or pattern. Data can be retrieved from a DSS file without having to enter the values, but the data must be correctly loaded into the file. The type of properties you specify for the paired data will be determined by the data source, as discussed in the following sections. Compare Figure 58 and Figure 59 to see the difference in entering data for manual or HEC-DSS data sources.
Chapter 5  Shared Component Data

Figure 59. Component editor for a storage-discharge curve retrieving data from a Data Storage System (HEC-DSS) file.

Data Units

The data units can only be selected for a manual entry paired data (Figure 58); they are retrieved automatically for the DSS option (Figure 59). Paired data have only two options for units; one for the system international unit system and one for the U.S. customary unit system. For example, a storage-discharge curve can use 1000 cubic meters and cubic meters per second (1000M3 - M3/S) or acre feet and cubic feet per second (ACFT - CFS). The units available in the "Units" field will depend on the paired data type of the selected component.

Generally you should choose the data units before entering any data for the component. However, if you change the units after entering data, the data will be adjusted to the new units. There is no units conversion during the adjustment. The values are all kept the same but the assigned units are changed. This is helpful when the data is entered without first checking to make sure the data units are in the desired unit system.

Select the data units for a paired data component using the Component Editor. Access the editor by selecting a paired data in the Watershed Explorer. The "Paired Data" tab in the Component Editor will display the data units if the manual entry option is selected.

Time Intervals

Unit hydrographs are the only type of paired data that can have a time interval as seen in Figure 58. The time interval can only be selected for a manual entry unit hydrograph; it is retrieved automatically for the DSS option. An interval must be selected from the available choices that range from 1 minute to 24 hours. Generally you should choose the time interval before entering data for the unit hydrograph. However, if you change the time interval after entering data, the data will be adjusted to the new time interval.

Select the time interval for a unit hydrograph paired data using the Component Editor. Access the editor by selecting a unit hydrograph paired data in the Watershed Explorer. The "Paired Data" tab in the Component Editor will display the time interval if the manual entry option is selected.

Retrieval From a HEC-DSS File

Retrieving paired data from a DSS file requires that the data be loaded in a file. The file can be stored on the local computer or on a network server. It is not a good idea to store the file on removable media since the file must be available whenever the
paired data is selected in the Watershed Explorer, and during computes. It is poor practice to store the data in the project DSS file used for storing simulation results. Data for each paired data can be stored in a separate file or one file can contain data for several components. The HEC-DSSVue utility (HEC 2003) can be used to load paired data into a DSS file.

When the DSS option is selected, you must specify the filename to use for the paired data component (Figure 59). You may type the complete filename if you know it. To use a file browser to locate the file, press the Open File Chooser button to the right of the "DSS Filename" field. The browser allows you to find the desired file but it is limited to locating files with the DSS extension which is required for all Data Storage System files. Once you locate the desired file, click on it in the browser to select it and press the Select button. If you change your mind, press the Cancel button or the X button in the upper corner of the Select HEC-DSS File window to return to the Component Editor.

You must also specify the pathname to retrieve from the selected DSS file (Figure 59). You may type the complete pathname if you know it. Each pathname contains six parts called the A-part, B-part, C-part, D-part, E-part, and F-part. The pathname parts are separated with a slash and may contain spaces. The complete pathname, including slashes and spaces, can total up to 256 uppercase characters. The following is an example of a storage-discharge curve pathname:

```
//BEAR CREEK/STORAGE-OUTFLOW///COMPUTED/
```

If you do not know the full pathname of the record you wish to use, you can use the pathname browser to specify it. You must select a DSS file first before the browser is available. Press the Select DSS Pathname button to the right of the "DSS Pathname" field to open the browser. The browser initially shows all of the records in the specified DSS file, organized by pathname in the selection table. You can scroll through the list and select a record pathname by clicking on it. Press the Select button at the bottom of the browser to choose that record and return to the Component Editor. If you change your mind and do not want to select a record pathname, press the Cancel button or the X button in the upper right of the Select Pathname From HEC-DSS File window. You can reduce the number of record pathnames shown in the selection table using the "Search by Parts" filters. A separate filter selection is shown for each of the six pathname parts. By selecting a choice for a filter, only pathnames that match that choice will be shown in the selection table. If you make choices in several filters, only pathnames that satisfy all of the choices will be shown in the selection table.

The program observes a preferred order for paired data. For example, storage-outflow is preferred to outflow-storage. However, the program is capable of using data specified backwards from the preferred order. The program does observe a very strict set of rules for data type and units within the record pathnames. Data cannot be used unless it follows the rules correctly; error messages will be generated if you attempt to use an invalid data type or units. The units of both halves of the paired data must be in the same unit system. The acceptable data types for the different types of paired data are shown in Table 17. The correct unit labels are shown in Table 18.
Table 17.  Preferred data order and internal DSS data type label for different types of paired data.

<table>
<thead>
<tr>
<th>Paired Data Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage-Outflow</td>
<td>UNT</td>
<td>Defines a storage versus outflow function. The C-part should be &quot;STORAGE-FLOW&quot;.</td>
</tr>
<tr>
<td>Elevation-Storage</td>
<td>UNT</td>
<td>Defines an elevation versus storage function. The C-part should be &quot;ELEVATION-STORAGE&quot;.</td>
</tr>
<tr>
<td>Elevation-Area</td>
<td>UNT</td>
<td>Defines an elevation versus area function. The C-part should be &quot;ELEVATION-AREA&quot;.</td>
</tr>
<tr>
<td>Elevation-Discharge</td>
<td>UNT</td>
<td>Defines an elevation versus discharge function. The C-part should be &quot;STAGE-FLOW&quot;.</td>
</tr>
<tr>
<td>Inflow-Diversion</td>
<td>UNT</td>
<td>Defines an inflow versus diversion function. The C-part should be &quot;FLOW-DIVERSION&quot;.</td>
</tr>
<tr>
<td>Cross Section</td>
<td>UNT</td>
<td>Defines distance versus elevation function to represent a cross section. The C-part should be &quot;DISTANCE-ELEVATION&quot;.</td>
</tr>
<tr>
<td>Unit Hydrograph</td>
<td>INST-VAL</td>
<td>Defines a user-specified unit hydrograph. The C-part should be &quot;FLOW-UNIT GRAPH&quot;.</td>
</tr>
<tr>
<td>Percentage Curve</td>
<td>UNT</td>
<td>Defines a percentage versus percentage function. The C-part should be &quot;PERCENT GRAPH&quot;.</td>
</tr>
<tr>
<td>ATI-Meltrate</td>
<td>UNT</td>
<td>Defines an antecedent temperature index versus meltrate function. The C-part should be &quot;ATI-MELTRATE&quot;.</td>
</tr>
<tr>
<td>ATI-Coldrate</td>
<td>UNT</td>
<td>Defines an antecedent temperature index versus coldrate function. The C-part should be &quot;ATI-COLDRATE&quot;.</td>
</tr>
<tr>
<td>Groundmelt Pattern</td>
<td>INST-VAL</td>
<td>Defines an annual pattern of groundmelt. The C-part should be &quot;GROUNDMELT&quot;.</td>
</tr>
<tr>
<td>Evaporation Pattern</td>
<td>INST-VAL</td>
<td>Defines an annual pattern of evaporation. The C-part should be &quot;EVAPORATION&quot;.</td>
</tr>
<tr>
<td>Meltrate pattern</td>
<td>INST-VAL</td>
<td>Defines an annual pattern of meltrate. The C-part should be &quot;MELTRATE&quot;.</td>
</tr>
</tbody>
</table>
Table 18. Internal DSS units for different types of paired data when the preferred order is followed. There is no y-label for the unit hydrograph or patterns.

<table>
<thead>
<tr>
<th>Paired Data Type</th>
<th>X-Label</th>
<th>Y-Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage-Outflow</td>
<td>M3</td>
<td>M3/S</td>
<td>Cubic meters, and cubic meters per second.</td>
</tr>
<tr>
<td></td>
<td>ACRE-FT</td>
<td>CFS</td>
<td>Acre-feet, and cubic feet per second.</td>
</tr>
<tr>
<td>Elevation-Storage</td>
<td>M</td>
<td>THOU M3</td>
<td>Meters, and thousands of cubic meters.</td>
</tr>
<tr>
<td></td>
<td>FT</td>
<td>ACRE-FT</td>
<td>Feet, and acre-feet.</td>
</tr>
<tr>
<td>Elevation-Area</td>
<td>M</td>
<td>M2</td>
<td>Meters, and square meters.</td>
</tr>
<tr>
<td></td>
<td>FT</td>
<td>ACRE</td>
<td>Feet, and acres.</td>
</tr>
<tr>
<td>Elevation-Discharge</td>
<td>M</td>
<td>M3/S</td>
<td>Meters, and cubic meters per second.</td>
</tr>
<tr>
<td></td>
<td>FT</td>
<td>CFS</td>
<td>Feet, and cubic feet per second.</td>
</tr>
<tr>
<td>Inflow-Diversion</td>
<td>M3/S</td>
<td>M3/S</td>
<td>Cubic meters per second, and cubic meters per second.</td>
</tr>
<tr>
<td></td>
<td>CFS</td>
<td>CFS</td>
<td>Cubic feet per second, and cubic feet per second.</td>
</tr>
<tr>
<td>Cross Section</td>
<td>M</td>
<td>M</td>
<td>Meters, and meters.</td>
</tr>
<tr>
<td></td>
<td>FT</td>
<td>FT</td>
<td>Feet, and feet.</td>
</tr>
<tr>
<td>Unit Hydrograph</td>
<td>M3/S</td>
<td>CFS</td>
<td>Cubic meters per second.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Cubic feet per second.</td>
</tr>
<tr>
<td>Percentage Curve</td>
<td>%</td>
<td>%</td>
<td>Percent, and percent.</td>
</tr>
<tr>
<td>ATI-Meltrate</td>
<td>DEG C</td>
<td>MM/DAY</td>
<td>Degrees Celsius, and millimeters per day.</td>
</tr>
<tr>
<td></td>
<td>DEG F</td>
<td>IN/DAY</td>
<td>Degrees Fahrenheit, and inches per day.</td>
</tr>
<tr>
<td>ATI-Coldrate</td>
<td>DEG C</td>
<td>MM/DEG-D</td>
<td>Degrees Celsius, and millimeters per Celsius degree per day.</td>
</tr>
<tr>
<td></td>
<td>DEG F</td>
<td>IN/DEG-D</td>
<td>Degrees Fahrenheit, and inches per Fahrenheit degree per day.</td>
</tr>
<tr>
<td>Groundmelt Pattern</td>
<td>MM/DAY</td>
<td></td>
<td>Millimeters per day.</td>
</tr>
<tr>
<td></td>
<td>IN/DAY</td>
<td></td>
<td>Inches per day.</td>
</tr>
<tr>
<td>Evaporation Pattern</td>
<td>MM/DAY</td>
<td></td>
<td>Millimeters per day.</td>
</tr>
<tr>
<td></td>
<td>IN/DAY</td>
<td></td>
<td>Inches per day.</td>
</tr>
<tr>
<td>Meltrate Pattern</td>
<td>%</td>
<td></td>
<td>Percent.</td>
</tr>
</tbody>
</table>

Table

The data for the current paired data is shown in tabular form on the "Table" tab of the Component Editor (Figure 60). Data in the table can be edited if the paired data uses manual entry. Data is not editable if the paired data retrieves data from a DSS file. Furthermore, if the paired data uses DSS data and no data is available, then the table will not contain any data.
You can enter all of the data one value at a time in the table. However, there are tools to help you enter the data quickly. The table includes support for the clipboard. This means you can copy data stored in a spreadsheet or other file and then paste it into the table. You can also use the fill tool to enter or adjust data values in the table. Select the cells in the table you wish to fill and click the right mouse button. A context menu is displayed; select the Fill... command. The Fill Table Options window opens for you to control the process of filling and adjusting cell values. Options include linearly interpolating the values between the first and last cell in the selection, copying the first selected cell value to all other selected cells, adding a constant value to all selected cells, and multiplying the selected cell values by a constant. Press the OK button to apply your choice, or the Cancel button to return to the table without making any changes.

Graph

The data for the current paired data is shown in graphical form on the "Graph" tab of the Component Editor (Figure 61). Data in the graph cannot be edited regardless of whether the paired data uses manual entry or retrieves data from an external DSS file. If no data is available, then the graph will not contain any data.
Grid Data

Some of the methods included in the program operate on a grid cell basis. This means that parameters must be entered for each grid cell. It also means that boundary conditions like precipitation must be available for each grid cell. One example of grid data is the SCS curve number grid, which is used as a parameter grid. Another example is the temperature gridset, which is a time-series of grids. The program separates different types of grid data with different data types. Grid data only has to be entered one time. The data are part of the project and can be shared by multiple basin or meteorologic models.

Creating a New Grid

A new grid is created using the grid data manager. To access the manager, click on the Components menu and select the Grid Data Manager menu command (Figure 62). The manager can remain open while you perform tasks elsewhere in the program. You can close the manager using the X button in the upper right corner. At the top of the manager is a Data Type menu. This menu lets you select one of the grid data types supported by the program. Refer to Table 9 for a complete list of grid data types. When a data type is selected, the manager will show all grid data of the same type. The buttons to the right of the grid data list can be used to manage existing data or create new data. To create a grid, press the New... button. After you press the button a window will open (Figure 63) where you can name and describe the new grid. A default name is provided for the grid; you can use the default or replace it with your own choice. A description can also be entered. If the description is long, you can press the button to the right of the description field to open an editor. The editor makes it easier to enter and edit long descriptions. When you are satisfied with the name and description, press the Create button to finish the process of creating the new grid. You cannot press the Create button if no name is specified. If you change your mind and do not want to create the grid, press the Cancel button or the X button in the upper right to return to the grid data manager.
Chapter 5  Shared Component Data

Figure 63. Creating a new precipitation gridset after pressing the New… button in the Grid Data Manager.

Copying a Grid

There are two ways to copy a grid. Both methods for copying a grid create an exact duplicate with a different name. Once the copy has been made it is independent of the original and they do not interact.

The first way to create a copy is to use the grid data manager, which is accessed from the Components menu. First, select the grid data type you want to copy from the Data Type menu. Then, select the grid you want to copy by clicking on it in the list of current grids. The selected grid is highlighted after you select it. After you select a grid you can press the Copy… button on the right side of the window. A new window will open where you can name and describe the copy that will be created (Figure 64). A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected grid. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected grid, press the Cancel button or the X button in the upper right to return to the grid data manager.

The second way to create a copy is from the Watershed Explorer, on the “Components” tab. Move the mouse over the grid data you wish to copy, then press the right mouse button (Figure 65). A context menu is displayed that contains several choices including copy. Click the Create Copy… menu option. A new window will open where you can name and describe the copy that will be

Figure 64. Creating a copy of a precipitation gridset after pressing the Copy… button in the Grid Data Manager.
created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected grid. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the grid, press the Cancel button or the X button in the upper right of the window to return to the Watershed Explorer.

Renaming a Grid

There are two ways to rename a grid. Both methods for renaming a grid changes its name and then all references to the old name are automatically updated to the new name.

The first way to perform a rename is to use the grid data manager, which you can access from the Components menu. First, select the grid data type you want to rename from the Data Type menu. Then, select the grid you want to rename by clicking on it in the list of current grids. The selected grid is highlighted after you select it. After you select a grid you can press the Rename... button on the right side of the window. A new window will open where you can provide the new name (Figure 66). You can also change the description at the same time. If the new description will be long, you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Rename button to finish the process of renaming the selected grid. You cannot press the Rename button if no name is specified. If you change your mind and do not want to rename the selected grid, press the Cancel button or the X button in the upper right of the window to return to the grid data manager.

The second way to rename is from the Watershed Explorer, on the “Components” tab. Select the grid you want to rename by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected grid and click the left mouse button again (Figure 67). The highlighted name will change to editing mode. You
Figure 66. Renaming a precipitation gridset after pressing the Rename… button in the Grid Data Manager.

Figure 67. Renaming a precipitation gridset by selecting it in the Watershed Explorer and using the right-mouse menu.

can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished changing the name, press the Enter key to finalize your choice. You can also finalize your choice by clicking elsewhere in the Watershed Explorer. If you change your mind while in editing mode and do not want to rename the selected grid, press the Escape key.

Deleting a Grid

There are two ways to delete a grid. Both methods for deleting a grid will remove it from the project and then automatically update all references to that grid. Once a grid has been deleted it cannot be retrieved or undeleted. Any references to the deleted grid will switch to using no grid, which is usually not a valid choice during a simulation. At a later time you will have to go to those components and manually select a different grid.

The first way to perform a deletion is to use the grid data manager, which you can access from the Components menu. First, select the grid data type you want to delete from the Data Type menu. Then, select the grid you want to delete by clicking on it in the list of current grids. The selected grid is highlighted after you select it. After you select a grid you can press the Delete button on the right side of the
Figure 68. Preparing to delete a precipitation gridset from the Grid Data Manager.

window (Figure 68). A window will open where you must confirm that you want to delete the selected grid. Press the OK button to delete the grid. If you change your mind and do not want to delete the selected grid, press the Cancel button or the X button in the upper right to return to the grid data manager.

The second way to delete a grid is from the Watershed Explorer, on the “Components” tab. Select the grid you want to delete by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected grid and click the right mouse button (Figure 69). A context menu is displayed that contains several choices including delete. Click the Delete menu option. A window will open where you must confirm that you want to delete the selected grid. Press the OK button to delete the grid. If you change your mind and do not want to delete the selected grid, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.

Figure 69. Preparing to delete a grid from the Watershed Explorer.
Retrieval From a HEC-DSS File

Retrieving grid data from a DSS file requires that the data be loaded in a file. The file can be stored on the local computer or on a network server. It is not a good idea to store the file on removable media since the file must be available whenever the grid data is selected in the Watershed Explorer, and during computes. It is poor practice to store the data in the project DSS file used for storing simulation results. Data for each grid can be stored in a separate file or one file can contain data for several grids. However, all data for a gridset must be stored in the same DSS file and use appropriate pathname convention. Utilities are available from HEC for loading various formats of gridded data into a DSS file.

You must specify the filename to use for the grid data component (Figure 70). You may type the complete filename if you know it. To use a file browser to locate the file, press the Open File Chooser button to the right of the “DSS Filename” field. The browser allows you to find the desired file but it is limited to locating files with the DSS extension which is required for all Data Storage System files. Once you locate the desired file, click on it in the browser to select it and press the Select button. If you change your mind, press the Cancel button or the X button in the upper corner of the Select HEC-DSS File window to return to the Component Editor.

You must also specify the pathname to retrieve from the selected DSS file (Figure 70). You may type the complete pathname if you know it. Each pathname contains six parts called the A-part, B-part, C-part, D-part, E-part, and F-part. The pathname parts are separated with a slash and may contain spaces. The complete pathname, including slashes and spaces, can total up to 256 uppercase characters. The following is an example of a pathname for a percolation parameter grid:

```
//SOLDIER CR WATERSHED/PERCOLATION///GIS ESTIMATE/
```

The convention for storing gridset data is different because a separate grid is required for each time interval. The different records will each have all the same pathname parts except for the D-part and E-part. The D-part indicates the starting time and the e-part the ending time of the individual record. Any of the record pathnames can be selected and the program will automatically retrieve the correct data depending on the time window during a compute. The following is an example of a temperature gridset:

```
//LOUISVILLE/TEMP/12JUL2003:1230/12JUL2003:1300/OBS/
```
If you do not know the full pathname of the record you wish you use, you can use the pathname browser to specify it. You must select a DSS file first before the browser is available. Press the Select DSS Pathname button to the right of the "DSS Pathname" field to open the browser. The browser initially shows all of the records in the specified DSS file, organized by pathname in the selection table. You can scroll through the list and select a record pathname by clicking on it. Press the Select button at the bottom of the browser to choose that record and return to the Component Editor. If you change your mind and do not want to select a record pathname, press the Cancel button or the X button in the upper right of the Select Pathname From HEC-DSS File window. You can reduce the number of record pathnames shown in the selection table using the "Search by Parts" filters. A separate filter selection is shown for each of the six pathname parts. By selecting a choice for a filter, only pathnames that match that choice will be shown in the selection table. If you make choices in several filters, only pathnames that satisfy all of the choices will be shown in the selection table.

The program observes a very strict set of rules for data type and units within the record pathnames. Rules governing the C-part of the pathname are also enforced. Data cannot be used unless is follows the rules correctly; error messages will be generated if you attempt to use an invalid C-part, data type, or units. The acceptable data types for the different types of grid data are shown in Table 19. The correct unit labels are shown in Table 20.

**Table 19. Internal DSS data type label for different types of grid data. Period average data is labeled as 0, period cumulative data is labeled as 1, and instant value data is labeled as 2.**

<table>
<thead>
<tr>
<th>Time-Series Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precipitation</td>
<td>1</td>
<td>The amount of precipitation, measured as a depth, occurring during the grid interval. The C-part should be &quot;PRECIPITATION&quot;. The D-part and E-part, respectively, should give the start and end time for the cumulative value.</td>
</tr>
<tr>
<td>Temperature</td>
<td>0</td>
<td>The average temperature, measured in degrees, occurring during the grid interval. The C-part should be &quot;TEMPERATURE&quot;. The D-part and E-part, respectively, should give the start and end time for the average value.</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>The temperature, measured in degrees, occurring at a specific time. The C-part should be &quot;TEMPERATURE&quot;. The time of the value should be specified in the D-part.</td>
</tr>
<tr>
<td>Solar Radiation</td>
<td>0</td>
<td>The average solar radiation, measured in power per area, occurring during the grid interval. The C-part should be &quot;SOLAR RADIATION&quot;. The D-part and E-part, respectively, should give the start and end time for the average value.</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>The solar radiation, measured in power per area, occurring at a specific time. The C-part should be &quot;SOLAR RADIATION&quot;. The time of the value should be specified in the D-part.</td>
</tr>
</tbody>
</table>
Table 19. continued

<table>
<thead>
<tr>
<th>Time-Series Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crop Coefficient</td>
<td>0</td>
<td>The average crop coefficient, specified as a dimensionless decimal number, occurring during the grid interval. The C-part should be &quot;CROP COEFFICIENT&quot;. The D-part and E-part, respectively, should give the start and end time for the average value.</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>The crop coefficient, specified as a dimensionless decimal number, occurring at a specific time. The C-part should be &quot;CROP COEFFICIENT&quot;. The time of the value should be specified in the D-part.</td>
</tr>
<tr>
<td>Storage Capacity</td>
<td>2</td>
<td>The storage capacity, measured as a depth, associated with a particular condition of the watershed. The C-part should be &quot;STORAGE CAPACITY&quot;.</td>
</tr>
<tr>
<td>Percolation Rate</td>
<td>2</td>
<td>The percolation rate, measured as a depth per time, associated with a particular condition of the watershed. The C-part should be &quot;PERCOLATION&quot;.</td>
</tr>
<tr>
<td>Storage Coefficient</td>
<td>2</td>
<td>The storage coefficient, measured in hours, associated with a particular condition of the watershed. The C-part should be &quot;STORAGE COEFFICIENT&quot;.</td>
</tr>
<tr>
<td>Moisture Deficit</td>
<td>2</td>
<td>The moisture deficit, measured as a depth, associated with a particular condition of the watershed. The C-part should be &quot;MOISTURE DEFICIT&quot;.</td>
</tr>
<tr>
<td>Impervious Area</td>
<td>2</td>
<td>The impervious area, measured as a percentage, associated with a particular condition of the watershed. The C-part should be &quot;IMPERVIOUS AREA&quot;.</td>
</tr>
<tr>
<td>SCS Curve Number</td>
<td>2</td>
<td>The curve number, as a dimensionless decimal number, associated with a particular condition of the watershed. The C-part should be &quot;CURVE NUMBER&quot;.</td>
</tr>
<tr>
<td>Elevation</td>
<td>2</td>
<td>The elevation, measured as a length or height, associated with a particular condition of the watershed. The C-part should be &quot;ELEVATION&quot;.</td>
</tr>
<tr>
<td>Cold Content</td>
<td>2</td>
<td>The cold content, measured as a depth, associated with a particular condition of the watershed. The C-part should be &quot;COLD CONTENT&quot;.</td>
</tr>
<tr>
<td>Cold Content ATI</td>
<td>2</td>
<td>The cold content antecedent temperature index, measured in degrees, associated with a particular condition of the watershed. The C-part should be &quot;COLD CONTENT ATI&quot;.</td>
</tr>
<tr>
<td>Meltrate ATI</td>
<td>2</td>
<td>The meltrate antecedent temperature index, measured in degrees, associated with a particular condition of the watershed. The C-part should be &quot;MELTRATE ATI&quot;.</td>
</tr>
<tr>
<td>Liquid Water</td>
<td>2</td>
<td>The amount of liquid water, measured as a depth, associated with a particular condition of the watershed. The C-part should be &quot;LIQUID WATER&quot;.</td>
</tr>
<tr>
<td>Snow Water Equivalent</td>
<td>2</td>
<td>The snow water equivalent, measured as a depth, associated with a particular condition of the watershed. The C-part should be &quot;SWE&quot;.</td>
</tr>
</tbody>
</table>
Table 20. *Internal DSS units label for different types of grid data.*

<table>
<thead>
<tr>
<th>Grid Data Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precipitation</td>
<td>MM</td>
<td>Millimeters</td>
</tr>
<tr>
<td></td>
<td>IN</td>
<td>Inches</td>
</tr>
<tr>
<td>Temperature</td>
<td>DEG C</td>
<td>Degrees centigrade</td>
</tr>
<tr>
<td></td>
<td>DEG F</td>
<td>Degrees Fahrenheit</td>
</tr>
<tr>
<td>Solar Radiation</td>
<td>WATT/M2</td>
<td>Watts per square meter</td>
</tr>
<tr>
<td></td>
<td>LANGLEY/MIN</td>
<td>Langley per minute</td>
</tr>
<tr>
<td>Crop Coefficient</td>
<td>UNDEF</td>
<td>Dimensionless coefficient</td>
</tr>
<tr>
<td>Storage Capacity</td>
<td>MM</td>
<td>Millimeters</td>
</tr>
<tr>
<td></td>
<td>IN</td>
<td>Inches</td>
</tr>
<tr>
<td>Percolation Rate</td>
<td>MM/HR</td>
<td>Millimeters per hour</td>
</tr>
<tr>
<td></td>
<td>IN/HR</td>
<td>Inches per hour</td>
</tr>
<tr>
<td>Storage Coefficient</td>
<td>HR</td>
<td>Coefficient in hours</td>
</tr>
<tr>
<td>Moisture Deficit</td>
<td>MM</td>
<td>Millimeters</td>
</tr>
<tr>
<td></td>
<td>IN</td>
<td>Inches</td>
</tr>
<tr>
<td>Impervious Area</td>
<td>%</td>
<td>Percent of area</td>
</tr>
<tr>
<td>SCS Curve Number</td>
<td>UNDEF</td>
<td>Dimensionless parameter</td>
</tr>
<tr>
<td>Elevation</td>
<td>M</td>
<td>Meters</td>
</tr>
<tr>
<td></td>
<td>FT</td>
<td>Feet</td>
</tr>
<tr>
<td>Cold Content</td>
<td>MM</td>
<td>Millimeters</td>
</tr>
<tr>
<td></td>
<td>IN</td>
<td>Inches</td>
</tr>
<tr>
<td>Cold Content ATI</td>
<td>DEG C</td>
<td>Degrees centigrade</td>
</tr>
<tr>
<td></td>
<td>DEG F</td>
<td>Degrees Fahrenheit</td>
</tr>
<tr>
<td>Meltrate ATI</td>
<td>DEG C</td>
<td>Degrees centigrade</td>
</tr>
<tr>
<td></td>
<td>DEG F</td>
<td>Degrees Fahrenheit</td>
</tr>
<tr>
<td>Liquid Water Content</td>
<td>MM</td>
<td>Millimeters</td>
</tr>
<tr>
<td></td>
<td>IN</td>
<td>Inches</td>
</tr>
<tr>
<td>Snow Water Equivalent</td>
<td>MM</td>
<td>Millimeters</td>
</tr>
<tr>
<td></td>
<td>IN</td>
<td>Inches</td>
</tr>
</tbody>
</table>

References

CHAPTER 6

Watershed Physical Description

This chapter describes how watershed information is entered into the program using a basin model. The basin model is responsible for describing the physical properties of the watershed and the topology of the stream network. It will contain the modeling components that describe infiltration, surface runoff, baseflow, channel routing, and lakes. It may additionally contain components for representing engineered structures such as diversions, reservoirs, and pump stations. It will generally be the focus of attention in performing simulations and viewing results. By creating multiple representations of the same watershed, different development scenarios or management alternatives can be evaluated.

Basin Models

Basin models are one of the main components in a project. Their principle purpose is to convert atmospheric conditions into streamflow at specific locations in the watershed. Hydrologic elements are used to break the watershed into manageable pieces. They are connected together in a dendritic network to form a representation of the stream system. Background maps can be used to aid in placing the elements in a spatial context.

Creating a New Basin Model

A new basin model is created using the Basin Model Manager. To access the manager, click on the Components menu and select the Basin Model Manager command. The manager will open and show all of the basin models currently in the project. The manager can remain open while you manage basin models or while you perform tasks elsewhere in the program. You can close the manager using the X button in the upper right corner. The buttons to the right of the model list can be used to manage existing models or create a new one. To create a new basin model, press the New… button. After you press the button a window (Figure 71) will open where you can name and describe the new basin model that will be created. A default name is provided for the new model; you can use the default or replace it with your own choice. A description can also be entered. If the description is long, you

![Figure 71. Creating a new basin model. This was accessed by opening the Basin Model Manager from the Components menu, and then pressing the New… button.](image)
can press the button to the right of the description field to open an editor. The editor makes it easier to enter and edit long descriptions. When you are satisfied with the name and description, press the **Create** button to finish the process of creating the new basin model. You cannot press the **Create** button if no name is specified for the new model. If you change your mind and do not want to create a new basin model, press the **Cancel** button or the X button in the upper right to return to the *Basin Model Manager* window.

### Copying a Basin Model

There are two ways to copy a basin model. Both methods for copying a model create an exact duplicate with a different name. Once the copy has been made it is independent of the original and they do not interact.

The first way to create a copy is to use the *Basin Model Manager*, which is accessed from the **Components** menu. Select the basin model you wish to copy by clicking on it in the list of current basin models. The selected model is highlighted after you select it. After you select a model you can press the **Copy** button on the right side of the window. A new *Copy Basin Model* window (Figure 72) will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the **Copy** button to finish the process of copying the selected basin model. You cannot press the **Copy** button if no name is specified. If you change your mind and do not want to copy the selected basin model, press the **Cancel** button or the X button in the upper right to return to the *Basin Model Manager* window.

![Copy Basin Model “Sandusky”](image)

**Figure 72.** Creating a copy of a basin model.

The second way to copy is from the "Components" tab of the *Watershed Explorer*. Move the mouse over the basin model you wish to copy, then press the right mouse button (Figure 73). A context menu is displayed that contains several choices including copy. Click the **Create Copy** command. A new *Copy Basin Model* window will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the **Copy** button to finish the process of copying the selected basin model. You cannot press the **Copy** button if no name is specified. If you change your mind and do not want to copy the selected basin model, press the **Cancel** button or the X button in the upper right of the *Copy Basin Model* window to return to the *Watershed Explorer*. 
Chapter 6 Watershed Physical Description

Figure 73. Copying a basin model from the Watershed Explorer. The Copy Basin Model window will appear after the Create Copy… menu command is selected.

Renaming a Basin Model

There are two ways to rename a basin model. Both methods for renaming a model change its name and then all references to the old model name are automatically updated to the new name.

The first way to perform a rename is to use the Basin Model Manager, which you can access from the Components menu. Select the basin model you wish to rename by clicking on it in the list of current basin models. The selected model is highlighted after you select it. After you select a model you can press the Rename… button on the right side of the window. A new Rename Basin Model window (Figure 74) will open where you can provide the new name. If you wish you can also change the description at the same time. If the new description will be long, you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Rename button to finish the process of renaming the selected basin model. You cannot press the Rename button if no name is specified. If you change your mind and do not want to rename the selected basin model, press the Cancel button or the X button in the upper right of the Rename Basin Model window to return to the Basin Model Manager window.

Figure 74. Renaming a basin model. This was accessed from the Basin Model Manager.
Chapter 6 Watershed Physical Description

Figure 75. Renaming a basin model in the Watershed Explorer.

The second way to rename is from the "Components" tab of the Watershed Explorer. Select the basin model you wish to rename by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected model and click the left mouse button again. The highlighted name will change to editing mode as shown in Figure 75. You can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished changing the name, press the Enter key to finalize your choice. You can also finalize your choice by clicking elsewhere on the "Components" tab. If you change your mind while in editing mode and do not want to rename the selected basin model, press the Escape key.

Deleting a Basin Model

There are two ways to delete a basin model. Both methods for deleting a model remove it from the project and then automatically update all references to that model. Once a model has been deleted it cannot be retrieved or undeleted. Any references to the deleted model will switch to using no basin model, which is usually not a valid choice during a simulation. At a later time you will have to go to those components and manually select a different basin model.

The first way to perform a deletion is to use the Basin Model Manager, which you can access from the Components menu. Select the basin model you wish to delete by clicking on it in the list of current basin models. The selected model is highlighted after you select it. After you select a model you can press the Delete button on the right side of the window. A window will open where you must confirm that you wish to delete the selected model as shown in Figure 76. Press the OK button to delete the model. If you change your mind and do not want to delete the selected basin model, press the Cancel button or the X button in the upper right to return to the Basin Model Manager window.

The second way to delete is from the "Components" tab of the Watershed Explorer. Select the basin model you wish to delete by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected model and click the right mouse button (Figure 77). A context menu is displayed that contains several choices including delete. Click the Delete command. A window will open where you must confirm that you wish to delete the selected model. Press the OK button to delete the model. If you change your mind and do not want to delete the selected basin model, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.
Chapter 6  Watershed Physical Description

---

Figure 76. Preparing to delete a basin model from the Basin Model Manager. A confirmation will be required after pressing the **Delete** button.

Figure 77. Deleting a basin model in the Watershed Explorer.

**Importing a Basin Model**

You can import an existing basin model into the current project. The model must have been created previously and stored on your computer or an accessible network location. Click the **Tools** menu and select the **File ⇒ Import ⇒ Basin Model...** command. A file browser will open that you can use to find the model you wish to import. The browser will only allow you to select basin model files which end with the BASIN extension. When you click on a basin model file in the browser, the description of the model is shown on the right side of the browser. Once you have located and selected the desired basin model, press the **Select** button. If you change your mind, you can press the **Cancel** button or the X button in the upper right to return to the main program window without importing a model. After you make your selection, the program automatically copies the selected file into the project folder and adds it to the list of current basin models.
Gridded Subbasins

Subbasins that use the ModClark gridded transform method are considered gridded subbasins. Loss rate and surface transform calculations will be carried out on a grid cell basis. Properties of the grid cells are specified in a special grid cell file. The file specifies which grid cells are in each subbasin, along with the properties of each cell including location, area within the subbasin, and distance to the subbasin outlet. One file is used for all subbasins in the basin model and its format is described in Appendix B. If you wish to use gridded subbasins, you must prepare the file external to the program and specify it as part of the basin model parameter data. Specify the complete filename of the grid cell file in the Component Editor for the basin model (Figure 78). Access the Component Editor from the Watershed Explorer on the “Components” tab by clicking on a basin model icon. You can use the file browser button to the right of the entry field to aid in finding the file.

![Figure 78. Basin model component editor showing option properties for gridded subbasins and flow computations.](image)

Optional Flow Computations

Local flow can be computed at junctions. Local flow is defined as the sum of all subbasin and source outflows entering a junction. The subbasin and source elements must be connected directly downstream to the junction. Any subbasin or source outflow that moves through a routing element is no longer considered local flow. When local flow is disabled, a junction element computes outflow as the sum of all inflow from any type of element. No local flow is computed. When local flow is enabled, a junction continues to compute outflow as the sum of all inflow. However, in addition to computing outflow, it also computes the additional local flow. Enabling or disabling local flow is done in the Component Editor for the basin model (Figure 78). Access the Component Editor from the Watershed Explorer on the “Components” tab by clicking on a basin model icon.

Flow ratios can be used to increase or decrease the computed flow by a fixed ratio; they can only be applied to subbasin and source elements. Once the flow ratios are turned on, each subbasin and source can have a separate ratio, or no ratio. It is not necessary to enter a ratio for every element in order to have a ratio at one element. The ratio 1.0 is used if no ratio is specified. The calculations for computing outflow proceed normally according the method choices and parameter data for each element. At the conclusion of normal processing, the flow ratio is applied to produce the final outflow.
Flow ratios are enabled or disabled in the Component Editor for the basin model (Figure 78). After disabling the flow ratios, any ratios specified for subbasin and source elements in the basin model are removed and cannot be retrieved again or undeleted. The actual flow ratio is specified in the Component Editor for the element on the "Options" tab. Access the editor from the Watershed Explorer on the "Components" tab by clicking on the element icon. The last tab in the Component Editor is the "Options" tab. The flow ratio field is disabled when flow ratios are disabled in the basin model. The field becomes enabled when flow ratios are enabled in the basin model. The flow ratio field is never enabled for elements other than subbasins and sources.

Missing inflow data for an element can be set to zero. Under some conditions it may be possible for source or subbasin elements to produce outflow with missing values. Downstream routing elements generally cannot process missing data. When missing flow data is not replaced, any element that encounters missing inflow data will halt a simulation with an error message. When missing flow data is replaced, the missing inflow data is set to zero and a message is generated that indicates how many values were missing. Processing in the routing element proceeds normally after any missing inflow data is set to zero. Setting the action to take with missing inflow data is done on the Component Editor for the basin model (Figure 78).

Unit System

Each basin model must be in either United States customary units (sometimes called English units) or in system international units (also called metric units). All parameter data in a basin model must be in the same unit system. If you change the unit system, all data will be automatically converted to the new unit system. All time-series data, paired data, and gridded data referenced in a basin model will be in its own unit system. If necessary these referenced data are automatically converted to the unit system of the basin model during a simulation.

Select the unit system using the Component Editor for the basin model (Figure 78). Access the Component Editor by clicking the basin model icon on the "Components" tab of the Watershed Explorer. If you change the unit system, all data is automatically converted to the new selection.

Background Maps

Background maps provide a spatial context for the hydrologic elements composing a basin model. The maps are not actually used in the compute process, but they can be very helpful in showing the spatial relationship between elements. They are commonly used for showing the boundaries of a watershed or the location of streams. They can also be useful for showing supplemental information such as the location of levees. The use of background maps is always optional.

Adding, removing, and managing background maps is done from the Background Maps window (Figure 79). Access the window by clicking the View menu and selecting the Background Maps command. The menu command is only available if the Basin Model window is currently open.

Add a map to the list of current background maps by pressing the Add... button. A file browser opens for you to select the map file you wish to add. Five different map file formats can be used. The HMS map file and geo-reference image file formats are described in Appendix D. File formats for the other map types are defined by their creators (Autodesk 2005, ESRI 1997, USGS 1999). Select the type of map file you wish to add using the "Files of type" selection list at the bottom of the file browser.
Figure 79. Background maps can be added to provide a spatial context for the basin model elements. Maps can be moved up or down in the drawing order.

Locate the map file you wish to add and select it. Press the Select button to add the map to the list of current background maps. If you change your mind and do not want to add a map, press the Cancel button or the X button in the upper right of the Select window. The program does not include any coordinate transformation tools so you must independently make sure all maps you wish to use are in the same coordinate system.

The current background maps are drawn in a specified order so that you can control overlapping and other drawing issues. The draw order is based on the order they are shown in the Background Maps window. The map at the bottom of the list is drawn first. After it is drawn, the map shown above it in the list is drawn second. The map shown at the top of the list is drawn last. The hydrologic elements are drawn after all of the maps have been drawn.

The draw order of the maps can be changed once all the desired background maps are shown in the list of current maps. To change the order of a map you must first select it in the list of current maps. Place the mouse over the desired map and click the left mouse button; the map name is highlighted to show that it is selected. Press the Move Up button to move the map up in the draw order so that other maps are drawn first. Press the Move Down button to move the map down in the draw order so that other maps are drawn after it. Each time you press the Move Up or Move Down button the map is moved one position up or down. You can press the buttons more than once to get the map to the desired position in the drawing order.

A background map can be removed. Place the mouse over the map you wish to remove and select it by clicking the left mouse button; the map name is highlighted to show that it is selected. Press the Remove button. The background map is not deleted when it is removed from the list of current background maps. The files that contain the actual background map data cannot be deleted from the program; they must be deleted manually.
Changes to the current background maps or their draw order only take affect when the OK button is pressed at the bottom of the Background Maps window. After the OK button is pressed the current basin model is redrawn with the new background map settings. If you change your mind about the changes you have made since opening the Background Maps window, press the Cancel button. Pressing the Cancel button will return you to the main program screen without making any changes to the current basin model.

**Maximum Extents**

The maximum extents are designed to limit the area shown in the Basin Model window to a reasonable view. This is especially helpful if background maps are used which cover a very large region, much larger than the watershed. Four different methods are available for specifying the maximum extents. Setting the maximum extents is done from the Maximum Extents window (Figure 80) accessed by selecting the View ⇒ Maximum Extents command.

The "Manual" option will set the extents to a region specified by the user. When this option is selected, the "Manual view extents" box will be available. The "Minimum Northing" corresponds to the South edge and the "Maximum Northing" corresponds to the North edge of the extents. The "Minimum Easting" corresponds to the West edge and the "Maximum Easting" corresponds to the East edge of the extents. The northing and easting values can automatically be filled in from the current view in the basin map by pressing the Set button.

The "Union of All Elements" option will set the extents to the combined extends of all the hydrologic elements in the basin model. As elements are added and removed, the maximum extents will automatically be updated. The "Element Buffer" can be used to make sure there is some space around the elements. When the extents are computed, the buffer is computed as the percentage of the width and height of the elements themselves with no buffer applied.

![Maximum Extents window](image)

*Figure 80.* The maximum extents are used to control the view size of the basin model, and facilitate use of maps larger than the watershed of interest.
The "Union of All Maps" option will set the extents to the combined extents of all background maps. As maps are added and removed, the maximum extents will automatically be updated.

The "Union of All Maps and Elements" options will set the extents to the combined extents of all background maps and hydrologic elements in the basin model. As elements are added and removed, or as background maps are added and removed, the extents will automatically be updated. The "Element Buffer" will be applied to the elements as part of computing the extents.

**Hydrologic Elements**

Hydrologic elements are the basic building blocks of a basin model. An element represents a physical process such as a watershed catchment, stream reach, or confluence. Each element represents part of the total response of the watershed to atmospheric forcing. Seven different element types have been included in the program: subbasin, reach, reservoir, junction, diversion, source, and sink.

An element uses a mathematical model to describe the physical process. Sometimes the model is only a good approximation of the original physical process over a limited range of environmental conditions. Data availability and the required parameters of a model can also determine fitness. To make the program suitable for many different conditions, most elements have more than one model or method for approximating the physical process. For example, there are five different methods for specifying the input data for a reservoir.

**Creating a New Element**

New hydrologic elements are created directly in the *Basin Model* map. Begin the process of creating a new element by opening the basin model into which you wish to add a new element. Select a basin model in the *Watershed Explorer* to open it. Separate tools are provided in the toolbar for each of the seven different kinds of element. Select the tool corresponding to the type of element you wish to create: subbasin, reach, reservoir, junction, source, diversion, or sink. After selecting the appropriate tool, move the mouse over the *Basin Model* map; the mouse cursor changes to cross hairs. Move the mouse until the cross hairs are over the location where you wish to create the element. Click the left mouse button. A window will open where you can name and describe the new hydrologic element that will be created, as shown in Figure 81. A default name is provided for the new element; you can use the default or replace it with your own choice. A description can also be entered. If the description is long, you can press the button to the right of the description field to open an editor. The editor makes it easier to enter and edit long descriptions. When you are satisfied with the name and description, press the **Create** button to finish the process of creating the new hydrologic element. You cannot press the **Create** button if no name is specified for the new element. If you change your mind and do not want to create a new hydrologic element, press the **Cancel** button or the X button in the upper right to return to the *Basin Model* map window. After you finish creating one element, the element creation tool is still selected and you can create additional new elements of the same type.
Copying an Element

There are two ways to copy a hydrologic element. Both methods for copying an element place an exact but independent copy of the element on the clipboard. Once an element is in the clipboard it can be pasted into the same basin model from which it was copied or it can be pasted into a different model.

The first way to copy an element is from the Basin Model map. Select the hydrologic element you wish to copy by clicking on it with the arrow tool. You may also select more than one element in the map. The selected element or elements become highlighted after the selection. After you make a selection, place the mouse over a selected element and press the right mouse button as shown in Figure 82. A context menu is displayed that contains several choices including copy. Click the Copy Element command. If more than one element is selected, select the Copy Elements command. You can now paste the selection into the same or a different basin model. The copy command is only available if there is at least one element selected.
Chapter 6 Watershed Physical Description

Figure 82. Copying a group of selected elements from the basin map to the clipboard; the elements will remain in the basin model. If the elements were cut, they would be on the clipboard but removed from the basin model.

Figure 83. Copying an element to the clipboard from the Watershed Explorer. The element could also be cut to the clipboard. Copied elements remain in the basin model after the copy command is selected, but cut elements are removed from the basin model.
The second way to perform a copy is from the "Components" tab of the Watershed Explorer. Move the mouse over the element you wish to copy and then press the right mouse button (Figure 83). A context menu is displayed that contains several choices including copy. Click the **Copy Element** command. You can now paste the selection into the same or a different basin model. The copy command is only available if there is at least one element selected.

**Pasting an Element**

There are two ways to paste a hydrologic element from the clipboard into a basin model. Pasting an element into a basin model does not remove it from the clipboard so you can paste the same selection into multiple basin models.

The first way to paste an element is from the Basin Model map. Select the arrow tool and move the mouse to the location where you wish to paste the element. If there are multiple elements on the clipboard then you should place the mouse where you the center of the element grouping will be located. Press the right mouse button as shown in Figure 84. A context menu is displayed that contains several choices including paste. Click the **Paste Element** command. The paste command is only available if there is at least one element on the clipboard.

![Figure 84](image)

*Figure 84. Pasting an element selection into the basin map. The mouse was placed where the pasted element should be added to the basin map and the right mouse button was pressed. Now the **Paste Element** command can be selected.*
The second way to perform a paste is from the "Components" tab of the Watershed Explorer. Select the basin model in which you wish to paste elements by clicking on it in the Watershed Explorer; it will expand to show all of the elements in the basin model. Select any of the elements in the basin model by clicking with the right mouse button. A context menu is displayed that contains several choices including paste. Click the Paste Element command. The paste command is only available if there is at least one element on the clipboard.

**Cutting an Element**

There are two ways to cut a hydrologic element from a basin model to the clipboard. Both methods for cutting an element place an exact but independent copy of the element on the clipboard and then delete it from the basin model. Once an element is in the clipboard it can be pasted into the same basin model from which it was copied or it can be pasted into a different model.

The first way to cut an element is from the Basin Model map (Figure 82). Select the hydrologic element you wish to cut by clicking on it with the arrow tool. You may also select more than one element in the map. The selected element or elements become highlighted after the selection. After you make a selection, place the mouse over a selected element and press the right mouse button. A context menu is displayed that contains several choices including cut. Click the Cut Element command. You can now paste the selection into the same or a different basin model. The cut command is only available if there is at least one element selected.

The second way to perform a cut is from the "Components" tab of the Watershed Explorer. Move the mouse over the element you wish to cut then press the right mouse button (Figure 83). A context menu is displayed that contains several choices including cut. Click the Cut Element command. You can now paste the selection into the same or a different basin model. The cut command is only available if there is at least one element selected.

**Renaming an Element**

Rename a hydrologic element using the "Components" tab of the Watershed Explorer. Select the element you wish to rename by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected element and click the left mouse button again. The highlighted name will change to editing mode as shown in Figure 85. You can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished changing the name, press the Enter key to finalize your choice. You can also finalize your choice by clicking elsewhere on the "Components" tab. If you change your mind while in editing mode and do not want to rename the selected hydrologic element, press the Escape key.
Figure 85. Renaming an element in the Watershed Explorer. You can right-click on an element and select the Rename... command. Alternately, click with the left mouse button on an element that is already selected to immediately enter editing mode and change the name.

Deleting an Element

There are two ways to delete a hydrologic element. Both methods for deleting an element remove it from the basin model. Once an element has been deleted it cannot be retrieved or undeleted.

The first way to perform a deletion is from the Basin Model map. Select the hydrologic element you wish to delete by clicking on it with the arrow tool. You may also select more than one element in the map. The selected element or elements become highlighted after the selection. After you make a selection, place the mouse over a selected element and press the right mouse button (Figure 86). A context menu is displayed that contains several choices including delete. Click the Delete Element command. A window will open where you must confirm that you wish to delete the selected hydrologic element. Press the OK button to delete the element or elements. If you change your mind and do not want to delete the element selection, press the Cancel button or the X button in the upper right to return to the Basin Model map window.

The second way to delete is from the "Components" tab of the Watershed Explorer. Move the mouse over the element you wish to delete and press the right mouse button as shown in Figure 87. A context menu is displayed that contains several choices including delete. Click the Delete command. A window will open where you must confirm that you wish to delete the selected element. Press the OK button to delete the hydrologic element. If you change your mind and do not want to delete the selected element, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.
Figure 86. Deleting a subbasin element in the basin map.

Figure 87. Deleting a junction element in the Watershed Explorer.
Optional Features

Several optional features are available at every hydrologic element regardless of the type of element. While some of the features may be required for certain capabilities such as parameter estimation with optimization, they are all optional for normal use in simulation runs. All optional features are contained in a Component Editor that is automatically displayed along with the main element editor. Select an element in the Watershed Explorer or the basin map to view its Component Editor. A typical editor is shown in Figure 88.

A time-series discharge gage can be specified as observed flow for any hydrologic element. When used with subbasins, the gage should generally represent the measured flow at the outlet of the subbasin. For reaches, the gage should represent the measured flow at the downstream end of the reach. For all other elements it should be a measured estimate of the outflow from that element. The observed flow is added to the time-series results for the element and appears in summary tables, time-series tables, and graphs.

A time-series stage gage can be specified as observed stage for any hydrologic element. When used with subbasins, the gage should generally represent the measured stage at the outlet of the subbasin. For reaches the gage should represent the measured stage at the downstream end of the reach. For all other elements it should be a measured estimate of the stage at that element. The observed stage is added to the time-series results for the element. It is best used in combination with the elevation-discharge curve described next.

![Figure 88. Element component editor for specifying option properties.](image)

The program fundamentally computes flow for each of the hydrologic elements included in a basin model. An elevation-discharge curve can be specified so that stage can be computed as well. If a curve is specified, the stage for each time step is determined by taking the computed flow and using it to interpolate elevation from the curve. The computed stage is added to time-series results for the element and appears in summary tables, time-series tables, and graphs.

The flow ratio is only shown for subbasin and source elements, and only if the basin model is set to allow flow ratios. To enable or disable flow ratios, access the Component Editor for the basin model and make the desired selection. When the ratios are enabled in the basin model, the flow ratio can be entered for subbasin and source elements. The ratio is applied to the computed flow from the subbasin or source in order to compute the final outflow.
A reference flow can be specified to assist in interpreting computed flow results. The flow is added to the element results graph as a horizontal marker line at the specified flow value. The marker line is labeled with the specified label. The reference flow can represent any significant flow value such as bank-full discharge, flood watch, or levee overtopping.

**Element Inventory**

The element inventory provides a listing of some or all of the hydrologic elements in a basin model. This is helpful for reviewing the various element names and descriptions. To access the inventory, click the **Parameters** menu and select the **Element Inventory** command. A sample inventory is shown in Figure 89. If there is a current element selection, only the selected elements will be shown in the inventory when the window opens; you can switch to showing all elements by using the selection control at the top of the window. All hydrologic elements in the basin model will be shown if no elements are currently selected.

![Element Inventory](image)

**Flow Network**

The flow network is the skeleton that connects hydrologic elements together into a representation of the stream system in the watershed. Each link in the network is a one-way connector that takes outflow from an element and connects it as inflow to a downstream element.

**Connecting and Disconnecting Elements**

Hydrologic elements can be connected or unconnected from the network using two different methods. The first method uses the mouse in the **Basin Model** window. The second method is found on the **Component Editor** for the element.

To connect an element in the **Basin Model** window, start by selecting the **Arrow Tool** from the toolbar. Next move the mouse over the element you wish to connect to a
downstream element, then press the right mouse button. A context menu is displayed which includes the **Connect Downstream** command. If the

![Diagram of a Watershed Model](image)

**Figure 90.** Preparing to connect the subbasin downstream to West Branch junction. The process was started by placing the mouse over Subbasin-4 and pressing the right-mouse button. Then the **Connect Downstream** command was selected. Note the mouse has changed to a cross hairs cursor for selecting the desired downstream element.

...
You can also create and delete connections from the Component Editor for the element (Figure 91). To access the Component Editor, click on the desired element in the Basin Model window, or on the "Components" tab of the Watershed Explorer. The Component Editor shows the downstream element. If the element is not connected to a downstream element, the selection list will show None as the selected element. To connect the element currently shown in the Component Editor, select an element on the list. Only elements that could potentially be downstream of the current element are shown. To disconnect the current element, change the selection in the list to the None selection.

![Figure 91](image)

Moving Elements

Hydrologic elements are moved in the Basin Model window; they are moved the same way regardless of whether they are connected to a downstream element. To move an element, start by selecting the Arrow Tool from the toolbar. Next click the icon of the element you wish to move; the element you click will become highlighted. Keep the mouse over the element and hold down the left mouse button. Drag the mouse until the element icon is in the desired location. Release the left mouse button to finalize the move.

Reach elements are often connected between two junctions or possibly between other element types. Reach elements must connect to the upstream and downstream element. If a reach is connected on both ends, it can only be moved by moving the upstream or downstream element. If a reach is not connected on one end, that free end can be moved. Click on the reach once with the mouse to select it. Move the mouse over the free end of the reach and click again with the left mouse button. A small blue box appears at the free end. Keep the mouse over that box and hold the left mouse button. Drag the mouse to move the free end of the reach. Release the left mouse button to finalize the new location for that end of the reach. If a reach is not connected on either end, the entire reach can be moved. Click on the reach once with the mouse to select it. Keep the mouse over the reach and hold the left mouse button. Drag the mouse to move the reach to a new location. Release the left mouse button to finalize the new reach location.
Background Gridlines

Background gridlines are useful to helping to measure approximate distance in the Basin Model window. They are not drawn at a specific scale; the relative scale changes depending on the current view. There is only one way to turn the grid lines on and off.

Turn the gridlines on and off using the View menu. Click on the View menu and select the Gridlines command. A check is shown next to the menu command to indicate that the gridlines are turned on. The lines are drawn first in the map using a light gray color, then all other maps and the hydrologic elements are drawn. You can turn off the gridlines by clicking on the same menu command again.

Element Icons and Names

Hydrologic elements can be drawn with icons and name labels. Both properties are controlled independently. There is only one way to control each property.

Turn the icons on and off using the View menu. Click on the View menu and select the Element Icons command. A check is shown next to the menu command to indicate that the icons are turned on. You can turn off the icons by clicking on the same menu command again. If the icons are turned off and the names remain on, the name of each element will be converted to an icon.

Turn the element names on and off using the View menu. Click on the View menu and select the Element Names command. A check is shown next to the menu command to indicate that the names are turned on. You can turn off the names by clicking on the same menu command again. If the icons and names are turned off, only the reaches and element connection links are shown.

Displaying Flow Directions

Each reach element in the network only allows flow to move in one direction; from upstream to downstream. If a reach is connected to its upstream and downstream elements in the wrong direction, then the network may not be a good representation of the physical watershed. You can verify the flow directions by displaying direction arrows. When the direction arrows are turned on, arrow heads are added to reach elements to show the flow direction. There is only one way to turn the flow direction arrows on and off.

Turn the flow direction arrows on and off using the View menu. Click on the View menu and select the Flow Directions command. A check is shown next to the menu command to indicate that the arrows are turned on. You can turn off the direction arrows by clicking on the same menu command again.

Finding and Selecting Elements

The simplest way to find a hydrologic element in a basin model is to select it in the Watershed Explorer. All of the elements in a basin model are shown in alphabetical order under the basin model icon. Click on an element icon in the Watershed Explorer and it will become selected. The selected element is highlighted in the Watershed Explorer and in the Basin Model window. More than one element may be selected at a time but only the Component Editor for the first selected element is shown.

You can also find and select a hydrologic element in the Basin Model window. Begin by making sure the Arrow Tool is selected on the toolbar. Examine the element icons
in the Basin Model window until you find the one you wish to select. Click on it with
the arrow cursor and it will become selected. The selected element is highlighted in
the Basin Model window and in the Watershed Explorer. After you make the first
selection, you can add to the selection by holding the shift key and clicking on
additional elements. You can select several elements simultaneously by using the
arrow cursor to drag a box around the desired elements. To select using a drag box,
move the mouse to a blank area of the basin model map. Hold the left mouse button
and drag the mouse. A box is drawn to show which elements will be selected when
you release the mouse button.

It can be difficult to find a specific hydrologic element in a large basin model with
many elements. A special tool is included to that can be used to help locate a single
element or a group of elements. Access the tool by clicking the Edit menu and
selecting the Select Special command (Figure 92). The Select Special window will
remain open until it is closed by pressing the Close button or the X button at the
upper corner of the window. Elements are selected in the basin model according to
the selections on the Select Special window every time the Apply button is pressed.
There are three components to a special selection.

The first component of a special selection is the element name. You may enter a
specific name, for example, the name of an element appearing in an error message.
You can find all elements that begin with a specific sequence of letters by entering
those letters followed by an asterisk. For example, entering sub* will find all
elements with names that start with "sub". You can also find all elements that end
with a specific sequence of letters by entering an asterisk followed by those letters.
For example, entering *creek will find all elements with names that end in "creek".
Finally you can find all elements that contain a specific sequence of letters by
entering an asterisk, the letters, and ending with another asterisk. For example,
entering *basin* will find all elements with names that contain "basin". By default
the "Element Name" is set to an asterisk so that the special selection will find all
element names.

The second component of a special selection takes the result of limiting by element
name and further limits it based on the element type. Elements will only be selected
if they match the name criteria and their type is checked on. For example, to only
search among the source elements, check off all element types except source. You
may check on one, several, or all element types. The default is to search among all
element types.
Figure 92. Using the special selection tool to select all junctions whose names begin with the letters "West".

The third component of a special selection is the selection type to create. You may replace the current selection. This means that whatever elements are found to meet the name criteria and the element type criteria will become the selected elements. Any previously selected elements will no longer be selected. You may alternately add to the current selection. This means the new selection will include any elements that are currently selected plus the elements that meet the new name and element type criteria. Finally, you can select from the current selection. In this case the name and element type criteria are further limited by only selecting from among the elements that are already selected.

**Adjusting the View and Zooming**

Several tools and commands are provided to zoom in, zoom out, and move around the *Basin Model* window. Several of the tools are on the toolbar. The commands are all on the *View* menu.

There are two ways to zoom in on the *Basin Model* window. The first way is using the *Zoom In Tool* to zoom in on a specific region in the *Basin Model* window. Select the tool from the toolbar and then move the mouse over the *Basin Model* window; the mouse will change to the zoom in cursor. Place the mouse on one corner of the area you want to magnify, then hold the left mouse button and drag the mouse to draw a box around the region. When you release the left mouse button, the region you selected will be redrawn to fill the *Basin Model* window. You can zoom in as many times as you wish as long as the *Zoom In Tool* is selected. The second way is using the *Zoom In* command on the *View* menu. Every time you select the *Zoom In* command, the center of the Basin Model window will zoom in by a predefined amount. The *Zoom In* command is only accessible when the *Basin Model* window is open.
There are two ways to zoom out in the Basin Model window. The first way is using the Zoom Out Tool to zoom out from a specific point in the Basin Model window. Select the tool from the toolbar and then move the mouse over the Basin Model window; the mouse will change to the zoom out cursor. Place the mouse at the point where you wish to zoom out and press the left mouse button. The Basin Model window redraws immediately after zooming out a predefined amount, centered on the point where you clicked. The second way is using the Zoom Out command on the View menu. Every time you select the Zoom Out command, the center of the Basin Model window will zoom out by a predefined amount. The Zoom Out command is only accessible when the Basin Model window is open.

It may not be possible to view the entire basin model simultaneously in the Basin Model window if the zoom has been used. Scroll bars are automatically added to the Basin Model window when it is not possible to show the entire basin model. You can use the scroll bars regardless of which tool is selected on the toolbar. As you move the scroll bars, the view shown in the Basin Model window will change but it will not redraw until you stop scrolling. Redrawing the view can be time intensive when background maps have been added. Only one scroll bar can be used at a time, but the Pan Tool allows complete freedom to change the view in any direction. Select the tool from the toolbar and move the mouse over the Basin Model window; the mouse changes to the move cursor. Place the mouse where you wish to begin and hold the left mouse button. Drag the mouse in any direction to change the view. The new view will be redrawn when you release the mouse button.

It can be very difficult to find the selected element or elements in a basin model with many hydrologic elements. A special tool has been created to zoom to the current element selection. Begin by creating an element selection. You can click on an element in the Watershed Explorer, or use the Edit ⇒ Select Special command to create a current selection. You can zoom to the selection by clicking the View menu and selecting the Zoom To Selected command. The Basin Model window will automatically zoom to an appropriate scale for the current element selection and center the view on the selection.

After zooming in and moving around the basin model, you may want to quickly return to viewing the entire model. You can immediately zoom to the maximum extents. Click the View menu and select the Zoom To Maximum Extents command. The Basin Model window will automatically zoom out to the coordinates specified as the maximum extents and redraw.

Subbasin

A subbasin is an element that usually has no inflow and only one outflow. It is one of only two ways to produce flow in the basin model. Outflow is computed from meteorologic data by subtracting losses, transforming excess precipitation, and adding baseflow. The subbasin can be used to model a wide range of catchment sizes.

Selecting a Loss Method

While a subbasin element conceptually represents infiltration, surface runoff, and subsurface processes interacting together, the actual infiltration calculations are performed by a loss method contained within the subbasin. A total of nine different loss methods are provided. Some of the methods are designed primarily for simulating events while others are intended for continuous simulation. All of the methods conserve mass. That is, the sum of infiltration and precipitation left on the surface will always be equal to total incoming precipitation.
The loss method for a subbasin is selected on the Component Editor for the subbasin element. Access the Component Editor by clicking the subbasin element icon on the "Components" tab of the Watershed Explorer (Figure 93). You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open. You can select a loss method from the list of nine available choices. If you choose the None method, the subbasin will not compute infiltration and all precipitation will be assumed as excess and subject to surface runoff. Use the selection list to choose the method you wish to use. Each subbasin may use a different method or several subbasins may use the same method.

When a new subbasin is created, it is automatically set to use the default loss method specified in the project options. You may change the loss method for a subbasin at any time using the Component Editor for the subbasin element. Since a subbasin can only use one loss method at a time, you will be warned when changing methods that the old parameter data will be lost. You can turn off this warning in the program settings. You can change the loss method for several subbasins simultaneously. Click on the Parameters menu and select the Subbasin Methods ⇒ Loss command. The loss method you choose will be applied to the selected subbasins in the basin model, or to all subbasins if none are currently selected.

The parameters for each loss method are presented on a separate Component Editor from the subbasin element editor. The "Loss" editor is always shown next to the "Subbasin" editor. If the kinematic wave transform method is selected, there may be two loss editors, one for each runoff plane. The information shown on the loss editor will depend on which method is currently selected.

**Deficit Constant Loss**

The deficit constant loss method uses a single soil layer to account for continuous changes in moisture content. It should be used in combination with a meteorologic model that computes evapotranspiration. The potential evapotranspiration computed by the meteorologic model is used to dry out the soil layer between precipitation events. Infiltration only occurs when the soil layer is saturated.

The initial deficit is the initial condition for the method. It indicates the amount of water that is required to saturate the soil layer to the maximum storage.
The maximum storage specifies the amount of water the soil layer can hold, specified as a depth. An upper bound would be the depth of the active soil layer multiplied by the porosity. However, in most cases such an estimate will have to be reduced by the permanent wilting point and for other conditions that reduce the holding capacity of the soil.

The constant rate defines the infiltration rate when the soil layer is saturated. A good approximation is to use the saturated hydraulic conductivity.

The percentage of the subbasin which is directly connected impervious area can be specified. No loss calculations are carried out on the impervious area; all precipitation on that portion of the subbasin becomes excess precipitation and subject to direct runoff.

**Exponential Loss**

The exponential loss method is empirical and generally speaking should not be used without calibration. It represents incremental infiltration as a logarithmically decreasing of accumulated infiltration. It includes the option for increased initial infiltration when the soil is particularly dry before the arrival of a storm. Because it is a function of cumulative infiltration and does not include any type of recovery, it should not be used for continuous simulation.

The initial range is the amount of initial accumulated infiltration during which the loss rate is increased. This parameter is considered to be a function primarily of antecedent soil moisture deficiency and is usually storm-dependent.
Chapter 6 Watershed Physical Description

Figure 95. Exponential loss method editor.

The initial coefficient specifies the starting loss rate coefficient on the exponential infiltration curve. It is assumed to be a function of infiltration characteristics and consequently may be correlated with soil type, land use, vegetation cover, and other properties of a subbasin.

The coefficient ratio indicates the rate at which the exponential decrease in infiltration capability proceeds. It may be considered a function of the ability of the surface of a subbasin to absorb precipitation and should be a reasonable constant for large, homogeneous areas.

The precipitation exponent reflects the influence of precipitation rate on subbasin-average loss characteristics. It reflects the manner in which storms occur within an area and may be considered a characteristic of a particular region. It varies from 0.0 up to 1.0.

The percentage of the subbasin which is directly connected impervious area can be specified. No loss calculations are carried out on the impervious area; all precipitation on that portion of the subbasin becomes excess precipitation and subject to direct runoff.

**Green Ampt Loss**

The Green and Ampt infiltration method is essentially a simplification of the comprehensive Richard’s equation for unsteady water flow in soil. The Green and Ampt method assumes the soil is initially at a uniform moisture content, and infiltration takes place with so-called piston displacement. The method automatically accounts for ponding on the surface.

The initial loss is unrelated to the surface ponding that is part of the Green and Ampt infiltration model. This loss is an additional abstraction and should be used for canopy or other interception.

The moisture deficit is the initial condition on the Green and Ampt calculations. It should be estimated as the soil porosity minus the volumetric water content. In this case the soil porosity should not be the total porosity; it should be the porosity actually active in infiltration.

The wetting front suction must be specified. It is generally assumed to be a function of the soil texture.
The hydraulic conductivity must also be specified. It can be estimated from field tests or approximated by knowing the soil texture.

The percentage of the subbasin which is directly connected impervious area can be specified. No loss calculations are carried out on the impervious area; all precipitation on that portion of the subbasin becomes excess precipitation and subject to direct runoff.

**Gridded Deficit Constant Loss**

The gridded deficit constant loss method essentially implements the deficit constant method on a grid cell by grid cell basis. Each grid cell receives separate precipitation and potential evapotranspiration from the meteorologic model. Parameters are represented with grids from the grid data manager.

An initial deficit grid must be selected from the list of choices. The selection list will show all moisture deficit grids available in the grid data manager. You can use a chooser to select a grid by pressing the grid button next to the selection list. The chooser shows all of the moisture deficit grids in the grid data manager. Click on a grid to view the description. This is especially helpful since initial deficit and maximum storage grids are both stored as moisture deficit grids.

A maximum storage grid must be selected from the list of choices. The selection list will show all moisture deficit grids available in the grid data manager. You can use a chooser to select a grid by pressing the grid button next to the selection list. The chooser shows all of the moisture deficit grids in the grid data manager. Click on a grid to view the description. This is especially helpful since initial deficit and maximum storage grids are both stored as moisture deficit grids.

A constant rate grid must be selected from the list of choices. The selection list will show all percolation rate grids available in the grid data manager. You can use the chooser to select a grid by pressing the grid button next to the selection list, or select directly from the list of choices.

An impervious grid must be selected from the list of choices. The selection list will show all impervious area grids available in the grid data manager. You can use the chooser to select a grid by pressing the grid button next to the selection list.
Figure 97. Gridded deficit constant loss method editor.

The initial deficit grid ratio must be entered. The actual initial deficit value at each grid cell is obtained by multiplying the value obtained from the initial deficit grid by the specified ratio. The default value is 1.0.

The maximum storage grid ratio must be entered. The actual maximum storage value at each grid cell is obtained by multiplying the value obtained from the maximum storage grid by the specified ratio. The default value is 1.0.

The constant rate grid ratio must be entered. The actual constant loss rate value at each grid cell is obtained by multiplying the value obtained from the constant rate grid by the specified ratio. The default value is 1.0.

The impervious grid ratio must be entered. The actual percentage of impervious area at each grid cell is obtained by multiplying the value obtained from the impervious grid by the specified ratio. The default value is 1.0.

**Gridded SCS Curve Number Loss**

The gridded SCS curve number loss method essentially implements the SCS curve number method on a grid cell by grid cell basis. Each grid cell receives separate precipitation from the meteorologic model. All cells are initialized by scaling based on the curve number at each cell, and then allowed to evolve separately during the simulation based on individual precipitation inputs. The main parameter is represented with a grid from the grid data manager.

The curve number grid must be selected from the available choices. A curve number grid must be defined in the grid data manager before it can be used in the subbasin. You can use a chooser to select a grid by pressing the grid button next to the selection list. The chooser shows all of the curve number grids in the grid data manager.

It is optional to enter an initial abstraction ratio; it is assumed to be 0.2 if no value is entered. The initial abstraction ratio is used to compute the initial abstraction at each grid cell. The potential retention is calculated from the curve number for each cell, then multiplied by the ratio to determine the actual initial abstraction for that cell.
It is optional to enter a potential retention scale factor; it is assumed to be 1.0 if no value is entered. The potential retention scale factor is used to adjust the retention calculated from the curve number before it is multiplied by the initial abstraction ratio.

<table>
<thead>
<tr>
<th>Subbasin</th>
<th>Loss</th>
<th>Transform</th>
<th>Baseflow</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basin Name:</strong> Post Dam</td>
<td><strong>Element Name:</strong> Deer Cr</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Curve Number Grid:</td>
<td>Land Use 2015</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ratio:</td>
<td>0.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Factor:</td>
<td>1.0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 98. Gridded SCS curve number loss method editor.**

**Gridded Soil Moisture Accounting**

The gridded soil moisture accounting loss method essentially implements the soil moisture accounting method on a grid cell by grid cell basis. Each grid cell receives separate precipitation and potential evapotranspiration from the meteorologic model. All cells are initialized to the same initial conditions, and then allowed to evolve separately during the simulation based on individual precipitation inputs. Parameters are represented with grids from the grid data manager.

The initial condition of the canopy should be specified as the percentage of the canopy storage that is full of water at the beginning of the simulation. The same percentage will be applied to every grid cell. Likewise, the percentage full of the remaining surface, soil, and groundwater layers must also be specified.

The canopy storage grid must be selected from the grids that have been previously defined in the grid data manager. The grid should specify the maximum canopy storage in each grid cell. You may use a chooser to select the grid by pressing the grid button next to the selection list. You will not be able to select a grid if no grids have been created in the grid data manager. Likewise, you must also select a surface, soil, tension, and groundwater storage grids. All of the different layers use the same type of parameter grid so descriptions for the grids are important.

The maximum infiltration grid is selected from the percolation grids that have been previously defined in the grid data manager. The grid should specify the maximum infiltration rate at each grid cell. This is the upper bound on infiltration; the actual infiltration at any cell in a particular time interval is a linear function of the surface and soil storage in the cell. You may use a chooser to select the grid. The grid selections will be disabled unless you have previously created grids in the grid data manager. Likewise, you must also select a soil percolation and groundwater percolation grids. All infiltration and percolation grids use the same type of parameter grid so descriptions for the grids are important.
Groundwater coefficient grids must be selected for the upper and lower groundwater layers. The selected grid should specify the storage coefficient for each cell in the layer. The coefficient is used as the time lag on a linear reservoir for transforming water in storage to become lateral outflow. Contributions from each grid cell are accumulated to determine the total amount of flow available to become baseflow.

**Initial Constant Loss**

The initial constant loss method is very simple but still appropriate for watersheds that lack detailed soil information. It is also suitable for certain types of flow-frequency studies.

The initial loss specifies the amount of incoming precipitation that will be infiltrated or stored in the watershed before surface runoff begins. There is no recovery of the initial loss during periods without precipitation.

The constant rate determines the rate of infiltration that will occur after the initial loss is satisfied. The same rate is applied regardless of the length of the simulation.

The percentage of the subbasin which is directly connected impervious area can be specified. No loss calculations are carried out on the impervious area; all precipitation on that portion of the subbasin becomes excess precipitation and subject to direct runoff.
Chapter 6  Watershed Physical Description

Figure 100. Initial constant loss method editor.

**SCS Curve Number Loss**

The Soil Conservation Service (Now the Natural Resources Conservation Service) curve number method implements the curve number methodology for incremental losses. Originally, the methodology was intended to calculate total infiltration during a storm. The program computes incremental precipitation during a storm by recalculating the infiltration volume at the end of each time interval. Infiltration during each time interval is the difference in volume at the end of two adjacent time intervals.

You may optionally enter an initial abstraction. The initial abstraction defines the amount of precipitation that must fall before surface excess results. However, it is not the same as an initial interception or initial loss since changing the initial abstraction changes the infiltration response later in the storm. If this value is left blank, it will be automatically calculated as 0.2 times the potential retention, which is calculated from the curve number.

Figure 101. SCS curve number loss method editor.

You must enter a curve number. This should be a composite curve number that represents all of the different soil group and land use combinations in the subbasin. The composite curve number should not include any impervious area that will be specified separately.

The percentage of the subbasin which is directly connected impervious area can be specified. Any percentage specified should not be included in computing the composite curve number. No loss calculations are carried out on the impervious area; all precipitation on that portion of the subbasin becomes excess precipitation and subject to direct runoff.
Soil Moisture Accounting Loss

The soil moisture accounting loss method uses five layers to represent the dynamics of water movement above and in the soil. Layers include canopy interception, surface depression storage, soil, upper groundwater, and lower groundwater. The soil layer is subdivided into tension storage and gravity storage. Groundwater layers are not designed to represent aquifer processes; they are intended to be used for representing shallow interflow processes. The method provides for wetting and recovery cycles and can be used for long periods of continuous simulation.

The initial condition of the canopy should be specified as the percentage of the canopy storage that is full of water at the beginning of the simulation. Likewise, the percentage full of the remaining surface, soil, and groundwater layers must also be specified.

Canopy storage represents the maximum amount of water that can be held on leaves before through fall to the surface begins. Precipitation must fill canopy storage before through fall occurs and evapotranspiration recovers the canopy storage before other layers. It may be zero if you wish to eliminate canopy calculations from the simulation.

Surface storage represents the maximum amount of water that can pond on the soil surface before surface runoff begins. Infiltration from the surface to the soil occurs whenever there is water in the surface storage, regardless of how much water is in surface storage. Surface runoff occurs when the storage is full and there is excess precipitation. Storage capacity may be zero if you wish to eliminate surface depression calculations from the simulation.

![Figure 102. Soil moisture accounting loss method editor.](image)
The maximum infiltration rate sets the upper bound on infiltration from the surface storage into the soil. The actual infiltration rate is a linear function of the current storage in the surface and the current storage in the soil.

The percentage of the subbasin which is directly connected impervious area can be specified. No loss calculations are carried out on the impervious area; all precipitation on that portion of the subbasin becomes excess precipitation and subject to direct runoff.

Soil storage represents the total storage available in the soil layer. It may be zero if you wish to eliminate soil calculations and pass infiltrated water directly to groundwater.

Tension storage specifies the amount of water storage in the soil that does not drain under the affects of gravity. Percolation from the soil layer to the upper groundwater layer will occur whenever the current soil storage exceeds the tension storage. Water in tension storage is only removed by evapotranspiration. By definition, tension storage must be less that soil storage.

The soil percolation sets the upper bound on percolation from the soil storage into the upper groundwater. The actual percolation rate is a linear function of the current storage in the soil and the current storage in the upper groundwater.

Groundwater 1 storage represents the total storage in the upper groundwater layer. It may be zero if you wish to eliminate the upper groundwater layer and pass water percolated from the soil directly to the lower groundwater layer.

The groundwater 1 percolation rate sets the upper bound on percolation from the upper groundwater into the lower groundwater. The actual percolation rate is a linear function of the current storage in the upper and lower groundwater layers.

The groundwater 1 coefficient is used as the time lag on a linear reservoir for transforming water in storage to become lateral outflow. The lateral outflow is available to become baseflow.

Groundwater 2 storage represents the total storage in the lower groundwater layer. It may be zero if you wish to eliminate the lower groundwater layer and pass water percolated from the upper groundwater layer directly to deep percolation.

The groundwater 2 percolation rate sets the upper bound on deep percolation out of the system. The actual percolation rate is a linear function of the current storage in the lower groundwater layer.

The groundwater 2 coefficient is used as the time lag on a linear reservoir for transforming water in storage to become lateral outflow. It is usually a larger value that the groundwater 1 coefficient. The lateral outflow is likewise available to become baseflow.

**Selecting a Transform Method**

While a subbasin element conceptually represents infiltration, surface runoff, and subsurface processes interacting together, the actual surface runoff calculations are performed by a transform method contained within the subbasin. A total of seven different transform methods are provided. The choices include various unit hydrograph methods, a kinematic wave implementation, and a linear quasi-distributed method.
The transform method for a subbasin is selected on the Component Editor for the subbasin element. Access the Component Editor by clicking the subbasin element icon on the "Components" tab of the Watershed Explorer (Figure 93). You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open. You can select a transform method from the list of seven available choices. If you choose the None method, the subbasin will transform all excess precipitation as runoff at the end of each time step. Use the selection list to choose the method you wish to use. Each subbasin may use a different method or several subbasins may use the same method.

When a new subbasin is created, it is automatically set to use the default transform method specified in the project options. You may change the transform method for a subbasin at any time using the Component Editor for the subbasin element. Since a subbasin can only use one transform method at a time, you will be warned when changing methods that the old parameter data will be lost. You can turn off this warning in the program settings. You can change the transform method for several subbasins simultaneously. Click on the Parameters menu and select the Subbasin Methods ⇒ Transform command. The transform method you choose will be applied to the selected subbasins in the basin model, or to all subbasins if none are currently selected.

The parameters for each transform method are presented on a separate Component Editor from the subbasin element editor. The "Transform" editor is always shown near to the "Subbasin" editor. The kinematic wave method uses multiple tabs in the Component Editor. The information shown on the transform editor will depend on which method is currently selected.

**Clark Unit Hydrograph Transform**

The Clark unit hydrograph is a synthetic unit hydrograph method. That is, the user is not required to develop a unit hydrograph through the analysis of past observed hydrographs. Instead a time versus area curve built into the program is used to develop the translation hydrograph resulting from a burst of precipitation. The resulting translation hydrograph is routed through a linear reservoir to account for storage attenuation affects across the subbasin.

The time of concentration defines the maximum travel time in the subbasin. It is used in the development of the translation hydrograph.

The storage coefficient is used in the linear reservoir that accounts for storage affects. Many studies have found that the storage coefficient, divided by the sum of time of concentration and storage coefficient, is reasonably constant over a region.

![Figure 103. Clark unit hydrograph transform method editor.](image)
Kinematic Wave Transform

The kinematic wave method is designed principally for representing urban areas, although it can be used for undeveloped regions as well. It is a conceptual model that includes one or two representative planes. Typically, one plane is used for pervious surfaces and one for impervious. The same meteorologic boundary conditions are applied to each plane. However, separate loss rate information is required for each plane and is entered separately as part of the loss method. A separate Component Editor is provided for each plane; they are displayed whenever the Component Editor is shown for the subbasin (Figure 104).

The first parameter is the length. The typical length of the conceptual plane should be entered. For impervious areas, this should be the average flow length from the point where precipitation falls, to where the runoff first enters a collection gutter or channel. For pervious areas, this should likewise be the average flow length. When using the two planes to represent pervious and impervious areas, it is helpful to adopt a convention for which plane number (one or two) represents the pervious area.

The slope is also required for each plane that will be used. The slope should represent the average slope along the flow line from the point where precipitation falls to where the runoff first enters a gutter or channel.

Roughness is the principal difference between a plane meant to represent impervious or pervious area. Roughness coefficients for natural areas are much higher than for developed areas. However, in both cases the surface roughness coefficients are higher than typical Manning's roughness coefficients.

Figure 104. Plane editor for the kinematic wave transform method. The same properties are required for the second plane, if it is used.

The percentage of the subbasin area occupied by each plane must be entered. If you only want to use one plane, then enter 100 for the first plane and 0 for the second. You do not need to enter length, slope, or roughness if the area will be set to zero.

The number of routing steps is used as a hint to the program when it determines the correct distance step to use during runoff calculations. Criteria based on rate of precipitation and other factors are used to automatically determine the correct distance and time steps for solving the kinematic wave equation. The default value is five.
The outflow from each plane is scaled up to the subbasin according the percentage of the subbasin occupied by each plane type. The resulting composite outflow is linked to a subcollector channel. The subcollector is intended to represent primary collection systems such as street gutters but cross section choices allow alternate representations. The outflow from the planes is applied to the subcollector as lateral inflow.

The length should be the average distance from the beginning of the subcollector to where it will enter a collector. Usually this value will be measured from maps of the stormwater collection system.

The slope should be the average slope along the average flow length. This value may be estimated from maps if they provide sufficient vertical resolution. Field survey data may be necessary to actually determine elevations of the gutter or channel. If the slope varies significantly throughout the system, this may become a determining factor in how the system is broken into subcollectors, collectors, and main channel.

The Manning's n roughness coefficient should be the average value for the whole subcollector. It is important to remember that the parameter data entered for the subcollector should be typical of all similar subcollectors in the subbasin.

The number of subreaches is used as a hint to the program when it determines the correct distance step to use during routing calculations. The default value is five.

The typical area of each subcollector must be entered. This is used to determine how to apply the composite outflow from the subcollector to the collector channel. It essentially determines the number of subcollector channels in the subbasin.

Five options are provided for specifying the cross section shape: circle, deep, rectangle, trapezoid, and triangle. The circle shape cannot be used for pressure flow or pipe networks, but is suitable for representing a free water surface inside a pipe. The deep shape should only be used for flow conditions where the flow depth is approximately equal to the flow width. Depending on the shape you choose, additional information will have to be entered to describe the size of the cross section shape. This information may include a diameter (circle) bottom width (deep, rectangle, trapezoid) or side slope (trapezoid, triangle). The side slope is
dimensionless and entered as the units of horizontal distance per one unit of vertical distance.

The outflow from the subcollector enters a collector as lateral inflow. The collector channel is intended to represent small ditches or open channels that are part of an engineered stormwater management system. The parameters for the collector are exactly the same as for the subcollector. Length, slope, Manning's n, and the number of subreaches are all the same. The area served by a typical collector must be entered; this is used to apply lateral inflow from the collector to the main channel. Options for the cross section shape are exactly the same as for the subcollector.

Finally, the outflow from the collector enters a main channel. The channel is intended to represent the main stream in the subbasin. Outflow from the collector is applied to the channel as lateral inflow. Optionally, upstream inflow can be connected to the channel.

Normally it is not possible to connect upstream inflow to a subbasin element. However, because of the conceptual representation of the kinematic wave method, it is possible to have an upstream inflow on the main channel. In order to connect upstream elements to the subbasin, you must select the route upstream option.

The surface runoff on the two planes is always routed using the kinematic wave method. However, you have the choice of using Muskingum-Cunge routing in the subcollector, collector, and main channel. All three channels use the same method. Select the method you wish to use.

If the route upstream option is turned on, the length should be the distance from the upstream boundary to the subbasin to the outlet. If the route upstream option is turned off, the length should be from the identifiable concentration point of the channel to the subbasin outlet. There is only one channel in each subbasin.

The slope should be the average slope for the whole channel. This value may be estimated from maps if they provide sufficient vertical resolution. Field survey data may be necessary to actually determine elevations of the channel bed for calculating the slope.
The number of subreaches is used as a hint to the program when it determines the correct distance step to use during routing calculations. The default value is five. This parameter is only entered when the kinematic wave routing method is selected.

A cross section shape must be selected. If the kinematic wave routing method is selected, the options will include circle, deep, rectangle, trapezoid, and triangle. When the Muskingum-Cunge routing method is selected, the options will include circular, rectangle, trapezoid, triangle, and eight point. You will have to enter a Manning's n roughness value for the channel. If the eight point cross section shape is used, you will also have to enter a roughness value for the left and right overbank areas. You will have to enter other appropriate parameter data based on the cross section choice.

**ModClark Transform**

The ModClark method is a linear, quasi-distributed transform method that is based on the Clark conceptual unit hydrograph. It fundamentally represents the subbasin as a collection of grid cells. The Clark method uses a time-area curve and the time of concentration to develop a translation hydrograph. By contrast, the ModClark method eliminates the time-area curve and instead uses a separate travel time index for each grid cell. The travel time index for each cell is scaled by the overall time of concentration. Excess precipitation falling on each grid cell is lagged by the scaled time index and then routed through a linear reservoir. The outputs from the linear reservoirs of the cells are combined to produce the final hydrograph.

The time of concentration defines the maximum travel time in the subbasin. The grid cell in the subbasin with the largest travel time index will have exactly this specified time of concentration. All other grid cells will have a scaled time of concentration based on the ratio of the cell's travel time index to the maximum travel time index.

The storage coefficient is used in the linear reservoir for each grid cell. The same coefficient is used for all cells in the subbasin.

**SCS Unit Hydrograph Transform**

The SCS unit hydrograph method was originally developed from observed data collected in small, agricultural watersheds. The data were generalized as dimensionless hydrographs and a best-approximate hydrograph was developed for general application. The general hydrograph is scaled by the time lag to produce the unit hydrograph for use. It is interesting to note that 37.5% of the runoff volume occurs before the peak flow and the time base of the hydrograph is five time the lag.

The standard lag is defined as the length of time between the centroid of precipitation mass and the peak flow of the resulting hydrograph. Studies by the SCS (Now the
Natural Resources Conservation Service) found that in general the lag time can be approximated by taking 60% of the time of concentration.

<table>
<thead>
<tr>
<th>Subbasin</th>
<th>Loss</th>
<th>Transform</th>
<th>Baseflow</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basin Name: Post Dam</td>
<td>Element Name: Deer Cr</td>
<td>Lag Time (MIN)</td>
<td>190</td>
<td></td>
</tr>
</tbody>
</table>

Figure 108. SCS unit hydrograph transform method editor.

**Snyder Unit Hydrograph Transform**

The Snyder unit hydrograph is also a synthetic unit hydrograph method. It was originally developed to compute the peak flow as the result of a unit of precipitation. Additionally, empirical methods have been developed for estimating the time base of the hydrograph and the width at 50% of the peak flow. The implementation used in the program utilizes a unit hydrograph generated with the Clark methodology such that the empirical Snyder relationships are maintained.

The standard lag is defined as the length of time between the centroid of precipitation mass and the peak flow of the resulting hydrograph. Many relationships for estimating lag from subbasin characteristics have been developed for different regions.

The peaking coefficient measures the steepness of the hydrograph that results from a unit of precipitation.

<table>
<thead>
<tr>
<th>Subbasin</th>
<th>Loss</th>
<th>Transform</th>
<th>Baseflow</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basin Name: Post Dam</td>
<td>Element Name: Deer Cr</td>
<td>Standard Lag (HR)</td>
<td>6.7</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Peaking Coefficient</td>
<td>0.28</td>
<td></td>
</tr>
</tbody>
</table>

Figure 109. Snyder unit hydrograph transform method editor.

**User-Specified S-Graph Transform**

The user-specified s-graph method is not synthetic. It uses what is called a summation unit hydrograph (abbreviated as s-graph) to represent the response of a subbasin to a unit of precipitation. The s-graph is defined in terms of percentage of unit flow versus percentage of time lag. Consequently, the same s-graph can be used in different subbasins with different time lags. A given s-graph is generally only applicable in a particular region with subbasins that share certain characteristics.

The s-graph must be chosen from a selection list of percentage curves defined previously in the paired data manager. While percentage curves are used for other applications in the program, in this case they represent percentage of unit discharge versus percentage of time lag. You will not be able to use the selection list until you
create at least one s-graph. If you wish, you can use the paired data button next to the selection list to open a chooser to assist in selecting the correct s-graph. Click on a percentage curve to view its description. Descriptions are particularly important for percentage curves because of the different applications in the program.

The time lag is defined as the length of time between the centroid of precipitation mass and the peak flow of the resulting hydrograph.

The user-specified unit hydrograph method is not synthetic. Consequently, a separate unit hydrograph must be developed for each subbasin. Usually these unit hydrographs are developed from multiple storm observations when precipitation and flow have been measured at the same time interval. The unit hydrograph so developed has a so-called duration that is equal to the time interval of the precipitation measurements. The program will automatically adjust the duration of the user-specified unit hydrograph using the s-graph technique so that it matches the simulation time interval.

The unit hydrograph must be chosen from a selection list of unit hydrographs defined previously in the paired data manager. You will not be able to use the selection list until you create at least one unit hydrograph. If you wish, you can use the paired data button next to the selection list to open a chooser to assist in selecting the correct unit hydrograph.

While a subbasin element conceptually represents infiltration, surface runoff, and subsurface processes interacting together, the actual subsurface calculations are performed by a baseflow method contained within the subbasin. A total of four different baseflow methods are provided. Some of the methods are designed primarily for simulating events while others are intended for continuous simulation.
The baseflow method for a subbasin is selected on the Component Editor for the subbasin element. Access the Component Editor by clicking the subbasin element icon on the "Components" tab of the Watershed Explorer (Figure 93). You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open. You can select a baseflow method from the list of four available choices. If you choose the None method, the subbasin will not compute baseflow and the outflow will only include direct runoff from the transform method. Use the selection list to choose the method you wish to use. Each subbasin may use a different method or several subbasins may use the same method.

When a new subbasin is created, it is automatically set to use the default baseflow method specified in the project options. You may change the baseflow method for a subbasin at any time using the Component Editor for the subbasin element. Since a subbasin can only use one baseflow method at a time, you will be warned when changing methods that the old parameter data will be lost. You can turn off this warning in the program settings. You can change the baseflow method for several subbasins simultaneously. Click on the Parameters menu and select the Subbasin Methods ⇒ Baseflow command. The baseflow method you choose will be applied to the selected subbasins in the basin model, or to all subbasins if none are currently selected.

The parameters for each baseflow method are presented on a separate Component Editor from the subbasin element editor. The "Baseflow" editor is always shown near the "Subbasin" editor. The information shown on the baseflow editor will depend on which method is currently selected.

**Bounded Recession Baseflow**

The bounded recession baseflow method is intended primarily for real-time forecasting operations. The method is very similar to the recession method. The principal difference is that monthly baseflow limits can be specified. The baseflow is computed according to the recession methodology and then the monthly limits are imposed. One difference is that this method does not reset the baseflow after a storm event.

The initial baseflow at the beginning of a simulation must be specified. Two methods are available for specifying the initial condition: initial discharge and initial discharge per area. Using the first method, you must specify the initial baseflow as a discharge with units of volume per time. This method is particularly good when there is observed streamflow data at the outlet of the subbasin for determining the initial flow in the channel. In the second method you specify the initial baseflow as a volume per area per time. This method is better suited when general guidelines for watershed yield must be used to estimate the initial flow.

The recession constant describes the rate at which baseflow recedes between storm events. It is defined as the ratio of baseflow at the current time, to the baseflow one day earlier.

A baseflow value must be entered for the month of January. Likewise, a value must also be entered for each of the remaining months from February to December. This value is used to limit the computed baseflow.
Chapter 6  Watershed Physical Description

Figure 112. Bounded recession baseflow method editor.

Constant Monthly Baseflow

The constant monthly baseflow method allows the specification of a constant baseflow for each month of the year. It does not conserve mass within the subbasin. It is intended primarily for continuous simulation in subbasins where the baseflow is nicely approximated by a constant flow for each month.

A baseflow value must be entered for the month of January. Likewise, a value must also be entered for each of the remaining months from February to December.

Figure 113. Constant monthly baseflow method editor.

Linear Reservoir Baseflow

The linear reservoir baseflow method, as its name implies, uses a linear reservoir to model the recession of baseflow after a storm event. It conserves mass within the subbasin. Infiltration computed by the loss method is connected as the inflow to the linear reservoir. It can be used with one or two layers. When it is used with the soil moisture accounting or gridded soil moisture accounting methods, the infiltration is connected to the lateral outflow of the groundwater layers. For all other loss methods, the computed infiltration is separated equally between the two layers defined in the baseflow method.
Chapter 6 Watershed Physical Description

Figure 114. Linear reservoir baseflow method editor.

The initial baseflow at the beginning of a simulation must be specified. Two methods are available for specifying the initial condition: initial discharge and initial discharge per area. Using the first method, you must specify the initial baseflow as a discharge with units of volume per time. This method is particularly good when there is observed streamflow data at the outlet of the subbasin for determining the initial flow in the channel. In the second method you specify the initial baseflow as a volume per area per time. This method is better suited when general guidelines for watershed yield must be used to estimate the initial flow. The same method must be used for specifying the initial condition for both layers.

The groundwater storage coefficient is the time constant for the linear reservoir in each layer. Since it is measured in hours, it gives a sense of the response time of the subbasin.

The number of groundwater routing steps can be used so that baseflow is routing through several sequential reservoirs. Minimum attenuation is achieved when only one routing step is selected. Attenuation of the baseflow increases as the number of steps increases.

Recession Baseflow

The recession baseflow method is designed to approximate the typical behavior observed in watersheds when channel flow recedes exponentially after an event. This method is intended primarily for event simulation. However, it does have the ability to automatically reset after each storm event and consequently may be used for continuous simulation.

The initial baseflow at the beginning of a simulation must be specified. Two methods are available for specifying the initial condition: initial discharge and initial discharge per area. Using the first method, you must specify the initial baseflow as a discharge with units of volume per time. This method is particularly good when there is observed streamflow data at the outlet of the subbasin for determining the initial flow in the channel. In the second method you specify the initial baseflow as a volume per area per time. This method is better suited when general guidelines for watershed yield must be used to estimate the initial flow.

The recession constant describes the rate at which baseflow recedes between storm events. It is defined as the ratio of baseflow at the current time, to the baseflow one day earlier.
There are two different methods for determining how to reset the baseflow during a storm event: ratio to peak and threshold flow. When using the ratio to peak method, you must specify the flow ratio to the peak. The baseflow is reset when the current flow divided by the peak flow is falls to the specified value. For example, if a ratio of 0.2 is selected, the baseflow will be reset on the receding limb of an event hydrograph when the flow has decreased to 20% of the event peak flow. With the threshold flow method, the baseflow is always reset when the receding limb of the hydrograph falls to a specified flow value, regardless of the peak flow during the previous storm event.

Reach

A reach is an element with one or more inflow and only one outflow. Inflow comes from other elements in the basin model. If there is more than one inflow, all inflow is added together before computing the outflow. Outflow is computed using one of the several available methods for simulating open channel flow. The reach element can be used to model rivers and streams.

Selecting a Route Method

While a reach element conceptually represents a segment of stream or river, the actual calculations are performed by a routing method contained within the reach. A total of six different routing methods are provided. Each of the methods implements a hydrologic routing methodology as compared to a hydraulic approach that implements the full unsteady flow equations. Each method included in the program provides a different level of detail and not all methods are equally adept at representing a particular stream.

The routing method for a reach is selected on the Component Editor for the reach element. Access the Component Editor by clicking the reach element icon on the "Components" tab of the Watershed Explorer. You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open. You can select a routing method from the list of six available choices. If you choose the None method, the reach will translate flow instantaneously and without attenuation. Use the selection list to choose the method you wish to use. Each reach may use a different method or several reaches may use the same method.
Chapter 6 Watershed Physical Description

Figure 116. Reach component editor. All element editors include the basin model and element name, description, and downstream connection. The reach editor also has the routing method selection.

When a new reach is created, it is automatically set to use the default routing method specified in the project options. You may change the routing method for a reach at any time using the Component Editor for the reach element. Since a reach can only use one routing method at a time, you will be warned when changing methods that the old parameter data will be lost. You can turn off this warning in the program settings. You can change the routing method for several reaches simultaneously. Click on the Parameters menu and select the Reach Method command. The routing method you choose will be applied to the selected reaches in the basin model, or to all reaches if none are currently selected.

The parameters for each routing method are presented on a separate Component Editor from the reach element editor. The "Route" editor is always shown next to the "Reach" editor. The information shown on the routing editor will depend on which method is currently selected.

**Kinematic Wave Route**

The kinematic wave routing method approximates the full unsteady flow equations by ignoring inertial and pressure forces. It also is assumed that the energy slope is equal to the bed slope. Consequently, this method is best suited to fairly steep streams. It excels in urban areas where natural channels have been modified to have regular shapes and slopes.

The length should be the total length of the reach element. Usually this value will be measured from maps of the watershed.

The slope should be the average slope for the whole reach. This value may be estimated from maps if they provide sufficient vertical resolution. Field survey data may be necessary to actually determine elevations of the channel bed for calculating the slope. If the slope varies significantly throughout the stream represented by the reach, it may be necessary to use multiple reaches with different slopes.

The Manning's $n$ roughness coefficient should be the average value for the whole reach. This value can be estimated from pictures of streams with known roughness coefficient (Barnes, 1967) or by calibration.
Figure 117. Kinematic wave routing method editor.

The number of subreaches is used as a hint to the program when it determines the correct distance step to use during routing calculations. Criteria based on steepness of the inflow hydrograph and other factors are used to automatically determine the correct distance and time steps for solving the kinematic wave equation. The default value is two.

Five options are provided for specifying the cross section shape: circle, deep, rectangle, trapezoid, and triangle. The circle shape cannot be used for pressure flow or pipe networks, but is suitable for representing a free water surface inside a pipe. The deep shape should only be used for flow conditions where the flow depth is approximately equal to the flow width. Depending on the shape you choose, additional information will have to be entered to describe the size of the cross section shape. This information may include a diameter (circle) bottom width (deep, rectangle, trapezoid) or side slope (trapezoid, triangle). The side slope is dimensionless and entered as the units of horizontal distance per one unit of vertical distance.

**Lag Route**

The lag routing method only represents the translation of flood waves. It does not include any representation of attenuation or diffusion processes. Consequently, it is best suited to short stream segments with a predictable travel time that doesn't vary with flow depth.

The only parameter is the lag time in minutes. Inflow to the reach is delayed in time by an amount equal to the specified lag, and then becomes outflow.

Figure 118. Lag routing method editor.
Modified Puls Route

The modified Puls routing method is often called storage routing or level pool routing. It uses conservation of mass and a relationship between storage and discharge to route flow through the stream reach. Attenuation is achieved through the storage and delayed release of water in the reach instead of through a rigorous conservation of momentum approach. It can be useful for representing backwater due to flow constrictions in a channel so long as the backwater affects are fully contained within the reach.

A storage-discharge function defines the amount of outflow for a specific amount of storage in the reach. Storage is the independent variable and the values entered must cover the entire range of storages that may be encountered during a simulation. Usually the first storage will be zero and the maximum storage should slightly more than the volume in the stream reach when it is at maximum flow. Generally the outflow values corresponding to each storage value are computed with the assistance of a hydraulic model that computes water surface profiles. The function must be monotonically increasing. The storage-discharge function must be defined in the paired data manager before it can be used in the reach element.

The number of subreaches must be entered. It affects attenuation where one subreach gives the maximum attenuation and increasing the number of subreaches approaches zero attenuation. This parameter is necessary because the travel time through a subreach should be approximately equal to the simulation time step. A good estimate is to divide the actual reach length by the product of the wave celerity and the simulation time step. It can also be a calibration parameter in some cases.

There are two options for initial condition: specified discharge, and inflow equals outflow. If you use the first option, you will also have to enter a discharge value. The initial storage in the reach will be calculated from the specified discharge and the storage-discharge function. If you use the second option, it will be assumed that the initial outflow is the same as the initial inflow to the reach from upstream elements. This is essentially the same as assuming a steady-state initial condition. The initial storage will be computed from the first inflow to the reach and storage-discharge function.

Muskingum Route

The Muskingum routing method uses a simple conservation of mass approach to route flow through the stream reach. However, it does not assume that the water surface is level. By assuming a linear, but non-level, water surface it is possible to account for increased storage during the rising side of a flood wave and decreased
storage during the falling side. By adding a travel time for the reach and a weighting
between the influence of inflow and outflow, it is possible to approximate attenuation.

The Muskingum K is essentially the travel time through the reach. It can be
estimated from knowledge of the cross section properties and flow properties. It may
be a calibration parameter in some cases.

The Muskingum X is the weighting between inflow and outflow influence; it ranges
from 0.0 up to 0.5. In practical application, a value of 0.0 results in maximum
attenuation and 0.5 results in no attenuation. Most stream reaches require an
intermediate value found through calibration.

| Basin Name: Post Dam       |
| Element Name: Spring Run   |
| Muskingum K (HR) 1.58      |
| Muskingum X: 0.18          |
| Subreaches: 3              |

Figure 120. Muskingum routing method editor.

The number of subreaches must be entered. It affects attenuation where one
subreach gives more attenuation and increasing the number of subreaches
decreases the attenuation. A good approximation is to divide the reach length by the
product of the wave celerity and the simulation time step.

**Muskingum-Cunge Route**

The Muskingum-Cunge routing method is based on the combination of the
conservation of mass and the diffusion representation of the conservation of
momentum. It is sometimes referred to as a variable coefficient method because the
routing parameters are recalculated every time step based on channel properties and
the flow depth. It does represent attenuation of flood waves and can be used in
reaches with a small slope.

The length should be the total length of the reach element. Usually this value will be
measured from maps of the watershed.

The slope should be the average slope for the whole reach. This value may be
estimated from maps if they provide sufficient vertical resolution. Field survey data
may be necessary to actually determine elevations of the channel bed for calculating
the slope. If the slope varies significantly throughout the stream represented by the
reach, it may be necessary to use multiple reaches with different slopes.

The Manning's n roughness coefficient should be the average value for the whole
reach. This value can be estimated from pictures of streams with known roughness
coefficient (Barnes, 1967) or by calibration.

Five options are provided for specifying the cross section shape: circle, eight point,
rectangle, trapezoid, and triangle. The circle shape cannot be used for pressure flow
or pipe networks, but is suitable for representing a free water surface inside a pipe.
Depending on the shape you choose, additional information will have to be entered to
describe the size of the cross section shape. This information may include a
diameter (circle) bottom width (rectangle, trapezoid) or side slope (trapezoid,
The side slope is dimensionless and entered as the units of horizontal distance per one unit of vertical distance. The eight point shape requires a cross section simplified with only eight station-elevation values. The cross section is usually configured to represent the main channel plus left and right overbank areas. A separate Manning's n value is entered for each overbank. The cross section should extend from the channel invert up to the maximum water surface elevation that will be encountered during a simulation.

**Straddle Stagger Route**

The straddle stagger method uses empirical representations of translation and attenuation processes to route water through a reach. Inflow is delayed a specified amount of time. The delayed flows are average over a specified amount of time to produce the final outflow.

The lag parameter specifies travel time through the reach. Inflow to the reach is delayed in time by an amount equal to the specified lag.

The duration parameter specifies the amount of spreading in a flood peak at it travels through the reach. The delayed inflows are averaged over this specified time duration.
Source

A source is an element with no inflow, one outflow, and is one of only two ways to produce flow in the basin model. The source can be used to represent boundary conditions to the basin model such as measured outflow from reservoirs or unmodeled headwater regions. The boundary condition can also represent contributing area modeled in a separate basin model. Access the Component Editor by clicking the source element icon on the "Components" tab of the Watershed Explorer (Figure 123).

There are two methods for determining the outflow from a source element. The first method is to assume a constant flowrate. The second method is to use a time-series discharge gage.

![Source component editor. All element editors include the basin model and element name, description, and downstream connection. The source editor also has an area and other properties depending on the method.]

**Representative Area**

Specification of a representative area for the source is optional. If the area is specified, then it will be possible for the program to automatically compute drainage area at downstream elements. If the area is not specified, then downstream elements will not have a drainage area. When the source represents a region modeled separately, then the area should be equal to the drainage area at the source location in the watershed. When the source is used to represent a spring, inter-basin transfer, or other movement of water, then the area should usually be set to zero.

If you choose to include a representative area, specify the area on the Component Editor for the source element (Figure 123). Access the Component Editor by clicking the source element icon on the "Components" tab of the Watershed Explorer. You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open.

**Discharge Gage**

When the "Discharge Gage" method is selected for the source, you must select a time-series discharge gage. The gage should record the discharge to use for each time interval during a simulation. If there is missing data in the record and the basin model options are set to replace missing data, a zero flow rate will be substituted for each missing data value. If the basin model is not set to replace missing data, any
missing data will cause the simulation to stop and an error message will be displayed.

The time-series discharge gage must be defined in the time-series manager before it can be used in the source element (Figure 123). Selecting the correct gage is performed on the Component Editor for the source element. Access the Component Editor by clicking the source element icon on the "Components" tab of the Watershed Explorer. You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open.

**Constant Flow**

When the "Constant Flow" method is selected for the source, you must enter a flow rate. The same flowrate is used for all time steps during a simulation. Specify the flow rate on the Component Editor for the source element. Access the Component Editor by clicking the source element icon on the "Components" tab of the Watershed Explorer (Figure 124). You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open.

**Figure 124. Source editor using the constant flow method.**

**Diversion**

A diversion is an element with two outflows, main and diverted, and one or more inflows. Inflow comes from other elements in the basin model. If there is more than one inflow, all inflow is added together before computing the outflows. The amount of diverted outflow is computed from a user-specified, monotonically increasing inflow-diversion relationship. All flow that is not diverted becomes main outflow. Diverted outflow can be connected to an element that is computationally downstream. The diversion can be used to represent weirs that divert flow into canals, flumes, or off-stream storage. The element includes optional properties for limiting the amount of diverted flow. Access the Component Editor by clicking the source element icon on the "Components" tab of the Watershed Explorer (Figure 125).
Inflow-Diversion Function

The inflow-diversion function defines the amount of flow that should be diverted given an amount of inflow. Inflow is the independent variable. The range of inflows specified in the function should cover the complete range of total inflow from upstream elements. Usually the first inflow in the function should be zero. The last inflow should be greater than the maximum anticipated inflow to the element. Diversion flow is the dependent variable and must be specified for each corresponding inflow value. The determination of the correct diversion flow for a specified inflow depends on how the diversion operates. Generally you must compute the diversion for each inflow value using knowledge of the lateral weir or other structure that is represented by the diversion element.

The inflow-diversion function must be defined in the paired data manager before it can be used in the diversion element. Selecting the correct function is performed on the Component Editor for the diversion element. Access the Component Editor by clicking the diversion element icon on the "Components" tab of the Watershed Explorer (Figure 125). You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open.

Connecting Diversion Flow

You may optionally choose to connect the diversion flow to another point in the element network. In this case, the diversion flow can become inflow to a junction or element. This can be useful representing water that is diverted at point location in a watershed, moves through a separate channel network, and rejoins the stream from which it was diverted. Properly configured, it can also be used to represent inter-basin transfers. If you do not connect the diversion flow, then it is removed from the system at the diversion element. In either case, the time-series of diversion flow is shown in the graph and time-series tables for the diversion element. The amount of diversion flow is also shown in the diversion element summary table.

The connection for diversion flow is specified on the Component Editor for the diversion element. Access the Component Editor by clicking the diversion element icon on the "Components" tab of the Watershed Explorer. You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open. The selection list includes all elements that are computationally downstream of the diversion element. Select an element from the list to connect the diversion flow to that element as an inflow, or choose Not Connected.
Limiting Flow or Volume

Two options are available for limiting the amount of water sent through the diversion defined by the inflow-diversion function. If neither option is used, the diversion flow will be determined solely by the inflow-diversion function. If one or both options are used, diversion flow will be computed from the inflow-diversion function then reduced as necessary to meet the option requirements. Specifying the options is accessed from the Component Editor for the diversion element. Access the Component Editor by clicking the diversion element icon on the "Components" tab of the Watershed Explorer (Figure 125). You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open.

The first option for limiting diversion flow is the specification of a maximum volume. Diversion flow is computed normally from the inflow-diversion function and the cumulative volume of diverted flow is tracked. Once the cumulative volume reaches the specified maximum volume, all future diversion flow will be set to zero.

The second option for limiting diversion flow is the specification of a maximum allowed flow. Diversion flow is initially computed from the inflow-diversion function. The flow computed from the function is compared to the specified maximum flow. If the computed flow is above the maximum flow, the diversion flow is reduced to the specified maximum flow.

Reservoir

A reservoir is an element with one or more inflow and one computed outflow. Inflow comes from other elements in the basin model. If there is more than one inflow, all inflow is added together before computing the outflow. It is assumed that the water surface in the reservoir pool is level. Several methods are available for defining the storage properties of the reservoir. The element can be used to model reservoirs, lakes, and ponds. Access the Component Editor by clicking the reservoir element icon on the "Components" tab of the Watershed Explorer (Figure 126).

Selecting a Route Method

While a reservoir element conceptually represents a natural lake or a lake behind a dam, the actual storage routing calculations are performed by a route method.
Chapter 6  Watershed Physical Description

contained within the reservoir. Two different route methods are available. One is designed to represent the reservoir simply with a known storage-outflow relationship. The second method is designed to represent individual components of the outlet works.

The routing method for a reservoir is selected on the Component Editor for the reservoir element. Access the Component Editor by clicking the reservoir element icon on the "Components" tab of the Watershed Explorer. You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open. You can select a route method from the list of two available choices (Figure 126). Use the selection list to choose the method you wish to use.

The parameters for each route method are presented below the method selection list. The exact parameter data displayed in the Component Editor depends on which method is selected. If you choose the Outflow Structures method, additional input will be added to the Component Editor.

**Storage Method**

You must specify the storage characteristics for the reservoir. The exact form of the characteristics will depend on which routing method you select (compare Figure 126 and Figure 127). The Outflow Curve route method can accept three different forms of the storage characteristics: storage-outflow, elevation-storage-discharge, or elevation-area-discharge. The Outflow Structures route method can accept two different forms of the storage characteristics: elevation-storage, or elevation-area. Depending on which routing method you choose, the appropriate choices will be shown in the storage method selection list. Use the selection list to choose the method you wish to use.

You must select appropriate functions to define the selected storage method. For example, if you select the Elevation-Storage method you must select an appropriate elevation-storage paired data function that defines the storage characteristics of the reservoir. If you select the Elevation-Storage-Discharge method, you must select an elevation-storage and a storage-outflow paired data function. Appropriate selection lists will be shown directly under the storage method selection list.

Any necessary paired data functions must be defined in the paired data manager before they can be used in the reservoir. Choose an appropriate function in each selection list. If you wish, you can use a chooser by clicking the paired data button next to the selection list. A chooser will open that shows all of the paired data functions of that type. Click on a function to view its description.
Chapter 6 Watershed Physical Description

Figure 127. Reservoir component editor using the outflow structures routing method with four outlets, one spillway, and one dam top representing an emergency spillway.

Initial Condition

Both routing methods require an initial condition. The exact choices depend on which storage method is selected. Some choices such as initial discharge require you to specify a parameter value as part of selecting that initial condition type. Other choices such as inflow equals outflow do not require any additional parameter data. The available initial conditions for each storage method are shown in Table 21. When the initial elevation is chosen, it should be entered in the same vertical datum as the paired data functions used to describe the storage characteristics of the reservoir.

<table>
<thead>
<tr>
<th>Storage Method</th>
<th>Available Initial Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage-Discharge</td>
<td>Discharge, storage, inflow = outflow</td>
</tr>
<tr>
<td>Elevation-Storage-Discharge</td>
<td>Discharge, storage, elevation, inflow = outflow</td>
</tr>
<tr>
<td>Elevation-Area-Discharge</td>
<td>Discharge, elevation, inflow = outflow</td>
</tr>
<tr>
<td>Elevation-Storage</td>
<td>Storage, elevation, inflow = outflow</td>
</tr>
<tr>
<td>Elevation-Area</td>
<td>Elevation, inflow = outflow</td>
</tr>
</tbody>
</table>

Tailwater Method

The tailwater method only applies to the Outflow Structures routing method (Figure 127). The selected method determines how submergence will be calculated for the individual structures specified as part of the reservoir. When a structure is
submerged, the discharge through the structure will decrease in accordance with the physics of the structure and the tailwater elevation for each time interval. Only one tailwater method can be selected and it is applied to all structures specified as part of the reservoir.

The Assume None method is used in cases where reservoir tailwater has no affect on the reservoir outflow.

The Reservoir Discharge method is typically used with reservoirs that span the stream channel and are not influenced by backwater from downstream sources. For such cases, the tailwater below the reservoir only comes from the reservoir releases. A rating curve defined by an elevation-discharge paired data function must be selected to convert reservoir outflow to stage. The elevation-discharge function must be defined in the paired data manager before it can be used in the reservoir. Choose an appropriate function in the selection list. If you wish, you can use a chooser by clicking the paired data button next to the selection list. The rating curve should be specified in the same vertical datum as the paired data functions used to describe the storage characteristics of the reservoir.

The Downstream Discharge method is typically used with reservoirs that represent an interior pond or pump station, and the outflow from the reservoir will be a significant impact on the downstream stage. In this case, the outflow from the reservoir is combined with all other inflows to the element downstream of the reservoir. That combined inflow is used in combination with a rating curve to determine the stage for the reservoir tailwater. The elevation-discharge function for the rating curve must be defined in the paired data manager before it can be used in the reservoir. Choose an appropriate function in the selection list. If you wish, you can use a chooser by clicking the paired data button next to the selection list. The rating curve should be specified in the same vertical datum as the paired data functions used to describe the storage characteristics of the reservoir.

The Specified Stage method is typically used with reservoirs that represent an interior pond or pump station, and the outflow from the reservoir will have minimal affect on the downstream stage. In this case, the outflow from the reservoir is adjusted for submergence based on the stage specified in a stage time-series gage. The gage must be defined in the time-series data manager before it can be used in the reservoir. Choose an appropriate gage in the selection list. If you wish, you can use a chooser by clicking the gage data button next to the selection list. The stage should be specified in the same vertical datum as the paired data functions used to describe the storage characteristics of the reservoir.

**Outlets**

Outlets can only be included in reservoirs using the Outflow Structures routing method. These typically represent structures near the bottom of the dam that allow water to exit in a controlled manner. They are often called gravity outlets because they can only move water when the head in the reservoir is greater than the head in the tailwater. Up to 10 independent outlets can be included in the reservoir. Select the number of outlets you wish to include. An icon for each outlet will be added to the reservoir icon in the Watershed Explorer. You will need to click on the individual outlet icon to enter parameter data for it. There are two different methods for computing outflow through an outlet: culvert or orifice.

The culvert outlet allows for partially full or submerged flow through a culvert with a variety of cross-sectional shapes. It can account for inlet controlled outflow or outlet control. A typical culvert outlet is shown in Figure 128.
Chapter 6 Watershed Physical Description

Figure 128. Outlet editor with the culvert method selected.

You must select a solution method for the culvert: inlet control, outlet control, or automatic. You may select Inlet Control if it is known that at all times during a simulation the culvert outflow will be controlled by a high pool elevation in the reservoir. You may likewise select Outlet Control if it is known that at all times the culvert outflow will be controlled by a high tailwater condition. In general it is best to select Automatic control and the program will automatically select the controlling inlet or outlet condition.

You must select the number of identical barrels. This can be used to specify several culvert outlets that are identical in all parameters. There can be up to 10 identical barrels.

The shape specifies the cross-sectional shape of the culvert: circular, semi circular, elliptical, arch, high-profile arch, low-profile arch, pipe arch, box, or con span. The shape you choose will determine some of the remaining parameters in the Component Editor. The parameters you will need to enter are shown in Table 22.

The chart specifies the FHWA chart identification number. Only the charts that apply to the selected shape will be shown in the selection list (Figure 128).

The scale specifies the FHWA scale identification number. Only the scales that apply to the selected chart number will be shown in the selection list.

The length of the culvert must be specified. This should be the overall length of the culvert including any projection at the inlet or outlet.
Table 22. Listing of which parameters are required for each cross section shape.

<table>
<thead>
<tr>
<th>Cross Section Shape</th>
<th>Diameter</th>
<th>Rise</th>
<th>Span</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circular</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Semi Circular</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elliptical</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Arch</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>High-Profile Arch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low-Profile Arch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pipe Arch</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Box</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Con Span</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

The inlet elevation must be specified as the invert elevation at the bottom of the culvert on the inlet side. The inlet side is always assumed to be in the reservoir pool. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

The entrance coefficient describes the energy loss as water moves into the inlet of the culvert. Values may range from 0.2 up to 1.0.

The exit coefficient describes the energy loss that occurs when water expands as it leaves the culvert outlet. Typically the value is 1.0.

The outlet elevation must be specified as the invert elevation at the bottom of the culvert on the outlet side. The outlet side is always assumed to be in the reservoir tailwater. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

A Manning's n value should be entered that describes the roughness in the culvert. At this time, the same n value must be used for the entire length of the culvert, as well the entire top, sides, and bottom.

The orifice outlet assumes sufficient submergence on the outlet for orifice flow conditions to dominate. It should not be used to represent an outlet that may flow only partially full. The inlet of the structure should be submerged at all times by a depth at least 0.2 times the diameter. A typical orifice outlet editor is shown in Figure 129.

![Outlet editor with the orifice method selected.](image)

Figure 129. Outlet editor with the orifice method selected.
The center elevation specifies the center of the cross-sectional flow area. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir. It is used to compute the head on the outlet, so no flow will be released until the reservoir pool elevation is above this specified elevation.

The cross-sectional flow area of the outlet must be specified. The orifice assumptions are independent of the shape of the flow area.

The dimensionless discharge coefficient must be entered. This parameter describes the energy loss as water exits the reservoir through the outlet.

**Spillways**

Spillways can only be included in reservoirs using the Outflow Structures routing method. These typically represent structures at the top of the dam that allow water to go over the dam top in a controlled manner. Up to 10 independent spillways can be included in the reservoir. Select the number of spillways you wish to include. An icon for each spillway will be added to the reservoir icon in the Watershed Explorer. You will need to click on the individual outlet icon to enter parameter data for it. There are two different methods for computing outflow through a spillway: broad-crested or ogee.

The broad-crested spillway allows for controlled flow over the top of the reservoir according to the weir flow assumptions. A typical broad-crested spillway editor is shown in Figure 130.

The crest elevation of the spillway must be specified. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

The length of the spillway must be specified. This should be the total width through which water passes.

The discharge coefficient accounts for energy losses as water enters the spillway, flows through the spillway, and eventually exits the spillway. Typical values range from 2.6 to 4.0 depending on the exact shape of the spillway.

![Figure 130](image)

**Figure 130. Spillway editor with the broad-crested method selected.**

The ogee spillway allows for controlled flow over the top of the reservoir according to the weir flow assumptions. However, the discharge coefficient in the weir flow equation is automatically adjusted when the upstream energy head is above or below the design head. A typical ogee spillway editor is shown in Figure 131.
The ogee spillway may be specified with concrete or earthen abutments. These abutments should be the dominant material at the sides of the spillway above the crest. The selected material is used to adjust energy loss as water passes through the spillway.

The ogee spillway is assumed to have an approach channel that moves water from the main reservoir to the spillway. If there is such an approach channel, you must specify the depth of the channel, and the energy loss that occurs between the main reservoir and the spillway. If there is no approach channel, the depth should be the different between the spillway crest and the bottom of the reservoir, and the loss should be zero.

The crest elevation of the spillway must be entered. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

The crest length of the spillway must be specified. This should be the total width through which water passes.

![Figure 131. Spillway editor with the ogee method selected.](image)

The apron elevation is the elevation at the bottom of the ogee spillway structure. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

The apron width must be specified. This should be the total width of the spillway bottom.

The design head is the total energy head for which the spillway is designed. The discharge coefficient will be automatically calculated when the head on the spillway departs from the design head.

**Dam Tops**

Dam tops can only be included in reservoirs using the Outflow Structures routing method. These typically represent the top of the dam, above any spillways, where water goes over the dam top in an uncontrolled manner. In some cases it may
represent an emergency spillway. Up to 10 independent dam tops can be included in the reservoir. Select the number of dam tops you wish to include. An icon for each dam top will be added to the reservoir icon in the Watershed Explorer. You will need to click on the individual dam top icon to enter parameter data for it. There are two different methods for computing outflow through a dam top: level or non-level.

The level dam top assumes flow over the dam can be represented as a broad-crested weir. The calculations are essentially the same as for a broad-crested spillway. They are included separately mostly for conceptual representation of the reservoir structures. A typical level dam top is shown in Figure 132.

The crest elevation of the dam top must be specified. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

The length of the dam top must be specified. This should be the total width through which water passes, excluding any amount occupied by spillways if any are included.

The discharge coefficient accounts for energy losses as water approaches the dam top and flows over the dam. Typical values range from 2.6 to 4.0 depending on the exact shape of the dam top.

![Figure 132. Dam top editor with the level overflow method selected.](image)

The non-level dam top assumes that the top of the dam can be well-represented by a cross section with eight station-elevation pairs. A separate flow calculation is carried
out for each segment of the cross section. The broad-crested weir assumptions are made for each segment. A typical non-level dam top is shown in Figure 133.

A cross section must be selected which describes the shape of the top of the dam with a simplified eight point shape. From abutment to abutment of the dam, but should not include any spillways that may be included. It may be necessary to use multiple dam tops to represent the different sections of the dam top between spillways. The cross section should extend from the dam top up to the maximum water surface elevation that will be encountered during a simulation. The cross section must be defined in the paired data manager before it can be used in the reservoir element.

The discharge coefficient accounts for energy losses as water approaches the dam top and flows over the dam. The same value is used for all segments of the dam top. Typical values range from 2.6 to 4.0 depending on the exact shape of the dam top.

**Pumps**

Pumps can only be included in reservoirs using the Outflow Structures routing method. These typically represent pumps in interior ponds or pump stations that are intended to move water out of the reservoir and into the tailwater when gravity outlets alone cannot move sufficient water. Up to 10 independent pumps can be included in the reservoir. Select the number of pumps you wish to include. An icon for each pump will be added to the reservoir icon in the Watershed Explorer. You will need to click on the individual pump icon to enter parameter data for it. There is only one method for computing outflow through a pump: head-discharge pump.

The head-discharge pump is designed for representation of low-head, high-flow situations. This means that the pump is designed for high flow rates against a relatively small head. The pump can be controlled to come on and shut off as the reservoir pool elevation changes. A typical head-discharge pump is shown in Figure 134.

The intake elevation defines the elevation in the reservoir pool where the pump takes in water. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

![Figure 134. Pump editor with the head-discharge method selected.](image-url)
The discharge elevation defines the elevation in the reservoir tailwater where the pump discharges water. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

You must specify the elevation when the pump turns on. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir. Once the pump turns on, it will remain on until the reservoir pool elevation drops below the trigger elevation to turn the pump off.

You must specify the elevation when the pump turns off. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir. This elevation must be lower than the elevation at which the pump turns on.

The specification of a minimum rest time is optional. If it is used, once a pump shuts off it must remain off the specified minimum rest time even if the reservoir pool elevation reaches the trigger elevation to turn the pump on.

The specification of a minimum run time is optional. If it is used, once a pump turns on it must remain on the specified minimum run time even if the reservoir pool elevation drops below the trigger elevation to turn the pump off. The only exception is if the pool elevation drops below the intake elevation, then the pump will shut off even though the minimum run time is not satisfied.

The equipment loss includes all energy losses between the intake and discharge points, including the pump itself. This loss is added to the head difference due to reservoir pool elevation and tailwater elevation to determine the total energy against which the pump must operate.

The head-discharge curve describes the pumping capability of the pump as a function of the total head. Total head is the head difference due to reservoir pool elevation and tailwater elevation, plus equipment loss. A curve must be defined as an elevation-discharge function in the paired data manager before it can be selected for a pump in the reservoir. You can press the paired data button next to the selection list to use a chooser. The chooser shows all of the available elevation-discharge functions in the project. Click on a function to view its description.

**Dam Break**

Dam break can only be included in reservoirs using the Outflow Structures routing method. Only one dam break can be included in the reservoir. Choose whether you wish to include dam break. An icon for the dam break will be added to the reservoir icon in the Watershed Explorer. You will need to click on the dam break icon to enter parameter data for it. There are two different methods for computing outflow through a dam break: overtop and piping.

The overtop dam break is designed to represent failures caused by overtopping of the dam. These failures are most common in earthen dams but may also occur in concrete arch, concrete gravity, or roller compacted dams as well. The failure begins when appreciable amounts of water begin flowing over or around the dam face. The flowing water will begin to erode the face of the dam. Once erosion begins it is almost impossible to stop the dam from failing. The method begins the failure at a point on the top of the dam and expands it in a trapezoidal shape until it reaches the maximum size. Flow through the expanding breach is modeled as weir flow.

The top elevation is the top of the dam face. The breach may be initiated at a lower elevation than the top depending on the selection of the trigger. This information is
used to constrain the top of the breach opening as it grows. It should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

The bottom elevation defines the elevation of the bottom of the trapezoidal opening in the dam face when the breach is fully developed. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

The bottom width defines the width of the bottom of the trapezoidal opening in the dam face when the breach is fully developed.

The left side slope is dimensionless and entered as the units of horizontal distance per one unit of vertical distance. The right side slope is likewise dimensionless and entered as the units of horizontal distance per one unit of vertical distance.

The development time defines the total time for the breach to form, from initiation to reaching the maximum breach size. It should be specified in hours.

There are three methods for triggering the initiation of the failure: elevation, duration at elevation, and specific time. Depending on the method you choose, additional parameters will be required. For the Elevation method, you will enter an elevation when the failure should start. The breach will begin forming as soon as the reservoir pool elevation reaches that specified elevation. For the Duration at Elevation method, you will enter an elevation and duration to define when the failure should start. The reservoir pool will have to remain at or above the specified elevation for the specified duration before the failure will begin. For the Specific Time method, the breach will begin opening at the specified time regardless of the reservoir pool elevation. When specifying an elevation, it should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

Figure 135. Dam break editor with the overtop breach method selected.
The progression method determines how the breach grows from initiation to maximum size during the development time. Select the Linear method to have the breach grow in equal increments of depth and width. Select the Sine Wave method to have the breach grow quickly in the early part of breach development and more slowly as it reaches maximum size. The speed varies according to the first quarter cycle of a sine wave. Select the User Curve method to have the breach grow according to a specified pattern. You will need to select a curve in the selection list, which will show all percentage curves defined in the paired data manager. The independent variable should range from 0 to 100 percent and define the percentage of the development time. The dependent variable should define the percentage opening of the maximum breach size. The function must be monotonically increasing.

The piping dam break is designed to represent failures caused by piping inside the dam. These failures typically occur only in earthen dams. The failure begins when water naturally seeping through the dam core increases in velocity and quantity enough to begin eroding fine sediments out of the soil matrix. If enough material erodes, a direct piping connect may be established from the reservoir water to the dam face. Once such a piping connect is formed it is almost impossible to stop the dam from failing. The method begins the failure at a point in the dam face and expands it as a circular opening. When the opening reaches the top of the dam, it continues expanding as a trapezoidal shape. Flow through the circular opening is modeled as orifice flow while in the second stage it is modeled as weir flow.

The piping dam break uses many of the same parameters and the overtop dam break. The top elevation, bottom elevation, bottom width, left slope, and right slope all are used to describe a trapezoidal breach opening that will be the maximum opening in the dam. These are only used once the piping opening transitions to an open breach. The parameters for development time, trigger method, and progression method are also the same for defining when the failure initiates, how long it takes to attain maximum breach opening, and how the breach develops during the development time. The remaining parameters, unique to piping dam break, are described below.
Figure 136. Dam break editor with the piping breach method selected.

The piping elevation indicates the point in the dam where the piping failure first begins to form. This should be measured in the same vertical datum as the paired data functions defining the storage characteristics of the reservoir.

The piping coefficient is used to model flow through the piping opening as orifice flow. As such, the coefficient represents energy losses as water moves through the opening.

**Junction**

A junction is an element with one or more inflows and only one outflow. All inflow is added together to produce the outflow by assuming zero storage at the junction. It is usually used to represent a river or stream confluence.

The junction element does not have any special data or properties; it only has the standard Component Editor used by all elements. Access the Component Editor by clicking the junction element icon on the "Components" tab of the Watershed Explorer (Figure 137). You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open.

Figure 137. Junction component editor.
Sink

A sink is an element with one or more inflows but no outflow. Multiple inflows are added together to determine the total amount of water entering the element. Sinks can be used to represent the lowest point of an interior drainage area or the outlet of the basin model.

The sink element does not have any special data or properties; it only has the standard Component Editor used by all elements. Access the Component Editor by clicking the sink element icon on the "Components" tab of the Watershed Explorer (Figure 138). You can also access the Component Editor by clicking on the element icon in the basin map, if the map is currently open.

![Sink component editor](image)

Figure 138. Sink component editor.

References


CHAPTER 7

Meteorology Description

This chapter describes how meteorology information is entered into the program using a meteorologic model. The meteorologic model is responsible for preparing the boundary conditions that act on the watershed during a simulation. Consequently, a meteorologic model is prepared for use with one or more basin models. If the basin model contains subbasin elements, then the meteorologic model must specify how precipitation will be generated for each subbasin. Snowmelt may optionally be included if environmental conditions require it. Evapotranspiration should be included if the basin model is configured for continuous simulation using any of the following loss methods: deficit constant, gridded deficit constant, soil moisture accounting, gridded soil moisture accounting.

Meteorologic Models

Meteorologic models are one of the main components in a project. Their principle purpose is to prepare meteorologic boundary conditions for subbasins. Consequently, you must usually create at least one basin model before creating a meteorologic model. A meteorologic model can be used with many different basin models. However, results computed by the meteorologic model will be matched with the subbasins in the basin models using the name of the subbasin. If subbasins in different basin models have the same name, they will both receive the same boundary conditions from the meteorologic model. To avoid this, you can rename the subbasins so that separate boundary conditions are computed for each one.

Creating a New Meteorologic Model

A new meteorologic model is created using the Meteorologic Model Manager. To access the manager, click on the Components menu and select the Meteorologic Model Manager command. The manager will open and show all of the meteorologic models currently in the project. The manager can remain open while you manage meteorologic models or while you perform tasks elsewhere in the program. You can close the manager using the X button in the upper right corner. The buttons to the right of the model list can be used to manage existing models or create a new one. To create a new meteorologic model, press the New button. After you press the button a window (Figure 139) will open where you can name and describe the new meteorologic model that will be created. A default name is provided for the new model; you can use the default or replace it with your own choice. A description can also be entered. If the description is long, you can press the button to the right of the description field to open an editor. The editor makes it easier to enter and edit long descriptions. When you are satisfied with the name and description, press the Create button to finish the process of creating the new meteorologic model. You cannot press the Create button if no name is specified for the new model. If you change your mind and do not want to create a new meteorologic model, press the Cancel button or the X button in the upper right to return to the Meteorologic Model Manager window.
Copying a Meteorologic Model

There are two ways to copy a meteorologic model. Both methods for copying a model create an exact duplicate with a different name. Once the copy has been made it is independent of the original and they do not interact.

The first way to create a copy is to use the Meteorologic Model Manager, which is accessed from the Components menu. Select the meteorologic model you wish to copy by clicking on it in the list of current meteorologic models. The selected model is highlighted after you select it. After you select a model you can press the Copy… button on the right side of the window. A new Copy Meteorologic Model window (Figure 140) will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected meteorologic model. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected meteorologic model, press the Cancel button or the X button in the upper right to return to the Meteorologic Model Manager window.

The second way to copy is from the "Components" tab of the Watershed Explorer. Move the mouse over the meteorologic model you wish to copy, then press the right mouse button (Figure 141). A context menu is displayed that contains several choices including copy. Click the Create Copy… command. A new Copy Meteorologic Model window will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected meteorologic model. You cannot press the Copy
button if no name is specified. If you change your mind and do not want to copy the
selected meteorologic model, press the **Cancel** button or the X button in the upper
right of the Copy Meteorologic Model window to return to the Watershed Explorer.

![Figure 141. Copying a meteorologic model from the Watershed Explorer. The
Copy Meteorologic Model window will appear after the Create Copy... menu command is selected.](image)

Renaming a Meteorologic Model

There are two ways to rename a meteorologic model. Both methods for renaming a
model change its name and then all references to the old model name are
automatically updated to the new name.

The first way to perform a rename is to use the Meteorologic Model Manager, which
you can access from the **Components** menu. Select the meteorologic model you
wish to rename by clicking on it in the list of current meteorologic models. The
selected model is highlighted after you select it. After you select a model you can
press the **Rename...** button on the right side of the window. A new Rename
Meteorologic Model window (Figure 142) will open where you can provide the new
name. If you wish you can also change the description at the same time. If the new
description will be long, you can use the button to the right of the description field to
open an editor. When you are satisfied with the name and description, press the
**Rename** button to finish the process of renaming the selected meteorologic model.
You cannot press the **Rename** button if no name is specified. If you change your
mind and do not want to rename the selected meteorologic model, press the **Cancel**
button or the X button in the upper right of the Rename Meteorologic Model window
to return to the Meteorologic Model Manager window.

![Figure 142. Renaming a meteorologic model. This was accessed from the
Meteorologic Model Manager.](image)
The second way to rename is from the "Components" tab of the Watershed Explorer. Select the meteorologic model you wish to rename by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected model and click the right mouse button. Select the Rename... command from the menu and the highlighted name will change to editing mode as shown in Figure 143. You can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished changing the name, press the Enter key to finalize your choice. You can also finalize your choice by clicking elsewhere on the "Components" tab. If you change your mind while in editing mode and do not want to rename the selected meteorologic model, press the Escape key.

Deleting a Meteorologic Model

There are two ways to delete a meteorologic model. Both methods for deleting a model remove it from the project and then automatically update all references to that model. Once a model has been deleted it cannot be retrieved or undeleted. Any references to the deleted model will switch to using no meteorologic model, which is usually not a valid choice during a simulation. At a later time you will have to go to those components and manually select a different meteorologic model.

The first way to perform a deletion is to use the Meteorologic Model Manager, which you can access from the Components menu. Select the meteorologic model you wish to delete by clicking on it in the list of current meteorologic models. The selected model is highlighted after you select it. After you select a model you can press the Delete button on the right side of the window (Figure 144). A window will open where you must confirm that you wish to delete the selected model. Press the OK button to delete the model. If you change your mind and do not want to delete the selected meteorologic model, press the Cancel button or the X button in the upper right to return to the Meteorologic Model Manager window.

The second way to delete is from the "Components" tab of the Watershed Explorer. Select the meteorologic model you wish to delete by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected model and click the right mouse button (Figure 145). A context menu is displayed that contains several choices including delete. Click the Delete command. A window will open where you must confirm that you wish to delete the selected model. Press the OK button to delete the model. If you change your mind and do not want to delete the selected meteorologic model, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.
Chapter 7  Meteorology Description

Figure 144. Preparing to delete a meteorologic model from the Meteorologic Model Manager. A confirmation will be required after pressing the Delete button.

Figure 145. Deleting a meteorologic model in the Watershed Explorer.

**Importing a Meteorologic Model**

You can import an existing meteorologic model into the current project. The model must have been created previously and stored on your computer or an accessible network location. Click the File menu and select the Import ⇒ Meteorologic Model command. A file browser will open that you can use to find the model you wish to import. The browser will only allow you to select meteorologic model files which end with the MET extension. When you click on a meteorologic model file in the browser, the description of the model is shown on the right side of the browser. Once you have located and selected the desired meteorologic model, press the Select button. If you change your mind, you can press the Cancel button or the X button in the upper right to return to the main program window without importing a model. After you make your selection, the program automatically copies the selected file into the project folder and adds it to the list of current meteorologic models.
Precipitation Method

There are seven different precipitation methods or you can choose to have no precipitation. If you plan to use the meteorologic model with basin models that contain subbasins, you must choose a precipitation method. If any of the subbasins use the ModClark gridded transform method you must use the gridded precipitation method. You can use the "no precipitation" option if the basin models do not contain subbasins.

Select the precipitation method in the Component Editor for the meteorologic model (Figure 146). Only one precipitation method can be selected at a time. You can always change the precipitation method. When you change the precipitation method, all data for the old method is deleted and cannot be retrieved or undeleted.

Evapotranspiration Method

There are three different evapotranspiration methods or you can choose to have no evapotranspiration. If you plan to use the meteorologic model with basin models that contain subbasins, you may need to choose an evapotranspiration method. The following loss methods require evapotranspiration boundary conditions: deficit constant, gridded deficit constant, soil moisture accounting, gridded soil moisture accounting. If you use a meteorologic model with subbasins using any of those loss methods, you should select an evapotranspiration method. If you use those loss methods but no evapotranspiration method is selected in the meteorologic model, then evapotranspiration is assumed to be zero in the subbasins. If any of the subbasins use the ModClark gridded transform method you must use a gridded evapotranspiration method.

Select the evapotranspiration method in the Component Editor for the meteorologic model (Figure 146). Only one evapotranspiration method can be selected at a time. You can always change the evapotranspiration method. When you change the evapotranspiration method, all data for the old method is deleted and cannot be retrieved or undeleted.
Some evapotranspiration methods require parameter data for each subbasin. Other methods use the same data for all subbasins. Depending on the method you choose, the *Watershed Explorer* will be updated to indicate which data is required.

**Snowmelt Method**

There are two different snowmelt methods or you can choose to have no snowmelt. Snowmelt is only required if you plan to use the meteorologic model with basin models that contain subbasins and the watershed receives precipitation as snow, or as both rain and snow. The precipitation method is responsible for estimating the total depth of combined rain and snow. The snowmelt method determines if precipitation is rain or snow, and tracks the accumulation and melt of the snowpack. If any of the subbasins use the ModClark gridded transform method you must use a gridded snowmelt method.

Select the snowmelt method in the *Component Editor* for the meteorologic model (Figure 146). Only one snowmelt method can be selected at a time. You can always change the snowmelt method. When you change the snowmelt method, all data for the old method is deleted and cannot be retrieved or undeleted.

Some snowmelt methods require parameter data for each subbasin, and for elevation bands within each subbasin. Other methods use the same data for all subbasins. Depending on the method you choose, the *Watershed Explorer* will be updated to indicate which data is required.

**Unit System**

Each meteorologic model must be in either United States customary units (sometimes called English units) or in system international units (also called metric units). All parameter data in a meteorologic model, whether for all subbasins or individual subbasins, must be in the same unit system. If you change the unit system, all data will be automatically converted to the new unit system. All time-series data, paired data, and gridded data referenced in a meteorologic model will be in its own unit system. If necessary, these referenced data are automatically converted to the unit system of the meteorologic model during a simulation.

Select the unit system using the *Component Editor* for the meteorologic model (Figure 146). Access the *Component Editor* by clicking on the meteorologic model icon on the "Components" tab of the *Watershed Explorer*. If you change the unit system, all data is automatically converted to the new selection.

**Selecting Basin Models**

The main purpose of a meteorologic model is to prepare meteorologic boundary conditions for subbasins. These boundary conditions include precipitation and potential evapotranspiration. In the case of precipitation, the model is actually computing liquid water available at the soil surface. When precipitation falls as rain, all precipitation is immediately available at the soil surface. When precipitation falls as snow, it generally will not be immediately available. Instead, the snow accumulates in a snowpack and melts at a rate determined by atmospheric conditions. Water released by the melting snowpack is also available at the soil surface. In the case of evapotranspiration, the potential amount is computed by the meteorologic model based on atmospheric conditions. Subbasins use the liquid water available at the soil surface and the potential evapotranspiration to determine infiltration and surface runoff. Actual evapotranspiration is determined by considering the actual water available in and above the soil to meet the potential demand.
Chapter 7 Meteorology Description

Figure 147. Specifying which basin models should be used with a meteorologic model. The meteorologic model will be setup to work with all of the subbasins in the selected basin models.

The meteorologic model must be configured to compute precipitation and possibly evapotranspiration and snowmelt for subbasins. This is accomplished by specifying which basin models will be used with each meteorologic model as shown in Figure 147. Once a basin model is selected to work with a meteorologic model, the subbasins are connected to the meteorologic model. The connection is performed using the name of the subbasin. If several basin models all include a subbasin with the same name, the meteorologic model will compute the same boundary conditions for the subbasin in each model. If you want each subbasin to have unique boundary conditions, then the name of the subbasin must be unique across all basin models that will be used with the same meteorologic model.

Once a basin model is selected to work with a meteorologic model, the meteorologic model is automatically kept synchronized with changes in that basin model. When a basin model is renamed it is updated in all meteorologic models working with that basin model. When a basin model is deleted, any subbasins it contains are removed from all meteorologic models working with that basin model. However, subbasins will not be removed from a meteorologic model when a basin model is deleted if the subbasins are also included in other basin models still used by the meteorologic model. Subbasins are likewise removed if a basin model is unselected from a meteorologic model. Similar changes are also made automatically when subbasins are added to or deleted from a basin model set to work with a meteorologic model, or when they are renamed. Subbasins added to a basin model will be automatically added to all meteorologic models set to work with that basin model. Subbasins deleted from a basin model will be removed from all meteorologic models set to work with that basin model, so long as the subbasin in not included in any other basin models connected to a meteorologic model. Finally, renamed subbasins will also be renamed in the meteorologic model. However, if other basin models connected to the meteorologic model contain subbasins with the same name as the old name of the renamed subbasin, they will retain their original name and parameter data while the rename subbasin receives a copy of the data.

The "Basins" tab, part of the Component Editor for the meteorologic model, is used to connect basin models to the meteorologic model. The "Basins" tab shows a table of all current basin models in the project. Each basin model can be selected or unselected to work with the meteorologic model. The table is automatically updated as basin models are created, renamed, or deleted.
Precipitation

Precipitation is one of the three components of a meteorologic model, and the one required in almost all meteorologic models. The only time precipitation is not required is if a basin model contains no subbasins. Any basin model that contains at least one subbasin can only be used in a simulation with a meteorologic model that includes a precipitation method. Some of the method choices are designed to work with statistical data. Others are designed to work with gage data. Regardless of the supporting data source, the precipitation method produces a hyetograph at the correct time step for each subbasin.

Frequency Storm

The frequency storm method is designed to produce a synthetic storm from statistical precipitation data. The most common source of statistical data in the United States is the National Weather Service. Typically the data is given in the form of maps, where each map shows the expected precipitation depth for a storm of specific duration and exceedance probability. This method is designed to use data collected from the maps along with other information to compute a hyetograph for each subbasin.

This method uses the same parameter data for all subbasins in the meteorologic model. The Watershed Explorer will show the precipitation icon one level under the meteorologic model (Figure 148). Click on the icon to access the Component Editor for the frequency storm (Figure 149).

Each storm has a single exceedance probability which must be selected from the list of available choices. The choices range from 0.2 to 50 percent and generally match the precipitation maps that are commonly available. Please note that return interval is not used in the program.

The frequency storm method is designed to accept partial duration precipitation data, as this is the most common type. However, the method is capable of computing either annual or partial-duration output. You must select the type of output you wish the program to compute. The difference between annual and partial-duration output is small for exceedance probabilities 4% and smaller; you can must select the output type when the 10%, 20% or 50% exceedance probability is selected. The default selection is annual duration.

Figure 148. A meteorologic model using the frequency precipitation method with the precipitation node shown.
### Precipitation Editor for All Subbasins when the Frequency Storm Method is Selected

<table>
<thead>
<tr>
<th>Name: 1% Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Probability:</strong></td>
</tr>
<tr>
<td><strong>Output Type:</strong></td>
</tr>
<tr>
<td><strong>Intensity Duration:</strong></td>
</tr>
<tr>
<td><strong>Storm Duration:</strong></td>
</tr>
<tr>
<td><strong>Intensity Position:</strong></td>
</tr>
<tr>
<td><strong>Storm Area (MI2):</strong></td>
</tr>
<tr>
<td><strong>5 Minutes (IN):</strong></td>
</tr>
<tr>
<td><strong>15 Minutes (IN):</strong></td>
</tr>
<tr>
<td><strong>1 Hour (IN):</strong></td>
</tr>
<tr>
<td><strong>2 Hours (IN):</strong></td>
</tr>
<tr>
<td><strong>3 Hours (IN):</strong></td>
</tr>
<tr>
<td><strong>6 Hours (IN):</strong></td>
</tr>
<tr>
<td><strong>12 Hours (IN):</strong></td>
</tr>
</tbody>
</table>

**Figure 149.** Precipitation editor for all subbasins when the frequency storm method is selected.

The intensity duration specifies the shortest time period of the storm. Usually the duration should be set equal to the time step of the simulation. It must be less than the total storm duration.

Storm duration determines how long the precipitation will last. It must be longer than the intensity duration. If the simulation duration is longer than the storm duration, all time periods after the storm duration will have zero precipitation.

The intensity position determines where in the storm the period of peak intensity will occur. Changing the position does not change the total depth of the storm, it only changes how the total depth is distributed in time during the storm. You may select 25%, 33%, 50%, 67%, or 75% from the list of choices. If the storm duration is selected to be 6 hours and the 25% position is selected, the peak intensity will occur 1.5 hours after the beginning of the storm. The default selection is 50%.

The storm area is used to automatically compute the depth-area reduction factor. In most cases the specified storm area should be equal to the watershed drainage area at the point of evaluation. The same hyetograph is used for all subbasins. Optionally you may leave the storm area blank. When no storm area is specified, each subbasin will have a different hyetograph computed using the subbasin area as the storm area.

Precipitation depth values must be entered for all durations from the peak intensity to the total storm length. Values for durations less than the peak intensity duration, or greater than the total storm duration cannot be entered. The values must be entered as partial-duration data. Values should be entered as the total precipitation depth expected for the specified duration.
Gage Weights

The gage weights method is designed to work with recording and non-recording precipitation gages. Recording gages typically measure precipitation as it occurs and then the raw data are converted to a regular time step, such as 1 hour. Non-recording gages usually only provide an estimate of the total storm depth. The user can choose any method to develop the weights applied to each gage when calculating the hyetograph for each subbasin. For increased flexibility, the total storm depth and the temporal pattern are developed separately for each subbasin. Optionally, an index depth can be assigned to each gage and subbasin. The index is used to adjust for regional bias in annual or monthly precipitation.

This method uses separate parameter data for each gage used to compute precipitation and also uses separate parameter data for each subbasin in the meteorologic model. Because of the separate data and special options (Figure 150), there are multiple tabs in the Component Editor for this method. The Watershed Explorer may show a precipitation icon one level under the meteorologic model, depending on options. It will always show a precipitation gages icon one level under the meteorologic model. It will also always show a separate precipitation icon under each subbasin icon, as shown in Figure 151. Click on any of the icons to access the Component Editor for that portion of the gage weights method.

![Figure 150. Selecting options for the gage weights precipitation method.](image)

The gage weights precipitation icon is only shown one level under the meteorologic model icon when the “Use Indexing” option is enabled. You can enable and disable the indexing option from the "Options" tab of the Component Editor for the
meteorologic model (Figure 150). To access the options editor, click on the meteorologic model icon in the Watershed Explorer and then click on the "Options" tab in the Component Editor. If you decide to use indexing and turn on the option, the gage weight precipitation icon will appear. Click on the icon to access the Component Editor. The editor contains a table of all subbasins in the meteorologic model with a separate row for each subbasin (Figure 152). For each subbasin you can enter an index depth. The

<table>
<thead>
<tr>
<th>Subbasins</th>
<th>Name: Gage Wts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deer Cr</td>
<td>Index (MM)</td>
</tr>
<tr>
<td>Falle Local</td>
<td>988</td>
</tr>
<tr>
<td>West Branch Local</td>
<td>945</td>
</tr>
</tbody>
</table>

*Figure 152. Specifying indices for each subbasin using average annual precipitation depth. Other methods may be used to estimate the index.*

index depth is usually used to account for regional trends in annual or monthly average precipitation. If you enter an index for a subbasin, all precipitation gages used with that subbasin must also have a specified index or else indexing is ignored for that subbasin.

The precipitation gages icon is always shown one level under the meteorologic model icon. When the Use Indexing option and Total Override option are both turned off, the Component Editor for the precipitation gages only shows information for total storm gages. If one or both of the options are turned on, the Component Editor shows information for time-series and total storm gages. The "Time-Series Gages" tab (Figure 153) shows all currently defined precipitation gages in the Time-Series Data Manager. The "Total Storm Gages" tab (Figure 154) shows the gages that have been defined in the meteorologic model.

<table>
<thead>
<tr>
<th>Time-Series Gages</th>
<th>Total Storm Gages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Gage Wts</td>
<td></td>
</tr>
<tr>
<td>Gage Name</td>
<td>Total Depth (MM)</td>
</tr>
<tr>
<td>193472</td>
<td></td>
</tr>
<tr>
<td>193475</td>
<td></td>
</tr>
<tr>
<td>193476</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 153. Entering optional total depth and index for the precipitation gages.*
Figure 154. Creating a total storm gage and entering the total storm depth and optional index.

Total depth can be optionally entered for time-series gages. If no total depth is entered, the depth will be the sum of the data actually stored in the precipitation gage. However, if a total depth is entered, the exact pattern is maintained but the magnitude of precipitation at each time step is adjusted so that the specified depth is applied over the entire simulation. Total depth can be specified for no time-series gages, one gage, many gages, or all gages. Total depth is always required for a total storm gage. Turning off the "Total Override" option will delete all total depth information from the meteorologic model.

An index can be optionally entered for time-series gages or total storm gages. If you enter an index for a gage, it can only be used during a simulation if all gages used in a subbasin and the subbasin itself specify an index. Turning off the Use Indexing option will delete all indexes from the meteorologic model.

Total storm gages are created and managed directly from the meteorologic manager. To create a new total storm gage, access the "Total Storm Gages" tab and enter a gage name in the first column of the last row. The last row is always kept blank for creating new gages. You can rename a gage by typing over the name in the first column. You can delete a gage by deleting its name from the first column and any data from the other columns. You must always enter a total depth for the gage that represents the total precipitation during the simulation.

The parameter data describing which gages to use and what weights to apply is specified separately for each subbasin. The Watershed Explorer will show all subbasins in the meteorologic model and one level under each subbasin will be a precipitation icon. Click on the icon to access the Component Editor for specifying which gages to use and the weights for each gage.

The "Gage Selections" tab is where the gages are specified (Figure 155). All of the available gages are shown in a table. The available gages are the precipitation time-series gages defined in the Time-Series Data Manager plus any total storm gages defined in the meteorologic model. For each subbasin you must separately select which gages will be used for that subbasin.
Figure 155. Selecting which gages to use for a subbasin.

<table>
<thead>
<tr>
<th>Gage Name</th>
<th>Use Gage</th>
</tr>
</thead>
<tbody>
<tr>
<td>193472</td>
<td>Yes</td>
</tr>
<tr>
<td>193475</td>
<td>No</td>
</tr>
<tr>
<td>193476</td>
<td>Yes</td>
</tr>
<tr>
<td>Gage 496</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Figure 156. Entering depth and time weights for the selected gages.

<table>
<thead>
<tr>
<th>Gage Name</th>
<th>Depth Weight</th>
<th>Time Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>193472</td>
<td>0.33</td>
<td>1</td>
</tr>
<tr>
<td>193476</td>
<td>0.33</td>
<td>0</td>
</tr>
<tr>
<td>Gage 496</td>
<td>0.33</td>
<td></td>
</tr>
</tbody>
</table>

The "Gage Weights" tab is where the weights are specified for each gage selected for a subbasin (Figure 156). The gages are shown in a table with a separate row for each gage. Only the gages selected previously on the "Gage Selections" tab are included in the table. For each gage you can enter a depth weight. You can enter a time weight for time-series gages. The values entered for the depth or time weights are automatically normalized during the simulation. The value of the weights must be computed separate from the program. Possible methods for computing the weights include Thiessen polygons, inverse distance, inverse distance squared, isohyetal mapping, or any method deemed appropriate.

Gridded Precipitation

The gridded precipitation method is designed to work with the ModClark gridded transform. However, it can be used with other area-average transform methods as well. The most common use of the method is to utilize radar-based precipitation estimates for simulation. Using additional software, it is possible to develop a gridded representation of gage data or to use output from atmospheric models. If it is used with a transform method other than ModClark, an area-weighted average of the grid cells in the subbasin is used to compute the precipitation hyetograph for each subbasin.

This method uses the same parameter data for all subbasins in the meteorologic model. The Watershed Explorer will show the precipitation icon one level under the meteorologic model. Click on the icon to access the Component Editor for gridded precipitation data.

A gridded precipitation data must be stored as a precipitation grid before it can be used in the meteorologic model. The data may be from radar sources or could be the result of complex calculations exterior to the program. Regardless, the grid data
must be stored as a precipitation grid. Only precipitation grids already defined will be shown in the selection list.

The time shift can be used to correct for precipitation grids stored with a time zone offset. All calculations during a simulation are computed assuming an arbitrary local time zone that does not observe summer time (daylight savings in the United States). It is common for precipitation data from radar sources to be stored in universal time, also known as Greenwich mean time. If other data sources such as observed discharge or temperature are in local time and the precipitation grid data is in universal time, select the correct shift so that the precipitation data will match the rest of the data.

There are two choices available for specifying the action to take when missing data is encountered during the simulation. When the *Abort Compute* choice is used, a missing grid record for a time step will stop the compute. When the *Assume Zero* choice is used, the simulation continues by applying zero precipitation to all grid cells for that time step.

![Figure 157. Precipitation component editor for the gridded precipitation method.](image)

### Inverse Distance

The inverse distance method was originally designed for application in real-time forecasting systems. It can use recording gages that report on a regular interval like 15 minutes or 1 hour. It can also use gages that only report daily precipitation totals. Because it was designed for real-time forecasting, it has the ability to automatically switch from using close gages to using more distant gages when the closer gages stop reporting data. The latitude and longitude of the gages is used to determine closeness to one or more nodes specified in each subbasin. Optionally, an index depth can be assigned to each gage. The index is used to adjust for regional bias in annual or monthly precipitation.

This method uses separate parameter data for each gage used to compute precipitation and also uses separate parameter data for each subbasin in the meteorologic model. Because of the separate data and special options (Figure 158) there are multiple tabs in the *Component Editor* for this method. The *Watershed Explorer* will show a precipitation gages icon one level under the meteorologic model. It will also show a separate precipitation icon under each subbasin icon (Figure 159). Click on any of the icons to access the *Component Editor* for that portion of the inverse distance method.
Chapter 7 Meteorology Description

Figure 158. Selecting options for the inverse distance precipitation method.

Figure 159. View of a meteorologic model in the Watershed Explorer when the inverse distance precipitation method is selected. Options are selected as shown in Figure 158.

The precipitation gages icon is always shown one level under the meteorologic model icon. The Component Editor shows a table of all precipitation gages from the Time-Series Data Manager, with a separate row for each gage. In the first column of the table you must select if you wish to use each gage in this meteorologic model as shown in Figure 160. The latitude and longitude location must be specified for each gage. Enter the location information using the Component Editor for precipitation gages in the time-series data section of the Watershed Explorer.

The second column of the Component Editor is used to select how the gage data is processed. All gages used in the inverse distance method must be setup in the Time-Series Data Manager before they can be used. Each gage may use any of the allowable time intervals from 1 minute to 24 hours. When a gage is selected as a daily gage, it is assumed during calculations that the daily precipitation depth is known but there is no timing information. Usually daily gages are stored with a 24-hour time interval, but any interval may be used. Daily gage data is only used during processing for days where the entire day is within the simulation time window. When a gage is not selected as a daily gage, the data it contains is interpolated to the simulation time step.

You can enable and disable the indexing option from the "Options" tab of the Component Editor for the meteorologic model. To access the options editor, click on the meteorologic model icon in the Watershed Explorer and then click on the "Options" tab in the Component Editor. If you decide to use indexing and turn on the option, the extra column will be added to the Component Editor. For each gage you can enter an index depth. The index depth is usually used to account for regional
trends in annual or monthly average precipitation. If you enter an index for a gage, all precipitation gages and subbasin nodes must also have a specified index or else indexing is ignored.

You must create one or more nodes for each subbasin using the inverse distance precipitation icon under each subbasin in the meteorologic model (Figure 161). The Component Editor contains three tabs. The first "Node Weights" tab is used to specify nodes for a subbasin, with a minimum of one required node. The remaining tabs are used to enter the latitude and longitude of the nodes.

Nodes are created and managed directly from the Component Editor. To create a new node, access the "Node Weights" tab and enter a node name in the first column of the last row. The last row is always kept blank for creating new nodes. You can rename a node by typing over the name in the first column. You can delete a node by deleting its name from the first column and any data from the other columns. You must always enter a weight for a node. The weight controls how the final hyetograph is computed for the subbasin from the hyetographs computed at each node. If you have enabled the indexing option, you should also enter the index for each node. The index is used to adjust for regional bias in annual or monthly precipitation. All nodes that you have created will be shown on the Latitudes and Longitudes tabs. You must enter the appropriate coordinate information for each node.

You can control how far the program searches from each subbasin node to find precipitation gages. Specify the maximum distance to search from the "Options" tab of the Component Editor for the meteorologic model. To access the options editor, click on the meteorologic model icon in the Watershed Explorer and then click on the "Options" tab in the Component Editor.
SCS Storm

The SCS storm method implements the design storm developed by the Natural Resources Conservation Service (formerly the Soil Conservation Service). The original methodology was developed to provide guidance when designing safe water storage facilities for agricultural applications. However, the storm has been applied in a variety of other situations. The same hyetograph is computed for all subbasins.

This method uses the same parameter data for all subbasins in the meteorologic model. The Watershed Explorer will show the precipitation icon one level under the meteorologic model. Click on the icon to access the Component Editor for the SCS storm (Figure 162).

Each storm has only one time distribution type which must be selected from the list of available choices. The available types are Type 1, Type 1A, Type 2, and Type 3. Each storm is 24 hours long. The simulation must have a duration at least 24 hours long. All precipitation values after the first 24 hours will be zero.

Each storm has the same total precipitation depth for each subbasin in the meteorologic model. There is no depth-area reduction or any other kind of reduction or modification performed on the specified depth. The specified depth is applied to the selected time distribution type to generate the hyetograph for each subbasin.

Specified Hyetograph

The specified hyetograph method allows the user to specify the exact time-series to use for the hyetograph at subbasins. This method is useful when precipitation data will be processed externally to the program and essentially imported without alteration. This method is also useful when a single precipitation gage can be used to represent what happens over a subbasin. Several options are available to increase control over how the data is processed (Figure 163).
This method uses separate parameter data for each subbasin in the meteorologic model, but all subbasins are shown in a single table. Each subbasin is shown on a separate row of the table. The Watershed Explorer will show the precipitation icon one level under the meteorologic model. Click on the icon to access the Component Editor for the specified hyetograph (Figure 164).

A hyetograph must be stored as a precipitation gage before it can be used in the meteorologic model. The data may actually be from a recording gage or could be the result of complex calculations exterior to the program. Regardless, the hyetograph must be stored as a gage. You may use the same gage for more than one subbasin. For each subbasin in the table, select the gage to use for that subbasin. Only precipitation gages already defined will be shown in the selection list.

Optionally, you may enter a total depth for each subbasin. If no total depth is entered, the depth will be the sum of the data actually stored in the precipitation gage. However, if a total depth is entered for a subbasin, the exact pattern is maintained but the magnitude of precipitation at each time step is adjusted so that the specified depth is applied over the entire simulation. Total depth can be specified for no subbasins, one subbasin, many subbasins, or all subbasins. It is not required to enter the depth for all subbasins in order to specify it for just one subbasin.

<table>
<thead>
<tr>
<th>Subbasin Name</th>
<th>Gage</th>
<th>Total Depth (MM)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deer Cr</td>
<td>193472</td>
<td></td>
</tr>
<tr>
<td>Falls Local</td>
<td>193475</td>
<td>67</td>
</tr>
<tr>
<td>West Branch Local</td>
<td>193476</td>
<td></td>
</tr>
</tbody>
</table>

Figure 164. Selecting a gage for each subbasin. Total depth override is optional.

### Standard Project Storm

The standard project storm method implements the requirements of Engineering Manual EM-1110-2-1411 (Corps 1965). While the methodology is no longer frequently used, it is included in the program for projects where it is still necessary.

This method has separate parameter data for each subbasin in the meteorologic model, but also has some parameter data that is the same for all subbasins. The Watershed Explorer will show the precipitation icon one level under the meteorologic model. Click on the icon to access the Component Editor for the standard project storm. There is one tab for the parameter data that applies to all subbasins (Figure 165). There is a second tab that shows the parameter data for each subbasin. The second tab uses a table with each subbasin on a separate row.

The precipitation index represents the depth of rainfall during the storm. This index is not the same as the probable maximum precipitation and does not have an associated exceedance probability. The index is selected from a map in the engineering manual.

The storm area is used to automatically compute the depth-area reduction factor, based on figures in the Engineering Manual. In most cases the specified storm area should be equal to the watershed drainage area at the point of evaluation.
The distribution determines how the adjusted precipitation depth for each subbasin is shaped into a hyetograph; it must be selected from the list of available choices. The Standard option uses the procedure specified in the Engineering Manual to distribute the adjusted storm depth. The Southwest Division option uses a different procedure that may be more applicable in some watersheds.

The transposition factor accounts for the location of a subbasin in the watershed, relative to the center of the storm (Figure 166). The Engineering Manual contains an isohyetal map with concentric rings labeled in percent. If a subbasin is generally covered by the 120% isohyetal line, then a factor of 1.20 should be entered in the program.

<table>
<thead>
<tr>
<th>Name: Met 1</th>
<th>Precipitation</th>
<th>Subbasins</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index (IN)</td>
<td>12.8</td>
<td></td>
</tr>
<tr>
<td>Area (MI2)</td>
<td>45.6</td>
<td></td>
</tr>
<tr>
<td>Distribution</td>
<td>Standard</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 165. Entering properties of the standard project storm.**

<table>
<thead>
<tr>
<th>Name: Met 1</th>
<th>Subbasins</th>
<th>Transposition Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deer Cr</td>
<td></td>
<td>1.40</td>
</tr>
<tr>
<td>Falls Local</td>
<td></td>
<td>1.31</td>
</tr>
<tr>
<td>West Branch Local</td>
<td></td>
<td>1.25</td>
</tr>
</tbody>
</table>

**Figure 166. Entering a transposition factor for each subbasin.**

**Evapotranspiration**

Evapotranspiration is the second of the three components of a meteorologic model. It is the combination of evaporation from the ground surface and transpiration by vegetation. It is only required if the meteorologic model will be used with subbasins that use continuous simulation loss rate methods: deficit constant, gridded deficit constant, soil moisture accounting, and gridded soil moisture accounting. Even if those methods are used in the subbasins, an evapotranspiration method is not required. If a continuous simulation loss rate method is used and no evapotranspiration is specified in the meteorologic model, then zero evapotranspiration is used in the subbasins. In all cases, the meteorologic model is computing the potential evapotranspiration and subbasins will calculate actual evapotranspiration based on soil water limitations.

**Gridded Priestley Taylor**

The gridded Priestley Taylor method is designed to work with the gridded ModClark transform method. It is the same as the regular Priestley Taylor (described in a later section) method except the Priestley-Taylor equation is applied to each grid cell using
separate boundary conditions instead of area-averaged values over the whole subbasin. If it is used with a transform method other than ModClark, an area-weighted average of the grid cells in the subbasin is used to compute the boundary condition of the subbasin.

This method uses the same parameter data for all subbasins in the meteorologic model. The Watershed Explorer will show the evapotranspiration icon one level under the meteorologic model. Click on the icon to access the Component Editor for the gridded Priestley Taylor (Figure 167).

A crop coefficient gridset must be selected for all subbasins. Only crop coefficient gridsets already defined will be shown in the selection list. The crop coefficient is applied on a grid cell basis to the evapotranspiration computed with the Priestley-Taylor method to give the final potential evapotranspiration. The coefficient can be used to adjust the potential demand for different plants, growing season, and other physiological factors.

A dryness coefficient must be entered for all subbasins. The same coefficient is applied to all grid cells in all subbasins. The coefficient is used to make small corrections based on soil moisture state. A coefficient should be specified that represents typical soil water conditions during the simulation.

A solar radiation gridset must be selected for all subbasins. The available gridsets from the Grid Data Manager will be shown in the selection list. If no gridsets are currently available, you will not be able to make a selection. Gridsets must be created in the manager before they can be used in the meteorologic model.

A temperature gridset must be selected for all subbasins. The current gridsets are shown in the selection list. If there are many different gridsets available, you may wish to choose a gridset from the selector accessed with the grid button next to the selection list. The selector displays the description for each gridset, making it easier to select the correct one.

![Figure 167. Component editor for the gridded Priestley-Taylor evapotranspiration method.](image)

### Monthly Average

The monthly average method is designed to work with measured pan evaporation data. However, it can also be used with data collected with the eddy correlation technique or other modern methods. Regardless of how they are collected, the data are typically presented as the average depth of evaporated water each month. Maps or tabular reports can be found for each month and used with this method.

This method uses separate parameter data for each subbasin in the meteorologic model. The Watershed Explorer will show an evapotranspiration icon under each
subbasin icon in the meteorologic model. Click on the evapotranspiration icon to access the Component Editor for monthly average (Figure 168). The editor contains a table with a separate row for each month.

The evapotranspiration rate must be entered for each month. It is entered as the total amount of evapotranspiration for the month. Every time step within the month will have the same evapotranspiration rate.

The pan coefficient must also be entered for each month. The specified rate is multiplied by the coefficient to determine the final potential rate for each month. The coefficient is usually used to correct actual evaporation pan data to more closely reflect plant water use.

<table>
<thead>
<tr>
<th>Month</th>
<th>Rate (IN/MONTH)</th>
<th>Pan Coefficient</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>2.22</td>
<td>0.7</td>
</tr>
<tr>
<td>February</td>
<td>2.78</td>
<td>0.7</td>
</tr>
<tr>
<td>March</td>
<td>4.53</td>
<td>0.7</td>
</tr>
<tr>
<td>April</td>
<td>5.29</td>
<td>0.7</td>
</tr>
<tr>
<td>May</td>
<td>7.08</td>
<td>0.7</td>
</tr>
<tr>
<td>June</td>
<td>6.97</td>
<td>0.7</td>
</tr>
<tr>
<td>July</td>
<td>6.81</td>
<td>0.7</td>
</tr>
<tr>
<td>August</td>
<td>6.32</td>
<td>0.7</td>
</tr>
</tbody>
</table>

*Figure 168. Entering rate and pan coefficient data for a subbasin in a meteorologic model using the monthly average evapotranspiration method.*

**Priestley Taylor**

The Priestley Taylor method implements the Priestley-Taylor equation for computing evapotranspiration. It is capable of capturing diurnal variation in potential evapotranspiration through the use of a solar radiation gage, so long as the simulation time step is less than 24 hours. A crop coefficient is used to adjust the calculated Priestley-Taylor amount.

This method uses separate parameter data for each subbasin in the meteorologic model. The Watershed Explorer will show an evapotranspiration icon under each subbasin icon in the meteorologic model. Click on the evapotranspiration icon to access the Component Editor for Priestley Taylor (Figure 169).

A crop coefficient gage must be selected for a subbasin. You may use the same gage for more than one subbasin. Only crop coefficient gages already defined will be shown in the selection list. The crop coefficient is applied to the evapotranspiration computed with the Priestley-Taylor method to give the final potential evapotranspiration. The coefficient can be used to adjust the potential demand for different plants, growing season, and other physiological factors.

A dryness coefficient must be entered for a subbasin. The coefficient is used to make small corrections based on soil moisture state. A coefficient should be specified that represents typical soil water conditions during the simulation.

A solar radiation gage must be selected for a subbasin. The available gages from the Time-Series Data Manager will be shown in the selection list. If no gages are
currently available, you will not be able to make a selection. Gages must be created in the manager before they can be used in the meteorologic model.

A temperature gage must be selected for a subbasin. The current gages are shown in the selection list. If there are many different gages available, you may wish to choose a gage from the selector accessed with the gage button next to the selection list. The selector displays the description for each gage, making it easier to select the correct one.

<table>
<thead>
<tr>
<th>Evapotranspiration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crop Coefficient Gage: Historic LU</td>
</tr>
<tr>
<td>Dryness Coefficient: 1.20</td>
</tr>
<tr>
<td>Solar Gage: Airport</td>
</tr>
<tr>
<td>Temperature Gage: Airport</td>
</tr>
</tbody>
</table>

*Figure 169. Entering Priestley-Taylor properties for a subbasin.*

**Snowmelt**

Snowmelt is the third of the three components of a meteorologic model. It uses the precipitation computed by the precipitation method. Using temperature, it determines whether the precipitation previously computed was liquid rain or frozen snow. The accumulation and melt of the snowpack is simulated in response to atmospheric conditions. The output of the method is the liquid water available at the soil surface, which becomes the hyetograph for the subbasin.

**Gridded Temperature Index**

The gridded temperature index method is designed to work with the gridded ModClark transform method. It is the same as the regular temperature index method except the equations for simulating the snowpack are computed separately for each grid cell with separate precipitation and temperature boundary conditions. This method can only be used if gridded precipitation is also used. If it is used with a transform method other than ModClark, an area-weighted average of the grid cells in the subbasin is used to compute the boundary condition of the subbasin.

This method uses the same parameter data for all subbasins in the meteorologic model. The Watershed Explorer will show the snowmelt icon one level under the meteorologic model. Click on the icon to access the Component Editor for gridded temperature index (Figure 170).
Figure 170. Component editor for the gridded temperature index snowmelt method.

A temperature gridset must be selected as one of the atmospheric boundary conditions on the model. The current gridsets are shown in the selection list. If there are many different gridsets available, you may wish to choose a gridset from the selector accessed with the grid button next to the selection list. The selector displays the description for each gridset, making it easier to select the correct one.

The initial snow water equivalent that exists at the beginning of the simulation must be entered. This information is usually determined by interpolating from actual measurements of snow water equivalent. This value can be set to zero if there is no snow.

The initial cold content that exists at the beginning of the simulation must be entered. It represents the heat required to raise the temperature of the snow pack to 0°C (32°F) and is expressed as a number equivalent to mm (inches) of frozen water. Generally, this value is not known at the start of simulation unless there is no snow, in which case it can be set to zero. If the value is not known, it can be set to zero. The error in doing this may be small for relatively shallow ephemeral snow covers but may cause errors for deep, seasonal snowpacks.

The liquid water held within the snowpack at the beginning of the simulation must be entered. For any melt or precipitation to get through the snowpack, the liquid water holding capacity of the snow must first be satisfied. Liquid water can persist in the snow only if the snowpack temperature is at 0°C (32°F); at which point the cold content is zero. A snowpack with liquid water is said to be “ripe.” Generally this value is not known at the start of the simulation unless there is no snow, in which case it can be
set to zero. If the snow is known to be colder than 0°C (32°F) at the start of the simulation, this value can be set to zero.

The initial cold content antecedent temperature index is an index to the snow temperature near the surface of the snowpack. It is calculated assuming an approximation to the transient heat flow equations. This value is used to estimate the cold content of the snow. It should be set to the approximate snowpack temperature at the beginning of the simulation. If the initial temperature is not known, it can be set to 0°C (32°F).

The seasonal variation of melt rate is indexed by an antecedent temperature function. The initial melt rate ATI should be thought of as similar to “the accumulated thawing degree days.” This antecedent temperature function allows the melt rate to change as the snowpack matures and ages. If there is no snow on the ground at the start of the simulation this term can be set to zero. It can also be set to zero if the simulation is starting during or at the end of a cold period when air temperatures were continually below the base temperature.

The PX temperature is used to discriminate between precipitation falling as rain or snow. When the air temperature is less than the specified temperature, any precipitation is assumed to be snow. When the air temperature is above the specified temperature, any precipitation is assumed to be rain. This discrimination temperature is usually one to two degrees above freezing.

The difference between the base temperature and the air temperature defines the temperature index used in calculating snowmelt. The melt rate is multiplied by the difference between the air temperature and the base temperature to estimate the snowmelt amount. If the air temperature is less than the base temperature, then the amount of melt is assumed to be zero. Typically, the base temperature should be 0°C (32°F) or close to it.

The wet melt rate is used during time periods of precipitation when the precipitation is falling as rain, at rates greater than the rain rate limit. It represents the rate at which the snowpack melts when it is raining on the pack.

The rain rate limit discriminates between dry melt and wet melt. The wet melt rate is applied as the melt rate when it is raining at rates greater than the rain rate limit. If the rain rate is less than the rain rate limit, the melt rate is computed as if there were no precipitation.

A melt rate must be calculated for time intervals when the precipitation rate is less than the rain rate limit. The calculation starts with the melt rate antecedent temperature index. A coefficient is used to update the antecedent melt rate index from one time interval to the next. This index generally ranges from 0.015 to 0.550 and is separate from the cold content index. A typical value for the coefficient is 0.98.

An antecedent temperature index melt rate function is used to calculate a melt rate from the current melt rate index. The function must be specified separately in the Paired Data Manager before it can be used in the snow melt method. The function should define appropriate melt rates to use over the range of melt rate index values that will be encountered during a simulation.

Optionally, you may adjust the melt rate computed from the index melt rate function. A melt rate pattern may be specified that defines the percentage adjustment as a function of the time of year. If no melt rate pattern is selected, the melt rate will be computed only from the antecedent temperature index and the melt rate function.
The pattern must be specified separately in the *Paired Data Manager* before it can be used in the snow melt method.

The cold limit accounts for the rapid changes in temperature that the snowpack undergoes during high precipitation rates. When the precipitation rate exceeds the specified cold limit, the antecedent cold content index is set to the temperature of the precipitation. If the temperature is above the base temperature, the cold content index is set to the base temperature. If the temperature is below the base temperature, the cold content index is set to the actual temperature. If the precipitation rate is less than the cold limit, the cold content index is computed as an antecedent index. A typical value is 20 mm/day (0.8 in/day).

The cold content antecedent temperature index coefficient is used to update the antecedent cold content index from one time interval to the next. This is a separate index from the one used to update the meltrate index. A typical value for the coefficient is 0.84.

An antecedent temperature index cold content function is used to calculate a cold content from the current cold content index. The index typically ranges from 0.010 to 0.025. The function must be specified separately in the *Paired Data Manager* before it can be used in the snow melt method. The function should define appropriate cold contents to use over the range of cold content index values that will be encountered during a simulation.

The maximum liquid water capacity specifies the amount of melted water that must accumulate in the snowpack before liquid water becomes available at the soil surface for infiltration or runoff. Typically, the maximum liquid water held in the snowpack is on the order of 3%-5% of the snow water equivalent, although it can be higher. Liquid water can persist in the snow only if the snowpack temperature is at 0°C (32°F); at which point the cold content is zero. The maximum is entered as a percentage of the snow water equivalent.

Heat from the ground can cause snowmelt, especially if the snowpack accumulates on ground that is only partially frozen or completely unfrozen. In these cases the warm ground is insulated by the snowpack. Heat from the warm ground will cause the bottom of the snowpack to melt. Two methods are available for specifying the melting of the snowpack due to contact with unfrozen ground. A fixed value can be entered; the same amount of melt is computed for the snowpack regardless of atmospheric conditions above the pack or the time of year. An annual pattern can alternately be entered; the pattern specifies the meltrate due to contact with the ground as a function of the time of year. The pattern must be entered in the *Paired Data Manager* before it can be used in the snowmelt method.

**Temperature Index**

The temperature index method is an extension of the degree-day approach to modeling a snowpack. A typical approach to the degree day is to have a fixed amount of snowmelt for each degree above freezing. This method includes a conceptual representation of the cold energy stored in the pack along with a limited memory of past conditions and other factors to compute the amount of melt for each degree above freezing. As the snowpack internal conditions and atmospheric conditions change, the melt coefficient also changes.

Some of the parameter data required by this method is the same for all subbasins in the meteorologic model. The *Watershed Explorer* will show the snowmelt icon one level under the meteorologic model. Click on the icon to access the *Component Editor* for component data that is the same for all subbasins (Figure 171).
Chapter 7  Meteorology Description

Figure 171. Temperature index snowmelt properties for all subbasins in a meteorologic model.

The PX temperature is used to discriminate between precipitation falling as rain or snow. When the air temperature is less than the specified temperature, any precipitation is assumed to be snow. When the air temperature is above the specified temperature, any precipitation is assumed to be rain. This discrimination temperature is usually one to two degrees above freezing.

The difference between the base temperature and the air temperature defines the temperature index used in calculating snowmelt. The meltrate is multiplied by the difference between the air temperature and the base temperature to estimate the snowmelt amount. If the air temperature is less than the base temperature, then the amount of melt is assumed to be zero. Typically, the base temperature should be 0°C (32°F) or close to it.

The wet meltrate is used during time periods of precipitation when the precipitation is falling as rain, at rates greater than the rain rate limit. It represents the rate at which the snowpack melts when it is raining on the pack.

The rain rate limit discriminates between dry melt and wet melt. The wet meltrate is applied as the meltrate when it is raining at rates greater than the rain rate limit. If the rain rate is less than the rain rate limit, the meltrate is computed as if there were no precipitation.

A meltrate must be calculated for time intervals when the precipitation rate is less than the rain rate limit. The calculation starts with the meltrate antecedent temperature index. A coefficient is used to update the antecedent meltrate index from one time interval to the next. This index generally ranges from 0.015 to 0.550 and is separate from the cold content index. A typical value for the coefficient is 0.98.

An antecedent temperature index meltrate function is used to calculate a meltrate from the current meltrate index. The function must be specified separately in the Paired Data Manager before it can be used in the snow melt method. The function
should define appropriate melt rates to use over the range of melt rate index values that will be encountered during a simulation.

Optionally, you may adjust the melt rate computed from the index melt rate function. A melt rate pattern may be specified that defines the percentage adjustment as a function of the time of year. If no melt rate pattern is selected, the melt rate will be computed only from the antecedent temperature index and the melt rate function. The pattern must be specified separately in the Paired Data Manager before it can be used in the snow melt method.

The cold limit accounts for the rapid changes in temperature that the snowpack undergoes during high precipitation rates. When the precipitation rate exceeds the specified cold limit, the antecedent cold content index is set to the temperature of the precipitation. If the temperature is above the base temperature, the cold content index is set to the base temperature. If the temperature is below the base temperature, the cold content index is set to the actual temperature. If the precipitation rate is less than the cold limit, cold content index is computed as an antecedent index. A typical value is 20 mm/day (0.8 in/day).

The cold content antecedent temperature index coefficient is used to update the antecedent cold content index from one time interval to the next. This is a separate index from the one used to update the melt rate index. A typical value for the coefficient is 0.84.

An antecedent temperature index cold content function is used to calculate a cold content from the current cold content index. The index typically ranges from 0.010 to 0.025. The function must be specified separately in the Paired Data Manager before it can be used in the snow melt method. The function should define appropriate cold contents to use over the range of cold content index values that will be encountered during a simulation.

The maximum liquid water capacity specifies the amount of melted water that must accumulate in the snowpack before liquid water becomes available at the soil surface for infiltration or runoff. Typically, the maximum liquid water held in the snowpack is on the order of 3%-5% of the snow water equivalent, although it can be higher. Liquid water can persist in the snow only if the snowpack temperature is at 0C (32F); at which point the cold content is zero. The maximum is entered as a percentage of the snow water equivalent.

Heat from the ground can cause snowmelt, especially if the snowpack accumulates on ground that is only partially frozen or completely unfrozen. In these cases the warm ground is insulated by the snowpack. Heat from the warm ground will cause the bottom of the snowpack to melt. Two methods are available for specifying the melting of the snowpack due to contact with unfrozen ground. A fixed value can be entered; the same amount of melt is computed for the snowpack regardless of atmospheric conditions above the pack or the time of year. An annual pattern can alternate be entered; the pattern specifies the melt rate due to contact with the ground as a function of the time of year. The pattern must be entered in the Paired Data Manager before it can be used in the snowmelt method.

Some of the parameter data required by this method is different for each subbasin included in the meteorologic model. The Watershed Explorer will also show an icon for each subbasin; the snowmelt icon is shown under each subbasin. Click on the snowmelt icon under the subbasin to access the Component Editor for component data that is unique for each subbasin (Figure 172).
A temperature time-series must be selected as one of the atmospheric boundary conditions on the model. The current time-series gages are shown in the selection list. If there are many different time-series gages available, you may wish to choose a gage from the selector accessed with the gage button next to the selection list. The selector displays the description for each time-series, making it easier to select the correct one.

Each subbasin must have a specified lapse rate and each temperature time-series gage must have an elevation specified for it. The temperature for each elevation band is computed using the temperature recorded in the time-series, the elevation of the time-series gage, the lapse rate for the subbasin, and the elevation of the elevation band. The adjusted temperature for each elevation band is computed by adding a correction to the specified time-series, computed as the lapse rate multiplied by the band elevation minus the time-series elevation. The lapse rate should be negative if the air temperature is cooler at high elevation than at low elevation.

Each subbasin is broken into one or more elevation bands; each band has its own parameter data. One elevation band may be used to represent a subbasin with very little terrain variation. Subbasins with large elevation variations should use multiple elevation bands. Create an elevation band by clicking with the right mouse button on the snowmelt icon under a subbasin (Figure 173). A context menu is displayed that allows you to create a new elevation band. You can also create an elevation band by clicking with the right mouse button on any existing elevation band. The same context menu is displayed that allows you to create a new elevation band. Delete an elevation band by clicking on it with the right mouse button. A context menu is displayed that allows you to delete the elevation band. Clicking on the elevation band icon will access the **Component Editor** used for each band (Figure 174).
Chapter 7 Meteorology Description

You must specify the percentage of the subbasin that each elevation band composes. An elevation band is not required to be contiguous. The percentage specified for each elevation band will automatically be normalized if the sum of the percentages across all subbasins does not equal 100. There is no limit to the number of elevation bands that can be used, but at least one is required. Typically only one band is used in watersheds with small elevation differences. Mountainous watersheds usually require several bands for each subbasin.

Enter the average elevation for each elevation band. Typically the specified elevation will be either the area-weighted elevation of the band, or the average of the highest and lowest points in the band.

The initial snow water equivalent that exists at the beginning of the simulation must be entered. This information is usually determined by interpolating from actual measurements of snow water equivalent. This value can be set to zero if there is no snow.

The initial cold content that exists at the beginning of the simulation must be entered. It represents the heat required to raise the temperature of the snow pack to 0°C (32°F) and is expressed as a number equivalent to mm (inches) of frozen water. Generally, this value is not known at the start of simulation unless there is no snow, in which case it can be set to zero. If the value is not known, it can be set to zero. The error in doing this may be small for relatively shallow ephemeral snow covers but may cause errors for deep, seasonal snowpacks.

The liquid water held within the snowpack at the beginning of the simulation must be entered. For any melt or precipitation to get through the snowpack, the liquid water holding capacity of the snow must first be satisfied. Liquid water can persist in the snow only if the snowpack temperature is at 0°C (32°F); at which point the cold content is zero. A snowpack with liquid water is said to be "ripe." Generally this value is not known at the start of the simulation unless there is no snow, in which case it can be set to zero. If the snow is known to be cold at the start of the simulation, this value can be set to zero.

The initial cold content antecedent temperature index is an index to the snow temperature near the surface of the snowpack. It is calculated assuming an approximation to the transient heat flow equations. This value is used to estimate the cold content of the snow. It should be set to the approximate snowpack temperature at the beginning of the simulation. If the initial temperature is not known, it can be set to 0°C (32°F).
The seasonal variation of melt rate is indexed by an antecedent temperature function. The initial melt rate ATI should be thought of as similar to "the accumulated thawing degree days." This antecedent temperature function allows the melt rate to change as the snowpack matures and ages. If there is no snow on the ground at the start of the simulation this term can be set to 0°C (32°F). It can also be set to freezing if the simulation is starting during or at the end of a cold period when air temperatures were continually below the base temperature.

References

CHAPTER 8

Hydrologic Simulation

This chapter describes how watershed and meteorology information is combined to simulate the hydrologic response. The simulation run is the primary mode for performing simulations. A run may form the basis for additional analysis using optimization trials or analyses. In addition to configuring and computing simulation runs, this chapter also describes how to access the computed results.

Simulation Runs

Simulation runs are one of the three different components that can compute results: simulation runs, optimization trials, and analyses. Each run is composed of one meteorologic model, one basin model, and one control specifications. Results can be visualized as graphs, summary tables, and time-series tables either through the basin map or from the Watershed Explorer. In addition to selecting the meteorologic, basin, and control components, advanced features for controlling the run are also included.

Creating a New Run

A new simulation run is created using a wizard that helps you navigate the steps to creating a new run. There are two ways to access the wizard. The first way to access the wizard is to click on the Compute menu and select the Create Simulation Run command. The wizard will open and begin the process of creating a new simulation run. The second way to access the wizard is from the Simulation Run Manager. Click on the Compute menu and select the Run Manager command. The Simulation Run Manager will open and show any runs that already exist. Press the New... button to access the wizard and begin the process of creating a simulation run, as shown in Figure 175.

The first step of creating a simulation run is to provide the name for the new run (Figure 176). A default name is provided for the new simulation run; you can use the default or replace it with your own choice. After you finish creating the run you can add a description to it. If you change your mind and do not want to create a new simulation run, you can press the Cancel button at the bottom of the wizard or the X button in the upper right corner of the wizard. The Cancel button can be pressed at any time you are using the wizard. Press the Next> button when you are satisfied with the name you have entered and are ready to proceed to the next step.

The second step of creating a simulation run is to select a basin model. All of the basin models in the project are shown and you must select one before proceeding to the next step. By default the first basin model in the table is selected. The selected model is highlighted. You can use your mouse to select a different basin model by clicking on it in the table of available choices. You can also use the arrow keys on your keyboard to select a different model. Press the Next> button when you are satisfied with the basin model you have selected and are ready to proceed to the next step. Press the <Back button if you wish to return to the previous step and change the name for the new simulation run.
Chapter 8 Hydrologic Simulation

Figure 175. Beginning the process of creating a new simulation run using the Simulation Run Manager.

The third step of creating a simulation run is to select a meteorologic model. All of the meteorologic models in the project are shown and you must select one before proceeding to the next step. By default the first meteorologic model in the table is selected. The selected model is highlighted. You can use your mouse to select a different meteorologic model by clicking on it in the table of available choices. You can also use the arrow keys on your keyboard to select a different model. Press the Next> button when you are satisfied with the meteorologic model you have selected and are ready to proceed to the next step. Press the <Back button if you wish to return to the previous step and select a different basin model.

Figure 176. Entering a name for a new simulation run. The remaining steps are to select a basin model, meteorologic model, and control specifications.
The fourth and final step of creating a simulation run is to select a control specifications. All of the control specifications in the project are shown and you must select one before proceeding to the next step. By default the first control specifications in the table is selected. The selected specifications is highlighted. You can use your mouse to select a different control specifications by clicking on it in the table of available choices. You can also use the arrow keys on your keyboard to select a different specifications. Press the Finish button when you are satisfied with the name you have entered and the components you have selected, and are ready to create the simulation run. Press the <Back button if you wish to return to the previous step and select a different meteorologic model.

**Copying a Run**

There are two ways to copy a simulation run. Both methods for copying a run create an exact duplicate with a different name. Once the copy has been made it is independent of the original and they do not interact.

The first way to create a copy is to use the Simulation Run Manager, which is accessed from the Compute menu. Select the simulation run you wish to copy by clicking on it in the list of current simulation runs. The selected run is highlighted after you select it. After you select a run you can press the Copy… button on the right side of the window. A new Copy Simulation Run window (Figure 177) will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected simulation run. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected simulation run, press the Cancel button or the X button in the upper right to return to the Simulation Run Manager window.

![Figure 177. Creating a copy of a simulation run.](image)

The second way to copy is from the "Compute" tab of the Watershed Explorer. Move the mouse over the simulation run you wish to copy, then press the right mouse button (Figure 178). A context menu is displayed that contains several choices including copy. Click the Create Copy… command. A new Copy Simulation Run window will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected simulation run. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected simulation run, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.
Renaming a Run

There are two ways to rename a simulation run. Both methods for renaming a run change its name and then all references to the old run name are automatically updated to the new name.

The first way to perform a rename is to use the Simulation Run Manager, which you can access from the Compute menu. Select the simulation run you wish to rename by clicking on it in the list of current simulation runs. The selected run is highlighted after you select it. After you select a run you can press the Rename… button on the right side of the window. A new Rename Simulation Run window (Figure 179) will open where you can provide the new name. If you wish you can also change the description at the same time. If the new description will be long, you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Rename button to finish the process of renaming the selected simulation run. You cannot press the Rename button if no name is specified. If you change your mind and do not want to rename the selected simulation run, press the Cancel button or the X button in the upper right of the Rename Simulation Run window to return to the Simulation Run Manager window.

The second way to rename is from the "Compute" tab of the Watershed Explorer. Select the simulation run you wish to rename by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected run and click the left mouse button again. The highlighted name will change to editing mode (Figure 180). You can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished
changing the name, press the **Enter** key to finalize your choice. You can also finalize your choice by clicking elsewhere on the "Compute" tab. If you change your mind while in editing mode and do not want to rename the selected simulation run, press the **Escape** key.

![Figure 180. Renaming a simulation run in the Watershed Explorer.](image)

**Deleting a Run**

There are two ways to delete a simulation run. Both methods for deleting a run remove it from the project, automatically update all references to that run, and delete previously computed results. Once a run has been deleted it cannot be retrieved or undeleted. Any references to the deleted run will switch to using no simulation run, which is usually not a valid choice during a simulation. At a later time you will have to go to those components and manually select a different simulation run.

The first way to perform a deletion is to use the *Simulation Run Manager*, which you can access from the **Compute** menu. Select the simulation run you wish to delete by clicking on it in the list of current simulation runs. The selected run is highlighted after you select it. After you select a run you can press the **Delete** button on the right side of the window. A window will open where you must confirm that you wish to delete the selected run as shown in Figure 181. Press the **OK** button to delete the run. If you change your mind and do not want to delete the selected simulation run, press the **Cancel** button or the **X** button in the upper right to return to the *Simulation Run Manager* window.

The second way to delete is from the "Compute" tab of the *Watershed Explorer*. Move the mouse over the simulation run you wish to delete and press the right mouse button (Figure 182). A context menu is displayed that contains several choices including delete. Click the **Delete** command. A window will open where you must confirm that you wish to delete the selected run. Press the **OK** button to delete the run. If you change your mind and do not want to delete the selected simulation run, press the **Cancel** button or the **X** button in the upper right to return to the *Watershed Explorer*. 
Figure 181. Preparing to delete a simulation run from the Simulation Run Manager. A confirmation will be required after pressing the Delete button.

Figure 182. Deleting a simulation run in the Watershed Explorer.

Selecting Components

The principal task when creating a simulation run using the wizard is the selection of a basin model, meteorologic model, and control specifications. However, you can change the components you wish to use at any time using the Component Editor for a simulation run. Access the Component Editor from the "Compute" tab of the Watershed Explorer. If necessary, click on the "Simulation Runs" folder to expand it and view the available simulation runs. Click on the simulation run node you wish to edit and its Component Editor will automatically be shown (Figure 183). The Component Editor contains three lists for selecting the basin model, meteorologic model, and control specifications, respectively. The first selection list shows all of the basin models currently available in the project. Likewise, the second list contains all of the meteorologic models and the third list contains all of the control specifications. As the user, you are responsible for knowing which components are intended to be used together to produce simulation results.
Chapter 8  Hydrologic Simulation

Precipitation and Flow Ratios

Using precipitation and flow ratios is optional for a simulation run. If you do not use ratios, the simulation results will be exactly determined by the meteorologic conditions specified in the meteorology model and the watershed physical properties specified in the basin model. Optionally, you can apply a ratio to the precipitation computed by the meteorologic model before the precipitation is applied to the basin model. Alternately, you may instead apply a ratio to the outflow computed by subbasin and source elements in the basin model before routing the outflow downstream through the element network. You must choose between applying no ratio, a precipitation ratio, or a flow ratio. The same ratio is applied to all elements.

The ratio for the simulation run is accessed from the "Compute" tab of the Watershed Explorer. Click on the "Ratio" node under the simulation run to display the Component Editor for the ratio (Figure 184). The "Ratio" and other optional tabs are always shown when ever the Component Editor is shown. Select the type of ratio you wish to apply from the available choices. If you select the precipitation method, you can only choose to apply the ratio to subbasins. If you select the flow method, you can choose to apply the ratio to subbasins, sources, or both element types. Finally enter the ratio value. When working with a precipitation ratio, the precipitation value for each time step computed by the meteorologic model is multiplied by the specified ratio before the precipitation is applied to the subbasin.
elements. When working with a flow ratio, the outflow computed for each time step by the basin model is multiplied by the specified ratio before the outflow is routed to the next downstream element. You can only select whether to apply a ratio to subbasins and sources, and enter a ratio, if a ratio method is actually selected.

Start and Saved States

The various mathematical equations used in the basin and meteorologic models all contain state variables. A state variable is simply the current condition of the system during any time step. For example, the state variable in a reservoir is the amount of water in storage, usually measured as an elevation. In the soil moisture accounting loss method, the state variable is the amount of water currently held in each of the five layers. The state variables change during a simulation in response to changing boundary conditions and the dynamics of the mathematical equation governing the method.

The state variables all have to be specified at the beginning of a simulation, in which case they are called initial conditions. Some methods allow you to specify the value you wish to use, such as the initial storage in a reservoir. Some methods implicitly specify the initial condition, for example loss methods that allow you to specify the amount of infiltration that must occur before surface runoff begins, often called the initial loss. Many of the channel routing methods assume the initial condition that initial outflow equals the first inflow to the reach.

States have two main purposes: breaking long simulations into smaller time periods, and real-time forecasting operations. In the first case of long simulations, using states achieves exactly the same results as one long simulation. Suppose that a long simulation covers all of 1995 and 1996. You could configure a simulation run for 1995 and save states at the end of the simulation. You could then configure a simulation for 1996 that uses as start states the states saved at the end of the 1995 run. The results obtained by breaking the simulation into two runs and using states would be identical to the results obtained from a single long run. This approach can be useful when performing continuous simulation for many years or decades. In the second case of real-time forecasting operations, the typical approach is often to compute a simulation run daily and forecast three to five days into the future. The simulation can be configured to run for five days, saving the state variables at the end of the first day. When the forecast is updated on the subsequent day, it can start from the saved states of the previous day and continue forward. In this way, continuously updated results can be obtained without requiring the simulation to start at the last known watershed conditions which might be very old.

Figure 185. Selecting a start states for a simulation run.
Saving out the start variable during a simulation run, or starting a run from saved state variables is optional. If you do not use start states, then the initial conditions will be specified from the basin and meteorologic models. If you do use the start states, the initial conditions specified in the basin and meteorologic models will be overridden by the values contained in the saved states used as the start states. If you do not use save states, the simulation will run normally. If you do choose to save states, the simulation will pause momentarily to save the state variables and then continue normally. When start states are used, they must have been saved at exactly the same times.

Selecting optional start states for the simulation run is accessed from the "Compute" tab of the Watershed Explorer. Click on the "Start States" node under the simulation run to display the Component Editor for the start states (Figure 185). The "Start States" and other optional tabs are always shown when ever the Component Editor is shown. You can choose the states you wish to use from the selection list. Only states saved by a different simulation run using the same basin model are shown. The only way to create states for use as saved states is by allowing the program to save them during a separate simulation run.

Selecting optional save states for the simulation run is accessed from the "Compute" tab of the Watershed Explorer. Click on the "Save States" node under the simulation run to display the Component Editor for save states (Figure 186). The "Save States" and other optional tabs are always shown when ever the Component Editor is shown. You must specify a name for the saves and optionally may enter a description. There are two ways to specify when the states will be saved: at the end of the simulation run, or at a given time during the simulation run. If you select to save states at the end of the run, the program will automatically determine the correct date and time to save states. If you select to save states at a specific time, you must enter the date and time. The specified date and time must be after the start and either at or before the end of the simulation run.

![Figure 186. Configuring a simulation run to save states at the end of the compute time window.](image)

**Selecting a Current Run**

There are two ways to select the current simulation run. Both methods set the run so that it can be computed and results can be accessed from the basin map as soon as they are available.

The first way to select the current simulation run is from the Compute menu. Click on the Compute menu and move the mouse to the Select Run submenu. A sub
menu will open that lists all of the simulation runs in the project. Click on the run name that you wish to become the current run.

The second way to select the current simulation run is from the *Watershed Explorer*, on the "Compute" tab. Select the simulation run you wish to become the current run by clicking on it in the *Watershed Explorer*. The simulation runs are listed alphabetically in the "Simulation Runs" folder.

### Checking Parameters

The program is equipped with the capability to check parameter values in the basin and meteorologic model as part of performing a simulation run. The check is performed in two stages. The first stage of checking is performed before the actual simulation run begins. During the first stage, required parameters are checked to make sure they have been specified. They are also checked to make sure they are between the minimum and maximum allowed values. Checking also makes certain that the specified values are physically possible. In some cases, one required parameter may have relationships with other required parameters. When possible, the dependencies are checked to make sure they are valid. For example, the Clark unit hydrograph is required to have a time of concentration. If one is not entered, the first stage of parameter checking will detect that it is missing and issue an error message. During the second stage, checking is performed that cannot happen until the actual simulation begins. For example, all inflow to a reach must be greater than or equal to zero. There is no way to determine if this condition is satisfied until all operations necessary to compute inflow to that reach have finished. Second stage parameter checking may result in additional messages.

All messages issued during first or second stage parameter checking are classified as notes, warnings, or errors. Notes are used to communicate general information to the user. They may also be used to indicate actions taken where the result was within established guidelines. Warnings are used when the program must take action in order to continue the simulation, and the actions taken may conflict with the intentions of the user. These messages should be checked to make sure the program made appropriate assumptions. Errors are used for problems that stop the simulation from proceeding. These messages can be used to determine what required parameters are missing, or what specified parameters have invalid values. All messages are shown in the message window at the bottom of the program screen, regardless of when or how they are produced.

Parameter checking is performed automatically as part of computing a simulation run. However, you can manually perform the first stage parameter checking. First be certain that a simulation run is selected. To perform the check, click on the *Compute* menu and select the *Check Parameters* command. Any messages generated during the check will be displayed in the message window.

### Computing a Run

There are three ways to compute the currently selected simulation run. All methods automatically perform parameter checking, and if no errors are generated, proceed to the actual computing of simulation results.

The first way to compute a simulation run is from the *Compute* menu. Click on the *Compute* menu and then select the *Compute Run* command. The name of the current simulation run is shown in brackets as part of the menu command. If the command is not available, it is because there is no current simulation run; you must first select a run. A window will automatically open that shows the progress of the
compute. You will need to manually close the window when the compute is done, whether it failed or was successful.

The second way to compute a simulation run is from the Watershed Explorer, on the "Compute" tab. Select the simulation run you wish to compute by clicking on it in the Watershed Explorer with the right mouse button. A context menu is displayed that contains several choices including compute. Click the Compute command. The progress window will automatically open.

The third way to compute a simulation run is from the toolbar. The compute button is enabled when ever there is a current run that can be computed. If the button is not available or shows a different type of compute, you must first select a simulation run. Press the button to compute the current simulation run. The progress window will automatically open.

**Viewing Results for the Current Run**

A variety of graphical and tabular results are available after a simulation run is computed. The same results are also available for the current run, so long as no data used in the simulation has changed. The program tracks all of the data in the simulation run, the selected basin model, the selected meteorologic model, and the selected control specifications. It also tracks any time-series data, paired data, or grid data used in the basin and meteorologic models. Results for a simulation run are only available when none of this data has changed since the last time the run was computed. If any of the data has changed, you will need to recompute the simulation run before you will be allowed to view results. If any result is open at the time data changes, the affected results will automatically be closed.

**Global Summary Table**

There are two ways to access the global summary results for a simulation run. Both methods show the same results (Figure 187).

![Global Summary Results for Run “Current”](image)

*Figure 187. Viewing the global summary table for a simulation run. Volume in millimeters or inches is computed by dividing the volume by the drainage area.*
The first method for viewing global summary results is to use the Results menu. Click the Results menu and select the Global Summary Table command. The summary table will automatically open. The table includes one row for each element in the basin model and columns for element name, drainage area, peak flow, time of peak flow, and total outflow volume. The menu command on the Results menu will only be enabled if the results for the current simulation run do not need to be recomputed.

The second method for viewing global summary results is to use the button on the toolbar. Press the toolbar button with a picture of a table plus a globe. The button will only be enabled if there is a current simulation run and the results do not need to be recomputed.

**Individual Elements**

There are three ways to access results for individual elements in the current simulation run. All methods show the same results. You must select one or more elements in the basin map before you can view results for that element.

The first method for viewing individual element results is to use the Results menu. You may need to first open the basin model by clicking on it in the Watershed Explorer, on the "Components" tab. The current simulation run is shown in brackets in the basin map title bar. Select one or more elements in the basin map by clicking with the arrow tool. With an element selected in the basin map, click the Results menu and select the Element Graph command, the Element Summary Table command, or the Element Time-Series Table command. The appropriate result will automatically be shown in the desktop area. The information included in the graph (Figure 188) varies by element type, but always includes outflow. Optional items such as observed flow, computed stage, and observed stage are also included. The

![Graph for Subbasin "Subbasin-1"](image)

**Figure 188.** Element graph for a subbasin.
information included in the summary table (Figure 189) also varies by element type but always includes the peak flow, time of peak flow, and outflow volume. The time-series table includes the same information as the graph but in numerical format (Figure 190). If you selected more than one element, then one result for each element will open. The menu commands on the Results menu will only be enabled if the results for the current simulation run do not need to be recomputed, and there is an element selection in the basin map. The second method for viewing individual element results is to use the element icon in the basin map. Again you may need to open the basin model before attempting to view results. Click on an element to highlight it. Keep the mouse over the element and press the right mouse button. A context menu is displayed that contains several choices including View Results. The name of the current simulation run is shown in brackets after the menu command. Move the mouse into the View Results submenu and select any of the result commands: Graph, Summary Table, or Time-Series Table. The appropriate result will open. If you selected more than one element, then one result for each element will open. The View Results menu command will only be enabled if the results for the current simulation run do not need to be recomputed.

![Summary Results for Reach "Reach-2"](image)

**Figure 189. Element summary table for a reach.**

The third method for viewing individual element results is to use the buttons on the toolbar. First you must open the basin model and select one or more elements in the basin map by clicking with the arrow tool. Once you have a selected element, click the graph, summary table, or time-series table buttons. The button for selecting a graph shows a bar chart. The button for the summary table shows a plain table. The button for the time-series table shows a table plus a clock. The appropriate result will automatically open. If you selected more than one element, then one result for each element will be added to the desktop. The toolbar buttons for viewing element results will only be enabled if the results for the current simulation run do not need to be recomputed, and there is an element selection in the basin map.
Viewing Results for Other Runs

In addition to viewing results for the currently selected simulation run, it is also possible to view results for other runs that are not the current selection. However, those other runs are also tracked in the same way as the current run to make sure data has not changed and results do not need to be recomputed. If any of the data in a simulation run changes, it will have to be recomputed before results can be viewed. Results for other simulation runs are accessed from the Watershed Explorer, on the "Results" tab.

To begin viewing results, go to the "Results" tab of the Watershed Explorer and click on the desired simulation run icon. If necessary, click on the "Simulation Runs" folder to expand it and view the simulation runs in the project. The simulation run icon will be disabled if any data used in the run has changed and results need to be recomputed. If any result is open at the time data changes, the affected results will automatically be closed.

Global Summary Table

The global summary table can be accessed by clicking on the "Global Summary" node in the Watershed Explorer (Figure 191). The summary table will open. It is exactly the same table that can be viewed for the current simulation run. The table includes one row for each element in the basin model and columns for element name, drainage area, peak flow, time of peak flow, and total outflow volume.
Chapter 8  Hydrologic Simulation

Figure 191. Accessing simulation run results from the Watershed Explorer.

**Element Summary Table**

Each element in the basin model is shown in the Watershed Explorer under the simulation run node. These elements are listed in alphabetical order after the global summary table. The results for each element are accessed by clicking on its node. The first item listed for each element is the summary table; click on the “Summary” node to view the result (Figure 191). It is exactly the same summary table that can be viewed for the current simulation run. The information included in the summary table varies by element type but always includes the peak flow, time of peak flow, and outflow volume.

**Element Time-Series Preview Graph**

All of the time-series data computed by an individual element are available for viewing. The time-series data are listed under each element node in the Watershed Explorer. The first node under each element is the summary table. The remaining nodes for each element represent the different time-series data. Click on a time-series node to preview the data in the Component Editor. You may select multiple time-series data by holding the shift or control key while using the mouse to click on additional nodes (Figure 192). The selected time-series may come from different elements in the same simulation run, the same element in different runs, or different elements in different runs. The selected time-series data will automatically be partitioned into groups by data type.

**Time-Series Tables and Graphs**

Preview graphs of selected time-series data can be opened as graphs or time-series tables within the desktop area. Begin by selecting the time-series you wish to include in the graph or table. Once you have selected the desired time-series, you can press the graph or time-series table buttons on the toolbar. The chosen time-series will be graphed or tabulated (Figure 193).
Figure 192. Selecting computed outflow from the same element in two different simulation runs. Other types of time-series data could also be selected.

Figure 193. Custom graph created by selecting multiple time-series results for a preview and then pressing the graph button on the toolbar.
CHAPTER 9

Parameter Estimation

This chapter describes how observed streamflow can be used to automatically estimate parameters. A process called optimization is used that begins from initial parameter estimates and adjusts them so that the simulated results match the observed streamflow as closely as possible. Two different search algorithms are provided that move from the initial estimates to the final best estimates. A variety of objective functions are provided to measure the goodness of fit between the simulated and observed streamflow in different ways. While parameter estimation using optimization does not produce perfect results, it can be a valuable aid when calibrating models.

Optimization Trials

Parameter estimation is the process of adapting a general model to a specific watershed. Some parameters can be estimated directly from field measurements. For example, the area that must be entered for a subbasin element can be measured directly in the field using standard surveying procedures or from maps developed through surveying. Other parameters can be estimated indirectly from field measurements. In this case, the field measurement does not result in a value that can be input directly to the program. However, the field measurement can provide a strong recommendation for a parameter in the program based on previous experience. For example, measurements of soil texture are highly correlated with parameters such as hydraulic conductivity. Finally, there are parameters that can only be estimated by comparing computed results to observed results such as observed streamflow. Even for parameters of the first two types, there is often enough uncertainty in the true parameter value to require some adjustment of the estimates in order for the model to closely follow the observed streamflow.

The quantitative measure of the goodness-of-fit between the computed result from the model and the observed flow is called the objective function. An objective function measures the degree of variation between computed and observed hydrographs. It is equal to zero if the hydrographs are exactly identical. The key to automated parameter estimation is a search method for adjusting parameters to minimize the objective function value and find optimal parameter values. A minimum objective function is obtained when the parameter values best able to reproduce the observed hydrograph are found. Constraints are set to insure that unreasonable parameter values are not used.

Optimization trials are one of the three different components that can compute results: simulation runs, optimization trials, and analyses. Each trial is based on a simulation run. The run provides the basic framework of a basin model, meteorologic model, and control specifications within which parameters are estimated. A variety of result graphs and tables are available from the Watershed Explorer for evaluating the quality of the estimation.

The iterative parameter estimation procedure used by the program is often called optimization. Initial values for all parameters are required at the start of the optimization trial window. A hydrograph is computed at a target element by computing all of the upstream elements. The target must have an observed
hydrograph for the time period over which the objective function will be evaluated. Only parameters for upstream elements can be estimated. The value of the objective function is computed at the target element using the computed and observed hydrographs. Parameter values are adjusted by the search method and the hydrograph and objective function for the target element are recomputed. This process is repeated until the value of the objective function is sufficiently small, or the maximum number of iterations is exceeded. Results can be viewed after the optimization trial is complete.

Creating a New Trial

A new optimization trial is created using a wizard that helps you navigate the steps to creating a new trial. There are two ways to access the wizard. The first way to access the wizard is to click on the Compute menu and select the Create Optimization Trial command; it is only enabled if at least one simulation run exists. The wizard will open and begin the process of creating a new optimization trial. The second way to access the wizard is from the Optimization Trial Manager. Click on the Compute menu and select the Trial Manager command. The Optimization Trial Manager will open and show any trials that already exist. Press the New... button to access the wizard and begin the process of creating an optimization trial, as shown in Figure 194.

The first step of creating an optimization trial is to provide the name for the new trial (Figure 195). A default name is provided for the new optimization trial; you can use the default or replace it with your own choice. After you finish creating the trial you can add a description to it. If you change your mind and do not want to create a new optimization trial, you can press the Cancel button at the bottom of the wizard or the X button in the upper right corner of the wizard. The Cancel button can be pressed at any time you are using the wizard. Press the Next> button when you are satisfied with the name you have entered and are ready to proceed to the next step.
Figure 195. Entering a name for a new optimization trial. The remaining steps are to select a simulation run and the optimization location.

The second step of creating an optimization trial is to select a simulation run that will form the basis of the trial. All of the simulation runs containing at least one element with observed flow are shown and you must select one before proceeding to the next step. By default the first simulation run in the table is selected. The selected run is highlighted. You can use your mouse to select a different simulation run by clicking on it in the table of available choices. You can also use the arrow keys on your keyboard to select a different run. Press the Next button when you are satisfied with the simulation run you have selected and are ready to proceed to the next step. Press the <Back button if you wish to return to the previous step and change the name for the new optimization trial.

The third and final step of creating an optimization trial is to select an element where there is observed flow. The element is where the objective function will be evaluated. You will only be able to perform parameter estimation at, or upstream of the selected element. The elements in the selection list come from the basin model used in the simulation run that was selected in the previous step. By default the first element in the table is selected. The selected element is always highlighted. You can use your mouse to select a different element by clicking on it in the table of available choices. You can also use the arrow keys on your keyboard to select a different element. Press the Finish button when you are satisfied with the name you have entered, the simulation run and element you selected, and are ready to create the optimization trial. Press the <Back button if you wish to return to the previous step and select a simulation run.

Copying a Trial

There are two ways to copy an optimization trial. Both methods for copying a trial create an exact duplicate with a different name. Once the copy has been made it is independent of the original and they do not interact.

The first way to create a copy is to use the Optimization Trial Manager, which is accessed from the Compute menu. Select the optimization trial you wish to copy by clicking on it in the list of current optimization trials. The selected trial is highlighted.
after you select it. After you select a trial you can press the Copy... button on the right side of the window. A new Copy Optimization Trial window (Figure 196) will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected optimization trial. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected optimization trial, press the Cancel button or the X button in the upper right to return to the Optimization Trial Manager window.

Figure 196. Creating a copy of an optimization trial.

The second way to copy is from the "Compute" tab of the Watershed Explorer. Move the mouse over the optimization trial you wish to copy and press the right mouse button (Figure 197). A context menu is displayed that contains several choices including copy. Click the Create Copy... command. A new Copy Optimization Trial window will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected optimization trial. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected optimization trial, press the Cancel button or the X button in the upper right of the Copy Optimization Trial window to return to the Watershed Explorer.

Figure 197. Copying an optimization trial from the Watershed Explorer. The Copy Optimization Trial window will appear after the Create Copy... menu command is selected.
Renaming a Trial

There are two ways to rename an optimization trial. Both methods for renaming a trial change its name and perform other necessary operations.

The first way to perform a rename is to use the Optimization Trial Manager, which you can access from the Compute menu. Select the optimization trial you wish to rename by clicking on it in the list of current optimization trials. The selected trial is highlighted after you select it. After you select a trial you can press the Rename... button on the right side of the window. A new Rename Optimization Trial window (Figure 198) will open where you can provide the new name. If you wish you can also change the description at the same time. If the new description will be long, you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Rename button to finish the process of renaming the selected optimization trial. You cannot press the Rename button if no name is specified. If you change your mind and do not want to rename the selected simulation trial, press the Cancel button or the X button in the upper right of the Rename Optimization Trial window to return to the Optimization Trial Manager window.

![Figure 198. Renaming an optimization trial. This was accessed from the Optimization Trial Manager.](image1)

The second way to rename is from the "Compute" tab of the Watershed Explorer. Select the optimization trial you wish to rename by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected trial and click the left mouse button again. The highlighted name will change to editing mode (Figure 199). You can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished changing the name, press the Enter key to finalize your choice. You can also finalize your choice by clicking elsewhere on the "Compute" tab. If you change your mind while in editing mode and do not want to rename the selected optimization trial, press the Escape key.

![Figure 199. Renaming an optimization trial in the Watershed Explorer.](image2)
Deleting a Trial

There are two ways to delete an optimization trial. Both methods for deleting a trial remove it from the project and automatically delete previously computed results. Once a trial has been deleted it cannot be retrieved or undeleted.

The first way to perform a deletion is to use the Optimization Trial Manager, which you can access from the Compute menu. Select the optimization trial you wish to delete by clicking on it in the list of current optimization trials. The selected trial is highlighted after you select it. After you select a trial you can press the Delete button on the right side of the window. A window will open where you must confirm that you wish to delete the selected trial as shown in Figure 200. Press the OK button to delete the trial. If you change your mind and do not want to delete the selected optimization trial, press the Cancel button or the X button in the upper right to return to the Optimization Trial Manager window.

![Optimization Trial Manager](image)

**Figure 200.** Preparing to delete an optimization trial from the Optimization Trial Manager. A confirmation will be required after pressing the Delete button.

![Watershed Explorer](image)

**Figure 201.** Deleting an optimization trial in the Watershed Explorer.
The second way to delete is from the "Compute" tab of the Watershed Explorer. Select the optimization trial you wish to delete by clicking on it in the Watershed Explorer; it will become highlighted. Keep the mouse over the selected trial and click the right mouse button. A context menu is displayed that contains several choices including delete. Click the Delete command. A window will open where you must confirm that you wish to delete the selected trial. Press the OK button to delete the trial. If you change your mind and do not want to delete the selected optimization trial, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.

Selecting a Simulation Run

One of the principal tasks when creating an optimization trial using the wizard is the selection of a simulation run. The selected run forms the basis of the optimization trial by specifying the basin model, meteorologic model, and control specifications that will be used. However, you can change the simulation run you wish to use at any time using the Component Editor for the optimization trial. Access the Component Editor from the "Compute" tab of the Watershed Explorer (Figure 202). If necessary, click on the "Optimization Trials" folder to expand it and view the available optimization trials. The Component Editor contains a simulation run selection list that includes all of the runs in the project where the basin model has at least one element with observed flow.

![Optimization Trial](image)

Figure 202. The optimization trial component editor can be used to change the run used in a trial, to select the search method, and to control the search tolerance.

Search Method

Two search methods are available for minimizing the objective function and finding optimal parameter values. The univariate gradient method evaluates and adjusts one parameter at a time while holding other parameters constant. The Nelder and Mead method uses a downhill simplex to evaluate all parameters simultaneously and determine which parameter to adjust. The default method is the univariate gradient method. Also, the univariate gradient method is always used if only one parameter is selected.

Selecting the search method for the optimization trial is accessed from the "Compute" tab of the Watershed Explorer (Figure 202). Click on the optimization trial node to display the Component Editor for the optimization trial. If necessary, click on the "Optimization Trials" folder to expand it and view the available optimization trials in the project.
Controlling Search Tolerance

Two methods are provided for controlling the search process with the univariate gradient or Nelder Mead methods. The tolerance determines the change in the objective function value that will terminate the search. That is, when the objective function changes less than the specified tolerance, the search terminates. The maximum number of iterations also can be used to limit the search. Both search methods function by iteratively adjusting parameter values to lower the objective function value. The search will stop when the maximum number of iterations is reached regardless of changes in the objective function value or the quality of the estimated parameters.

Controlling the search method for the optimization trial is accomplished from the "Compute" tab of the Watershed Explorer (Figure 202). Click on the optimization trial node to display the Component Editor for the optimization trial. If necessary, click on the "Optimization Trials" folder to expand it and view the available optimization trials in the project. The tolerance is specified first and then the maximum iterations. Defaults are provided for both criteria. The initial default values depend on the selected search method.

Objective Function

The objective function measures the goodness-of-fit between the computed outflow and observed streamflow at the selected element. Six different functions are provided that measure the goodness-of-fit in different ways. The peak-weighted RMS error function is a modification of the standard root mean square error that gives greatly increased weight to flows above average and less weight to flows below average. The sum of squared residuals function gives increased weight to large errors and less weight to small errors. The sum of absolute residuals function gives equal weight to large and small errors. The percent error in peak flow function ignores the entire hydrograph except for the single peak flow value. The percent error in volume function ignores peak flow or timing considerations in favor of the volume. The time-weighted function gives greater weight to error near the end of the optimization time window and less weight to errors early in the window.

Select the objective function method for the optimization trial on the Component Editor for the objective function (Figure 203). Access the Component Editor from the "Compute" tab of the Watershed Explorer. If necessary, click on the "Optimization Trials" folder to expand it and view the available optimization trials in the project.
Click on the optimization trial node to expand it and see the objective function node. Click on the objective function node to view the editor. The objective function method is the first item in the Component Editor.

An element with observed flow was selected at the time the optimization trial was created. This is the location where the objective function will be evaluated. You can change the element location at any time from the Component Editor for the objective function. The selection list shows all of the elements with observed flow in the simulation run selected as the basis for the optimization trial. Select a different element in the list to change where the objective function will be evaluated. Recognize that parameters can only be estimated at locations upstream of the selected element. Changing the location will change which parameters can be estimated.

In general, the observed flow record at the selected element location should not contain any missing data. However, you can specify the amount of missing data in the observed flow that will be accepted. Specify the amount that may be missing as a percentage. The program will check the observed flow record and only perform the optimization if the percentage of missing flow in the record is less than the specified amount. Time steps with missing data are ignored when computing the value of the objective function. The default amount of missing flow is 0.0 percent.

The objective function is evaluated over a specified time window. The time window cannot begin before the start time in the control specifications used in the underlying simulation run. Also, the time window cannot end after the end time in the control specifications. However, you have the option of changing the time window to be narrower than the one given by the control specifications. By default, the start and end time for the objective function will default to the time window in the control specifications of the underlying simulation run.

Adding and Deleting Parameters

The parameters that will be automatically estimated must be at the selected element location or upstream of it in the element network. When the selected location is changed, elements may be automatically deleted if they are not upstream of the newly selected location. Parameters that can be chosen for estimation are a selected set of the loss rate, transform, baseflow parameters in the subbasin, and routing parameters in the reach. Parameters that should be strictly measured in the field are not allowed to be estimated. For example, it is not permissible to estimate subbasin area.

Care must be taken when selecting parameters for estimation. While it is possible to select the same parameter more than once, it is not recommended. In this scenario, the search method attempts to improve estimates by adjusting the same parameter value at different and sometimes conflicting points in the search. This can lead to a so-called blocking condition where the search method cannot accurately determine how to adjust parameters to improve the objective function and less than optimal results are achieved.

Care must also be taken when selecting parameters at elements upstream of the observed flow location. It is possible to select multiple parameters that have similar affects on the computed hydrograph at the evaluation location. In this case, adjustments to one parameter can off set adjustments in others. For example, estimates of the time of concentration at multiple subbasins upstream of the evaluation location often result in poor results. Special parameters called scale factors have been included that adjust all similar parameters upstream of the
evaluation location together in the same direction. However, care is still required even with this special scaling.

Add a new parameter to an optimization trial using the *Watershed Explorer*. Move the mouse over the optimization trial and press the right mouse button (Figure 204). A context menu is displayed that contains several choices including adding a parameter. Click the **Add Parameter** command. The subbasin loss rate parameters that can be added are shown in Table 23. Subbasin transform parameters are shown in Table 24 and baseflow parameters are shown in Table 25. Reach routing parameters that can be added are shown in Table 26.

Delete a parameter from an optimization trial using the *Watershed Explorer*. Select the parameter you wish to delete by clicking on it in the *Watershed Explorer*, it will become highlighted. Keep the mouse over the selected parameter and click the right mouse button (Figure 205). A context menu is displayed that contains several choices included deleting a parameter. Click the **Delete Parameter** command.

*Figure 204. Adding a parameter to an optimization trial.*

*Figure 205. Deleting a selected parameter from an optimization trial.*
Table 23. Subbasin loss rate parameters that can be estimated. Scale factors are included for all parameters except gridded curve number.

<table>
<thead>
<tr>
<th>Method</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deficit Constant</td>
<td>Initial Deficit</td>
</tr>
<tr>
<td></td>
<td>Constant Loss Rate</td>
</tr>
<tr>
<td></td>
<td>Maximum Deficit</td>
</tr>
<tr>
<td></td>
<td>Recovery Rate</td>
</tr>
<tr>
<td>Initial Constant</td>
<td>Initial Loss</td>
</tr>
<tr>
<td></td>
<td>Constant Loss Rate</td>
</tr>
<tr>
<td>Exponential</td>
<td>Initial Loss</td>
</tr>
<tr>
<td></td>
<td>Exponent</td>
</tr>
<tr>
<td></td>
<td>Loss Coefficient Ratio</td>
</tr>
<tr>
<td></td>
<td>Start Loss Coefficient</td>
</tr>
<tr>
<td>Green Ampt</td>
<td>Initial Loss</td>
</tr>
<tr>
<td></td>
<td>Hydraulic Conductivity</td>
</tr>
<tr>
<td></td>
<td>Wetting Front Suction</td>
</tr>
<tr>
<td></td>
<td>Initial Deficit</td>
</tr>
<tr>
<td>Curve Number</td>
<td>Initial Abstraction</td>
</tr>
<tr>
<td></td>
<td>Curve Number</td>
</tr>
<tr>
<td>Grid CN</td>
<td>Initial Abstraction Ratio</td>
</tr>
<tr>
<td></td>
<td>Potential Retention Factor</td>
</tr>
<tr>
<td>SMA</td>
<td>Canopy Capacity</td>
</tr>
<tr>
<td></td>
<td>Canopy Initial Percent</td>
</tr>
<tr>
<td></td>
<td>Surface Capacity</td>
</tr>
<tr>
<td></td>
<td>Surface Initial Percent</td>
</tr>
<tr>
<td></td>
<td>Soil Capacity</td>
</tr>
<tr>
<td></td>
<td>Tension Zone Capacity</td>
</tr>
<tr>
<td></td>
<td>Soil Initial Percent</td>
</tr>
<tr>
<td></td>
<td>Groundwater 1 Capacity</td>
</tr>
<tr>
<td></td>
<td>Groundwater 1 Initial Percent</td>
</tr>
<tr>
<td></td>
<td>Groundwater 2 Capacity</td>
</tr>
<tr>
<td></td>
<td>Groundwater 2 Initial Percent</td>
</tr>
<tr>
<td></td>
<td>Maximum Infiltration Rate</td>
</tr>
<tr>
<td></td>
<td>Maximum Soil Percolation Rate</td>
</tr>
<tr>
<td></td>
<td>Maximum Groundwater 1 Percolation Rate</td>
</tr>
<tr>
<td></td>
<td>Maximum Groundwater 2 Percolation Rate</td>
</tr>
<tr>
<td></td>
<td>Groundwater 1 Storage Coefficient</td>
</tr>
<tr>
<td></td>
<td>Groundwater 2 Storage Coefficient</td>
</tr>
</tbody>
</table>
### Table 24. Subbasin transform parameters that can be estimated.

<table>
<thead>
<tr>
<th>Method</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clark</td>
<td>Time of Concentration</td>
</tr>
<tr>
<td></td>
<td>Storage Coefficient</td>
</tr>
<tr>
<td>Kinematic Wave</td>
<td>Channel Mannings n</td>
</tr>
<tr>
<td></td>
<td>Collector Mannings n</td>
</tr>
<tr>
<td></td>
<td>Subcollector Mannings n</td>
</tr>
<tr>
<td>ModClark</td>
<td>Time of Concentration</td>
</tr>
<tr>
<td></td>
<td>Storage Coefficient</td>
</tr>
<tr>
<td>SCS</td>
<td>Time Lag</td>
</tr>
<tr>
<td>Snyder</td>
<td>Peaking Coefficient</td>
</tr>
<tr>
<td></td>
<td>Standard Lag</td>
</tr>
</tbody>
</table>

### Table 25. Subbasin baseflow parameters that can be estimated. The exact parameters that can be estimated for recession baseflow depend on the initial condition and threshold method selected in the basin model.

<table>
<thead>
<tr>
<th>Method</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bounded Recession</td>
<td>Initial Flow Rate</td>
</tr>
<tr>
<td></td>
<td>Initial Flow Rate per Area</td>
</tr>
<tr>
<td></td>
<td>Recession Constant</td>
</tr>
<tr>
<td>Linear Reservoir</td>
<td>Groundwater 1 Storage Coefficient</td>
</tr>
<tr>
<td></td>
<td>Groundwater 1 Number of Steps</td>
</tr>
<tr>
<td></td>
<td>Groundwater 2 Storage Coefficient</td>
</tr>
<tr>
<td></td>
<td>Groundwater 2 Number of Steps</td>
</tr>
<tr>
<td>Recession</td>
<td>Initial Flow Rate</td>
</tr>
<tr>
<td></td>
<td>Initial Flow Rate per Area</td>
</tr>
<tr>
<td></td>
<td>Recession Constant</td>
</tr>
<tr>
<td></td>
<td>Threshold Ratio</td>
</tr>
<tr>
<td></td>
<td>Threshold Flow Rate</td>
</tr>
</tbody>
</table>

### Table 26. Reach routing parameters that can be estimated.

<table>
<thead>
<tr>
<th>Method</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lag</td>
<td>Time Lag</td>
</tr>
<tr>
<td>Modified Puls</td>
<td>Number of Steps</td>
</tr>
<tr>
<td>Muskingum</td>
<td>Muskingum K</td>
</tr>
<tr>
<td></td>
<td>Muskingum X</td>
</tr>
<tr>
<td></td>
<td>Number of Steps</td>
</tr>
<tr>
<td>Muskingum Cunge</td>
<td>Mannings n</td>
</tr>
</tbody>
</table>
Specifying Parameter Information

A variety of information must be specified for each optimization parameter in order for the search method to function. Select the parameter you wish to edit by clicking on it in the Watershed Explorer. Click on the optimization trial node to expand it. The first node under the optimization trial will be the objective function. Following the objective function will be a separate node for each parameter. Click on the desired node in the Watershed Explorer to view the Component Editor for the optimization.

Each optimization parameter must select the element where the desired parameter resides. All eligible subbasin and reach elements upstream of the objective function evaluation location are shown in the selection list. Eligible subbasins are those using the methods listed in Table 23, Table 24, and Table 25. Eligible reaches are those using the methods listed in Table 26. Choosing an element from the list will update the list of available parameters based on the methods in use at that selected element. You may also have the choice of selecting the "All Subbasins" option in order to apply scale factors.

Each optimization parameter must select a specific parameter for the chosen element. The available choices are shown in the selection list. Once you make a choice from the list, the remainder of the data in the Component Editor will become available for use (Figure 206).

![Figure 206. Specifying properties for a parameter in an optimization trial.](image)

The initial value is the starting point for the parameter estimation process. The search method will begin search from that point for optimal parameter values. The default initial value is the parameter value in the corresponding basin model in the underlying simulation run. You may change the initial value without affecting the basin model.

It is possible to lock a parameter. When a parameter is locked, the initial value is used and no adjustments are made during the search process.

The minimum parameter value can be used to narrow the lower end of the range of values that will be used by the search method. Likewise, the maximum parameter value can be used to narrow the upper end of the range of values that will be used by the search method. A good source of information for narrowing the search range is preliminary estimates from field measurements or manual calibration. Default values for the minimum and maximum are provided based on physical and numerical limits. The search may continue outside the specified range. When it does so, a penalty is applied that is proportional to the distance outside the specified range. The penalty nudges the search for optimal parameter values back to the specified minimum and maximum range.
Selecting a Current Trial

There are two ways to select the current optimization trial. Both methods set the trial so that it can be computed.

The first way to select the current optimization trial is from the Compute menu. Click on the Compute menu and move the mouse to the Select Trial submenu. A submenu will open that lists all of the optimization trials in the project. Click on the trial name that you wish to become the current trial.

The second way to select the current simulation run is from the Watershed Explorer, on the "Compute" tab. Select the optimization trial you wish to become the current trial by clicking on it in the Watershed Explorer. The optimization trials are listed alphabetically in the "Optimization Trials" folder.

Checking Parameters

The program is equipped with the capability to check parameter values in the basin and meteorologic model as part of performing an optimization trial. The check is performed in two stages, similar to the way parameters are checked as part of a simulation run. The first stage of checking is performed before the actual optimization begins. During the first stage, required parameters are checked to make sure they have been specified and are within the minimum and maximum values. During the second stage, checking is performed that cannot happen until the actual optimization begins.

Parameter checking is performed automatically as part of computing an optimization trial. However, you can manually perform the first stage parameter checking. First be certain that an optimization trial is selected. To perform the check, click on the Compute menu and select the Check Parameters command. Any messages generated during the check will be displayed in the message window.

Computing a Trial

There are three ways to compute the currently selected optimization trial. All methods automatically perform parameter checking, and if no errors are generated, proceed to the actual computing of optimization results.

The first way to compute an optimization trial is from the Compute menu. Click on the Compute menu and then select the Compute Trial command at the bottom. The name of the current optimization trial is shown in brackets as part of the menu command. If the command is not available, it is because there is no current optimization trial; you must first select a trial. A window will automatically open that shows the progress of the compute. You will need to manually close the window when the compute is done, whether it failed or was successful.

The second way to compute an optimization trial is from the Watershed Explorer, on the "Compute" tab. Select the optimization trial you wish to compute by clicking on it in the Watershed Explorer with the right mouse button. A context menu is displayed that contains several choices including compute. Click the Compute command. The progress window will automatically open.

The third way to compute an optimization trial is from the toolbar. The compute button is enabled when ever there is a current trial that can be computed. If the button is not available or shows a different type of compute, you must first select an optimization trial. Press the button to compute the current optimization trial. The progress window will automatically open.
Viewing Results for a Trial

A variety of graphical and tabular results are available after an optimization trial is computed. The same results are also available for the current trial, so long as no data used in the optimization has changed. The program tracks all of the data in the optimization trial and selected simulation run. It further tracks all of the data used in the basin model, meteorologic model, and control specifications used in the selected simulation run. Results for an optimization trial are only available when none of this data has changed since the last time the trial was computed. If any of the data has changed, you will need to recompute the optimization trial before you will be allowed to view results. If any result is open at the time data changes, the affected results will automatically be closed.

Objective Function Table

The objective function table provides summary information about the objective function at the evaluation location, and is accessed on the "Results" tab of the Watershed Explorer. It includes summary information such as the basin model, meteorologic model, and control specifications used in the underlying simulation run. It indicates which objective function method was used, the start and end of the evaluation period for the function, and the final value of the function when the search method finished. It gives the volume, peak flow, time of peak flow, and time to the center of mass of the computed and observed hydrographs. Finally, it provides volume and peak flow differences between the computed and observed hydrographs.

![Objective Function Table](image)

**Figure 207.** Objective function table for an optimization trial. The table presents statistical results of the computed and observed flow at the optimization location.
The objective function table is accessed from the *Watershed Explorer*. Click on the optimization trial node to expand it. If necessary, first click on the "Optimization Trials" folder to expand it and view the optimization trials in the project. The optimization trial icon will be disabled if any data used in the trial has changed and results need to be recomputed. The objective function table icon is the first icon under its optimization trial node. Once you click on the objective function table node, the table will automatically open (Figure 207).

**Optimized Parameters Table**

The optimized parameters table provides summary information such as the basin model, meteorologic model, and control specifications used in the underlying simulation run, and is accessed on the "Results" tab of the *Watershed Explorer*. In tabular form it lists the parameters that were selected for optimization with one row for each parameter. The table has columns for element name, parameter name, units, initial value, optimized value, and sensitivity. The sensitivity is computed after the search method has finished; it indicates the percentage change in the objective function value resulting from a one percent change in the parameter value.

The optimized parameter table is accessed from the *Watershed Explorer*. Click on the optimization trial node to expand it. If necessary, first click on the "Optimization Trials" folder to expand it and view the optimization trials in the project. The optimization trial icon will be disabled if any data used in the trial has changed and results need to be recomputed. The optimized parameters table icon is the second icon under its optimization trial node. Once you click on the optimized parameters table node, the table will automatically open (Figure 208).

![Optimized Parameter Results for Trial "May 96" Table](image)

*Figure 208. Optimized parameters table for an optimization trial.*
**Hydrograph Comparison Graph**

The hydrograph comparison graph shows the computed outflow and observed streamflow at the objective function evaluation location. This allows you to visually compare how well the computed and observed hydrographs match. Vertical lines are drawn to show the start and end of the objective function time window. The degree to which the hydrographs match helps to indicate the quality of the parameter estimation.

The hydrograph comparison graph is accessed on the "Results" tab of the Watershed Explorer. Click on the optimization trial node to expand it. If necessary, first click on the "Optimization Trials" folder to expand it and view the optimization trials in the project. The optimization trial icon will be disabled if any data used in the trial has changed and results need to be recomputed. The hydrograph comparison icon is the third icon under its optimization trial node. Once you click on the hydrograph comparison node, the graph will automatically open (Figure 209).

![Figure 209. Hydrograph comparison graph showing the computed and observed flow at the optimization location.](image)

**Flow Comparison Graph**

The flow comparison graph shows the computed flow plotted against the observed flow. If the computed flow is exactly equal to the observed flow, then the data will plot exactly on a 45-degree line. However, in virtually all cases the match is not exact and there will be scatter in the data around the 45-degree line. Data points before the time of peak flow are shown with red circles and points after the time of peak flow are shown with blue triangles. The amount of scatter helps to indicate the quality of the parameter estimation.
Chapter 9 Parameter Estimation

Figure 210. Flow comparison graph showing the computed flow plotted against the observed flow. Different symbols are used for points before and after the observed peak flow.

The flow comparison graph is accessed on the "Results" tab of the Watershed Explorer. Click on the optimization trial node to expand it. If necessary, first click on the "Optimization Trials" folder to expand it and view the optimization trials in the project. The optimization trial icon will be disabled if any data used in the trial has changed and results need to be recomputed. The flow comparison icon is the fourth icon under its optimization trial node. Once you click on the flow comparison node, the graph will automatically open (Figure 210).

Flow Residuals Graph

The flow residuals graph shows the difference between computed and observed flow for each time step. It is determined as the computed flow minus the observed flow and may be positive or negative. Vertical lines are drawn to show the start and end of the objective function time window. The magnitude of the residuals helps to indicate the quality of the parameter estimation. The residuals also help to indicate if there are biases in the agreement between the computed and observed flows.

The flow residuals graph is accessed on the "Results" tab of the Watershed Explorer. Click on the optimization trial node to expand it. If necessary, first click on the "Optimization Trials" folder to expand it and view the optimization trials in the project. The optimization trial icon will be disabled if any data used in the trial has changed and results need to be recomputed. The flow residuals icon is the fifth icon under its optimization trial node. Once you click on the flow residuals node, the graph will automatically open (Figure 211).
Chapter 9  Parameter Estimation

Figure 211. Flow residuals showing the computed minus the observed flow at the optimization location.

Objective Function Graph

The objective function graph shows the value of the objective function at each iteration of the search method. The graph gives some indication of how fast the search method was able to converge to optimal parameter values. In some cases it may show that the search method was not converging at all.

The objective function graph is accessed from the Watershed Explorer. Click on the optimization trial node to expand it. If necessary, first click on the "Optimization Trials" folder to expand it and view the optimization trials in the project. The optimization trial icon will be disabled if any data used in the trial has changed and results need to be recomputed. The objective function icon is the sixth icon under its optimization trial node. Once you click on the objective function node, the graph will automatically open (Figure 212).

Element Summary Table

Each element upstream of the objective function evaluation location is shown on the "Results" tab of the Watershed Explorer under the optimization trial node (Figure 213). These elements are listed in alphabetical order after the objective function result tables and graphs. The results for each element are accessed by clicking on its node. The first item listed for each element is the summary table; click on the "Summary" node to view the result. It is similar to the summary table that can be viewed for a simulation run. The information included in the summary table varies by element type but always includes the peak flow, time of peak flow, and outflow volume.
Chapter 9 Parameter Estimation

Figure 212. Objective function graph showing the value of the objective function after each iteration in the search.

**Element Time-Series Preview Graph**

All of the time-series data computed by an individual element are available for viewing. The time-series data are listed under each element node on the "Results" tab of the *Watershed Explorer*. The first node under each element is the summary table. The remaining nodes for each element represent the different time-series data. Click on a time-series node to preview the data in the *Component Editor*. You may select multiple time-series data by holding the shift or control key while using the mouse to click on additional nodes. The selected time-series may come from different elements in the same optimization trial, the same element in trials, or different elements in different trials. The selected time-series may even come from both simulation runs and optimization trials. The selected time-series data will automatically be partitioned into groups based on data type (Figure 214).

**Time-Series Tables and Graphs**

Preview graphs of selected time-series data can be opened as graphs or time-series tables within the desktop area. Begin by selecting the time-series you wish to include in the graph or table. Once you have selected the desired time-series, you can press the graph or time-series table buttons on the toolbar. The chosen time-series will be graphed or tabulated.
Chapter 9 Parameter Estimation

Figure 213. Viewing optimization results in the Watershed Explorer. The summary table is available for each element above the optimization location. Actual time-series are also available for each element.

Figure 214. Preview graph showing computed outflow and observed flow from one optimization trial plus computed outflow from a different trial.
CHAPTER 10

Analyzing Simulation Runs

This chapter describes the family of tools that can be used to analyze simulation runs and produce secondary results or value-added processing. Each analysis uses one or more simulation runs as the basis for its computations. Currently there is only one type of analysis but more are planned for future versions of the program. The depth-area analysis automates the process of producing flow estimates due to frequency precipitation at multiple points of interest within a watershed.

Analyses

Analyses are one of the three different components that can compute results: simulation runs, optimization trials, and analyses. Each analysis is based on one or more simulation runs. The run provides the basic framework of a basin model, meteorologic model, and control specifications. Different types of analyses require different types and amounts of additional information in order to provide value-added processing to the simulation results. The results available from each analysis depend on the type of analysis. Specific information on the required parameters and available results for each type of analysis is given later in this chapter in the section describing each type of analysis.

Creating a New Analysis

A new analysis is created using a wizard that helps you navigate the steps to creating a new analysis. There are two ways to access the wizard. The first way to access the wizard is to click on the Compute menu and select the Create Analysis command. The wizard will open and begin the process of creating a new analysis. The second way to access the wizard is from the Analysis Manager. Click on the Compute menu and select the Analysis Manager command. The Analysis Manager will open and show any analyses that already exist. Press the New button to access the wizard and begin the process of creating an analysis, as shown in Figure 215.

The first step of creating an analysis is to select the type of analysis you wish to create (Figure 216). Currently there is only one choice: depth-area. Select the type of analysis you wish to create and press the Next button when you are ready to proceed to the next step. If you change your mind and do not want to create a new analysis, you can press the Cancel button at the bottom of the wizard or the X button in the upper right corner of the wizard. The Cancel button can be pressed at any time you are using the wizard.

The remaining steps in the wizard will depend on the type of analysis you choose to create. One of the steps will be to enter a name for the new analysis. A default name is provided which you can accept, or you can change the name to one you choose. You will be able to enter a description for the analysis at a later time. One of the steps will also be to specify the basis for the analysis. Some analysis types use a single simulation run as their basis. Other types may use multiple simulation runs. The wizard will guide you through the steps appropriate for the type of analysis.
you have chosen to create. Your progress will be shown in the title of the wizard, where it indicates the current step and the total number of steps. At any step you can press the <Back button to return to a previous step and change your choices. When you arrive at the last step, press the Finish button to create the new analysis. You will subsequently need to use the Component Editor for the analysis to finish specifying properties before it can be computed.

Figure 215. Beginning the process of creating a new depth-area analysis using the Analysis Manager. Create a different type of analysis by first selecting the desired type.

Figure 216. The first step of creating a new analysis is to select the type of analysis to create. The remaining steps depend on the type of analysis but always including giving it a name.
Chapter 10  Analyzing Simulation Runs

Copying an Analysis

There are two ways to copy an analysis. Both methods for copying an analysis create an exact duplicate with a different name. Once the copy has been made it is independent of the original and they do not interact.

The first way to create a copy is to use the Analysis Manager, which is accessed from the Compute menu. First select the type of analysis you wish to copy using the selection list at the top of the manager. With the correct analysis type showing, select the analysis you wish to copy by clicking on it in the list of current analyses. The selected analysis is highlighted after you select it. After you select a analysis you can press the Copy... button on the right side of the window. A new Copy Analysis window (Figure 217) will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected analysis. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected analysis, press the Cancel button or the X button in the upper right to return to the Analysis Manager window.

Figure 217. Creating a copy of an analysis.

The second way to copy is from the "Compute" tab of the Watershed Explorer. You may need to first click on the "Analyses" folder to expand it, then click on the folder for the correct type of analysis. Move the mouse over the analysis you wish to copy and press the right mouse button (Figure 218). A context menu is displayed that contains several choices including copy. Click the Create Copy... command. A new Copy Analysis window will open where you can name and describe the copy that will be created. A default name is provided for the copy; you can use the default or replace it with your own choice. A description can also be entered; if it is long you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Copy button to finish the process of copying the selected analysis. You cannot press the Copy button if no name is specified. If you change your mind and do not want to copy the selected analysis, press the Cancel button or the X button in the upper right of the Copy Analysis window to return to the Watershed Explorer.
Chapter 10  Analyzing Simulation Runs

Figure 218. Copying an analysis from the Watershed Explorer. The Copy Analysis window will appear after the Create Copy… menu command is selected.

Renaming an Analysis

There are two ways to rename an analysis. Both methods for renaming an analysis change its name and perform other necessary operations.

The first way to perform a rename is to use the Analysis Manager, which you can access from the Compute menu. First select the type of analysis you wish to rename using the selection list at the top of the manager. With the correct analysis type showing, select the analysis you wish to rename by clicking on it in the list of current analyses. The selected analysis is highlighted after you select it. After you select an analysis you can press the Rename… button on the right side of the window. A new Rename Analysis window (Figure 219) will open where you can provide the new name. If you wish you can also change the description at the same time. If the new description will be long, you can use the button to the right of the description field to open an editor. When you are satisfied with the name and description, press the Rename button to finish the process of renaming the selected analysis. You cannot press the Rename button if no name is specified. If you change your mind and do not want to rename the selected analysis, press the Cancel button or the X button in the upper right of the Rename Analysis window to return to the Analysis Manager window.

Figure 219. Renaming an analysis. This was accessed from the Analysis Manager.

The second way to rename is from the "Compute" tab of the Watershed Explorer. Select the analysis you wish to rename by clicking on it in the Watershed Explorer; it will become highlighted. You may need to first click on the "Analyses" folder to expand it, then click on the folder for the correct type of analysis. Keep the mouse over the selected analysis and click the left mouse button again. The highlighted name will change to editing mode (Figure 220). You can then move the cursor with the arrow keys on the keyboard or by clicking with the mouse. You can also use the
mouse to select some or all of the name. Change the name by typing with the keyboard. When you have finished changing the name, press the Enter key to finalize your choice. You can also finalize your choice by clicking elsewhere on the "Compute" tab. If you change your mind while in editing mode and do not want to rename the selected analysis, press the Escape key.

![Image](image.png)

*Figure 220. Renaming an analysis in the Watershed Explorer.*

### Deleting an Analysis

There are two ways to delete an analysis. Both methods for deleting an analysis remove it from the project and automatically delete previously computed results. Once an analysis has been deleted it cannot be retrieved or undeleted.

The first way to perform a deletion is to use the Analysis Manager, which you can access from the Compute menu. First select the type of analysis you wish to delete using the selection list at the top of the manager. With the correct analysis type showing, select the analysis you wish to delete by clicking on it in the list of current analyses. The selected analysis is highlighted after you select it. After you select a analysis you can press the Delete button on the right side of the window (Figure 221). A window will open where you must confirm that you wish to delete the selected analysis. Press the OK button to delete the analysis. If you change your mind and do not want to delete the selected analysis, press the Cancel button or the X button in the upper right to return to the Analysis Manager window.

The second way to delete is from the "Compute" tab of the Watershed Explorer. Select the analysis you wish to delete by clicking on it in the Watershed Explorer; it will become highlighted. You may need to first click on the "Analyses" folder to expand it, then click on the folder for the correct type of analysis. Keep the mouse over the selected analysis and click the right mouse button. A context menu is displayed that contains several choices including delete (Figure 222). Click the Delete command. A window will open where you must confirm that you wish to delete the selected analysis. Press the OK button to delete the analysis. If you change your mind and do not want to delete the selected analysis, press the Cancel button or the X button in the upper right to return to the Watershed Explorer.
Chapter 10  Analyzing Simulation Runs

Figure 221. Preparing to delete an analysis from the Analysis Manager. A confirmation will be required after pressing the **Delete** button.

Figure 222. Deleting an analysis in the Watershed Explorer.

**Selecting a Current Analysis**

There are two ways to select the current analysis. Both methods set the analysis so that it can be computed.

The first way to select the current analysis is from the **Compute** menu. Click on the **Compute** menu and move the mouse to the **Select Analysis** submenu. A submenu will open that lists the different types of analysis. Move the mouse to the correct submenu for the analysis type you wish to select. All of the analyses of that type currently in the project will be listed. Click on the analysis name that you wish to become the current analysis.

The second way to select the current analysis is from the **Watershed Explorer**, on the "Compute" tab. Select the analysis you wish to become the current run by clicking on it in the **Watershed Explorer**. You may need to first click on the "Analyses" folder to expand it, then click on the folder for the correct type of analysis. The analyses in the...
project are listed alphabetically under the appropriate type, under the "Analyses" folder.

**Checking Parameters**

The program is equipped with the capability to check parameter values in the basin and meteorologic model as part of performing an analysis. The check is performed in two stages, similar to the way parameters are checked as part of a simulation run. The first stage of checking is performed before the actual analysis begins. During the first stage, required parameters are checked to make sure they have been specified and are within the minimum and maximum values. During the second stage, checking is performed that cannot happen until the actual analysis begins.

Parameter checking is performed automatically as part of computing an analysis. However, you can manually perform the first stage parameter checking. First be certain that an analysis is selected. To perform the check, click on the **Compute** menu and select the **Check Parameters** command. Any messages generated during the check will be displayed in the message window.

**Computing an Analysis**

There are three ways to compute the currently selected analysis. All methods automatically perform parameter checking, and if no errors are generated, proceed to the actual computing of analysis results.

The first way to compute an analysis is from the **Compute** menu. Click on the **Compute** menu and then select the compute command at the bottom of the menu. The exact wording of the compute command will depend on the type of analysis that is selected. When a depth-area analysis is selected, the command will read **Compute Depth-Area**. The name of the current analysis is shown in brackets as part of the menu command. If the command is not available, it is because there is no current analysis; you must first select an analysis. A window will automatically open that shows the progress of the compute. You will need to manually close the window when the compute is done, whether it failed or was successful.

The second way to compute an analysis is from the **Watershed Explorer**, on the "Compute" tab. Select the analysis you wish to compute by clicking on it in the **Watershed Explorer** with the right mouse button. You may need to first click on the "Analyses" folder to expand it, then click on the folder for the correct type of analysis. A context menu is displayed that contains several choices including compute. Click the **Compute** command. The progress window will automatically open.

The third way to compute an analysis is from the toolbar. The compute button is enabled when ever there is a current analysis that can be computed. If the button is not available or shows a different type of compute, you must first select an analysis. Press the button to compute the current analysis. The progress window will automatically open.

**Viewing Results for an Analysis**

A variety of graphical and tabular results are available after an analysis is computed, the exact type or results depends on the type of analysis. The same results are also available for the current analysis, so long as no data used in the analysis has changed. The program tracks all of the data in the analysis and selected simulation run or runs on which it is based. It further tracks all of the data used in the basin model, meteorologic model, and control specifications used in the selected simulation run or runs. Results for an analysis are only available when none of this data has
changed since the last time the analysis was computed. If any of the data has changed, you will need to recompute the analysis before you will be allowed to view results. If any result is open at the time data changes, the affected results will automatically be closed. Specific information on the results available for each type of analysis is given in the section describing each type of analysis.

**Depth-Area Analysis**

A depth-area analysis is designed to assist in the process of developing peak flows in a watershed due to frequency precipitation. For example, it may be the goal to compute the streamflow expected to result from the storm with 1% exceedance probability (100-yr storm). The usual assumption is that the 1% precipitation will result in the 1% flow, and that the hydrology model can accurately simulate the conversion of precipitation to flow. Developing the flow values throughout a watershed for a specific exceedance probability is a key step in developing flow frequency curves.

Storm area is a key component of a frequency storm. The area is used to determine the appropriate depth-area reduction factor. The depth-area reduction factor is used to account for the observation from empirical data that average precipitation intensity decreases as the area of a storm increases. Thus the average precipitation intensity of a 200 km$^2$ storm is generally much less than the intensity of a 10 km$^2$ storm. Proper determination of the flow at a given evaluation point in the watershed requires that the frequency storm have an area equal to the drainage area at that point. Failure to match the storm area to the drainage area can result in significant under or over estimation of the flow. It is simple enough to setup a simulation run with the meteorologic model set to compute flow at a particular evaluation point. However, it is often the case that the flow must be estimated at many points in the watershed.

The depth-area analysis automates the process of developing a separate frequency storm for each evaluation point. The analysis requires the specification of an underlying simulation run that must use a meteorologic model set to use the frequency storm precipitation method. The analysis also includes the listing of various analysis points where the flow should be evaluated. When the analysis computes, it automatically generates frequency storms based on the one specified in the meteorologic model but with appropriate storm area for each analysis point. The instantaneous peak flows at each analysis point are automatically collected and available in a tabular display.

**Selecting a Simulation Run**

One of the steps in the wizard for creating a new depth-area analysis is the selection of a simulation run. This type of analysis must use a meteorologic model with the frequency precipitation method. Only simulation runs where the run uses an appropriate meteorologic model will be shown.

Selecting the simulation run for a depth-area analysis after it has been created is accessed from the "Compute" tab of the Watershed Explorer. Click on the analysis node to display the Component Editor for the depth-area analysis. You may need to first click on the "Analyses" folder to expand it, then click on "Depth-Area Analyses" folder. The "Depth-Area Analysis" tab is shown along with the "Analysis Points" tab, as shown in Figure 223. The selection list shows all of the simulation runs that have an appropriate meteorologic model using the frequency precipitation method. You can also press the simulation run button next to the selection list to bring up a chooser. The chooser helps to make a selection by showing the description of each run.
Chapter 10 Analyzing Simulation Runs

Selecting Analysis Points

Selecting analysis points is done after a depth-area analysis has been created using the wizard. Access the Component Editor for the analysis points from the "Compute" tab of the Watershed Explorer. Click on the analysis node to display the "Analysis Points" tab (Figure 224). You may need to first click on the "Analyses" folder to expand it, then click on the "Depth-Area Analyses" folder. The analysis points are selected in a table. All elements in the basin model from the underlying simulation run are available for selection.

Peak Flow Summary Table

Results for the depth-area analysis are only available on the "Results" tab in the Watershed Explorer. Currently the results are limited to a summary table showing information for each of the analysis points (Figure 225). The table shows certain summary information such as the analysis name, underlying simulation run name, and component names in the underlying simulation run. The principal information is a table that includes one row for each analysis point and columns for analysis point name, drainage area, peak flow, and time of peak flow. Access the peak flow summary table from the "Results" tab of the Watershed Explorer. Click on the analysis for which you wish to view results by clicking on it. You may need to first click on the "Analyses" folder to expand it, then click on the "Depth-Area Analyses" folder. Clicking on the analysis will cause it to expand. Currently, the only item under the analysis is the peak flow summary table. Click on the summary table and it will automatically open (Figure 226).
Chapter 10  Analyzing Simulation Runs

Figure 225. Selecting the peak flow summary table from the results available for a depth-area analysis.

Figure 226. Viewing the peak flow summary table for a depth-area analysis.
APPENDIX A

Data Storage in HEC-DSS

The project DSS file stores time-series and paired data generated in the project. Data is stored in blocks called records that are identified with a unique pathname. Predefined descriptors are used in the C-part of the pathname. This appendix describes the C-part descriptors for each data type.

Descriptors

- **AREA**  Computed area for a reservoir element.
- **ATI-COLD**  Computed antecedent temperature index for cold content in the snowmelt method.
- **ATI-COLDRATE**  Manually entered antecedent temperature index versus coldrate function for a paired data function.
- **ATI-MELT**  Computed antecedent temperature index for meltrate in snowmelt.
- **ATI-MELTRATE**  Manually entered antecedent temperature index versus meltrate function for a paired data function.
- **COLD CONTENT**  Computed cold content in snowmelt.
- **CROP COEFFICIENT**  Manually entered time-series of crop coefficient for a time-series gage.
- **DISTANCE-ELEVATION**  Manually entered cross section in the paired data manager.
- **ELEVATION**  Computed pool elevation for a reservoir element.
- **ELEVATION-AREA**  A manually entered elevation-area function defined in the paired data manager.
- **ELEVATION-FLOW**  An elevation-discharge curve defined in the reservoir element. No longer used in the current program version.
- **ELEVATION-Storage**  A manually entered elevation-storage function defined in the paired data manager.
- **ET-CANOPY**  Computed actual evapotranspiration from the canopy layer in the soil moisture accounting loss method.
- **ET-POTENTIAL**  Potential evapotranspiration for a subbasin element as computed by the meteorologic model.
- **ET-SOIL**  Computed actual evapotranspiration from the soil layer in the soil moisture accounting loss method.
- **ET-SURFACE**  Computed actual evapotranspiration from the surface depression layer in the soil moisture accounting loss method.
EXCESS-CANOPY  Computed incremental precipitation minus canopy interception in the soil moisture accounting loss method.

FLOW  Final computed flow for an element.

FLOW-BASE  Computed baseflow for a subbasin element.

FLOW-COMBINE  Computed total inflow to an element.

FLOW-DIRECT  Surface flow computed by transforming excess precipitation for a subbasin element.

FLOW-DIVERSION  Computed diversion flow for a diversion element.

FLOW-IN  Total inflow to a reach element.

FLOW-LOCAL  Local flow at a junction when the basin model is set to compute local flow at junctions.

FLOW-LOCAL-SIM  Computed local flow without blending for a junction when observed flow is present, blending is used, and the basin model is set to compute local flow at junctions.

FLOW-OBSERVED  Observed flow for an element using the optional observed flow time-series gage.

FLOW-RESIDUAL  Residual flow for an element with observed flow. The residual is calculated as computed flow minus the observed flow.

FLOW-SIM  Computed flow without blending at an element when observed flow is present and blending is used.

FLOW-UNIT GRAPH  Manually entered unit hydrograph in the paired data manager.

GROUNDMELT  Manually entered annual groundmelt pattern in the paired data manager.

INfiltrATION  Computed infiltration from the surface layer to the soil in the soil moisture accounting loss method. Also, the amount of loss attributed to infiltration in the deficit constant loss method.

LIQUID WATER  Computed liquid water in the snowpack in snowmelt.

MELTRATE  Manually entered annual meltrate pattern in the paired data manager.

MOISTURE DEFICIT  Computed moisture deficit in the deficit constant and gridded deficit constant loss methods.

OUTFLOW-GW  Computed outflow from a groundwater layer to channel baseflow in the soil moisture accounting loss method.

PERC-SOIL  Computed percolation from the soil layer to the upper groundwater layer in the soil moisture accounting loss method.

PERC-GW  Computed percolation from the upper groundwater layer to the lower groundwater layer or from the lower groundwater layer out of the system in the soil moisture accounting loss method.

PERCENT-GRAPH  Manually entered percentage curve in the paired data manager.
Appendix A  Data Storage in HEC-DSS

PRECIP-EXCESS  At a subbasin, incremental precipitation minus losses.
PRECIP-CUM    Cumulative precipitation for a time-series gage.
PRECIP-INC    Incremental precipitation for a time-series gage or subbasin element.
PRECIP-LOSS   At a subbasin, the incremental precipitation that was converted to loss during loss calculations.
PRECIP-LWASS  The liquid water available at the soil surface calculated for a subbasin by a snowmelt method.
PRECIP-STAND DEV  At a subbasin, the standard deviation of incremental precipitation for each time interval computed using gridded precipitation.
RECOVERED DEFICIT  Computed recovery of the deficit by evapotranspiration in the deficit constant and gridded deficit constant loss methods.
SOLAR RADIATION  Manually entered time-series of solar radiation for a time-series gage.
STAGE         Computed stage for an element when the optional elevation-discharge curve is used. Also, manually entered time-series of stage for a time-series gage.
STAGE-FLOW    A manually entered elevation-discharge function defined in the paired data manager.
STAGE-OBSERVED  Observed stage for an element using the optional observed stage time-series gage.
STAGE-RESIDUAL  Residual stage for an element with observed stage. The residual is calculated as computed flow minus the observed flow.
STAGE-TAILWATER  The computed tailwater stage at a reservoir element.
STORAGE       Computed storage for a reservoir element.
STORAGE-CANOPY  Computed storage depth of the canopy layer in the soil moisture accounting loss method.
STORAGE-ELEVATION  A storage-elevation curve defined in the reservoir element. No longer used in the current program version.
STORAGE-FLOW    A manually entered storage-discharge function defined in the paired data manager.
STORAGE-GW      Computed storage depth of a groundwater layer in the soil moisture accounting loss method.
STORAGE-SOIL    Computed storage depth of the soil layer in the soil moisture accounting loss method.
STORAGE-SURFACE  Computed storage depth of the surface layer in the soil moisture accounting loss method.
SWE            Computed snow water equivalent in snowmelt.
TEMPERATURE    Computed temperature for a subbasin elevation band in snowmelt. Also, manually entered time-series of temperature for a time-series gage.
APPENDIX B

Grid Cell File Format

The ModClark transform method requires a grid cell file. The file defines cells for each subbasin. Parameters for each cell are also included in the grid-cell file. This appendix describes the grid-cell file format. The file can be produced using available geographic information system (GIS) tools.

File Definition

The grid-cell file begins with the keyword "Parameter Order" followed by a colon and parameter keywords indicating the order for reading parameters from the file (Figure 227). The keyword "End" must be on a line by itself after the "Parameter Order" line. Valid parameter keywords are shown in Table 27. Parameter keywords are not case sensitive and are separated by spaces. If the parameter order is not defined, it is assumed to be: Xcoord Ycoord TravelLength Area. The coordinate system of Xcoord and Ycoord used in the file must match the coordinate system used in the gridded DSS records. Typically the coordinate system will be either hydrologic rainfall analysis project (HRAP) or standard hydrologic grid (SHG).

Table 27. Parameter keyword definitions.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Definition</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>XCoord</td>
<td>x-coordinate of the southwest corner of the cell</td>
<td>integer value</td>
</tr>
<tr>
<td>YCoord</td>
<td>y-coordinate of the southwest corner of the cell</td>
<td>integer value</td>
</tr>
<tr>
<td>TravelLength</td>
<td>travel time index from the cell to the subbasin outlet</td>
<td>kilometers</td>
</tr>
<tr>
<td>Area</td>
<td>area of cell within the subbasin</td>
<td>square kilometers</td>
</tr>
</tbody>
</table>

The data for a subbasin begins with the keyword "Subbasin" followed by a colon and the subbasin identifier. One line beginning with the keyword "Grid Cell" follows for each cell in the subbasin. Data for the subbasin ends with the keyword "End". Keywords are not case sensitive and may contain spaces. Blank lines can be included and lines beginning with "#" are ignored as comments. The same grid-cell file can be referenced by more than one subbasin, allowing data for many subbasins to be stored in the same file. The identifier for a subbasin must be exactly the same in the grid-cell file as it is in the basin model.
Parameter Order: Xcoord YCoord TravelLength Area
End:
Subbasin: 85
<table>
<thead>
<tr>
<th>Grid Cell</th>
<th>Xcoord</th>
<th>Ycoord</th>
<th>TravelLength</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>633</td>
<td>359</td>
<td>88.38</td>
<td>3.76</td>
<td></td>
</tr>
<tr>
<td>634</td>
<td>359</td>
<td>84.51</td>
<td>0.18</td>
<td></td>
</tr>
<tr>
<td>633</td>
<td>358</td>
<td>85.55</td>
<td>16.13</td>
<td></td>
</tr>
<tr>
<td>632</td>
<td>358</td>
<td>82.55</td>
<td>12.76</td>
<td></td>
</tr>
<tr>
<td>625</td>
<td>348</td>
<td>13.75</td>
<td>12.07</td>
<td></td>
</tr>
<tr>
<td>626</td>
<td>348</td>
<td>17.12</td>
<td>0.09</td>
<td></td>
</tr>
<tr>
<td>622</td>
<td>347</td>
<td>21.19</td>
<td>3.26</td>
<td></td>
</tr>
<tr>
<td>623</td>
<td>347</td>
<td>15.56</td>
<td>9.96</td>
<td></td>
</tr>
</tbody>
</table>
End:
Subbasin: 86
<table>
<thead>
<tr>
<th>Grid Cell</th>
<th>Xcoord</th>
<th>Ycoord</th>
<th>TravelLength</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>637</td>
<td>361</td>
<td>59.13</td>
<td>6.79</td>
<td></td>
</tr>
<tr>
<td>638</td>
<td>361</td>
<td>59.04</td>
<td>6.95</td>
<td></td>
</tr>
<tr>
<td>636</td>
<td>361</td>
<td>56.68</td>
<td>1.17</td>
<td></td>
</tr>
<tr>
<td>636</td>
<td>360</td>
<td>55.08</td>
<td>16.38</td>
<td></td>
</tr>
<tr>
<td>636</td>
<td>347</td>
<td>67.96</td>
<td>2.45</td>
<td></td>
</tr>
<tr>
<td>637</td>
<td>347</td>
<td>71.72</td>
<td>7.41</td>
<td></td>
</tr>
<tr>
<td>638</td>
<td>347</td>
<td>72.57</td>
<td>8.78</td>
<td></td>
</tr>
<tr>
<td>639</td>
<td>347</td>
<td>73.32</td>
<td>0.04</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 227. Sample grid-cell file.*
Map File Format

Watershed boundaries and stream lines can be displayed as a background for hydrologic elements on the Basin Model screen. The use of a background map is optional and not required for any calculations. This appendix describes the background map file format. The file can be produced using available geographic information system (GIS) tools.

File Definition

Watershed boundary and stream line features are both defined in the same file, which is in plain ASCII format. Each feature type is contained in a separate section of the file; it is not important which section is first in the file. Each section begins with the keyword "MapGeo" followed by a colon and either "BoundaryMap" or "RiverMap" (Figure 228).

A map segment defines a list of map coordinates that are connected by a line. A closed segment defines a polygon and an open segment defines a line. Closed segments are used for watershed boundaries and open segments are used for stream lines. Each segment begins with the keyword "MapSegment" followed by a colon and either "Closed" or "Open." The last coordinate in a closed segment is automatically connected to the first coordinate.

Segment coordinates are defined with x-y pairs. Map features are automatically scaled in the Basin Model screen. Coordinates are therefore independent of projection, units, and offset. All segments must be in the same coordinate system.
Appendix C  Map File Format

<table>
<thead>
<tr>
<th>MapGeo: BoundaryMap</th>
<th>MapSegment: closed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>582242.875000, 4174922.500000</td>
</tr>
<tr>
<td></td>
<td>582220.875000, 4174961.500000</td>
</tr>
<tr>
<td></td>
<td>582205.625000, 4175013.750000</td>
</tr>
<tr>
<td></td>
<td>581981.000000, 4174672.750000</td>
</tr>
<tr>
<td></td>
<td>582025.812500, 4174696.250000</td>
</tr>
<tr>
<td></td>
<td>582068.812500, 4174711.000000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MapSegment: closed</th>
</tr>
</thead>
<tbody>
<tr>
<td>582810.125000, 4174024.500000</td>
</tr>
<tr>
<td>582874.687500, 4173973.750000</td>
</tr>
<tr>
<td>582950.687500, 4173902.750000</td>
</tr>
<tr>
<td>582554.000000, 4174000.250000</td>
</tr>
<tr>
<td>582667.687500, 4174003.750000</td>
</tr>
<tr>
<td>582810.125000, 4174024.500000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MapGeo: RiverMap</th>
<th>MapSegment: open</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>582750.187500, 4176706.000000</td>
</tr>
<tr>
<td></td>
<td>582687.000000, 4176594.000000</td>
</tr>
<tr>
<td></td>
<td>582657.375000, 4176468.500000</td>
</tr>
<tr>
<td></td>
<td>582613.125000, 4176359.500000</td>
</tr>
<tr>
<td></td>
<td>582482.125000, 4174521.500000</td>
</tr>
<tr>
<td></td>
<td>582555.250000, 4174377.500000</td>
</tr>
<tr>
<td></td>
<td>582555.250000, 4174378.000000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MapSegment: open</th>
</tr>
</thead>
<tbody>
<tr>
<td>582941.500000, 4175098.500000</td>
</tr>
<tr>
<td>582920.500000, 4175009.750000</td>
</tr>
<tr>
<td>582912.312500, 4174956.500000</td>
</tr>
<tr>
<td>582699.375000, 4174540.500000</td>
</tr>
<tr>
<td>582618.250000, 4174468.250000</td>
</tr>
</tbody>
</table>

Figure 228. Sample background map file.
Appendix D

HEC-HMS and HEC-1 Differences

Development of the Hydrologic Modeling System (HEC-HMS) was initiated as part of the Next Generation Software Project. It was designed to succeed the aging HEC-1 program for simulating the rainfall-runoff process. However, it was not designed to simply add a graphical user interface to the old program. Instead it was designed to use advances in engineering and computer science wherever possible to improve the quality of simulation results. The modernization process has therefore resulted in some changes in how computations are performed. While these modernizations result in computation differences between the two programs, the HEC-HMS results are preferred because of the modern techniques that have been implemented. Changes in parameter specifications or computations are detailed in the following sections.

Recession Baseflow

The recession baseflow method includes a recession constant for specifying the rate at which recession flow decreases with time. In HEC-HMS the parameter is defined as the ratio of the current recession flow to the recession flow one day earlier. The HEC-1 parameter, called RTIOR, is defined as the ratio of the current recession flow to the flow one hour later. The following equation can be used to convert an HEC-1 recession constant for use in HEC-HMS:

\[ \text{Recession Constant} = \frac{1}{(\text{RTIOR})^{24}} \]

Clark Unit Hydrograph

The Clark method produces a unit hydrograph that theoretically has an infinite number of ordinates, because each ordinate on the tail of the unit hydrograph is computed by multiplying the preceding ordinate by a constant fraction. In both HEC-HMS and HEC-1, the tail of the unit hydrograph is truncated when the volume represented by the unit hydrograph exceeds 99.5% of the unit depth. In HEC-HMS the ordinates are then adjusted using a flow weighting scheme to produce a volume of exactly 100%. No adjustment is made in HEC-1.

Muskingum Cunge Routing

Hydraulic properties of channels and cross sections are computed differently in HEC-HMS and HEC-1.

General Channel Properties

In HEC-HMS, properties are computed from the physical properties of the channel, whereas in HEC-1 the properties are computed with formulas based on the kinematic wave assumption. In HEC-HMS the cross-sectional flow area is computed as:

\[ A = y(w + z y) \]
and the ratio of wave speed, $c$, to flow velocity, $v$, is:

$$\frac{c}{v} = \frac{(10 w z y) + \left(16 z y^2 \sqrt{z^2 + 1}\right) + \left(5 w^2\right) + \left(6 w y \sqrt{z^2 + 1}\right)}{3(w + 2 z y)(w + 2 y \sqrt{z^2 + 1})}$$

where $w$ is the bottom width, $z$ is the side slope, and $y$ is the flow depth. Velocity is computed using Manning's formula.

In HEC-1 the cross-sectional flow area is computed as:

$$A = \left(\frac{Q}{\alpha}\right)^{\frac{1}{m}}$$

and the wave speed, $c$, is computed as:

$$c = \alpha m A^{m-1}$$

where $\alpha$ and $m$ are kinematic parameters based on the channel shape.

**Eight Point Cross Sections**

In HEC-HMS the flow depth for a given discharge is determined from the cross section properties and then area, top width, and wave speed are computed for that depth using the cross section properties. In HEC-1 the discharge, area, top width, and wave speed are computed for 20 depths and stored in a table. During the routing process, area, top width, and wave speed are interpolated from the table for each discharge value.
Appendix E Terms and Conditions of Use

APPENDIX E

Terms and Conditions of Use

Use of the program is governed by the terms and conditions of use. They limit what can be done with the program software, waive warranty, limit liability, and indemnify the developers and the United States government. The program cannot be used unless the terms and conditions of use are accepted; the full text is given below.

Terms and Conditions of Use

The United States Government, US Army Corps of Engineers, Hydrologic Engineering Center ("HEC") grants to the user the rights to install Hydrologic Modeling System (HEC-HMS) "the Software" (either from a disk copy obtained from HEC, a distributor or another user or by downloading it from a network) and to use, copy and/or distribute copies of the Software to other users, subject to the following Terms and Conditions of Use:

All copies of the Software received or reproduced by or for user pursuant to the authority of this Terms and Conditions of Use will be and remain the property of HEC.

User may reproduce and distribute the Software provided that the recipient agrees to the Terms and Conditions for Use noted herein.

HEC is solely responsible for the content of the Software. The Software may not be modified, abridged, decompiled, disassembled, unobfuscated or reverse engineered. The user is solely responsible for the content, interactions, and effects of any and all amendments, if present, whether they be extension modules, language resource bundles, scripts or any other amendment.

No part of this Terms and Conditions for Use may be modified, deleted or obliterated from the Software.

No part of the Software may be exported or re-exported in contravention of U.S. export laws or regulations.

Waiver of Warranty

THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS PROVIDE HEC-HMS "AS IS," WITHOUT ANY WARRANTY OR CONDITION, EXPRESS, IMPLIED OR STATUTORY, AND SPECIFICALLY DISCLAIM ANY IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. Depending on state law, the foregoing disclaimer may not apply to you, and you may also have other legal rights that vary from state to state.

Limitation of Liability

IN NO EVENT SHALL THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, BE LIABLE FOR LOST PROFITS OR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR
IN CONNECTION WITH USE OF HEC-HMS REGARDLESS OF CAUSE, INCLUDING NEGLIGENCE.

THE UNITED STATES GOVERNMENT'S LIABILITY, AND THE LIABILITY OF ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, TO YOU OR ANY THIRD PARTIES IN ANY CIRCUMSTANCE IS LIMITED TO THE REPLACEMENT OF CERTIFIED COPIES OF HEC-HMS WITH IDENTIFIED ERRORS CORRECTED. Depending on state law, the above limitation or exclusion may not apply to you.

Indemnity

As a voluntary user of HEC-HMS you agree to indemnify and hold the United States Government, and its agencies, officials, representatives, and employees, including its contractors and suppliers, harmless from any claim or demand, including reasonable attorneys' fees, made by any third party due to or arising out of your use of HEC-HMS or breach of this Agreement or your violation of any law or the rights of a third party.

Assent

By using this program you voluntarily accept these terms and conditions. If you do not agree to these terms and conditions, uninstall the program and return any program materials to HEC (If you downloaded the program and do not have disk media, please delete all copies, and cease using the program.)